Contents

Chapter 1. Introduction                                      1
    Using the Carlson Software Manual ........................................... 2
    Product Overview ........................................................................... 2
    System Requirements ........................................................................ 4
    Installing Carlson Software ......................................................... 5
    Authorizing Carlson Software ........................................................ 11
    Carlson Registration ........................................................................ 13
    LandXML ......................................................................................... 14
    Setting Up a Project ......................................................................... 14
    Startup Wizard .................................................................................. 15
    Command Entry .................................................................................. 17
    Layer and Style Defaults ................................................................. 18
    Standard Report Viewer ..................................................................... 18
    Report Formatter ................................................................................ 20
    Instruction Manual and Program Conventions ................................... 23
    Carlson File Types ........................................................................... 24
    Quick Keys ......................................................................................... 27
    Obtaining Technical Support ............................................................. 28

Chapter 2. AutoCAD Overview 30
    Issuing Commands ............................................................................... 31
    General Commands ............................................................................. 32
    Selection of Items ............................................................................... 33
    Properties and Layers ......................................................................... 34
    Properties Toolbar ............................................................................. 35

Chapter 3. File Menu 36
    Set Project/Data Folder ..................................................................... 37
    Drawing Explorer ................................................................................ 40
    Project Explorer .................................................................................. 43
    Store Project Archive ......................................................................... 45
    Extract Project Archive .................................................................... 46
Chapter 4. Edit Menu

Erase by Layer ........................................... 65
Erase by Closed Polyline .................................. 65
Erase Outside ............................................ 66
Copy To Layer ............................................ 67
Copy Polyline Section ..................................... 67
Variable Offset .......................................... 68
Block Explode ............................................ 68
Extend to Intersection .................................... 68
Extend Arc ............................................... 69
Extend by Distance ....................................... 69
Break by Crossing Polyline ............................... 72
Break Polyline at Specified Distances ..................... 73
Break at Intersection ..................................... 74
Change Elevations ........................................ 74
Change Attribute Style .................................... 74
Change Style ............................................. 75
Change Block/Inserts Rotate ............................... 76
Change Block/Inserts Substitute .......................... 77
Change Block/Inserts Resize .............................. 77
Pivot Point Rotate by Bearing ............................. 78
Entity Insertion Point Rotate .............................. 78
Text Enlarge/Reduce ...................................... 79
Rotate Text ............................................... 79
Change Text Font .......................................... 79
Change Text Size .......................................... 80
Change Text Width ........................................ 80
Change Text Oblique Angle ............................... 81
Flip Text ................................................. 82
Split Text into Two Lines ........................................ 82
Text Explode To Polylines ....................................... 83
Replace Text .............................................. 83
2D Align .............................................. 83
Entities to Polylines ........................................ 85
Reverse Polyline ........................................ 85
Reduce Polyline Vertices .................................... 85
Densify Polyline Vertices .................................... 86
Smooth Polyline ........................................ 86
Draw Polyline Blips ....................................... 87
Add Intersection Points .................................... 88
Add Polyline Vertex ....................................... 88
Edit Polyline Vertex ....................................... 89
Edit Polyline Section ....................................... 90
Remove Duplicate Polylines .................................. 91
Remove Polyline Arcs ...................................... 91
Remove Polyline Segment ................................... 92
Remove Polyline Vertex .................................... 92
Create Polyline ID Labels .................................... 93
Change Polyline Width ...................................... 94
Set Polyline Origin ....................................... 94
Remove Polyline Arcs ...................................... 95
Change Polyline Elevation ................................... 95
Check Elevation Range ..................................... 96
Highlight Crossing Plines .................................... 97
Fillet 3D Polyline ......................................... 98
Join 3D Polyline .......................................... 99
Offset 3D Polyline ......................................... 99
Join Nearest ............................................. 100
3D Entity to 2D .......................................... 101
Add Points At Elevation ..................................... 101
Select by Filter ........................................... 102
Select by Elevation ......................................... 102
Select by Area ............................................. 103
### Chapter 5. View Menu

- Zoom Selection ................................................... 105
- Zoom Points ...................................................... 105
- 3D Viewer Window ................................................ 105
- Surface 3D Viewer ............................................... 108
- Twist Screen: Standard .......................................... 109
- Twist Screen: Line Pline or Text .............................. 110
- Twist Screen: Surveyor .......................................... 110
- Restore Due North ............................................... 111
- Set Layer ........................................................... 111
- Change Layer ...................................................... 111
- Freeze Layer ....................................................... 112
- Thaw Layer ........................................................ 112
- Isolate Layer ....................................................... 112
- Restore Layer ....................................................... 113

### Chapter 6. Draw Menu

- 2D Polyline ........................................................ 115
- 3D Polyline ........................................................ 117
- 3 Point .............................................................. 118
- PC, PT, Radius Point ............................................. 118
- PC, Radius, Chord ................................................. 118
- PC, Radius, Arc Length ......................................... 119
- 2 Tangents, Radius ............................................... 119
- 2 Tangents, Arc Length .......................................... 120
- 2 Tangents, Chord Length ....................................... 120
- 2 Tangents, Mid-Ordinate ....................................... 120
- 2 Tangents, External .............................................. 121
- 2 Tangents, Tangent Length ..................................... 121
- 2 Tangents, Degree of Curve .................................... 122
- Tangent, PC, Radius, Arc Length .............................. 122
- Tangent, PC, Radius, Tangent Length ......................... 123
- Tang, PC, Radius, Chord Length ............................... 123
- Tang, PC, Radius, Delta Angle ................................. 124
- Compound or Reverse .......................................... 124
- 3-Radius Curve Series .......................................... 125
Best Fit Curve .......................................................... 126
Curve Calc .............................................................. 126
Spiral Curve ............................................................ 127
Insert Symbols .......................................................... 128
Insert Multi-Point Symbols ........................................ 130
Draw By Example ....................................................... 133
Sequential Numbers .................................................. 134
Arrowhead ............................................................. 135
Curve - Arrow .......................................................... 136
Boundary Polyline ..................................................... 136
Shrink-Wrap Entities .................................................. 137
Polyline by Nearest Found ......................................... 138

Chapter 7. Inq-Set Menu 140

Point ID ............................................................... 141
Layer ID ............................................................... 141
Bearing & 3D Distance ............................................ 141
Curve Info ............................................................. 142
Polyline Info .......................................................... 143
Drawing Setup ......................................................... 143
Layer Report .......................................................... 146
Layer Inspector ....................................................... 146
Drawing Inspector .................................................... 147
Find Point ............................................................. 148
Display-Edit File ..................................................... 149
Display Last Report ................................................ 149
System Variable Editor ............................................ 149
Point Object Snap .................................................... 152
Save/Load Tablet Calibration ..................................... 152
Tablet Calibrate ....................................................... 153
Set/Reset X-Hairs .................................................... 154
Rescale Drawing ....................................................... 155
Mortgage Block ....................................................... 156
Title Block ............................................................ 156
Edit Symbol Library ................................................. 159
Toolbars ............................................................... 160
Chapter 8. Points Menu

Point Defaults ............................................. 184
Draw-Locate Points ......................................... 186
List Points ................................................... 189
Import Text/ASCII File ...................................... 191
Export Text/ASCII File ...................................... 192
Set Coordinate File ......................................... 194
CooRDinate File Utilities .................................... 195
Point Group Manager ........................................ 210
Edit Points ................................................... 219
Erase Points ................................................... 220
Translate Points ............................................. 220
Rotate Points .................................................. 222
Align Points ................................................... 224
Scale Points ................................................... 225
Move Points ................................................... 228
Edit Point Attributes ....................................... 228
Edit Multiple Pt Attributes ................................. 230
Move Point Attributes Single .............................. 233
Move Point Attributes with Leader ....................... 233
Scale Point Attributes ..................................... 234
Erase Point Attributes ..................................... 235
Twist Point Attributes ..................................... 235
Resize Point Attributes .................................... 236
Fix Point Attribute Overlaps ............................... 236
Trim by Point Symbol ...................................... 239
Change Point Layer.Color .................................. 240
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tape Baseline</td>
<td>263</td>
</tr>
<tr>
<td>Create Points from Entities</td>
<td>264</td>
</tr>
<tr>
<td>SurvCE/SurvStar Data Transfer</td>
<td>265</td>
</tr>
<tr>
<td>Edit-Process Raw Data File</td>
<td>267</td>
</tr>
<tr>
<td>Field to Finish</td>
<td>315</td>
</tr>
<tr>
<td>4 Sided Building</td>
<td>339</td>
</tr>
<tr>
<td>Inverse with Area</td>
<td>340</td>
</tr>
<tr>
<td>Station/Polyline Centerline</td>
<td>341</td>
</tr>
<tr>
<td>Offsets Point Entry</td>
<td>348</td>
</tr>
<tr>
<td>Calculate Offsets</td>
<td>350</td>
</tr>
<tr>
<td>Cut Sheet Spreadsheet Editor</td>
<td>352</td>
</tr>
<tr>
<td>Cut Sheet Report</td>
<td>353</td>
</tr>
</tbody>
</table>

**Chapter 10. Field Menu**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carlson Field Icon Menu</td>
<td>364</td>
</tr>
<tr>
<td>Configure Field</td>
<td>365</td>
</tr>
<tr>
<td>Equipment Setup</td>
<td>375</td>
</tr>
<tr>
<td>Align GPS To Local Coordinates</td>
<td>396</td>
</tr>
<tr>
<td>Typical Alignment Scenarios</td>
<td>399</td>
</tr>
<tr>
<td>Point Store</td>
<td>400</td>
</tr>
<tr>
<td>Stakeout</td>
<td>408</td>
</tr>
<tr>
<td>Auto Points at Interval</td>
<td>411</td>
</tr>
<tr>
<td>Track Position</td>
<td>413</td>
</tr>
<tr>
<td>Satellite SkyPlot</td>
<td>414</td>
</tr>
<tr>
<td>Monitor GPS Position</td>
<td>415</td>
</tr>
<tr>
<td>Benchmark</td>
<td>415</td>
</tr>
<tr>
<td>Resection</td>
<td>416</td>
</tr>
<tr>
<td>Building Face Surface</td>
<td>417</td>
</tr>
<tr>
<td>Pattern Point Survey</td>
<td>417</td>
</tr>
<tr>
<td>Point Check By Robotics</td>
<td>418</td>
</tr>
</tbody>
</table>

**Chapter 11. DTM Menu**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation Difference</td>
<td>420</td>
</tr>
<tr>
<td>List Elevation</td>
<td>422</td>
</tr>
<tr>
<td>Assign Contour Elevations</td>
<td>422</td>
</tr>
<tr>
<td>Make 3D Grid File</td>
<td>424</td>
</tr>
</tbody>
</table>
Chapter 12.  Roads Menu

Centerline Position ........................................... 455
Offset Stakeout .................................................. 457
Slope Staking .................................................... 461
Slope Inspector ................................................... 465
Prepare Story Stake ............................................. 466
Story Stake By Points .......................................... 468
Story Stake Along Polyline ..................................... 468
Input-Edit Centerline File ...................................... 469
Polyline to Centerline File ..................................... 476
Draw Centerline File .......................................... 476
Centerline Conversions ......................................... 477
Input-Edit Profile File .......................................... 477
Draw Profile .................................................... 479
Profile Conversion .............................................. 494
Design Template ................................................ 496
Draw Typical Template ......................................... 506
Template Transition ............................................. 508
Input-Edit Super Elevation ..................................... 511
Draw Section File ................................................ 515
Section Conversion ............................................. 526

Chapter 13.  GIS Menu

GIS Settings .................................................... 529
Define Template Database ..................................... 529
Input-Edit GIS Data ............................................. 532
GIS Inspector .................................................... 533
GIS Inspector Settings ......................................... 534
GIS Query/Report ............................................... 535
Chapter 14. Field User Guide ................................. 551
  Field to Finish ........................................ 552
  GIS Data Collection .................................... 557
  Depth Sounder ....................................... 568

Chapter 15. Equipment Reference ......................... 571
  Apache Lightbar ................................... 572
  CSI GBX Pro ....................................... 572
  Depth Sounder ...................................... 573
  Geodimeter/Trimble 5600 .............................. 574
  InnerSpace Tech Depth Sounder ...................... 575
  Laser Atlanta ..................................... 576
  Leica Disto ........................................ 576
  Leica GPS System 500 ................................ 576
  Leica TC Series ..................................... 577
  Manual Total Station ................................ 579
  Mikrofyn Lightbar .................................. 580
  Navcom Configuration Guide ......................... 580
  Navcom GPS Setup ................................... 582
  Nikon Total Stations .................................. 585
  OmniStar Otto ....................................... 586
  Simulation (GPS) ..................................... 587
  Sokkia .................................................. 587
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topcon Total Stations</td>
<td>589</td>
</tr>
<tr>
<td>Trimble</td>
<td>592</td>
</tr>
</tbody>
</table>
Introduction
Using the Carlson Software Manual

This manual is designed as a reference guide. It contains a complete description of all commands in the Carlson Software product. The chapters are organized by program menus, and are arranged in the order that the menus appear in Carlson Software.

Product Overview

Carlson Software offers a full suite of commands for downloading, entering, and processing field survey data and for generating final plats and drawings. Carlson Software can function as a total and complete software solution for the land surveying firm, or as an affordable downloading, calculation, and preparatory solution used in conjunction with the more full-featured Carlson Software. Built around the Autodesk 2007 OEM graphics engine, Carlson Software reads and writes standard AutoCAD drawings and assures familiarity to AutoCAD trained staff.

Data Collection

The power of Carlson Survey begins with data collection. Carlson Survey downloads all major collectors ranging from Geodimeter and TDS to Leica, Nikon, Sokkia, and SMI. The raw data is stored in "RW5" format and can be viewed, edited and processed. The processing, or calculation of coordinates, recognizes "direct and reverse" and other forms of multiple measurement, and processes sets of field measurements. Surveys can be balanced and closed by selective use of angle balance, compass, transit, Crandall, and least squares methods—or simply by direct calculation with no adjustment. Commands exist for finding bad angles and for plotting the traverse and sideshot legs of the survey in distinct colors as a means of searching for "busts" or errors. In addition to downloading of data from electronic data collectors, the program accepts manual entry of field notes directly into a spreadsheet format, permitting review, storage, and editing. Alternatively, field notes can be entered for immediate calculation and screen plotting of points, with the "raw notes" stored simultaneously, permitting re-processing and re-calculation as needed. For data that was not field-surveyed, but was provided in the form of an ASCII or binary point file, Carlson Software offers the "Import Text/ASCII File" command, unrivaled in its flexibility to read foreign data sources.

Field to Finish

The survey world is recognizing the power of coding field shots with descriptions that lead to automatic layering, linework, and symbol work. Office drafting time can be reduced by 50% or more with intelligent use of descriptions, leading to "field to finish" plotting. For example, breaklines, which act as barriers to triangulation, should be placed on streams, ridges, toe-of-slopes and top-of-banks for more accurate contouring. With the field to finish command, breaklines can be created by field coding, with descriptions such as DL, for creating 3D polyline ditch lines, or TB for creating top-of-bank polylines, etc. and this coordinate data can be simply plotted to the screen as undifferentiated points. However, with the field to finish command, the data can be plotted in one step, creating 3D polyline break lines, building lines, light poles, manholes, edge-of-pavements, that are all distinctly layered and fully annotated. The field to finish command within Carlson Survey is extremely robust, so much so that it can adapt to a coding system made up on-the-fly, or a coding system that has been received from an outsourced survey. Field crew coding and office processing using the field to finish command can save valuable hours of drafting and eliminate misinterpretations, paving the way for quick plat generation or supporting supplemental engineering work.

Deed Work

Carlson Survey allows you to enter old deeds and plot the linework, then add bearing and distance annotation optionally. Distances can be entered in meters and feet, and even in the old measurement forms of chains, poles, links, and varas. Both tangent and non-tangent arcs can be entered. Closures, distances traversed, and areas are
automatically reported. Working in reverse, the command Legal Description creates a property description suitable for deed recording directly from a closed polyline on the screen. If that polyline has point numbers with descriptions at any of the property corners, these descriptions will appear in the deed report, as in "...thence N 45 degrees, 25 minutes, 10 seconds E to a fence post...". Deed files can be saved, re-loaded, edited, re-drawn and printed or plotted to the screen in a report form.

Drafting and Design

Carlson Software offers approximately 150 different symbols and north arrows, broken down by categories (for example, points, trees, map symbols). You can create new categories or supplement or change the available point symbols within any category. The program is designed to receive entire sets of new, customized point symbols in a single command. Attributes of points, such as elevation and point number, can be selectively "frozen," allowing the creation of final plats with symbols and optional descriptions remaining on points, as desired. Linework, typically in the form of polylines, can be drawn by any combination of point number and "snap" selection, to create property lines, street lines, easements and right-of-ways, building lines and borders. In addition to Carlson Software's standard line types, dozens of special line types are available, including tree lines, fence lines, all manner of utility lines, stonewalls, and customizable line types. Design features include automatic street intersections and cul-de-sacs, and automatic lot layout. For lots, you can pick your right-of-way and back property polylines, specify desired acreages and frontage/rear lot parameters, and the lots are automatically calculated and drawn. Hinged Area, Sliding Side Area, and Area Radial from Curve are excellent design tools, with an easy, graphic interface. All design polylines can be converted to point numbers at vertices and radius points for purposes of field stakeout.

Annotation

With a full slate of annotation commands, Carlson Survey is all you need to finalize your boundary surveys and plats. There is a wide range of bearing and distance annotation options, including the Auto-Annotate command, which allows you to annotate an entire selection set of polylines in one step. Station and offset annotating, as for right-of-way lines, is provided. Use commands such as Special Leader, Station Polyline, Draw North Arrow, and Draw Bar Scale to dress up the drawing and give it a hand-drafted look. Commands such as Title Block and Draw Legend, as well as sequential lot numbering and the area labeling commands, help you complete the finished drawing quickly.

Powerful Utilities

Carlson Software contains many strong utilities, particularly polyline utilities. You can Join Nearest disconnected polylines, turn 2-sided figures into closed, 4-sided figures, offset, trim, and extend 3D polylines, create building "footprints" with left and right entries using Extend by Distance, even reverse polyline directions. There are over 20 significant polyline utilities available, including Reduce Vertices, which weeds out duplicate or unnecessary vertices and cuts down on drawing size. Boundary Polyline is a simplified version of the AutoCAD command Boundary, and its opposite, Shrinkwrap Entity. Other categories of utilities include point attribute editing, scaling, twisting and re-sizing, text editing, font alteration and re-sizing, and advanced layer manipulation. Raster images such as aerial photos and scanned images can be placed on drawings.

Contouring and Terrain Modeling

There are many higher order features in Carlson Survey. Full contouring is provided, with options for smoothing and labeling contours, highlighting index contours and clipping contours to selected perimeters. Carlson Survey can be used to create both grid files and TIN files (.flt format). Volumes can be computed between grid files, inside any selected polyline perimeter. Profiles can be extracted from contour maps or hand-entered, as generic "point-to-point" profiles or as road profiles with vertical curves. The Design Pad Template command carves in building pads, pits, parking lots, roads, and other 3D features into any existing terrain. Land forms created by contouring and Design
Pad Template can be viewed in 3D and rotated in real time, using the 3D Viewer Window command. In addition to all the commands needed to create final drawings, Carlson Survey also contains commands to perform many engineering tasks typically encountered by survey firms.

Carlson Software is the ideal stand-alone solution for the survey and drafting organization, but it is also the perfect go-between product for the large civil engineering firm with in-house or outsourced survey operations. It compliments Carlson Roads. Carlson Survey enables Carlson Software to serve the full spectrum of the surveying and civil engineering design world.

**System Requirements**

**Operating System**

- Microsoft® Windows® Vista, Windows XP Professional or Home Edition (SP1 or SP2), Windows XP Tablet PC Edition (SP2), or Windows 2000 (SP3 or SP4).

**Notes**

- It is recommended that you install and run Carlson Software on an English version of the operating system.
- Users of Windows NT 4.0 or Windows 2000 Professional must have Administrator permissions to install Carlson Software. Not assigning these permissions can cause Carlson Software to perform incorrectly. See Windows Help for information about assigning user permissions.
- Carlson OEM 2007 based products do not support Windows 95, 98 and ME (all editions).

**Processor**

Intel® Pentium® IV processor recommended

**RAM**

512 MB

**Video**

1024 x 768 VGA display with true color

**Hard disk**

750 MB free disk space

**Pointing device**

Mouse

**CD-ROM**

Any speed (for installation only)

**Optional hardware**
Printer or plotter
Digitizer
Modem or access to an Internet connection
Open GL-compatible 3D video card

The OpenGL driver that comes with the 3D graphics card must have the following: Full support of OpenGL or later. An OpenGL Installable Client Driver (ICD). The graphics card must have an ICD in its OpenGL driver software. The "miniGL" driver provided with some cards is not sufficient for use with this Autodesk CAD engine.

Web browser
Microsoft Internet Explorer 6.0 (SP1 or higher)

Installing Carlson Software

If you're installing Carlson Software on Microsoft® Windows NT® 4.0 or Windows 2000, you must have permission to write to the necessary system registry sections. To do this, make sure that you have administrative permissions on the computer on which you're installing. Before you install Carlson Software, close all running applications. Make sure you disable any virus-checking software. Please refer to your virus software documentation for instructions.

Note: If you are upgrading from an older version of Carlson Software, you must uninstall the older version before installing Carlson Software. This is required for successful software installation and to meet the guidelines of the EULA (End User License Agreement).

1 Insert the CD into the CD-ROM drive.
If Autorun is enabled, it begins the setup process when you insert the CD.
To stop Autorun from starting the installation process automatically, hold down the SHIFT key when you insert the CD.
To start the installation process without using Autorun, from the Start menu (Windows), choose Run. Enter the CD-ROM drive letter, and setup. For example, enter d:\setup.

2 The Windows Installer dialog box is displayed briefly, followed by a dialog box for entering in your serial number.
In the Enter Carlson Software 2008 Serial Number dialog box, you must enter the serial number provided with your copy of Carlson Software. Then click OK.

3 The Setup dialog box appears briefly, followed automatically by the Carlson Software 2008 Setup dialog. If this is the initial installation, you will see the dialogs shown below.
After reading this second dialog box, press Next. If this version of Carlson Software has already been installed, you will see a different Add/Remove dialog instead. In this case, it is recommended that you Cancel the current install and go to Windows > Control Panel > Add/Remove Programs and remove Carlson Software 2008. After the old installation is removed, you may start the install process once more to continue.

4 Review the End-user License Agreement, accept it with the correct click choice, and then click Next. You can optionally print it out.

5 On the Select Installation Type dialog box, select the type of installation you want: Typical or Custom. Choose Next.
Typical installs the following features:

- Program files: Executables, menus, toolbars, Help templates, TrueType® fonts, and additional support files
- Internet tools: Support files
- Fonts: SHX fonts
- Samples: Sample drawings
- Help files: Online documentation

Custom installs only the files you select. By default, the Custom installation option installs all Carlson Software features. To install only the features you want, choose a feature, and then select one of the following options from the list:

- Will be installed on local hard drive: Installs a feature or component of a feature on your hard drive.
- Entire feature will be installed on local hard drive: Installs a feature and its components on your hard drive.
- Feature will be installed when required only: Installs a feature on demand.
- Entire feature will be unavailable: Makes the feature unavailable.

6 On the Destination Folder dialog box, do one of the following:
Choose Next to accept the default destination folder/directory.

Choose Browse to specify a different drive and folder where you want Carlson Software to be installed. Choose any directory that is mapped to your computer (including network directories), or enter a new path. Choose OK and then Next.

Setup installs some files required by Carlson Software in your system folder (for example, c:\Windows\System, or c:\Winnt\System32). This folder may be on a different drive than the folder you specify as the installation folder (for example, d:\Program Files\Carlson Software). You may need up to 60 MB of space in your system folder, depending on the components you select to install. Setup alerts you if there is insufficient free space on the drive that contains your system folder.

On the Start Installation page, choose Next to start the installation.
The Updating System dialog box is displayed while Carlson Software is installed.

When the installation is complete, the Setup Complete dialog box is displayed. Choose Finish to exit the installation program.

It is strongly recommended that you restart your computer at this point in order for the new configuration settings to take effect.

Congratulations! You have successfully installed Carlson Software. You are now ready to register your product and
start using the program. To register the product, double-click the Carlson Software icon on your desktop and follow the instructions.

**Authorizing Carlson Software**

The first time you start Carlson Software, the Registration Wizard is displayed.

Carlson Software has installed an automated procedure for registering your software license. Change keys are no longer given over the telephone. Please choose one of the following registration methods.

**Form:** This method allows you to fill out a form that you can print out and fax or mail to Carlson Software for registration.

**Internet:** If your computer is online, you may register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter change key:** Choose this method after you have received your change key from Carlson Software (if you previously used the Form method above).

**Register Later:** Choose this method if you want to register later. You may run Carlson Software for 30 days before you are required to register.

After you choose the registration method, press Next.
Choose the reason for installation. The very first time you install Carlson Software is the only time you will choose the first reason. All subsequent installations require a choice from the remaining options.

**New install or maintenance upgrade of Carlson Software:** If you are installing Carlson Software for the first time, choose this reason.

**Home use. See License Agreement:** Choose this reason if you are installing on your home computer. See your license agreement for more details!

**Re-Installation of Carlson Software:** Choose this reason if you are reinstalling on the same computer with no modifications.

**Windows or AutoCAD upgrade:** Choose this reason if you have reinstalled Carlson Software after installing a new version of Microsoft Windows.

**New Hardware:** Choose this reason if you are installing Carlson Software on a new computer or if your existing computer has had some of its hardware replaced such as the hard disk, network adapter, etc.

After you choose the reason for installation, press Next, and then enter the required information into the dialog.

If you are using the Form method, press the Print Fax Sheet button, to print out the form. You may fax this form to the number printed on the form, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY
If you are using the Internet method, press Next. After a few seconds, your registration will complete. If your registration is successful, you will receive a message such as the one below. If your registration is unsuccessful, please note the reason why and try again. Keep in mind that each serial number may be registered to a single computer only.

![Carlson Software Registration Dialog](image.png)

If you do not have access to the Internet, and do not have a printer, you must write down the information from the User Info tab (shown above) and fax it to 606-564-9525, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

**Carlson Registration**

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

![Carlson Registration Options](image.png)

**Fax:** This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

**Internet:** Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter pre-authorized change key:** If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.
Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

LandXML

What is LandXML?

LandXML, initiated by Autodesk in December 1999, is an industry-driven, open XML data exchange standard that addresses the needs of private and public land development professionals, software/hardware producers, and service vendors. The first draft LandXML schema was derived from the earlier ASCII-based EAS-E (Engineering and Surveying - Exchange) data interchange standard initiative.

LandXML specifies a design data structure that:

- Transfers civil engineering / survey design data between producers and consumers.
- Provide a data format suitable for long-term data archival.
- Provide a standard format for official electronic design submission.

LandXML data may also be used as:

- Source data for quantity take-off, cost estimation.
- Source data for custom calculations and reports.
- Accessible design data from remote/field devices.
- Data extraction and submittal format for GIS databases.
- Engineering design data transport layer for collaborative applications.

In the past year, many software programs adopted native XML support features. Desktop applications such as Microsoft Office, AutoCAD as well as database programs such as Microsoft SQL 2000, IBM DMBS and Oracle support XML data nearly seamlessly. LandXML provides a specialized XML format for land development professionals that suits their needs and provides data that can be used in new ways with business, technical and database software that supports XML.

For the latest in LandXML developments, visit http://www.landxml.org/

Setting Up a Project

Over 200 Carlson Software settings can be specified in the Configure command on the Settings menu. These values are used to initialize Carlson Software options when opening a new or existing drawing. Among these settings is the coordinate point number format, object linking options, and settings for the COGO portion of Carlson Software. The template drawing is the default drawing that opens up each time Carlson Software is started. To customize the template drawing, run the OPEN command under the File pulldown menu, change the files of type setting to
Drawing Template and choose the template drawing, "survey.dwt". Then make your changes and SAVE the drawing as survey.dwt in the Template folder.

When starting a new drawing, one of the first steps is to run **Drawing Setup** in the Settings menu. Drawing Setup sets the drawing scale, the units mode as either english or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure > General Settings. When a drawing is saved, the Drawing Setup variables are saved with the drawing. Carlson Software will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson Software will draw the text with a height of 5 (50 * 0.1). Then, when the drawing is plotted at 1"=50', the text will be 0.1 inches.

Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE or SAVEAS command, Carlson Software writes a settings file that contains all the active data file names. Then, when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same folder as the drawing file, and has the same name as the drawing, with an .INI extension. For example, a drawing called survey.dwg would have a settings file called survey.ini.

The Drawing Explorer command, in the Settings menu within the **Project** command, tracks and stores project files associated with each saved drawing. You may use this command to generate a report of all files used in a particular drawing. Project Explorer takes this concept one level further and allows you to group drawing files and their associated project files. Reports can also be generated using this tool.

**Startup Wizard**

For creating a new drawing in Carlson Software, the Startup Wizard can guide you through starting and setting up the drawing. This wizard is optional, and it can be turned on or off in the Settings menu by clicking **Configure**, then General Settings. You can also exit out of the Startup Wizard at any time. When the Startup Wizard is turned on and the New drawing command is executed, you will see the Select template dialog box.
Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

Here, you need to set the new drawing name and scale. Set the drawing (.dwg) name by picking the Set button. The Drawing to Create dialog box opens. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. Type in the drawing name in the File name field and click the Save button.

Then you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Clicking the Next button brings up the Startup Wizard Data Files dialog box. This is for setting the Data Path and CRD File.
The Set button for the Data Path is for setting the folder where Carlson Software will store the data files, such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information.

![Startup Wizard Data Files](image)

The Coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate file. The New option will erase any point data that is found in the specified CRD file. The Existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.

The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. If the None option is set, then the Startup Wizard is finished.

Once point data has been imported from the data collector or text/ASCII file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the AutoCAD command prompt. Pressing Enter at the command prompt repeats that last command. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Preferences dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.
Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and AutoCAD commands. This allows you to execute the commonly used AutoCAD commands from the menus while running Carlson.

Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

**Layer and Style Defaults**

Many Carlson Software commands have default layers such as AREATXT for area labels and BRGTEXT for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands, and several can be set in the **Configure** command under the Settings menu. Sometimes you may want to use the current layer, and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that is set in the dialog, the default layer can be set as "CLAYER", which will use the current layer.

For example, if the annotation layer is set to CLAYER, then annotation will be drawn in the current layer instead of BRGTEXT or whatever the annotation layer used to be. This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.

**Standard Report Viewer**

Many Carlson routines display output in the Standard Report Viewer as shown below. The report can be edited directly in the report viewer. Report Viewer commands are described below.

**Open:** This allows you to open an ASCII file and display the contents in the report viewer.

**Save:** Save the contents of the report viewer to a text file.
**SaveAs:** This allows you to save the contents of the report viewer to a file.

**Append To:** This allows you to append the contents of the report viewer to another file.

**Print:** Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

**Screen:** Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

**Undo:** Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Select All: Selects all the text in the report viewer.
Cut: Deletes the selected text and places it on the Windows® clipboard.
Copy: Copies the selected text to the Windows® clipboard.
Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.
Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.
Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.
Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.
Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

Report Formatter

A number of Carlson routines use a dialog box called Report Formatter Options to allow you to specify how and which results of calculations should be presented in the report. This report routine lets you select a set of data to report and the format of the selected data. The report can be displayed in either the standard report viewer as described in the previous section, Microsoft® Excel or Microsoft® Access.

The data set in the Report Formatter may be thought of as a spreadsheet, where columns are various fields related to a single item such as time period, drillhole, area and etc. Each new row represents a new item. Descriptions of these field names are displayed in the Available list of the Report Formatter. To include a data field in the report, highlight the field name in the Available list on the left and pick the Add button. This moves the field name to the Used list on the right. The order of items in the right list defines the order in which they will be displayed. In addition, the items may be sorted as specified by the user in the right column. Items are first sorted by the first column, then items with the same value in the first column are sorted as specified for the second column, and so on.
These subsequent sortings do not modify sortings of previous columns. If you specify no sorting for some column (even the first one) then no sorting will happen in subsequent columns either. For example, you may want to sort production by mining panel name but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It will bring up a standard report viewer showing the report data. Upon exiting the viewer, you come back into the Report Formatter for further data manipulation if needed. The other data output and destination options include saving the specified data into a comma-delimited text or CSV file, creating a spreadsheet preview whereby the data may be exported using several methods, and direct export to Microsoft® Excel. Due to the popularity of the Excel output choice, you can also customize certain Excel options, including setting mirror output, just prior to export. Data can also be merged to combine current and old reports, and it be exported to XML format files. There is an option for output to other database formats as well.

You may define new columns as equations based on existing columns. Click on the Edit User Attributes button to add a new field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones (except that for
them these options are set by program). The summation level is defined by the "Total" pop-up list in the middle of the dialog. By default only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted. For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name. This feature makes the Report Formatter a very flexible tool for results exploration, even before or without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.

To save a new version of the format, type in a new name (or use default to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine it will recall this last format. To pick another format just pull down on list of formats in the left top corner and pick which format to use. To Delete an unwanted format, pick it from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file to load before export, as well as a left upper cell to start with and sheet number to use. Totals which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.
For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the AutoCAD entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS menu commands to manage and report the data.

![Image of Report Formatter Options dialog box]

**Instruction Manual and Program Conventions**

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

<90.0000>

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response to AutoCAD or Carlson commands.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an *OSNAP* mode that is turned on by the command.
Carlson File Types

.AAN Auto-annotate Settings
.ADF Annotation Default Settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CG C&G Coordinate File
.CG R C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.CO G Cadvantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CR Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.CTL SDMS Format Raw Data
.CTR Auto-Run Strata Isopach Maps
.CUI Customized User Interface AutoCAD Menu
.CUT SMI Format Cutsheet
.CV T SEDCAD Format Hydro Network
.DAT GPS Localization Definition
.DCF Deed Correlation File
.DCL Carlson dialogs
.DEM Digital Elevation Model
.DEQ Drillhole equations
.DHF Drillhole Text File
.DHT Dragline History
.DIL StrataCalc Convert As-Determined Qualities
.DLL Carlson programs files
.DTF Drillhole Data Format
.DTS Drillhole Text Settings
.DWG AutoCAD drawings
.DXF Drawing Exchange Format
.DZR Dozer Push Settings
.EQO Mining equipment options
.EQU Mining equipment definitions
.ERD Erodible Channel Settings
.EW Earthwork Section End Areas
.EXE Carlson programs
Chapter 1. Introduction
Quick Keys

"Quick Keys" allows you to enter in the coding shown here on the left, and by doing so run the commands shown on the right.

2DP = 2D Polyline
3DP = 3D Polyline
A = Arc
AL = Align
B = Block
BB = Bearing-Bearing Intersect
BD = Bearing-Distance Intersect
BH = Boundary Hatch
C = Circle
CH = Change Properties
CO = Color
CP = Copy
DD = Distance-Distance Intersect
DI = Distance
DT = Draw Text
E = Erase
EA = Enter-Assign Point
EX = Extend
F = Fillet
Obtaining Technical Support
via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.
via Electronic Mail

- The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.
AutoCAD Overview

This chapter explains the essentials of using AutoCAD including command entry, selection sets and layers. Since Carlson Software is built on the AutoCAD OEM engine, it is helpful to know the AutoCAD basics. Several of the Carlson Software commands are native AutoCAD commands and many others have an AutoCAD style user-interface.
Issuing Commands

Virtually all commands in Carlson Software have three or more ways they can be initiated. The two most common are the menu and the toolbar, but the command line can many times be a very easy method of working through commands. Using the menu and toolbar should be second nature to Windows users, so this section will mainly focus on the command line usage in Carlson Software.

Command Line Prompt-Command:

Carlson Software has a command line prompt where commands are "issued" and the status of a command is reported. When you select a command from the menu or toolbar, that command name is sent to the command line and is executed. Before most commands can begin, all other commands must be terminated. The exceptions are referred to as transparent commands. The easiest way to see if no commands are running is to look at the command line. If it displays Command: no commands are currently in progress.

Enter

When you are required to press the Enter key in Carlson Software, you can use the Enter key on the keyboard or you can press the spacebar or click the right mouse button.

Pressing the Enter key will perform different operations depending on your location within Carlson Software. If you are in the process of running a command, the Enter key will end the command (if there are no available options) or it will select one of the options available (see below). If you are at the command line Command: prompt, pressing the Enter key will repeat the last command.

Right Mouse Button

As mentioned above, the right mouse button can be used as enter. However, you can set the right mouse button to perform different functions. The control for the Right Mouse Button behavior is in the Mouse Click Settings command. When you click the right mouse button, you will get a drop down list of the options and can select the desired one. Move the cursor the desired option and click on it with the left mouse button.

Getting Out of a Command-Esc

For commands that provide no options, the Enter key (or spacebar or right mouse button) will end the command you are using. Also, when a command is issued in Carlson Software, this action will also automatically end the previous command. However, there are exceptions to these two rules.

To avoid any problems with using the above methods to end a command, you can press the Escape (Esc) key. For example, if the command line displays something other than Command: or if a command you want to run does not start because you are using another command, you will want to end the command and return to the command prompt. Using the Escape (Esc) key will accomplish this every time.

Note: Some commands have several optional levels which will require the escape key to be pressed more than once.

If you accidentally select a location on the screen and start a selection window, the command prompt will prompt for another corner. Either select another point on the screen to finish the selection (not advised) or press the Esc key to return to the Command: prompt.

Commands Option
When any command is issued, the command line acts as a status bar that will show the available options and "ask" for input from you.

When there are options for the command you are currently running, these options will be shown on the command line with capital letters in the option name. To use one of the options, type the capital letter(s) at the prompt. For example, if you issue the Zoom command, the command prompt will show All/Center/Dynamic/Extents/...<Realtime>: To select the Dynamic option, type D at the command line, then press the Enter key. If you do not input an option and just hit enter, you will be selecting the option that appears in the <> brackets. For the example shown, that is the Realtime Zoom option.

**Transparent Commands**

Several commands in Carlson Software can be run transparently. This means that they can be performed while another command is running. For example, if you are in a command and are trying to select something in the drawing but it is too small to see, you can use the zoom command transparently. Zoom to the area where the object is, then select the object without ending the initial command. The most commonly used commands are the View commands of Zoom and Pan, and the Properties commands including the Layer dialog box.

To issue a transparent command, type an ' (apostrophe) before the command name. For example, 'Z would be transparent zoom. Note that many commands will automatically be assumed to be transparent if they are issued from the toolbar while another command is running.

When you are in a command that is running transparently, this will be indicated with a >> at the far left of the command line preceding any options or other text. When a transparent command is complete, you will return to the command you were previously running. If you are in a transparent command and want to end the command to get back to the command prompt, you will need to press the Esc key twice.

**Note:** If you select a View command while running another command, the other command will not end. You will be running the View command transparently. This is one of the exceptions to the rules for ending a command. If you do not want to run the View command transparently, you need to complete the other command or end it by pressing the Esc key.

**General Commands**

**Enter**

When you are required to press the Enter key in Carlson Software, you can use the Enter key, the spacebar on the keyboard or click on the right mouse button.

**Repeating Commands**

When you press the Enter key at the command line Command: prompt, you will repeat the last command.

**Cancel**

The Escape key (Esc) key can be used to cancel any command. Some commands may require pressing the Escape key more than once.

**Command Options**
The command line changes as a command is running. When there are options available for the command you are running, they will display at the command line. To select one of the options, type the capital letter(s) in the name of the option and press the Enter key.

**Selection of Items**

Most commands in Carlson Software require the selection of objects. When you need to select objects, the command line will prompt Select objects:. When you are at this prompt, your next step will be to create a selection set. While creating the selection set, the prompt Select Objects: repeats and you can continue to select objects until you press the Enter key, at which time the command you are using will continue and use the objects selected. If you are selecting object for an Eagle Point Software command, the objects selected will be then used for that command.

**Selection Sets**

There are several ways to create a selection set from the Select objects: prompt. With all selection methods, the number of objects selected will be displayed in the command line along with any objects that were duplicated. Following are the most commonly used methods for creating a selection set:

**Single**

A single selection is made when you move the object selection target to an object on the screen and click on it. The selected object will highlight and the select objects prompt will return. The cursor changes to a small square when the command line displays Select objects:.

**Window**

A Window will select all objects completely inside of the rectangle drawn. Create a window by selecting a point on the view screen and then moving the cursor right. The window will display as a solid rectangle. You can also create a window by typing **W** at the select objects prompt. In this case you can move the cursor to the left to create the window.

**Crossing**

A crossing will select all objects within the rectangle as well as those touched by the rectangle. If you select a point on the view screen and move the cursor to the left, you are creating a crossing. The crossing will display as a dashed rectangle. You can force a crossing by typing **C** at the select objects prompt, allowing you to move the cursor to the right and create the crossing.

**Previous**

After you select several objects, they will be temporarily stored as a selection set. Should you want to re-use the same objects that were selected by the last command, you can type **P** at the Select objects: prompt.

**Remove**
If you select incorrect objects, you can type **R** to remove objects from the selection set. When you are in Remove mode, the prompt will be Remove objects: Click on the objects that you do not want to include in your selection. To return to select or add mode, type **A** at the command line.

**Grips**

Objects may also be selected before issuing the command and receiving the **Select objects:** prompt. This selection will turn on Carlson Software "grips." Grips appear as small blue squares in the drawing. All objects with grips will be used when a command is issued. Grips are turned on similar to selecting objects as described in the previous section, but with the command line at the **Command:** prompt, not the **Select Objects:** prompt. You can select single objects by clicking on an object with the standard cursor or you can select multiple objects by clicking in the view where there are no objects, then creating the window (right) or crossing (left). To remove grips, press the **Esc** key twice.

**Using Grips**

Grips can also be used to edit or change the location of objects in the drawing. Move your cursor to a grip and click. You should notice the cursor "snap" to the grip. The grip will turn from blue to red. The object grip is now attached to the cursor so you can move the object to the desired location and release it by clicking again.

**Properties and Layers**

Properties define how an object in Carlson Software is stored. One of the most common properties is the Layer. Layers can be turned off or frozen so the objects on that layer are hidden from the view of the drawing. Layers that are turned off can still be selected while frozen layers are essentially removed from the working set of the drawing. After layers are turned off or on, a redraw (which is done automatically) will update the view. A redraw of a file is a rather quick process. After a frozen layer is thawed, a regeneration may be required to update the view. Regenerations on large files may take a considerable amount of time depending on your hardware.

**Layer Dialog Box**

The Layer dialog box provides control of the drawing layers. You can turn layers on, off, freeze or thaw them, change the layer color and linetype, set the current layer, add new layers, delete layers, etc. To perform any of these functions, click on the **Layers** button .

In the Layer dialog box, you can highlight several individual layers to perform actions on at once by holding down the Control key and clicking on the desired layers. You can also highlight a continuous range of layers by highlighting one layer, holding down the Shift key, and clicking on another layer. All layers between the two will be selected. To select all of the layers, hold down the CTRL key and press A on the keyboard.

**Layer Drop List**

To turn layers on/off or freeze/thaw, you can also use the drop list on the toolbars. When you click on the symbols in the list, the layer's status will be changed appropriately.

**Setting Current Layer**

The current layer will be the one shown in the Layer drop list box. You can change the current layer by selecting the desired current layer from the drop list. You can also use the Set Current Layer button and select an object on the layer.
Changing Properties

To change the properties of an object in the drawing, use the Properties button on the toolbar or the Change command from the command line. This command will allow you to change the layer an object is on, the color or linetype of the object. The color and linetype can be set to bylayer or to a specific setting. Bylayer means that when the property for a layer is changed, so does the property for the object. For example, the specific setting of an object may be the color blue. No matter what color you set for the layer the object is on, that object will be blue.

Properties Toolbar

![Properties Toolbar Image]

If this toolbar (or any toolbar) is not displayed, you can open it using the Toolbars dialog box. Type `toolbars` at the command line.

Layer

The Layer dialog box is used to modify layers properties (color or linetype) or status (on/off, freeze/thaw).

Key-in: `LA` or `ddlmodes`

Toolbar: 📚

Current Layer

The Current Layer is the layer that you are on and will be working with. The Current Layer is the one shown in the Layer drop list. For example, in the above toolbar illustration, the Current Layer is **Water**.

Toolbar: 📚

Change

The Change command allows you to modify the properties of an object, such as layer and color.

Key-in: `CH`

Toolbar: 📚
The Carlson Software programs share some of the same pull-down menus, such as File, Edit, View, Draw, Settings and Points. Within each program, the other pull-down menus, typically, are specific to the that program. The common pull-down menus contain general commands that are applicable within all programs. Many of these commands are AutoCAD commands which are described in your AutoCAD Reference manual. The Carlson commands located in the more common pull-down menus are explained in the next sections.

All the options on the File menu not described here are AutoCAD commands, which are discussed in the AutoCAD Reference Manual.
Set Project/Data Folder

This command sets both the project work folder and the data folder to use as the default folders for your Carlson drawing and data files. The \PROJECT folder typically contain the .DWG and .BAK files, while the \DATA folder typically contains files such as coordinate (.CRD), Field to Finish code definition (.FLD), profile (.PRO) and centerline (.CL) files. This routine also shows you the tree structure of existing folders available on your computer. The first dialog provides you with a choice of three for the Data Folder Setup. The three options are Project Folder, Drawing Folder or Fixed Folder. You will choose one.

**Project Folder:** This option will make available the two buttons (rectangular boxes) in the middle of this dialog box. These large option buttons are labeled Project Sub-Folders Setup and Data Type Sub-Folders, respectively. Clicking the left-side Project Sub-Folders Setup button will produce a dialog called Project Folders.

![Project Folders Dialog](image1)

In the Project Folders dialog you are able to Add, Rename and Delete folders and sub-folders for your project.

![Folder Management](image2)
Clicking the Data Type Sub-Folders button on the right-side will produce a dialog that has a spreadsheet look and function. Here you have the ability to define the Data Folders and Sub-Folders by matching them up with the Data Types and Descriptions. Be sure to scroll down, using the scroll tool on the right, to review the dozens of rows of Data Types in the list. You can also edit the sub-folder structure (note the dropdown arrows in the Sub-Folder column) as described above.

### Drawing Folder:
When this option is clicked, all of the options below become grayed out. The drawings will automatically be stored in the Current Project Folder, and the data files will automatically will go into the same folder as the drawing.
**Fixed Folder:** With the Fixed Folder option, you will "Set" a folder for all of your data to be stored in. The \DATA folder is the default folder, but you can also create and set any folder you would like.

To create a new data folder, for example, first note the Current Data Folder section at the bottom of the dialog box, and notice the Set button to the right. Click Set. A new dialog appears that will allow you to select the data folder of your choice. Here, you can create or remove any folder.
If you choose Create Directory, the program will prompt you for the new directory name. The Remove Directory button allows you to delete directories that have no files inside. After you have made your choices, click OK.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** settmpdir  
**Prerequisite:** None

## Drawing Explorer

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing. The knowledge of these files is contained in the .INI file that shares the drawing name (e.g. Estates.dwg, Estates.ini). If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will display "No Files". In **Configure > General Settings**, if Save Drawing INI Files is clicked off, then Drawing Explorer will again display "No Files". Drawing Explorer will also not show any data files where the drawing name starts with the seven letters "Drawing". Using any other file name, once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files in the order that they are created. Drawing Explorer helps manage drawing-related data.

### Example 1

If we are working in a drawing called Estates.dwg and create a coordinate file Estates.crd, then later create a second coordinate file called Estates-GPS.crd, Drawing Explorer would display the following:

The coordinate file created or modified last appears at the top of the list. All data files are displayed in the order of most recent to oldest. If the Estates.crd file is set as current by the command **Set Coordinate File**, then added to or revised, Estates.crd will move to the top of the list. Thus old, relatively unused files will gravitate to the bottom of the list.

Files are displayed by category. So far, we have only the Coordinate Files category. There are also Raw Field Note files (.RW5), profiles (.PRO), section files (.SCT) - in fact dozens of file type categories that will display once these files are actually created.

If a data file is selected and highlighted, the Up and Down keys will become enabled, and the user can move files up to the top of the list or otherwise alter their position. The position of files affects only the reporting of the files using the Report option in the lower left of the dialog. When highlighted, a file can be removed from the list (but it won't be deleted from the hard drive!). The Add option will add other older or non-referenced data files to the list of files associated with the drawing.
Example 2

As we do more work in the file Estates.dwg, data files will begin to proliferate and will appear in Drawing Explorer. Shown below is a more comprehensive list of files, with occasional examples of multiple files within the same category. Categories themselves float to the top of the list if any of their data files have been used more recently than data files in other categories.

Note that there is even a Miscellaneous Files category, that includes ASCII point files created by the command Export Text/ASCII File.

When many data files are involved, the Report option becomes very useful. Here you can use the Report Formatter to display, in any order, the File Name, File Type, Date last modified, Time last modified, Size in bytes, and whether it is Found (e.g. exists) in the specified directory. For example, if a file was created in a certain directory but moved using Windows Explorer to another directory without being further altered in Carlson, it would show up here as not found. ("No" would appear in the Found column).

Shown here is a summary of our data files by size, with reporting of the found status. In this case, the Estates.Lot file has been moved or deleted.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button (not shown above) that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.

A deleted or missing file such as Estates.Lot will appear in Drawing Explorer with a special red [no entry] symbol as shown here.
Chapter 3. File Menu
Pulldown Menu Location: Settings > Project
Keyboard Command: dwgxplore
Prerequisite: None
File Name: \lsp\gisutil.arx

Project Explorer

This tool is used for management of a complete project. A project can contain numerous drawings, and each drawing within that project can contain numerous related files.

Think of the Project Explorer as the trunk of the hierarchical tree structure that develops into a project. While within each drawing, Carlson keeps track of the files that you create (such as grids and coordinates). These are related to the drawing and you can use Drawing Explorer to manage them. When management reaches the top level, the Project Explorer is used to tie these together.

Prompts

When you initiate the Project Explorer, you will be prompted to select an existing or create a new Project File. Project files end in the PRJ extension. Once a project file is open, the following dialog will appear.
Add: When you choose the Add button, you are prompted to select a drawing file to add to the project. The selected drawing file is added to the project tree along with any files related to the drawing.

Remove: When any branch of the tree structure (except the top root) is selected, it is removed. Keep in mind that removing any node of a tree structure removes all nodes under it.

Up/Down: When you select a branch of the tree structure that can be moved, the Up and Down buttons become available. This allows you to rearrange the items vertically.

Report: This option displays the Report Formatting Options for formatting the report of the Drawing Explorer (see Drawing Explorer).

When you choose the Add button you will be presented with a dialog to select a drawing to add to the project. Once a drawing is selected, it will be added to the project tree along with any files related to the drawing.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.
Store Project Archive

This command will zip and archive an entire project. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. If the drawing hasn't been saved recently, the following window appears first.
Pulldown Menu Location: Settings > Project
Keyboard Command: zip_project
Prerequisite: A project file
File Name: \lsp\contour4.arx

Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.
Pulldown Menu Location: Settings > Project
Keyboard Command: unzip_project
Prerequisite: A project file that has been zipped (ZIP)

New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. SURV.DWT is the default template file for use in Carlson Survey. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

There are two methods that you can use to create a new drawing. One is this New command. The other is Open, also under the File pulldown menu. If you need to open an existing drawing, use the OPEN command, under File, then choose an existing file name.
The opening dialog, Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right. If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in either the surv.dwt or surviso.dwt template, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.

English: This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

Metric: This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.
The New command creates a new drawing using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson Survey. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

**Pulldown Menu Location:** File  
**Keyboard Command:** new  
**Prerequisite:** None

### Display-Edit Text/ASCII File

This command allows you to edit or review an ASCII/Text file generated by any program. The file contents are displayed in the Standard Report Viewer. From this routine, you can edit the text or print the file.

**Pull-Down Menu Location:** File  
**Prerequisite:** A file to edit

### Import DXF File

**Function**

This command allows the user to import a DXF file (Data eXchange File) into the current drawing. Drawings or objects created in other CAD systems can be used in Carlson Software by importing them using this command. (AutoCAD DWG files need not be imported; they can be directly opened in Carlson Software).

### Export DXF File

**Function**

This command allows the user to create a DXF file from the current drawing. It gives the option to create a DXF file from the entire drawing or selected objects. The degree of precision for numbers can be selected. Whether a binary file needs to be used can also be selected. These DXF files can be used by other CAD systems to open up Carlson Software drawings.

### Import/Export LandXML Files

This command performs two functions: Export Carlson files to LandXML and Import LandXML files into Carlson. This command supports version 1.0 of LandXML and the following Carlson file types: Coordinate (.CRD) files, Centerline (.CL) files, Profile (.PRO) files, Section (.SCT) files, Grid (.GRD) files, Triangulation (.FLT) files, and Lot (.LOT) files.
**Export to LandXML**: Allows you to export a Carlson file to LandXML. Choose a new or existing LandXML file, then choose an existing Carlson file.

**Import to Carlson**: Allows you to import a LandXML file into Carlson. First, choose a new or existing Carlson file, then choose an existing LandXML file.

You first see the Import/Export LandXML dialog. To Export, for example, first click Export to LandXML. Then click Current Drawing Data Files button. You will then see the Select LandXML File dialog box. Select an existing .XML file to be exported from the list of files on the right and click Open.

The next dialog appears, showing the new buttons to be used for the Export. Choose the Add, Remove, Change Directory and/or Report buttons, and then Continue.

Choosing the Continue button takes you further into the Export process. The Report button will give you the Report Formatter Options dialog box.
Data protection is turned on by default, meaning that if you are importing/exporting to an existing file, you will be prompted before the program overwrites existing data. There is a Point Protection option that will not allow any points to be overwritten if the same number appears more than once in the XML file being imported. If you decide to Import From LandXML, go back to the opening dialog and choose the existing LandXML file.

**Pulldown Menu Location:** File  
**Keyboard Command:** imp_exp  
**Prerequisite:** Files to convert  
**File Name:** \lsp\gisutil.arx

### Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

- **Show:** Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.
- **Hide:** Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.
- **Exit:** Exits this command

**Pulldown Menu Location:** Settings  
**Keyboard Command:** TBARCFG  
**Prerequisite:** None

### Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. *Configure* will restore the current drawing settings to these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.
The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in Configure, and will be described here.

**Use Startup Wizard:** The *Use Startup Wizard* controls whether this wizard appears when creating a new drawing.

**Generate Report Log:** When the Generate Report Log option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt. This function toggles the
report log on/off.

**Save Drawing INI Files:** Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.

**Auto Zoom Center for New Points:** This option zooms the display to center the new, located point. If it is off, the screen does not center the new point.

**Ignore Zero Elevs:** This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

**Use South Azimuth:** Turning on this option will use a South Azimuth instead of a North Azimuth, which is the default.

**Use Dview Twist Angle:** This will use the screen Twist Angle defined with the AutoCAD command DVIEW. This is similar to Twist Screen.

**Set Dimscale to Drawing Scale:** This will set the dimension scale to match the drawing scale. By default, it is set to 40.0.

**Set PDSIZE to Symbol Size:** This will set the PDSIZE scale to match the symbol size defined in Drawing Setup. By default, it is set to 4.0.

**Set INSUNITS to Unitless:** This will set the INSUNITS (Insertion Units) AutoCAD system variable to Unitless when the drawing is opened.

**Point Layer:** This is the default layer to draw any new points.

**Coordinate Report Order:** You can choose the traditional north-east format, or reverse these in reports with east-north.

**Date Format:** You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

**Report Viewer:** This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

**AutoCAD Menu:** This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

**Object Linking:** The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

**Database Format:** The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.
CRD File Pt# Format: Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:

- **Carlson Numeric:** This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 32767.
- **Carlson Alphanumeric:** This native Carlson format allows letters in the point numbers, and the point name can be up to 10 characters. Any combination of letters and numbers is acceptable.
- **C&G Numeric:** This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric:** This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK:** This is the Simplicity Systems coordinate file format.
- **LDT Points.mdb:** This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is found in a projects \COGO directory. The number limitation is established by the database structure, but is frequently numeric and allows unlimited point numbers.

**Digitizer Puck Layout & View:** There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

**Use Mouse:** This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

**Auto Tablet On for Digitize Commands:** This option will activate the auto tablet when using the digitize commands.

**Drawing Setup:**
The settings under *Drawing Setup* are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the Configure menu choice, using the Localization Settings button.

**Survey Settings:**
There are five different areas for default Survey Settings. These all appear elsewhere in Survey, but if you set them there, they will just apply for that drawing. If you make changes here, it will apply to the current and/or future drawings. Since each is defined elsewhere in the Survey chapter, each is not detailed here, just the dialog for viewing.
Chapter 3. File Menu
Most of the DTM-Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

Inverse Distance/LeastSquares Modeling Parameters: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

Specify Grid Resolution As: There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of
cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision:** This is the number of decimals that are stored in the grid file.

**Section-Profile Settings:**
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image)

**Hydrology Settings:**
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image)
**Mine Note Options:**
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

![Mine Note Entry Options](image)

**Mine Settings:**
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

![Mining Settings](image)

**Inverse Distance/Least Squares Search Radius, Samples and Quadrants:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**SDPS Directory:** This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

**Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance):** This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing
strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. None will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. All will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do want they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The marker bed is the "main" seam and other seams will conform to it. There can be more than one marker seam. There is also a hierarchy for conformance, so if the main marker seam is not present, then the next marker seam in line will prevail.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinchout when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best "guess" is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turned on when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weight the quality attribute by a Density value instead of thickness. The Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.

**Use Strata Limit Lines:** When using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one is on, then you will be prompted to select them for all commands.

**Auto Select All Strata Limit Lines:** Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

**Use 0 Values for Blank Entries in Coal Sections:** When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

**Report Format for Quantities by Avg/Grid Methods:** This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

**Key Material Name:** This is the name of the KEY material you are mining. Enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.
**Startup Options:**
These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

![Startup Options Dialog Box]

**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson 2008 Folder:** This is the folder where Carlson is installed. The Browse button allows for selecting a new file.

**Carlson 2008 Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.

**Profile Name:** This is the AutoCAD Profile that will be used when working in Carlson and AutoCAD.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start up procedure.

**AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**Localization Options:**
There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

### Annotate Defaults
- Area Defaults
- Cogo Design
- Drawing Setup
- DTM and Contour
- General
- Line/Curve Table
- Minimal Length To Label
- Section Profile
- Stack Label Arc
- Survey Text Defaults

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.
**Pulldown Menu Location:** Settings  
**Keyboard Command:** config_scad  
**Prerequisite:** None  
**File Names:** \lsp\survini.lsp, \lsp\cogoini.lsp, \lsp\dtmini.lsp, \lsp\mineini.lsp, \lsp\hydroini.lsp \lsp\sctini.lsp, \lsp\cfg_scad.lsp, \lsp\cfg_scad.dcl
Shown here is the Edit menu of Carlson Field. There are useful commands available here for making your drawing more accurate and for manipulating existing entities.
Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline.

Pulldown Menu Location: Edit > Erase
Keyboard Command: ldel
Prerequisite: Something to erase
File Name: \lsp\dellayr.lsp

Erase by Closed Polyline

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.
First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.

In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** erasepline  
**Prerequisite:** Entities and a closed polyline  
**File Name:** \lsp\poly3d.arx

### Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

**Prompts**

**Pick 1st corner of window to erase outside of:** *Pick point location*  
**Pick 2nd corner:** *Pick second point location*  

**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** eraseout  
**Prerequisite:** Entities to erase  
**File Name:** \lsp\surv1.lsp
Copy To Layer

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).

Prompts

Select entities to copy.  
Select objects: select entities  
Select Layer dialog select a layer from list and click OK

Pulldown Menu Location: Edit > Copy  
Keyboard Command: copy2layer  
Prerequisite: Entities to be copied  
File Name: \lsp\surv1.lsp

Copy Polyline Section

This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline  
Select first break point along polyline: Pick location on the polyline  
Select second break point along polyline: Pick the second location on the same polyline  
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy  
Keyboard Command: copy_pl  
Prerequisite: Polyline to be copied
**Variable Offset**

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

**Prompts**

* Vary offsets by line segments or at points [Line]/Point? press Enter
* Select a polyline to offset (Enter for none): pick polyline
* Select side to offset: pick a point on the side to offset to
  As you go from segment to segment, you can enter in different offset values for each line segment.
  * Enter the segment horizontal offset <0.000>: 56
  * Enter the segment horizontal offset <56.000>: 33
  * Enter the segment horizontal offset <33.000>: 12
* Select a polyline to offset (Enter for none): press Enter

**Block Explode**

This command retains the values of attributes when a block is exploded. The standard AutoCAD *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Prompts**

* Select first line or polyline to extend: pick a line or polyline
* Select second line or polyline to extend: pick another line or polyline
Extend Arc

This command extends an arc entity.

Prompts

Pick arc to extend: select an arc entity
Break Arc at Extension [Yes/<No>]? N Answering Yes will create a new arc starting at the end of the existing arc.
Enter or pick the distance to extend: 5 This extends the arc 5 units
Enter or pick the distance to extend ('U' to Undo): press Enter to end

Extend by Distance

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.
The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

# - **Number**: Distance to draw or extend
A# - **Angle change**: Rotates pointer by specified number of degrees
A - **Align**: Rotates pointer to align with segment
B - **Bearing**: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
C - **Close**: Closes the polyline
D - **Draw Mode**: Actions draw or extend the line or polyline
E - **Extend to Edge**: Extends to intersection with a selected line or polyline
I - **Input mode**: Toggles distance input between decimal feet and feet-inches
L - **Left rotate**: Rotates counterclockwise 90 degrees
M - **Move Mode**: Actions only move the pointer
N - **Next**: Moves pointer forward to next point
O - **Open**: Opens the polyline
P - **Previous**: Moves pointer backward to previous point
R - **Right rotate**: Rotates clockwise 90 degrees
S - **Switch**: Reverses pointer direction
T# - **Total distance**: Sets current segment to specified distance
U - **Undo**: Undo the last Extend by Distance command
Z - **Zoom mode**: Toggles auto-zoom between on/off
? - **Info**: Displays lengths of current polyline

**H - Help**: The Help option also displays this Extend by Distance Commands list.
**Press <Enter>:** Ends the routine
Prompts

Select line or polyline to extend: select line or polyline near the place to extend
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units.
Use the Pick option to pick a distance.
Pick/Horizontal Distance to Extend ([Enter] for new line): R Rotate right 90 degrees.
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units.
Use the Pick option to pick a distance.
Extend another (<Yes>/No)? No
Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

**Pulldown Menu Location:** Edit > Extend

**Keyboard Command:** extender

**Prerequisite:** An existing line or polyline with at least one segment from which to start.

**File Name:** \lsp\scadutil.arx

### Break by Crossing Polyline

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

**Prompts**

**Select the clip edge polyline:** pick a closed polyline

**Select the polylines and lines to be clipped.**

**Select Objects:** pick the entities to break

Specify layer names for Inside segments (Yes/No)? Yes

Enter a layer name for the Inside segments <0>: press Enter

Specify layer names for Outside segments (Yes/No)? Yes

Enter a layer name for the Outside segments <0>: Final
Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline
Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.
Break at Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the Area by Lines & Arcs command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

Prompts

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point

Pulldown Menu Location: Edit > Break
Keyboard Command: breakat
File Name: \lsp\surv1.lsp

Change Elevations

This command will change the elevation of selected entities. It can move the entity to a specified elevation from it's current elevation (absolute) or do a differential change by adding or subtracting a value from it's current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.

Prompts

Ignore zero elevations (<Yes>/No)? press Enter If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Elevation to change to: 125 By using the Absolute option all entities selected are changed to the elevation 125.
Select Entities for elevation change.
Select objects: C
First corner: pick a point
Other corner: pick a point
Select objects: press Enter

If Carlson points are selected, the command warns:
This command DOES NOT change the elevations in the Coordinate file!
Use Coordinate File Utilities menu option F to update the file.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \lsp\scadutil.arx

Change Attribute Style

This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under Existing Style, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the Pick Attr button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Chapter 4. Edit Menu
Select the **New Style** that you want to apply to the attributes.

Enter a **New Height** for the attributes. An entry of zero (0) will not modify the existing height.

**Pulldown Menu Location:** Edit > Change  
**Keyboard Command:** chgattr  
**Prerequisite:** You may want to use the LIST command to check the current Text size.  
**File Name:** \lsp\chgattr.lsp

**Change Style**

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under **Existing Style**, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the **Pick TEXT** button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the **New Style** that you want to apply to the text.

Enter a **New Height** for the text. An entry of zero (0) will not modify the existing height.
Change Block/Inserts Rotate

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

**Existing Block:** Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.

**Replace With:** Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select an AutoCAD drawing file.

**Retain Size and Rotation:** When checked, the new block will retain the size and rotation values from the old block.

**New Size:** Available if Retain Size and Rotation is not checked. Enter the size for the new block.

**New Rotation Angle:** Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

**Chapter 4. Edit Menu**
Change Block/Inserts Substitute

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

Existing Block: Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.

Replace With: Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select an AutoCAD drawing file.

Retain Size and Rotation: When checked, the new block will retain the size and rotation values from the old block.

New Size: Available if Retain Size and Rotation is not checked. Enter the size for the new block.

New Rotation Angle: Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

Pulldown Menu Location: Edit > Change > Block/Inserts

Keyboard Command: chgblk

Prerequisite: None

File Name: \lsp\chgblk.lsp

Change Block/Inserts Resize

This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts
Scaling Multiplier \(<0.5\>): Enter the size scale factor.
Select symbols and blocks to scale.
Select objects: select entities

Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: sizeblk
Prerequisite: block/inserts in drawing
File Name: \lsp\sizeblk.lsp

Pivot Point Rotate by Bearing

This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

Prompts

Select entities to rotate.
Select objects: select the entities
Base pivot point ?
Pick point or point number: 2 The program then reads the coordinate value for pt#2 from the current CRD file.
Reference Bearing point ?
Pick point or point number: pick a point
Reference Bearing N 44d31'1'' E The program then displays the reference bearing defined by the two points selected.
Azimuth/<Bearing (Qdd.mmss)>: 245.3030 Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.

If Carlson Points are selected the program warns:
This command DOES NOT change the coordinates in the CooRDinate file!
Use CooRDinate File Utilities menu, Update CRD from Drawing.
This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.

Pulldown Menu Location: Edit > Rotate
Keyboard Command: brot
Prerequisite: None
File Name: \lsp\scrot.lsp

Entity Insertion Point Rotate

This command allows you to rotate the selected entities from the drawing where they will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick.

Prompts
Text Enlarge/Reduce

This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl
File Name: \lsp\surv1.lsp

Rotate Text

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

Prompts

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

Pulldown Menu Location: Edit > Text
Keyboard Command: twisttxt
Prerequisite: Text
File Name: \lsp\twisttxt.lsp

Change Text Font

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name,
you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.

Pulldown Menu Location: Edit > Text  
Keyboard Command: chgtxtstyle  
Prerequisite: Text entities to be changed  
File Name: \lsp\chtxtst.lsp

**Change Text Size**

This command will change the size of the selected text objects to the user specified size. The *Text Enlarge/Reduce* command also changes text size. The difference is that this routine sets the text to an absolute size whereas *Text Enlarge/Reduce* scales, or relatively changes, the text size.

**Prompts**

Select the text to size.
Select objects: select the text
Enter new text size: enter value

Pulldown Menu Location: Edit > Text  
Keyboard Command: chgtxtsize  
Prerequisite: Text entities to be changed  
File Name: \lsp\surv1.lsp

**Change Text Width**

This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.
Change Text Oblique Angle

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

Prompts

Select the text to change.
Select objects: Select text entities to change oblique angle on. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.
Enter new oblique angle <0.0>: Enter the desired oblique angle.
Flip Text

This command will change the alignment of text entities by 180 degrees.

Pulldown Menu Location: Edit > Text
Keyboard Command: fliptext
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

Pulldown Menu Location: Edit > Text
Keyboard Command: txtbrk
Prerequisite: Text entity to break
File Name: \lsp\txtbrk.lsp
Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the Write Polyline File command.

Prompts

Select text to be EXPLODED.
Select objects: select the text
Substitute With Simple Font [<Yes>/No]? Y
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Reading the selection set ...
Joining ...
Converting ...

Pull-down Menu Location: Edit > Text
Keyboard Command: textexp
Prerequisite: Text
File Names: \lsp\textexp.lsp, \lsp\poly3d.arx

Replace Text

This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. In AutoCAD 2000 and later, the command Find and Replace Text includes more options, including replacing partial strings and searching attributes and MTEXT.

Pull-down Menu Location: Edit > Text
Keyboard Command: chgtext
Prerequisite: Text entities to be changed
File Name: \lsp\chgtext.lsp

2D Align

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the AutoCAD Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.
Prompts

Select entities to align.
Select objects: *pick entities to process*

First Source Point?
Pick point or point number: *pick point 84*

First Destination Point?
Pick point or point number: *pick point 18*

Second Source Point?
Pick point or point number: *pick point 85*

Second Destination Point?
Pick point or point number: *pick point 19*

Scale factor: 1.00434258

Scale objects based on alignment points [Yes/<No>]? *Y*

This command DOES NOT change the coordinates in the CooRDinate file!

Use Coordinate File Utilities menu, Update CRD File from Drawing.
Entities to Polylines

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use Join Nearest to convert adjoining lines and arcs into continuous polylines.

Prompts

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: select entities

Reverse Polyline

This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands Station Polyline, MXS by Polyline, Profile from Surface Model or CL File from Polyline, since the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the Reverse Polyline command to change it's order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

Prompts

Select the Polyline to Reverse: pick a point on polyline

Reduce Polyline Vertices

This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline. This command is explained further in the Triangulate & Contour command.

Prompts
Enter the offset cutoff <0.1>: .5
Select polylines to reduce.
Select objects: pick polylines
Processed polylines: 1
Total number of vertices: 10
Number of vertices removed: 1

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: reduce
Prerequisite: A polyline
File Name: \lsp\tri4.arx

Densify Polyline Vertices

This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.

Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity> 1
Added 17 points to 1 polyline.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. The looping factor controls smoothing amount. A higher factor gives more looping. This command is explained further in the Surface menu section.

Prompts
Enter the looping factor (1-10) <5>: 7
Enter the offset cutoff <0.05>: press Enter  This is the same reducing filter described above.
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline
File Name: \lsp\tri4.arx

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual
location of each vertex. The Blips are temporary. Any change to the viewport (pan, zoom, regen) will make the
blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will
remain visible during and after viewport changes.

Prompts

Select polylines to draw blips.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline
Add Intersection Points

This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.

Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline.
at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

**Prompts**

**Select polyline to add to:** *pick a polyline*

**Pick or enter point to add:** *pick a point*

**Select polyline to add to:** *press Enter to end*

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline

**Keyboard Command:** addpl

**Prerequisite:** A polyline

**File Name:** poly3d.arx

**Edit Polyline Vertex**

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you to convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.
Prompts

Select polyline to edit: *pick a polyline*
Pick point on polyline to edit: *pick a point to be modified*
Edit Polyline Vertex dialog click "Pick Position"
Pick vertex position: *pick a new location for the vertex*
Edit Polyline Vertex dialog click OK
Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

Select polyline to edit (Enter to end): *press Enter to end*

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Edit Polyline Section

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select polyline to edit: *pick the polyline at the place to start editing*
Pick intermediate point (Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *press Enter*
Pick reconnection point on polyline: *pick the polyline at the place to join*
Remove Duplicate Polylines

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

Prompts

Select lines, arcs and polylines to process.
Select objects: select linework to process
Reading the selection set ...
Removed 1 duplicate linework entities.

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter
Remove Polyline Segment

This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.

![Diagram showing Original Polyline, Continuous Removal, and Break Removal]

Prompts

- **Break polyline at removal or keep continuous (Break/Continuous)?** press Enter
- **Select polyline segment to remove:** pick point on polyline
- **Select polyline segment to remove:** press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline

Keyboard Command: removepl

Prerequisite: A polyline

File Names: \lsp\removepl.lsp, \lsp\poly3d.arx

Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete.
Press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Create Polyline ID Labels

This command labels the selected polylines with either the AutoCAD "Handle", which can be seen with a list, or with unique text numbers, such as 1, 2, 3, 4, etc.. When using the Text option, the following window appears to choose the text settings.
Prompts

Select Polylines to label.
Select objects: pick polyline
Label polylines by Text or Handles [Handles/<Text>]? press Enter

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: label_polys
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Change Polyline Width

This command sets the width of the selected polylines. In later versions of AutoCAD, the command PEDIT can also modify the width of multiple polylines.

Prompts

New width <1.0>: 2
Select Polylines/Contours to change width of:
Select objects: pick polylines

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: cwidth
Prerequisite: A polyline
File Name: \lsp\surv1.lsp

Set Polyline Origin

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.
Prompts

Select Polyline: pick a polyline
Pick Near New Origin Point: pick a point on the polyline to be the starting point
Processing ...
Select Polyline: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: plchgorg
Prerequisite: A closed polyline
File Name: \lsp\plchgorg.lsp

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs
File Name: \lsp\poly3d.arx

Change Polyline Elevation

This command will change the elevation of selected entities. It can move the entity to a specified elevation from it's current elevation (absolute) or do a differential change by adding or subtracting a value from it's current elevation. If Carlson points are selected, their elevation attribute text and the elevation stored in the external coordinate file are changed. If the points are in the drawing at their real Z, this is also adjusted, however, if they are in the drawing at a fixed elevation, e.g. 0, the point blocks remain at that elevation.

There are options to move the changed objects to a new layer, and alternately to select a source object's elevation to supply the value of the elevation to change the selected object(s) to.

Prompts

Type of elevation change [<Absolute>/Differential]: press A to change to a specific (absolute) value, or press D to enter an amount of elevation change to apply to object's current elevation.
Change Layer for changed entities [Yes/<No>]: press Enter or N to keep on same layer, press Y to change layer of object after changing elevation.
Select/<Enter Elevation <100.0000>: 125 By using the Absolute option all entities selected are changed to the elevation 125. You may simply press Enter to keep the value shown in brackets. Press S to select a source object's
elevation for the new elevation to change the selected object(s) to.

Select objects: 1 found
Select objects: press Enter to conclude selection.
Tested 1 Entities
Carlson Software Points Changed > 1
Select/<Input another Elevation (Enter to end)>: press Enter

Pulldown Menu Location: 3D Data
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \lsp\scadutil.arx

Check Elevation Range

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.

Prompts

Enter elevation range minimum: 0
Enter elevation range maximum: 4900
Select polylines to check.
Select objects: pick polylines to process
Found 1 polylines outside of elevation range.
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: checkpl
Prerequisite: Polylines with elevations
Highlight Crossing Plines

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.
Prompts

Select polylines to check.
Select objects: pick polylines to process
Ignore zero elevations [Yes/No]? press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.
Use Report Formatter [Yes/No]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.
Minimum delta Z to report <0.0>: 2
Add polyline vertices at intersections [Yes/No]? Y
Set 3D polyline to crossing contour elev or average elevs [Set/Average]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of the intersection point as the average of the crossing polyline elevations at that point.
Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

Pull down Menu Location: Edit > Polyline Utilities
Keyboard Command: xing_plines
Prerequisite: Polylines with elevations

Fillet 3D Polyline

This command fillets two segments of a 3D polyline with the given radius. AutoCAD’s FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

Prompts

Fillet corner of a polyline or intersection of two polylines [Corner/Intersection]? press Enter
Enter fillet radius <10.00>: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Pull down Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: fillet3d
Prerequisite: 3D polyline
File Name: \lsp\poly3d.arx
Join 3D Polyline

This command joins $3DPOLY$ entities into a single 3D polyline entity.

Prompts

Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first
3 segments added to the polyline.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: join3d
Prerequisite: Plot the $3DPoly$ lines to use for selection
File Names: \lsp\join3d.lsp, \lsp\poly3d.arx

Offset 3D Polyline

This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are three offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

Prompts

Enter the offset method [$<\text{Interval}>$/$\text{Constant}$/Variable]: press Enter
Vertical/$<\text{Horizontal offset amount}>$: 15
Percent/Ratio/Vertical offset amount $<0>$: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: offset3d
Prerequisite: Plot the $3DPoly$ lines to use for selection.
File Name: \lsp\poly3d.arx
Join Nearest

This command joins lines, arcs and/or polylines together. While AutoCAD's *PEDIT-Join* command requires the endpoints to match, *Join Nearest* will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.

**Max Separation to Join:** Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

**Max Deflection Angle (degrees):** This option will not join any lines if the angle between them is greater than this angle in degrees.

**Connection Method:** Determines how to connect the endpoints. See the illustration below.

1. **Average Endpoints Together:** New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. **Directly Connect Endpoints:** Original endpoints are connected with new segment (see the middle illustration below).
3. **Fillet with Radius Zero:** Same as AutoCAD *FILLET* command using zero radius (see the illustration on right).

**Convert Lines and Arcs Into Polylines:** When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

**Join Across Intersections:** This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

**Join Only Identical Layers:** When checked, only entities on the same layer will be joined.

**Join Only Common Elevations:** When checked, only endpoints located on the same elevation will be joined.

**Different Layer Prompt:** When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

**Different Elevation Prompt:** When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.
Pullown Menu Location: Edit
Keyboard Command: nearjoin
Prerequisite: Lines or polylines to be joined
File Names: \lsp\nearjoin.lsp, \lsp\poly3d.arx

3D Entity to 2D

This command changes a 3D Line, Arc, Circle, Polyline, Insert or Point to 2D, i.e. an entity with the elevations of the endpoints at the same Z coordinate. When the program detects a 3D polyline with all vertices with the same elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation here is used.

Prompts

Select/<Enter Elevation <0.00>: press Enter
Select Lines, Arcs, Circles, Polylines, Inserts and Points for elevation change.
Select objects: pick a 3D polyline
3D POLY to 2D POLYLINE
Number of entities changed > 1

Add Points At Elevation

This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts

Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines
File Name: \lsp\poly3d.arx

Select by Filter

This command can be used to build a selection set of objects inside a drawing based on layer and entity type. When the tool is executed it displays the following dialog. Select the layer(s) on the left you wish to select, then turn on the toggle(s) for the entity types to consider. The tool then builds a selection set of those objects that resides on those layers. When you execute your command following this selection building process, when you are prompted to select objects simply enter "P" for previous.

Select by Filter dialog image

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: fsel
Prerequisite: None
File Name: \lsp\fsel.fas

Select by Elevation

This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the
selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [\texttt{<Greater>/Less/Between}]? \texttt{press Enter}
Enter elevation for greater than: 19
Ignore zero elevations [\texttt{<Yes>/No}]? \texttt{press Enter}
Select objects to build selection set. \texttt{pick objects}
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type \texttt{P} at Select objects: prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: zselect
Prerequisite: Entities
File Name: \texttt{lsp\volcalc.arx}

Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: \texttt{pick the closed polyline}
Select objects: \texttt{press Enter}
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: \texttt{press Enter}
Type of selection (Window/\texttt{<Crossing>})? \texttt{press Enter}
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: \texttt{press Enter}
Built selection set with 43 objects.
Command: \texttt{Erase}
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: \texttt{press Enter}

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssgetarea
Prerequisite: Closed perimeter polylines
File Name: \texttt{lsp\volcalc.arx}
Shown here is the View menu of Carlson Field. There are many commands listed here for your viewing and display needs.
**Zoom Selection**

This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use *Zoom Selection* to select the entities of one of these dots and quickly zoom the display to these entities.

**Prompts**

- **Select objects to zoom onto:**
- **Select objects:** *select entities*

**Pulldown Menu Location:** View

**Keyboard Command:** zoom_on

**Prerequisite:** Entities

**File Name:** \lsp\mineutil.arx

---

**Zoom Points**

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

**Prompts**

- **Find by point number or description [</Number>/Desc]?** N
- **Point number or range of point numbers to find <1>:** 2079
- **Magnification or Height <179.50>:** *press Enter*

Accept the default zoom magnification

**Pulldown Menu Location:** View

**Keyboard Command:** zoompnt

**Prerequisite:** A .CRD file

**File Names:** \lsp\fpoint.lsp, \lsp\crdutil.arx

---

**3D Viewer Window**

This command views in 3D, the selected 3D faces, polylines, lines and points. This routine uses the OpenGL graphics library for rendering, which gives it superior performance. Some of it's features include the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade in user-positioned lighting.
View Control

- **Ignore Zero Elevations**: When checked, the 3D viewer ignore entities at zero elevation.
- **Color By Elevation**: This will color the contours or 3D faces by elevation. The elevation scale legend is displayed on the left of the window.
- **Vert. scale**: Sets the vertical scale factor for the 3D viewer. Flat surfaces can be exaggerated by increasing the vertical scale.

This control represents position of the sun in the sky if looked from above. Therefore, the position of the sun in the center means that the sun is in a zenith, and position near the edge of the circle means that the sun is near the horizon. To move the sun, simply drag it to a new location, or click on the new location. The slide bars on the sides are the intensity and brightness of the display.

- **Zooms IN.**
- **Zooms OUT.**
- **Switch to Dynamic Zoom mode.**
Switch to Pan mode. Click and drag to pan.

Switch to Rotation mode.

Switch to initial view.

Toggles shading on and off.

This is an inquire tool. Point the arrow to any entity to display entity data including the layer, type, elevation and length.

Resets the 3D view to plan.

Exit the 3D viewer window.

- **Clip Plane:** This slider will clip the image based on the location of the slider. When the slider is all the way to the left, the entire image is displayed. Moving the slider to the right will clip the image, going deeper as the slider is moved to the right. This is useful to view items that are hidden behind something else.

- **Scroll Bars:** Use X,Y,Z scrollbars near the bottom to rotate the view. The range of these scrollbars is -180 to +180 degrees with middle being 0 which is the default position when the viewer starts. When the cursor is near the middle of the window, the XY icon will allow for rotating the image with the mouse, while holding the left mouse button. Move the cursor to the edge, and the icon switches to Z. This allows for rotating around the Z axis with the mouse, while holding the left mouse button.

![View Control Advanced Block model objects: Trender](image)
Advanced Tab

- **Block Model Objects:** This option has three choices when loading block model entities. 1. To leave as points. 2. To Render and 3. To prompt each time. If render is selected, it will apply to all face objects such as a TIN or GRD.

- **Block Model layers:** This will display the block color scheme. Colors of the blocks can be turned on or off to view blocks in the middle.

- **Shading Mode:** There are 3 shading modes to render 3D faces. They are 1. Shade Front, 2. Shade Both, and 3. Shade Back. This will render the top and bottom of the faces if desired.

- **Display Axis Icon:** This controls whether to show the X/Y/Z axis icon in the lower left of the graphic window.

- **Display Bounding Box:** This controls whether to display a 3D box around the limits of the data.

- **Display Vertical Scale:** This controls whether to display the current vertical scale in the graphic window.

This function exports the graphic display to an image file. Several different image file formats are supported including bmp, png, jpg, xpm and gif. There is a Export Image Selections dialog to choose the image resolution and color depth.

Sets the AutoCAD view to match the view shown in the 3D viewer window.

- **Saved Views:** This option allows for naming and saving a 3D view. These can be selected from the pulldown. They can be deleted from the list.

**Pulldown Menu Location:** View
**Keyboard Command:** cube
**Prerequisite:** Entities to display
**File Name:** `\lsp\cube.arx`

Surface 3D Viewer

This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in 3D Viewer Window appears.
Twist Screen: Standard

This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as Rotate Points and Translate Points, if you want to do a coordinate rotation or translation.

Prompts

This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of AutoCAD's DVIEW command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.

Pulldown Menu Location: View > Twist Screen
Keyboard Command: twist1
Prerequisite: None
File Name: \lsp\surv1.lsp
Twist Screen: Line Pline or Text

This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

**Prompts**

*Pick a line, polyline or text to make horizontal: pick a line or polyline*

---

Twist Screen: Surveyor

This is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

**Prompts**

*Angle to set to horizontal: 0 This would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen.*

---

**Pulldown Menu Location:** View > Twist Screen

**Keyboard Command:** twist2

**Prerequisite:** None

**File Name:** \lsp\scadutil.arx

Chapter 5. View Menu
**Restore Due North**

This command twists the screen to make due north vertical.

**Pull down Menu Location:** View > Twist Screen  
**Keyboard Command:** twist4  
**Prerequisite:** None  
**File Name:** \lsp\surv1.lsp

**Set Layer**

This command allows the user to change the current layer to a different layer by picking an entity on that layer.

**Pull down Menu Location:** View  
**Keyboard Command:** lset  
**Prerequisite:** None  
**File Name:** \lsp\picklayr.lsp

**Change Layer**

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed it or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

Choose entities to be changed.  
**Select objects:** pick entities  
**The Select Layer dialog appears** select a layer from the list, or select Screen Pick  
If Screen Pick is chosen,  
**Pick entity with layer to change to:** pick another entity This assigns the selected entities to the layer of this entity, or  
**Enter new layer name or pick entity with layer (Enter/\Pick>):** E

Chapter 5. View Menu
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View  
Keyboard Command: lchg  
Prerequisite: None  
File Name: \sp\chglayr.lsp

Freeze Layer
This command will freeze layers by picking entities on that layer.

Pulldown Menu Location: View  
Keyboard Command: loff  
Prerequisite: None  
File Name: \sp\loff.lsp

Thaw Layer
This command thaws the layers frozen by the Freeze Layer command.

Pulldown Menu Location: View  
Keyboard Command: lon  
Prerequisite: None  
File Name: \sp\lon.lsp

Isolate Layer
This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

Prompts
Select objects on layers to isolate.  
Select objects: pick entities  
Retain POINT layers [Yes/<No>]? Press Enter

Isolate the wall layer by picking one wall line
Pulldown Menu Location: View
Keyboard Command: isolate
Prerequisite: None
File Name: \lsp\isolate.lsp

**Restore Layer**

This command thaws the layers that were frozen by the *Isolate Layer* command.

Pulldown Menu Location: View
Keyboard Command: restore
Prerequisite: None
File Name: \lsp\restore.lsp
Shown here is the Draw menu of Carlson Field. There are many commands listed here for your drawing and image creation needs.
2D Polyline

A polyline is a series of line and/or arc segments joined together in one entity or object. In addition to the regular AutoCAD Draw Polyline command (PL), there is this Carlson command that has several key features and options. This command allows you to draw a polyline entity in a variety of ways, including: Continue, Extend, Follow, Arc, Direction, Close, Pick point or point numbers. This dialog shown below automatically appears when you run the command.

The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If you do not want it to come up, then toggle it off. In this dialog you can set the elevation of the polyline, as well as the layer it will appear on.

**Offset from centerline** allows you to make another choice. First, a unique command line appears.

[Continue/Extend/Follow/Offset/Options/\(<\text{Pick point or point numbers}>\)]:

**Auto-Zoom mode** regenerates the screen as you draw your polyline, to give you the best view as you are working. **Always** means it will always regenerate the screen. **Proximity** regenerates the screen according to the **Proximity Zoom Level %** value. **Never** toggles off this feature. The **Elevation** of the polyline can be set here. The default is 0. If it is off, then the last settings will apply. To get the box back, choose **O** for Options on the command line.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer. If the current layer is not used, the **Layer** option allows you to **Select** from a list or **Pick** from the screen.
There are three options under **Auto-Zoom Mode**. **Never** will not zoom to the last point picked. **Proximity** will zoom to the percent proximity set below. **Always** will always zoom center on every point.

If the **Proximity** Auto-Zoom mode is checked, the percent of the proximity is set in the box on the right.

**Annotate closed pads**, when checked, will make available the Settings button on the right side. When Settings is chosen, the Annotate pad dialog appears. Here is where you can enter in values that will result in annotation for the closed polyline.

With regards the options available on the command line, they are explained as follows:

**Continue** allows you to run Arc, Direction, Close, Extend, or Follow for an existing polyline.

**Extend** allows you to extend an existing polyline by picking or entering in a distance.

**Follow** allows you to match the path of your polyline with an existing polyline. You are prompted to select the point in which your polyline first intersects with the existing polyline and the point in which it exits. If the existing polyline is a closed polyline than you will be prompted to approve the direction in which your polyline follows the existing closed polyline.

**Options** brings up the Polyline 2D Options dialog that appears when you first run the command, unless Offset from centerline is checked, in which case the letter indicates this feature, and a centerline will be requested.

**Pick point** allows you to pick a point on the screen to start your polyline.

**Point numbers** allows you to enter in coordinates to start your polyline.

**Arc** allows you to draw an arc by Arc length/Chord/Radius/Second point in your polyline. The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line. This is useful for plotting buildings.

**Distance** for an angle code, a backsight point, an angle (dd.mmss), and a distance to draw your polyline.

**Close** will connect the ends of your polyline making it a closed polyline.

**Prompts**

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Segment length: 0.00, Total length: 0.00

[Arc/C/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 3.83, Total length: 3.83

[Arc/C/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 2.94, Total length: 6.77 press Enter to end
```

**Pulldown Menu Location:** Draw

**Keyboard Command:** 2DP

**Prerequisite:** None

**File Names:** \lsplsp\poly3d.arx
3D Polyline

In addition to the regular AutoCAD Draw 3D Polyline command, there is this Carlson command that has several options.

![Polyline 3D Options dialog box]

The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

**Prompt for Elevation/Slope** controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

**Use Surface Model from File** will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer.

If the current layer is not used, the **Layer** option allows you to **Select** from a list or **Pick** from the screen.

There are 3 options under **Auto-Zoom Mode**. Never will not zoom to the last point picked. Proximity will zoom to the percent proximity set below. Always will always zoom center on every point.

If the Proximity Auto-Zoom mode is checked, the percent of the proximity is set in the **Proximity Zoom Level** box.

**Prompts**

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Elevation <0.00>: 435
Z: 435.00, Hz dist: 0.00, Slope dist: 0.00, Slope: 0.0% Ratio: 0.0:1

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: pick a point
Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 444
Z: 444.00, Hz dist: 3.67, Slope dist: 9.72, Slope: 245.3% Ratio: 0.4:1

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: pick a point
Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 399
Z: 399.00, Hz dist: 3.16, Slope dist: 45.11, Slope: -1425.2% Ratio: -0.1:1
3 Point

This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either be picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

PC, PT, Radius Point

This command draws an arc between the PC point, radius point and PT point. The points can either be picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N

PC, Radius, Chord

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either be picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts
Radius of Arc <40.00>: 500
PC Start Point?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d0'041'')
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcb
Prerequisite: None

PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00>: 150
Is this arc in the correct direction (<Yes>/No)? press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None
File Name: \lsp\cenarc.lsp

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.000>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlin
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlin.lsp

Chapter 6. Draw Menu
2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: press Enter or enter distance
[int on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlal.lsp

2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts

Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlcl.lsp

2 Tangents, Mid-Ordinate

This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.
Prompts

Middle Ordinate <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlmo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlmo.lsp

2 Tangents, External
This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
External Distance <50.00>: press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlex
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlex.lsp

2 Tangents, Tangent Length
This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.
2 Tangents, Degree of Curve

This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.

Prompts

Degree of Curve (ddd.mmss) <5.0000>: press Enter
Define by [C]hord or [A]rc length <A>: press Enter
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanldo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanldo.lsp

Tangent, PC, Radius, Arc Length

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point ?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: sral
**Prerequisite:** Tangent lines should be drawn before execution

**File Name:** \lsp\sral.lsp

---

**Tangent, PC, Radius, Tangent Length**

This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.

Radius of Arc <300.0000>: press Enter

Tangent Length <236.0000>: press Enter

PC Start Point ?

Pick point or point number: pick a point

[nea on] Pick point along perpendicular tangent line: pick a point

Radius Point Coordinates: (5251.37 4534.71 0.0)

Pulldown Menu Location: Draw > Arc

Keyboard Command: srtl

**File Name:** \lsp\srtl.lsp

---

**Tang, PC, Radius, Chord Length**

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.

Radius of Arc <300.0000>: press Enter

Chord Length <25.0000>: press Enter

PC Start Point ?

Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Pull down Menu Location: Draw > Arc
Keyboard Command: SRCL
Prerequisite: Tangent lines should be drawn before execution
File Name: lsp\srcl.lsp

Tang, PC, Radius, Delta Angle

This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Pull down Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution
File Name: lsp\srda.lsp

Compound or Reverse

Function

This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)

Reverse curve off an existing curve
Prompts

[end on] Select ARC at PC Start point of the curve: pick a point
Type of curve [<Compound>/Reverse]: press Enter
Enter the Radius: 300
Define arc method [Tangent/Chord/Delta/<Length>]: press Enter
Enter the arc length: 236

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcr
Prerequisite: Tangent arc should be drawn before execution
File Name: \lsp\srcr.lsp

3-Radius Curve Series

This command is used to best fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents” is the distance perpendicular to the tangent from both ends of the second curve.

Prompts

Please pick two tangents...
Pick first tangent: pick a point
Pick second tangent: pick a point
Pulldown Menu Location: Draw > Arc  
Keyboard Command: 3curves  
Prerequisite: Two tangents

**Best Fit Curve**

This command draws an arc between to endpoints with a radius that is derived from sampling points and averaging the radius of an arc that passes though these points.

**Prompts**

Starting Point ?  
Pick point or point number: *pick a point*  
Ending point ?  
Pick point or point number: *pick a point*  
Select points from screen or by point number [Screen/Number]: *press Enter*  
Select Points to sample.  
Select objects: *W* Use window to select a group of points. After selecting all the points to sample, end selection by pressing Enter.  

Pulldown Menu Location: Draw > Arc  
Keyboard Command: bfitcrv  
Prerequisite: Points for sampling should be drawn before execution.  
File Name: \lsp\bfitcrv.lsp

**Curve Calc**

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.
Roadway or Railroad: Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

Select: Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

3 Points: Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

Plot: Allows you to plot the currently defined arc in the drawing.

Clear: Clears all edit boxes in the dialog.

Prompts

Curve Calculator dialog Enter at least two values, as described above
The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the Enter or Tab key.

Pulldown Menu Location: Draw > Arc
Keyboard Command: curvcalc
Prerequisite: None
File Names: \lsp\curvcalc.lsp, \lsp\scadcfu.dcl

Spiral Curve

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the Calculate Offsets, Station Polyline/Centerline or Offset Point Entry commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.
Prompts

Spiral method [TS/ST/<PI>] press Enter
PI Point ?
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24'9'' E Azimuth= 56d24'9''
Tangent out direction= S 65d9'1'' E Azimuth= 114d50'59''
Overall Delta= 58d26'50''
Point calculating distance resolution <10.0>: press Enter
Length of Spiral <350.0>: press Enter
Radius of simple curve (precede with - sign if curve to left) <954.93>: 954.93
Degree of curve: 6d0'0''
Theta of Spiral= 0.18325951 (radians) 10d30'0'' (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) <P>: press Enter
Point calculating distance resolution <10.0>: 5 Enter the resolution at which you would like the line segments of the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
<press [Enter] for symmetrical spiral out>/[D]elta of simple curve: press Enter If you want a spiral in only enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26'50'' Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pulldown Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the tangent line in or out.
File Name: \lsp\spiral.lsp

Insert Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the Edit Symbol Library command.

In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation.
The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and size.

After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering a easting, northing and elevation in x,y,z order.
Prompts

**Insert Symbols dialog** Choose parameters and click OK

Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point

Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.

Options/Select entities/Enter coords/<Pick point or point numbers>: S

Insert Symbols dialog

Select arcs, faces, points, text, lines and polylines. select objects

Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end

Pulldown Menu Location: Draw > Symbols

Keyboard Command: ptsym

Prerequisite: None

File Name: \sp\lptsym.lsp

**Insert Multi-Point Symbols**

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The **Insert Multi-Point Symbols** command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.
Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing Draw Field to Finish under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting the desired symbol. Next, select the Symbol Pts button. This brings up a dialog called Define Symbol Placement Points. Here is where you define the symbol by three points. You do this by entering an X and Y coordinate and a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pnts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, let's go through the Insert Multi-Point Symbol command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Let's look at the BLD code three point insertion definition. Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The three point PAD and the tree with drip line examples follow. We start by specifying the building pad codes.

**Prompts**

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

Specify LTFNT PAD point.
Pick Point or Point Number (Enter to End): 15
Specify LT REAR PAD point.
Pick Point or Point Number (Enter to End): 16
Specify RT REAR PAD point.
Pick Point or Point Number (Enter to End): 17
Insert another BLD symbol [<Yes>/No]? N

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

Specify Trunk Location point.
Pick Point or Point Number (Enter to End): 1
Specify Drip Line Point.
Pick Point or Point Number (Enter to End): 13
Insert another TREE symbol [<Yes>/No]? N
From the Field to Finish routine
Two points symbol placement for TREE

Three points for building PAD

Two point tree with drip line

**Pulldown Menu Location:** Draw > Symbols  
**Keyboard Command:** multisym  
**Prerequisite:** Field to Finish file (.FLD) with codes defined with Multi-Point Symbols  
**File Name:** \lsp\finish.arx

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the *Pline* command. Likewise if you pick text, this command will begin the *Text* command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** *pick an entity*  
The remaining prompts depend on the type of the selected entity.

**Pulldown Menu Location:** Draw  
**Keyboard Command:** drawbyex  
**Prerequisite:** Entities
Sequential Numbers

This command draws a text label and then increments to the next value for additional labels. The label and optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size. First, pick one of the seven formats.
Specify the **Text Size** (height). Defaults to size set in *Drawing Setup*.

Specify the **Text** label.

Specify an optional text **Prefix**.

Specify an optional text **Suffix**.

When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the Increment field.

When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels.

If Auto Increment Labels is checked, Text value is incremented by the **Increment** value.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.

**Prompts**

Select Symbol for Numbers dialog  *select your symbol*

Sequential Numbering Options dialog  *make your choices*

Pick point at beginning of label:  *pick a point*

Pick point for label alignment:  *pick a point to the right of the first point*

Pick point at beginning of label:  *press Enter to end the routine*

Pulldown Menu Location: Draw

Keyboard Command: numbers

Prerequisite: None

File Name: `\sp\cir_num.lsp`

---

**Arrowhead**

This command draws an arrowhead at the end of the selected line or polyline.

**Prompts**

Enter the arrow size `<5.00>`:  *press Enter*

Pick a line or pline to add arrow:  *pick a line or polyline*

Pick a line or pline to add arrow (Enter to End):  *press Enter*
**Curve - Arrow**

Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. The arrowhead size is determined by the AutoCAD system variable "DIMASZ". In order to change this size, type `DIMASZ` at the AutoCAD command prompt. This routine also has a Zorro option which creates a Z leader curve.

**Prompts**

Create a Zorro (Yes/<No>)? N
Include an arrow (Yes/<No>)? Y
Enter the arrow head size <4.00>: press Enter This defaults to the DIMASZ system variable.
Pick a starting point: pick a point
Pick an ending point: pick a point
Pick an intermediate point (U to Undo): pick a point
Pick an intermediate point (U to Undo): press Enter

**Examples of Curve - Arrow**

**Boundary Polyline**

This is a streamlined analog of the AutoCAD command Boundary. The Carlson version is faster and works in many cases where Boundary fails. Boundary Polyline supports a snap tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. Then click inside openings you would like to trace and the routine will generate corresponding closed polylines. The duplicate polylines are detected and not created, so that clicking more than once in the
same area does not change anything. These new polylines are always created in the current layer. Layers of the original linework do not matter.

**Prompts**

**Select polylines:** *pick an entities to be used*

**Enter snap tolerance or press Enter for none:**

**Pick an internal point:** *pick the points to enclose*

These three polylines are created from original linework by clicking at shown locations

**Pulldown Menu Location:** Draw

**Keyboard Command:** boundpl

**Prerequisite:** Entities

**File Names:** \lsp\scbpoly.arx

**Shrink-Wrap Entities**

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points.
Prompts

Shrink-wrap across gaps or bounded linework only [<Gap>/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [<2D>/3D]? 2D

Pulldown Menu Location: Draw
Keyboard Command: swplines
Prerequisite: Entities
File Name: \lsp\scbpoly.arx

Polyline by Nearest Found

This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method
draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

Prompts

Create 2D polyline at zero elevation or 3D polyline [<2d>/3d]? press Enter
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points

Pulldown Menu Location: Draw
Keyboard Command: plnear
Prerequisite: None
File Names: \lsp\crdutil.arx
Inq-Set Menu

Shown here is the Carlson Software Inquiry & Settings (Inq-Set) menu. The top section contains detailed inquiry commands. The lower section of the menu includes setup and control commands.
**Point ID**

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

**Prompts**

Pick point or point number: 255

|PointNo. Northing(Y) Easting(X) Elev(Z) Description |
|:---|:---|:---|:---|:---|
|255 |4379.83 |4265.48 |19.01 |GROUND/SHOT |
|N: |4379.83 |E: |4265.48 |Z: |19.01 |
|Pt#: |255 |CRD File: |c:\Carlson2008\data\mantopo.crd |

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None
File Name: \lsp\pt_id.lsp

**Layer ID**

This command reports the layer name of the selected entity.

**Prompts**

Pick entity to read layer: pick an entity
Layer: FINAL
Pick entity to read layer: press Enter to end

Pulldown Menu Location: Inquiry
Keyboard Command: layerid
Prerequisite: None
File Name: \lsp\surv1.lsp

**Bearing & 3D Distance**

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

**Prompts**

Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0''
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Pulldown Menu Location: Inquiry
Keyboard Command: 3DIST
Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]? Y

Pulldown Menu Location: Inquiry
Prerequisite: None
Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: *pick a polyline or line*
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None
File Name: \lsp\polylen.lsp

Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

• Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
• Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' is your drawing scale.

• The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.

• The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.

• The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.

• **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD **UNITS** command.

• **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the section on Localization under the Coordinate File Utilities command for more information.

• **Distance Scale Factor for Labels and Reports** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be entered directly into the edit box or calculated using the Calculate button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor.

• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.
– The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
– The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.

**Prompts (for Set Paper)**

**Pick or Type lower left corner point for border** \((5000.00 \ 5000.00 \ 0.0)\): *pick a point*

**Erase existing Set Paper boundary** [Yes/No]? *Y* This prompt only appears if there is an existing paper boundary in this drawing.

**Set Limits** [Yes/No]? *Y* If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in **LIMITS** on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

**Pulldown Menu Location:** Settings

**Keyboard Command:** setup

**Prerequisite:** None

**File Names:** \lsp\survset.lsp, \lsp\scadenvr.dcl
Layer Report

This command generates a report containing each layer name, the number of entities on each layer, the color and the linetype applied to each layer.

Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you’d like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.
Pulldown Menu Location: Inquiry  
Keyboard Command: layerinspect  
Prerequisite: None  
File Name: \lsp\contour4.arx

**Drawing Inspector**

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.

<table>
<thead>
<tr>
<th>Keyboard Enter</th>
<th>Turn Off Drawing Inspector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Layer Name</td>
<td>Display Elevation</td>
</tr>
<tr>
<td>Display Azimuth-Distance</td>
<td>Display Bearing-Distance</td>
</tr>
<tr>
<td>Display Point Data</td>
<td>Display Text Data</td>
</tr>
<tr>
<td>Display Curve Data</td>
<td>Display Polyline Data</td>
</tr>
<tr>
<td>Display Polyline Blips</td>
<td>Enable Highlighting</td>
</tr>
<tr>
<td></td>
<td>Enable Tag Display</td>
</tr>
<tr>
<td>Show Data On Status Bar</td>
<td>Use Default Cursor</td>
</tr>
<tr>
<td>Report In High Precision</td>
<td></td>
</tr>
</tbody>
</table>

In the **Drawing Inspector** menu, you can choose one or more properties to display.

**Display Layer Name:** Allows you to display the layer name of the entity.

**Display Elevation:** Allows you to display the elevation of the entity.

**Display Azimuth-Distance:** Allows you to display the azimuth and distance of a line.

**Display Bearing-Distance:** Allows you to display the bearing and distance of a line.

**Display Point Data:** Allows you to display the coordinate data of point.

**Display Text Data:** Allows you to display the attributes of text.

**Display Curve Data:** Allows you to display the radius, arc length, chord length and delta angle of a curve.

**Display 3D Face Data:** Allows you to display the Z elevations at the face corners.

**Display Polyline Data:** Allows you to display the end point elevations, horizontal distance, slope distance and slope ratios.

**Display Polyline Blips:** Allows you to displays temporary blip plus marks at the vertex locations of polylines.
In the *Drawing Inspector* menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the *Drawing Inspector* is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the AutoCAD cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

---

**Example of Drawing Inspector reporting Bearing-Distance using the Tag Display**

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** inspector

**Prerequisite:** None

**File Name:** `\isp\autotag.arx`

---

**Find Point**

This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is considered the same as TEST). Matching points are highlighted on the graphics screen with the preview arrow and listed on the text screen.

**Prompts**

*Find by point [N]umber or [D]escription <N>: press Enter*

Point number or range of point numbers to find <1>: 8-10

8 4856.75 4747.20 0.00
9 4909.25 4648.37 0.00
10 4223.30 4545.46 0.00 RADPT

If you respond with *D* for the first prompt the program prompts:

Conforms to AutoCAD's wild card matching.

Point Description(s) text to search for <>: rad*

Searching file C:\Carlson/DATA/LOT.CRD for point descriptions matching RAD* ...
Display-Edit File

This command allows you to edit or review an ASCII/text file. Files are displayed in the Standard Report Viewer section of this manual.

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None
File Name: \lsp\fpnt.lsp

Display Last Report

This brings up the last report generated by any Carlson command that uses the standard report viewer.

Pulldown Menu Location: Inquiry
Keyboard Command: report_up
Prerequisite: A previously viewed report
File Name: \lsp\quickkey.lsp

System Variable Editor

The AutoCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.
The Variable Editor contains a list of variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, so use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **List Box:** Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **Edit Field:** When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

- **Description:** When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

- **Integer:** Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.

- **Real:** Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.

- **String:** Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.

- **2D Point:** Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.

- **3D Point:** Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must used, separating the X and Y and Z values.
Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

- **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.

- **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.

- **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

- **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.

- **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

- **Off (0)**: Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.

- **On (1)**: Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.

Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each buttons purpose is explained below.

- **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

- **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.

- **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

- **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

- **Print**: Used to print the current system variables. After choosing this option, you will prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each buttons purpose is explained below.

- **Change**: Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.

- **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.
• **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of **supported** system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.

**Pulldown Menu Location**: Settings  
**Keyboard Command**: VAREDIGIT  
**Prerequisite**: None

### Point Object Snap

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD *NODE* snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the *2DP* command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.

**Pulldown Menu Location**: Settings  
**Keyboard Command**: `pointsnap`  
**Prerequisite**: None  
**File Name**: `\lsp\scadutil.arx`

### Save/Load Tablet Calibration

A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

**Save Configuration Procedure:**  
1) Command: TABBSAVE
2) Designate filename (*.TCF) to save configuration into.

**Restore Configuration Procedure:**
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

**Pulldown Menu Location:** Settings > Tablet Calibration

**Keyboard Commands:** tablet1, tablet2

**Prerequisite:** None

**File Name:** \lsp\tablet.lsp

---

**Tablet Calibrate**

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Before proceeding, please refer to the Settings menu, then go to Configure and General Settings. Then look at the Digitizer Puck Layout section for the selection of the correct puck layout.

**Tablet Calibration**

**Known Reference Points** uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and pick the Pick button. Pick the points from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the **Tablet Calibration Dialog** the next time it is accessed, so if you are working in the same drawing, you can use the **Known Reference Points** method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.

![Tablet Calibration Dialog](image-url)
**Drawing Scale with New Reference Points** is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then pick the Pick button and pick the point on the drawing to assign the specified coordinate to. The program will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display in the **Tablet Calibration Dialog** as **Known Reference Points** the next time you calibrate the tablet, so you can digitize back to the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitize board.

![Tablet Calibration Dialog](image)

**Prompts**

**Tablet Calibration Dialog**
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: *pick a point*
Pick second reference point: *pick another point*

**Pulldown Menu Locations:** Settings > Tablet Calibration

**Keyboard Command:** digsetup

**Prerequisite:** Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

**File Name:** \lsp\digsetup.lsp

**Set/Reset X-Hairs**

*Set X-Hairs* sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. *Reset*
**X-Hairs** restores the crosshairs alignment to horizontal.

**Pulldown Menu Location:** Settings > Crosshairs  
**Keyboard Commands:** setxhairs, resetxhairs  
**Prerequisite:** Line entity  
**File Names:** \lsp\xh.lsp, \lsp\rh.lsp

---

**Rescale Drawing**

This command globally resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.

**Prompts**

Old Horizontal Scale: 20  
New Horizontal Scale: 30  
Select text, symbols, dimensions and blocks to scale.  
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter  
41 found  
Select objects: press Enter  
Number of symbols and blocks changed > 7  
Testing Entity > 41  
Number of text entities changed > 20

---

![Graphs showing scale changes](image)

---

**Pulldown Menu Location:** Settings  
**Keyboard Command:** scaledwg  
**Prerequisite:** Drawing entities to be scaled
**Mortgage Block**

This command draws a personalized title block for a mortgage survey. You may select an 8 1/2" x 11" sheet, an 8 1/2" x 14" sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the `mortgage.dwg` file located in the `\sup` directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 1/2 x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a `mortgage.ini` file located in the `\User` directory.

The **LIMITS** of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the *Attribute Edit* command under the Edit menu.

---

**Pulldown Menu Location:** Settings  
**Keyboard Command:** mortgage  
**Prerequisite:** Set horizontal scale in *Drawing Setup*  
**File Names:** `\lsp\mortgage.lsp`, `\sup\mortgage.dwg`

---

**Title Block**

**Function**

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The *Other* choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can
choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
Pulldown Menu Location: Settings
Keyboard Command: tblock
Prerequisite: Set horizontal scale in Drawing Setup

Chapter 7. Inq-Set Menu
File Names: \lsp\title.lsp, \lsp\title2.fas, \sup\tblock*.dwg(s)

Edit Symbol Library

Function

This command allows you to customize the symbol library.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.

The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit
mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

**Pulldown Menu Location:** Settings  
**Keyboard Command:** editptsym  
**Prerequisite:** None  
**File Names:** \lsp\scadutil.arx, \user\symbols.dta

### Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

- **Show:** Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.  
- **Hide:** Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.  
- **Exit:** Exits this command

**Pulldown Menu Location:** Settings  
**Keyboard Command:** TBARCFG  
**Prerequisite:** None

### Mouse Click Settings

This command can be used to make custom mouse click preferences. It allows you to set the preferred functionality of your mouse wheel and mouse buttons.

The Middle Button Click options apply to a 2-button wheel mouse (with the wheel acting as the middle button) or a 3-button mouse. Choose between using the middle mouse wheel for real-time pan, or to show an Object Snap pop-up menu. The mouse wheel can also be clicked and depressed for panning, and it can be used for zooming in and out by scrolling with the wheel.
In the lower section of the dialog, you can determine how the right mouse button will operate. For the right button, there are different levels of pop-up menus that can be activated. With all these menus off, the right button will be used like Enter on the keyboard.

**Pulldown Menu Location:** Settings

**Keyboard Command:** clickset

**Prerequisite:** None

## Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. **Configure** will restore the current drawing settings to these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.

The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in **Configure**, and will be described here.
Use Startup Wizard: The Use Startup Wizard controls whether this wizard appears when creating a new drawing.

Generate Report Log: When the Generate Report Log option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt. This function toggles the report log on/off.

Save Drawing INI Files: Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.

Auto Zoom Center for New Points: This option zooms the display to center the new, located point. If it is off, the screen does not center the new point.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth, which is the default.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the AutoCAD command DVIEW. This is similar to Twist Screen.

Set Dimscale to Drawing Scale: This will set the dimension scale to match the drawing scale. By default, it is set to 40.0.

Set PDSIZE to Symbol Size: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup. By default, it is set to 4.0.

Set INSUNITS to Unitless: This will set the INSUNITS (Insertion Units) AutoCAD system variable to Unitless when the drawing is opened.
**Point Layer:** This is the default layer to draw any new points.

**Coordinate Report Order:** You can choose the traditional north-east format, or reverse these in reports with east-north.

**Date Format:** You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

**Report Viewer:** This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

**AutoCAD Menu:** This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

**Object Linking:** The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

**Database Format:** The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.

**CRD File Pt# Format:** Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:

- **Carlson Numeric:** This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 32767.
- **Carlson Alphanumeric:** This native Carlson format allows letters in the point numbers, and the point name can be up to 10 characters. Any combination of letters and numbers is acceptable.
- **C&G Numeric:** This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric:** This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK:** This is the Simplicity Systems coordinate file format.
- **LDT Points.mdb:** This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is found in a projects \COGO directory. The number limitation is established by the database structure, but is frequently numeric and allows unlimited point numbers.

**Digitizer Puck Layout & View:** There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.
Use Mouse: This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

Auto Tablet On for Digitize Commands: This option will activate the auto tablet when using the digitize commands.

Drawing Setup:
The settings under Drawing Setup are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the Configure menu choice, using the Localization Settings button.

**Survey Settings:**
There are five different areas for default Survey Settings. These all appear elsewhere in Survey, but if you set them there, they will just apply for that drawing. If you make changes here, it will apply to the current and/or future drawings. Since each is defined elsewhere in the Survey chapter, each is not detailed here, just the dialog for viewing.
Chapter 7. Inq-Set Menu
Chapter 7. Inq-Set Menu
DTM-Contour Settings:

Most of the DTM-Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

**Inverse Distance/LeastSquares Modeling Parameters:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**Specify Grid Resolution As:** There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of cells.
cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision:** This is the number of decimals that are stored in the grid file.

**Section-Profile Settings:**
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image1)

**Hydrology Settings:**
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image2)
Mine Note Options:
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

Mine Note Entry Options:
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

Mine Settings:
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

Inverse Distance/Least Squares Search Radius, Samples and Quadrants: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datpoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

SDPS Directory: This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance): This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing
strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. None will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. All will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinchout when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best "guess" is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turned when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weight the quality attribute by a Density value instead of thickness. The Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.

**Use Strata Limit Lines:** When using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one is on, then you will be prompted to select them for all commands.

**Auto Select All Strata Limit Lines:** Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

**Use 0 Values for Blank Entries in Coal Sections:** When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

**Report Format for Quantities by Avg/Grid Methods:** This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

**Key Material Name:** This is the name of the KEY material you are mining. Enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.
**Startup Options:**

These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson 2008 Folder:** This is the folder where Carlson is installed. The Browse button allows for selecting a new file.

**Carlson 2008 Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.

**Profile Name:** This is the AutoCAD Profile that will be used when working in Carlson and AutoCAD.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start up procedure.

**AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**Localization Options:**

There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

- Annotate Defaults
- Area Defaults
- Cogo Design
- Drawing Setup
- DTM and Contour
- General
- Lin/Curve Table
- Minimal Length To Label
- Section Profile
- Stack Label Arc
- Survey Text Defaults

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.
Pulldown Menu Location: Settings
Keyboard Command: config_scad
Prerequisite: None
File Names: \lsp\survini.lsp, \lsp\cogoini.lsp, \lsp\dtmini.lsp, \lsp\mineini.lsp, \lsp\hydroini.lsp, \lsp\sctini.lsp, \lsp\cfg_scad.lsp, \lsp\cfg_scad.dcl

Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.
Prerequisite: A project file that has been zipped (ZIP)

Store Project Archive

This command will zip and archive an entire project. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. If the drawing hasn't been saved recently, the following window appears first.

Pulldown Menu Location: Settings > Project
Keyboard Command: zip_project
Prerequisite: A project file
File Name: \ls\contour4.arx
**Project Explorer**

This tool is used for management of a complete project. A project can contain numerous drawings, and each drawing within that project can contain numerous related files.

Think of the *Project Explorer* as the trunk of the hierarchical tree structure that develops into a project. While within each drawing, Carlson keeps track of the files that you create (such as grids and coordinates). These are related to the drawing and you can use *Drawing Explorer* to manage them. When management reaches the top level, the *Project Explorer* is used to tie these together.

**Prompts**

When you initiate the *Project Explorer*, you will be prompted to select an existing or create a new Project File. Project files end in the PRJ extension. Once a project file is open, the following dialog will appear.

![Project Explorer dialog](image)

**Add:** When you choose the Add button, you are prompted to select a drawing file to add to the project. The selected drawing file is added to the project tree along with any files related to the drawing.

**Remove:** When any branch of the tree structure (except the top root) is selected, it is removed. Keep in mind that removing any node of a tree structure removes all nodes under it.

**Up/Down:** When you select a branch of the tree structure that can be moved, the Up and Down buttons become available. This allows you to rearrange the items vertically.

**Report:** This option displays the Report Formatting Options for formatting the report of the Drawing Explorer (see Drawing Explorer).

When you choose the Add button you will be presented with a dialog to select a drawing to add to the project. Once a drawing is selected, it will be added to the project tree along with any files related to the drawing.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g., File type first, File name second, etc.). Click the Display button that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.
Pulldown Menu Location: Settings > Project
Keyboard Command: prjxplore
Prerequisite: None
File Name: \sp\gisutil.arx

## Drawing Explorer

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing. The knowledge of these files is contained in the .INI file that shares the drawing name (e.g. Estates.dwg, Estates.ini). If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will display "No Files". In Configure > General Settings, if Save Drawing INI Files is clicked off, then Drawing Explorer will again display "No Files". Drawing Explorer will also not show any data files where the drawing name starts with the seven letters "Drawing". Using any other file name, once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files in the order that they are created. Drawing Explorer helps manage drawing-related data.

**Example 1**

If we are working in a drawing called Estates.dwg and create a coordinate file Estates.crd, then later create a second coordinate file called Estates-GPS.crd, Drawing Explorer would display the following:

The coordinate file created or modified last appears at the top of the list. All data files are displayed in the order of most recent to oldest. If the Estates.crd file is set as current by the command Set Coordinate File, then added to or revised, Estates.crd will move to the top of the list. Thus old, relatively unused files will gravitate to the bottom of the list.

Files are displayed by category. So far, we have only the Coordinate Files category. There are also Raw Field Note files (.RW5), profiles (.PRO), section files (.SCT) - in fact dozens of file type categories that will display once these files are actually created.

If a data file is selected and highlighted, the Up and Down keys will become enabled, and the user can move files up to the top of the list or otherwise alter their position. The position of files affects only the reporting of the files using the Report option in the lower left of the dialog. When highlighted, a file can be removed from the list (but it won't be deleted from the hard drive!). The Add option will add other older or non-referenced data files to the list.
of files associated with the drawing.

![Drawing Explorer](image)

**Example 2**

As we do more work in the file Estates.dwg, data files will begin to proliferate and will appear in Drawing Explorer. Shown below is a more comprehensive list of files, with occasional examples of multiple files within the same category. Categories themselves float to the top of the list if any of their data files have been used more recently than data files in other categories.

Note that there is even a Miscellaneous Files category, that includes ASCII point files created by the command Export Text/ASCII File.

When many data files are involved, the Report option becomes very useful. Here you can use the Report Formatter to display, in any order, the File Name, File Type, Date last modified, Time last modified, Size in bytes, and whether it is Found (e.g. exists) in the specified directory. For example, if a file was created in a certain directory but moved using Windows Explorer to another directory without being further altered in Carlson, it would show up here as not found. ("No" would appear in the Found column).

Shown here is a summary of our data files by size, with reporting of the found status. In this case, the Estates.Lot file has been moved or deleted.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button (not shown above) that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.

A deleted or missing file such as Estates.Lot will appear in Drawing Explorer with a special red [no entry] symbol as shown here.
Chapter 7. Inq-Set Menu
Set Project/Data Folders

This command sets both the project work folder and the data folder to use as the default folders for your Carlson drawing and data files. The \PROJECT folder typically contain the .DWG and .BAK files, while the \DATA folder typically contains files such as coordinate (.CRD), Field to Finish code definition (.FLD), profile (.PRO) and centerline (.CL) files. This routine also shows you the tree structure of existing folders available on your computer. The first dialog provides you with a choice of three for the Data Folder Setup. The three options are Project Folder, Drawing Folder or Fixed Folder. You will choose one.

**Project Folder:** This option will make available the two buttons (rectangular boxes) in the middle of this dialog box. These large option buttons are labeled Project Sub-Folders Setup and Data Type Sub-Folders, respectively. Clicking the left-side Project Sub-Folders Setup button will produce a dialog called Project Folders.

In the Project Folders dialog you are able to Add, Rename and Delete folders and sub-folders for your project.
Clicking the Data Type Sub-Folders button on the right-side will produce a dialog that has a spreadsheet look and function. Here you have the ability to define the Data Folders and Sub-Folders by matching them up with the Data Types and Descriptions. Be sure to scroll down, using the scroll tool on the right, to review the dozens of rows of Data Types in the list. You can also edit the sub-folder structure (note the dropdown arrows in the Sub-Folder column) as described above.
**Drawing Folder:** When this option is clicked, all of the options below become grayed out. The drawings will automatically be stored in the Current Project Folder, and the data files will automatically go into the same folder as the drawing.

**Fixed Folder:** With the Fixed Folder option, you will "Set" a folder for all of your data to be stored in. The \DATA folder is the default folder, but you can also create and set any folder you would like.
To create a new data folder, for example, first note the Current Data Folder section at the bottom of the dialog box, and notice the Set button to the right. Click Set. A new dialog appears that will allow you to select the data folder of your choice. Here, you can create or remove any folder.

If you choose Create Directory, the program will prompt you for the new directory name. The Remove Directory button allows you to delete directories that have no files inside. After you have made your choices, click OK.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** setmpdir  
**Prerequisite:** None

### Load Saved Report

This brings up the Report Formatter for the report data file saved previously by the Report Formatter.

**Pulldown Menu Location:** Inquiry  
**Keyboard Command:** load_report  
**Prerequisite:** A saved report  
**File Name:** \lsp\scadutil.arx
Points Menu

Shown here is the Points menu of Carlson Field.
**Point Defaults**

This command sets Carlson point options.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Elevations:** Specify whether you are prompted for a point elevations when creating points and whether the point elevations are labeled in the point block.

**Locate on Real Z Axis:** When checked, points are located at their actual elevation, otherwise points will be located zero elevation.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in AutoCAD drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Symbol Name:** Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the symbol library.

**Prompt for Symbol Names:** When checked, you will be prompted for each symbol name instead of using the default symbol.

**Point Numbers:** When this toggle is OFF, no point number will be created and no points will be stored in the coordinate (.CRD) file.

**Automatic Point Numbers:** When this toggle is OFF, commands that locate a point will prompt for a point number. Otherwise, point numbers are numbered sequentially. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the Draw-Locate Points command and use the Range option, then a point entity is plotted.
The following table illustrates the effects of elevation settings:

<table>
<thead>
<tr>
<th>Elevation Settings</th>
<th>Real Z Settings</th>
<th>Picked Point Labels</th>
<th>Point Number Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>point, Prompts for elevation, uses 0 for z coordinate</td>
<td>point, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>point, Prompts for elevation for z coordinate</td>
<td>point, No Prompt, uses z coordinate from file</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>point, No Prompt, uses z coordinate of picked point</td>
<td>point, No Prompt, uses z coordinate from file</td>
</tr>
</tbody>
</table>

**Start Point Number:** Specify the next point number to use.

**Vertical Angle Mode:** Specify how Carlson should prompt you for vertical angles. None means no prompt. Applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

**Separate Layers:** Specify settings for point attribute layers.

- **None:** The point symbol, point number, elevation and description use the layer names PNTMARK, PNTNO, PNTELEV and PNTDESC.
- **Points:** The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC.
- **Symbols:** The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- **Both:** The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

**Layer for Points:** Specify the layer name for Carlson points.

**Auto Zoom:** When checked, AutoCAD will perform a Zoom—Center around new points to keep the display centered around current working area. This only applies during commands such as Traverse. This setting is also available in Configure under General Settings where it is called Auto Zoom Center for New Points.

**Use Field to Finish For:** Allows you to use the code definitions from Field to Finish for the Point Symbols, Layers, Descriptions, Attribute Layout IDs and whether to locate the point on the "Real Z" and whether to Separate Attribute Layers when creating new points. For example, when creating a point with description "EP", Carlson would look up "EP" in the Field to Finish table and will use the field code definitions to establish the point instead of the definitions defined in Point Defaults.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results.
Draw-Locate Points

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.

The name of the symbol file is displayed in **Symbol Name**. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

**Symbol Rotation Azimuth** is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

**Layer by Desc** inserts the points in the layer named by the point description. Using Layer by Desc organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.
**Draw Nodes Only** inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting **Elev Text Only** draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

**Locate within Polyline** inserts only the points that are inside a closed polyline. The command prompts you to select a closed polyline. All the points in the current coordinate file are checked. Any points that are located within the closed polyline are drawn.

**Locate within Distance** inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

**Locate within Window/Coord Range** inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted.

**Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use `'+'` labels the positive elevations with a leading '+' For example, "+159.43".

Use `'-'` labels the negative elevations with a leading '-'

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered.
**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name or choose an existing layer by clicking **Select Layer**. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Erase Duplicates** option will erase existing point entities that match the point numbers currently being drawn.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** choose **Screen Pick**

**Pick point to create:** pick a point

**Select/<Enter Point Elevation <0.00>: Enter elevation** Press S to select text to set elevation.

**Enter Point Description <>:** Enter

**N: 5106.57 E: 4901.96 Z: 0.00**

**Enter/<Select text of elevation >:** Select text entity that defines elevation of point.
To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose **Draw Range**

**Point numbers to draw:** 3
**Points Drawn:** 1
Locates point 3.

**Point numbers to draw:** 1-2
**Points Drawn:** 2
Locates a range of points. From 1 to 2.

**Point numbers to draw:** Enter

**Keyboard Commands:** lpoint

**Prerequisite:** A CRD file and you may want to execute **Drawing Setup** (see the Setting menu) to set the scale and size.

**File Names:** \lsp\lp.lsp, \lsp\crdutil.arx

**List Points**

This command generates a report of point numbers, northings, eastings, elevations and descriptions.

**Selection Method-Range** allows you to specify the points to list by point number range.

**Selection Method-Area** allows you to select a closed polyline to list all of the points inside of that polyline.

**Selection Method-Selection Set** allows you to specify the points to list by selecting them from the drawing.

**Range of Points:** If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the **All** button.
**Point Group** allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.

![Select Point Group(s)](image)

**Description Match:** Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

**Report Coordinate Range:** When checked, the point list will include the minimum and maximum northing, easting and elevation.

**List Point Notes:** When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the *Input-Edit Point* command found in *Coordinate File Utilities*.

**Use Report Formatter:** When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

**Double Space Between Points:** When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the *Edit Points* command in the Points menu.

Example of List Points Report:

```
List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000 Job Date> 06/01/2002
PointNo. Northing(Y) Easting(X) Elev(Z) Description
1 5355.240 5000.000 91.8 CP2
2 5000.000 5000.000 90.0 CP2
1000 5355.236 5000.000 91.8 CK
1001 4941.911 4622.029 91.4 FPC
1002 4952.629 4642.818 90.6 FH
1003 4959.931 4634.440 89.8 TOE1
```
**Pulldown Menu Location:** Points  
**Keyboard Command:** listpt  
**Prerequisite:** Points in a coordinate file or on the screen  
**File Name:** \lsp\crdutil.arx

### Import Text/ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:

```
5100.0,5150.5,485.1  
5127.1,5190.3,487.3
```

The Coordinate Order would be:

```
Y X Z
```

For a text file with point number, easting, northing, elevation, description and space delimiters:

```
1 5000.0 5000.0 490.3 TRA V  
2 5030.4 4930.5 495.5 TRA V
```

The Coordinate Order would be:

```
P X Y Z D
```

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File.

Multiple files can be imported at once. To do this toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

The special formats of Leica .gsi files, TDS .cr5 files, Geodimeter .obs/.raw files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files and Cad Advantage .cog files can be directly imported by choosing that File Format at the top of the dialog.
Pulldown Menu Location: Points
Keyboard Command: readpt
Prerequisite: A text file to read
File Name: \lsp\crdutil.arx

Export Text/ASCII File

This command outputs point data from the current Carlson coordinate file to an ASCII text file. Specify the type of file to write with the Coordinate Order radio buttons. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, D45, Cadvantage, Multiplane and SDMS CTL formats. In addition there is an option, User-Defined Format, to define the order of
the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data.

Specify the Delimiter of the export file as either Comma or Space in the Delimiter field. There are three Selection Methods provided for the data to export. Specify either Range, Screen Points or Screen Entities in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from.
A description filter is also available for exporting only points from the range or selection set with certain descriptions. After selecting the OK button, another dialog appears that allows you to specify a new text?ASCII file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

**Pulldown Menu Location:** Points

**Keyboard Command:** writept

**Prerequisite:** A Coordinate File (.CRD)

**File Name:** \lsp\crdutil.arx

---

**Set Coordinate File**

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the Configure command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.
Pulldown Menu Location: Points
Keyboard Command: setcrd
Prerequisite: None
File Names: \lsp\pcrdfile.lsp, \lsp\scadfile.dcl

**CooRDinate File Utilities**

This command allows you to manipulate the coordinates stored in a coordinate (.CRD) file. One of the most important commands is the Update CRD File from Drawing which allows you to update the file after editing the drawing with commands such as **Erase**, **Move**, **Rotate** or **Change Elevations**. Another handy option is the **Draw Entities by Point Number** which allows the user to input point number ranges and plot Lines, Arcs, Polylines or 3D polylines. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point number 7A). The type of point number format is displayed at the top title bar of the main dialog.
Open CRD File: Allows the user to switch to another file. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

Copy/Merge CRD File: This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.
Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together, for example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.

Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The
Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.

**Convert CRD File Format:** This allows you to convert the current CRD file from numeric format to alphanumeric format or visa versa. This routine will also change crd files to and from different software formats. These formats include C&G, AutoDesk Land Desktop, and Simplicity. The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

![Convert Coordinate File Format](image)

**Map Points from 2nd File:** This routine adds point to the current CRD file from points stored in a second CRD file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current crd file) and source point number (point number to be copied from second crd file) will be displayed.

**Import Text/ASCII File:** This routine converts point data from a text file into the current coordinate (.CRD) file. See the *Import Text/ASCII File* command in this chapter for more information.

**Export Text/ASCII Text File:** This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See the *Export Text/ASCII File* command in this chapter for more information.

**Edit Header:** Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

![Edit Job Header Info](image)

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.
Coordinate Transformation: Transforms coordinates between local, state plane 27, state plane 83, latitude/longitude, and Universal Transverse Mercator (UTM). Works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between state plane 27 and 83, Carlson calls upon NADCON from the National Geodetic Survey to apply the latitude/longitude adjustment. The NADCON program, ndcon210.exe, is stored in the Carlson EXEC directory.

The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.

Example Lat/Long to Grid dialog
For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the **Screen Entities**. If a range of points or a particular point is desired, the **Point Numbers** option would be used. Manual entry of coordinates to transform one at a time is accomplished with the **Enter Coordinates** option. The coordinates can be typed in or use the Input Point Number option. Output Point Number is an option to store the results in the coordinate file.

![Enter Transform Coordinates dialog](image)

For all transformations there are two output options when using point numbers as the input data. **Overwrite Existing Coords** replaces the original coordinate values with the new coordinate values after transformation. **New Point Numbers** will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a **Local Coordinate System**, there are two options for defining the transformation as shown in the next dialog.

![Local Coordinate Transformation Options](image)

The **Align by Two Pairs of Points** option uses two pairs of source and destination coordinates. The first pair defines the translation as the difference between the source and destination northing and easting.
This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.
Over Determination by Plane Similarity is used to find the least squares best fit transformation for all the given source and destination points. Besides doing a translation and rotation, this option will also scale the points during the transformation. The Rigid Body Transformation also does a best fit least squares transformation, but applies only translation and rotation with no scale. The Helmert 7-Parameter method can also be used for local transformations. The 7-Parameter Values can be calculated from control points or entered by the user.

The Add button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

The Edit button is used to edit existing data.

The Delete button removes the source and destination pairing from the transformation setup.
The **Process On/Off** button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The **Optimize** option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The **Report** option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The **Load** and **Save** options allow for saving and recalling local coordinate transformation pairings and settings.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.

**Prompts**

**Plot Entities by Point Number**

*Type of entity, Arc/Polyline/3dpoly/2dline/Exit/<Line>: P* This response causes the program to plot polylines.

*Example:* ‘1*4-7-10*12-5-8’ would draw lines from point number’s 1 through 4 then to 7, to 10 through 12, then to 5 to 8. (limit 132 characters)

*Undo/<Enter point numbers or ranges>: 1*10-20*30*

The program draws a polyline from point number 1 through 10 to point number 20 through 30.

**New Last Point Number:** This option sets the highest point number in the CRD file. All points above this number are erased.

**Swap Northing-Easting:** This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) becomes the northing(s).

**Point Entry CRD File Links Manager:** When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the coordinate file such as Move Point which selects a point entity and updates the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the
coordinate file assigned to point entities which is useful when the coordinate file has been moved after the points were drawn. Use the Unlink button to remove the link.

**Update Drawing from CRD File:** This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

**Update CRD File from Drawing:** This function allows you to select all or some of the points in the drawing and add or update them to the .CRD file. The points can be filtered with AutoCAD's Select Objects: selection mechanism and/or wild card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the CRD file. Use this command to update the file after a global edit such as *Move, Rotate, Renumber Points, Change Elevations, Erase,* etc. This routine directly reads Leica
(Wildsoft), Softdesk, Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

**List Points:** List the points stored in the .CRD file. See the *List Points* command in this chapter for more information.

**Delete Points:** Deletes points in the coordinate (crd) file by point number or description.

**Screen Pick Point:** Pick a point on the graphics screen and its coordinate values are added to the coordinate (crd) file. Prompts for point number, elevation, and description will be displayed. This command does not plot a point, point attributes, or point symbol. Use the command *Draw-Locate Points* command to do this.

**Scale Points:** This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for metric-English conversion. See the *Scale Points* command in this chapter for more information.

**Translate Points:** This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See the *Translate Points* command in this chapter for more information.

**Rotate Points:** This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See the *Rotate Points* command in this chapter for more information.

**Align Points:** This option does a translate based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. See the *Align Points* command in this chapter for more information.

**Description for Points:** This option sets the point description field with the user-specified text for a range of point numbers.

**Elevation for Points:** This option sets the elevation of a specified point or range of points.
**Point Number Report:** This routine lists the used and the unused point numbers in the CRD file.

**Duplicate Points:** This function searches the CRD file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be erased or only reported. For the erase option, the first point number is kept and any higher point numbers with duplicate coordinates are erased from the CRD file.

**Compare Points:** This function compares the coordinates in the .CRD file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another CRD file or with different point numbers from the same CRD file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report.
Example Bearing-Distance format Compare Points Report

**Renumber Points:** This option renumbers points in the user-specified range starting from a new point number. The old point numbers are erased. The condense points will renumber such that there are no unused point numbers in the renumbered range. Otherwise the spaces between the points is maintained. In the example shown, renumbering 1-25 with points 1,2,24,25 to starting point number 101 will result in points 101,102,103,104 if condense is on or 101,102,124,125 if condense is off.

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. The standard description field is limited to 32 characters. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press Enter. To edit a note, highlight the line in the list box and edit the text in the edit box.
Point History: All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back. It is important to note that if maintaining such a history file is your objective, in the Settings > Configure > General Settings dialog you must make sure that Maintain CRD History File is checked.
The **Disable History Feature** button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying **Enable History Feature**. You can also choose **Delete History File** to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting **History**, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on **Details** also shows the selected command's details. **Undo thru Selected** will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

**Point Protect Toggle:** This option, located at the bottom-left of the main **Coordinate File Utilities** dialog, toggles point protection on and off. With this option on, when attempting to store a point with a point identifier (point number) that already exists in the current coordinate file, the following dialog will be displayed.
Overwrite with new coordinates will update the existing point number with the new location of the point.

The Use Another Number field displays the point number that will be used if the Use Another Number option is selected. This number will depend upon the option chosen from the Another Number From settings. If Next Available is chosen, the next available number will be displayed in the Use Another Number Field. If there are number gaps in the coordinate file this number will not be the next highest number in the file. For example if points 1-10 and 20-30 exist in the crd file leaving a gap from 11-19, the Next Available number would be 11. If the desired point number, in this example, is 31, then the option of End of File would be selected.

The Overwrite All and Renumber All options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing CRD files.

Pulldown Menu Location: Points
Keyboard Command: cfu
Prerequisite: None
File Names: \lsp\crdutil.lsp, \lsp\crdutil.arx, \lsp\scadcfu.dcl, \lsp\scadfile.dcl

Point Group Manager

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

Groups Pulldown

Create Point Group: This option creates point groups. When selected, the New Point Group dialog box is displayed.
**Group Name** is the name of Point Group to create.

**Description** is the description of Point Group to create.

Use the **Include Tab** to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When **Include All** is toggled on, all points in the coordinate file will be included in the selection.

When **Point List** is toggled on, an option of defining the point list must be selected.

**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools, are available for selection of the points.

**DWG: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
**CRD: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

**CRD: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

**Elevation Range** allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

**Set By Selection** allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

**Set From List** allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.
The **Description** option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.
The **Exclude Tab** allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12, an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.

**Edit Point Group** allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.
See Create Point Groups for further definitions of the available options.

**Delete Point Groups** deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Import Point Groups** allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.
The **Insert into Drawing** option draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example, points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.

**Erase from Drawing** erases specified point group/groups or specified points from within the group from the drawing.

**Erase from Coordinate File and Drawing** erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:
Selecting Yes will complete the command and erase the points from the screen and also the coordinate file. Selecting No will cancel the command leaving the drawing and the coordinate file unchanged.

The Report option will generate a point list of the points contained in the selected group/groups or specified points from within the group.

The Highlight option highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

The Draw 2D Line option draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

The Export command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When ASCII/Text is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.  
**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.  
Specify the file name of the CRD file to create and press save.
Edit Points

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. Edit Points shows all the points in the coordinate file. New points can be added and points can be deleted by using the Insert and Delete keys.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension "not" having the same name as the CRD and residing in the same folder.
Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the
screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the
point symbol, point attributes, and point node. The points may optionally be erased from the coordinate file. As
long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points.

Prompts

Select points from screen, group or by point number [Screen/Group/Number]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file (Yes/No)? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and
Z can be entered directly or calculated from original and destination coordinates. The original and destination
coordinates can be entered directly, specified by point number, selecting the point number from a point list by
selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified,
the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points
in the drawing will be updated automatically in addition to updating the coordinate file.
**Define Translation By Angle/Distance** requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.

With **Process Elevations** checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

**Ignore Zero Elevations** is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With **Translate Screen Entities** checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.
Various **Output Options** for the translated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40....) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command **MOVE** can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in **Configure**. (Note: This toggle must have been turned ON prior to locating the points). If you do use the **MOVE** command and the CRD file needs updating, run the command **Update CRD file From Drawing** found in **Coordinate File Utilities**.

**Pulldown Menu Location:** Points  
**Keyboard Command:** transpt  
**Prerequisite:** points in a coordinate file  
**File Name:** \lsp\crdutil.arx

---

**Rotate Points**

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.
The Rotation Point will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the List button to pick from a list of points contained in the coordinate file, or from the screen by using the Pick button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The Original Bearings/Azimuths and Destination Bearings/Azimuths can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 10-12 match the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With Rotate Screen Entities checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):.
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation of the points and screen entities will be completed.

Various Output options for the rotated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

New Point Numbers will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.
Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.

The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** rotatept  
**Prerequisite:** points in a coordinate file  
**File Name:** \lsp\crdutil.arx

### Align Points

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked from the point list by selecting the List button.
When **Align Screen Entities** is checked, after specifying the point range or group to align and selecting OK on the dialog box the following command line prompt is displayed:

**Select objects to rotate (points excluded):** At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When **Ignore Zero Elevations** is checked, all points with an elevation of 0 will be ignored in the alignment.

**Undo Last Align** restores the points to their previous location before alignment. It is important to note that if Align Screen Entities has been checked to restore the aligned objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** alignpt  
**Prerequisite:** Points in a coordinate file  
**File Name:** \lsp\crdutil.arx

### Scale Points

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.
Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field. The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. This calculation process begins with the Calculate Scale Factor dialog shown below.
The **Projection Type** must be specified as either State Plane 83 or State Plane 27 as well as what state plane **Zone** is required.

The available **Coordinate Units** are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The **Range of Numbers** to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the **List** button.

**Scale Direction** determines which way the scale factor will be calculated. A scale for Ground to Grid or Grid to Ground can be calculated and applied.

Pressing the **Calculate** button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the **OK** button.

The **Report** option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points  
**Keyboard Command:** scalept  
**Prerequisite:** points in a coordinate file  
**File Name:** \lsp\crdutil.arx

## Move Points

This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: an AutoCAD POINT entity, a symbol, and a point block with the point number, elevation and description. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point.

**Pulldown Menu Location:** Points  
**Keyboard Command:** mpnt  
**Prerequisite:** Carlson points  
**File Name:** \lsp\mpnt.lsp

## Edit Point Attributes

This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: **Select point to edit (Enter to end).** At this point, you can select any part of the point including the symbol, elevation, point number or the description. Next, a dialog will appear as shown.
To change the symbol, either type in a new symbol name in the edit box, or choose the "Select Symbol" button where you can choose from a list of symbols. To change any of the other properties of the point, simply change or replace the contents of the edit box with the new information. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in the coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point(s) changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted [O]verwrite w/new coordinates, overwrite [A]ll, or use number <1000>:. You can choose to use the next available point number in the CRD file (this is the default), or overwrite the point number. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update screen entities. Selecting the History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.

You may also choose to use the AutoCAD DDATTE command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

**Pulldown Menu Location:** Points  
**Keyboard Command:** editpnt  
**Prerequisite:** Carlson points  
**File Name:** \lsp\editpnt.lsp
Edit Multiple Pt Attributes

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.

After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attribute's properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.
The **X location** refers to the distance in the X direction from the center (or insertion point) of the point symbol. The **Y location** refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The **Layer** refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the **Attribute Block Layer** option. The **Height** is expressed in real units (generally feet or meters), not plotted size. The **Rotation angle** is expressed in absolute decimal degrees. The **Point Entity Layer** refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required.

To change a point symbol, check on the **Symbol** option and use the select button to choose the desired symbol. The **Attribute Layout ID** refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Each change to an attribute is defined separately. Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

**Edit Multiple Points dialog**

Again, the number of points selected will be shown in the dialog title. Let's now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.
Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:

Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:

At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.
Before and After Changes

**Pull Down Menu Location:** Points

**Keyboard Command:** modpnts

**Prerequisite:** Points drawn on the screen

**File Name:** \lsp\crdutil.arx

---

**Move Point Attributes Single**

This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

**Prompts**

*Select Point Number, Elevation, or Description to Move:* select point attribute

*Pick new location:* pick point

*Pick new angle:* pick new angle or press Enter

**Pull Down Menu Location:** Points

**Keyboard Command:** movepnt

**Prerequisite:** Carlson points

**File Name:** \lsp\surv1.lsp

---

**Move Point Attributes with Leader**

This command allows the user to move Carlson point attribute (including the point number, elevation or description) and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts.

**Prompts**

*Select Point Label to Move (O for Options):* select point attribute

*Pick label position:* pick point
Select another Point Label to Move (O for Options, Enter to End): O

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.
Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

Pulldown Menu Location: Points
Keyboard Command: movepntleader
Prerequisite: Carlson points
File Name: \lsp\lsp

Scale Point Attributes

This command will scale point attribute text (number, elevation and descriptions) and point symbols up or down in size. The routine prompts for a scale multiplier and a selection set of objects. If you want to enlarge, enter a value greater than one. If you want to reduce, enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. This command has the added benefit that it will adjust the point attributes and symbols to a new screen twist angle.

Prompts

Scaling Multiplier <0.500>: 2.5 This response would enlarge the point attributes and symbols by 250 percent.
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [Screen/Group/Number]? press Enter
Select Carlson Software points. pick a point
Select objects: Specify opposite corner: pick a point
Scaling Carlson Software Point Attributes ....
Number of entities changed> 174

Pulldown Menu Location: Points
Keyboard Command: pntenl
Prerequisite: Carlson points
File Name: \lsp\pntenl.lsp

Chapter 8. Points Menu 234
**Erase Point Attributes**

This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

**Prompts**

Select Point No., Elev, or Desc to Erase: select point attribute

Pulldown Menu Location: Points

Keyboard Command: erasepnt

Prerequisite: Carlson points

File Name: \lsp\surv1.lsp

**Twist Point Attributes**

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

**Prompts**

Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]? F

Select reference polylines to follow. pick a polyline

Select objects: 1 found

Select objects:

Select points from screen, group or by point number [<Screen>/Group/Number]? select Enter

Select Carlson Software points.

Select objects: pick the Carlson point inserts

Point attributes aligned by Follow Polyline option of Twist Point

Pulldown Menu Location: Points

Keyboard Command: twistpts

Prerequisite: None

File Name: \lsp\twist.pt.lsp
Resize Point Attributes

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

Prompts

Enter point attribute and symbol size <4.0>: press Enter
Scale symbols only, point labels only or both [Symbols/Labels/Both]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points.
Select objects: pick the point entities
Finding Carlson Software Point Attributes ....
Number of entities changed > 10

Pull down Menu Location: Points
Keyboard Command: sizepnt
Prerequisite: Carlson points
File Name: \lsp\sizepnt.lsp

Fix Point Attribute Overlaps

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.
**Methods:** There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

- **Alternate Layout ID 0-9**
  These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the *Point Defaults* command on the Points menu.

- **Flip Individual Attributes**
  This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

- **Slide Individual Attributes**
  This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.

- **Rotate (If Only One Attribute)**
  This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

- **Offset Attribute Block**
  This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See *Offset Options* below for a description of the options that can be used with this method.

**Offset Options:** These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.

- **Maximum Offset Scaler:** This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.
- **Use Leader:** Specifies whether or not a leader should be drawn when offsetting the attribute block.
- **Minimum Leader Length Scaler:** Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.
- **Draw Arrowhead:** Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
- **Minimum Leader for Arrow Scaler:** Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that the leader must be before an arrowhead is placed on it.

- **Use Selection Set for Points:** Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, then all the points in the drawing are used.

- **Avoid Linework Conflicts:** Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

- **Review Remaining Overlaps:** Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.
Skip Resolved Overlaps: Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, then both resolved overlaps and unresolved overlaps will be available for review. This option only applies if Review Remaining Overlaps is on.

Overlap Reviewer

The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.

Pan and Zoom Controls: Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

First, Last, Back, and Next: These buttons allow you to step through each overlap or to jump to the first or the last.

Status: This drop-down list indicates the status of the current overlap. open means that the overlap has not been fixed yet. resolved means that the overlap has been fixed. ignore can be chosen by you to remove the overlap from the list.

Restore: Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.
Move Block: Allows you to move one or more attribute blocks in the drawing. See the documentation for Move Point Attributes with Leader command in the Points menu.

Move Attrs: Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for Move Point Attributes command in the Points menu.

Auto-Zoom: Check this checkbox to automatically zoom and pan the view as each overlap is viewed.

Prompts

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed.
Select the points to fix overlaps with: pick the Carlson point inserts

Pulldown Menu Location: Points
Keyboard Command: overlappts
Prerequisite: None
File Name: \lsp\n
Trim by Point Symbol

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

Prompts

Select Carlson Software point symbols to trim against.
Select objects: select the point symbols

Before Trim by Point Symbol
**Pulldown Menu Location:** Points  
**Keyboard Command:** trimpts  
**Prerequisite:** Carlson point symbols  
**File Name:** \lsp\trimpts.lsp

### Change Point LayerColor

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK, TRAVNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVPNO1.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.

The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30, 32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.
Renumber Points

This command will edit the point number attributes of a group of Carlson points. The command prompts for the user to enter the point number difference. Enter the positive or negative amount you would like to have added/subtracted from the current value. After selecting the point to change, a prompt to delete the old point number is displayed. If yes is chosen the old point number is deleted from the CRD file, if no is selected the old and new point numbers are retained in the file. This results in one coordinate position represented by two point numbers.

The following illustrates number changes from point 4, 5 and 6 to 104, 105 and 106. This prompt sequence retains both numbers in the CRD file. If the intent is to renumber and delete the original points 4, 5 and 6, then Yes would be selected when prompted to Delete old point numbers.

Prompts

Positive number increases, negative number decreases Point number.

Point Number difference <1>: 100 This response would add 100 to the current point number value.
Select Carlson Software Points for Point Number change.
Select objects: select a point number or a group of points by window or crossing
Delete old point numbers from file [<Yes>/No]? Choose correct response. In this example the response was N, leading to the following.
PT#: 6 changed to PT#: 106..
PT#: 5 changed to PT#: 105..
PT#: 4 changed to PT#: 104..
Number of entities changed: 3

Explode Carlson Points

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. Caution: After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:

1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if
you wish).
4. Exit the drawing without saving.

Prompts

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities!
The resulting points will NOT be useable by most Carlson Software commands!!!!
Select Carlson Software Points to Explode, select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed> 345

Pulldown Menu Location: Points
Keyboard Command: explode.scad
Prerequisite: Carlson points
File Name: \lsp\scexp.lsp

Convert Surveyor1 to CRD

This command will convert a Surveyor1 coordinate file to the current Carlson format.
Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: SURVEYOR2CRD
Prerequisite: A Surveyor1 coordinate file

Convert CRD to TDS CR5/Convert TDS CR5 to CRD

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.
Pulldown Menu Location: Points
Keyboard Commands: crd_cr5, cr5_crd
Prerequisite: A CRD or CR5 file
File Name: \lsp\cogoutil.arx

Convert CRD to Land Desktop MDB

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.
Pulldown Menu Location: Points > Convert Point Format  
Keyboard Command: crd, ldd  
Prerequisite: A .CRD file  
File Name: \lsp\gisutil.arx  

Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

Pulldown Menu Location: Points > Convert Point Format  
Keyboard Command: LDD, crd  
Prerequisite: An LDD point database file  
File Name: \lsp\gisutil.arx
Convert Civil 3D to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

Pulldown Menu Location: Points
Keyboard Command: ldd, crd
Prerequisite: An LDD point database file
File Name: \lsp\gisutil.arx

Convert Carlson Points to Land Desktop

Function

This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you'd like to convert.

Prompts

Convert all or selected points [All/<Selected>]? press Enter
Select Carlson Software Points to convert:
Select objects: pick first point for window selection method
Select objects: pick second point
Processing Carlson Software point...

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: pt, aec
Prerequisite: A Carlson CRD file

**Convert Softdesk to Carlson Points**

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command **Update CRD File from Drawing** in **Coordinate File Utilities**, this updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** 2surv

**Prerequisite:** Softdesk points

**File Name:** \lsp\2surv.lsp

**Convert Carlson Points to C&G**

This command converts a Carlson CRD file into a C&G Point file.

Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** crd2cg

**Prerequisite:** A Carlson CRD file

**Convert C&G to Carlson Points**

This command converts C&G Points into a Carlson CRD file.
Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** cg2crd

**Prerequisite:** A C&G point file

## Convert Carlson Points to Simplicity

**Function**

This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button. Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** crd_zak

**Prerequisite:** A Simplicity point file
Convert Simplicity to Carlson Points

This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** zak.crd  
**Prerequisite:** A Simplicity point file

Convert Leica to Carlson Points

This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv3  
**Prerequisite:** Leica points

Convert Geodimeter to Carlson Points

This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv4  
**Prerequisite:** Geodimeter points
Convert Carlson Points to Ashtech GIS

This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned off).

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2ashtech  
**Prerequisite:** Carlson Points

Convert Carlson Points to Softdesk

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2soft  
**Prerequisite:** Carlson points  
**File Name:** \lsp\2soft.lsp

Convert PacSoft CRD to Carlson CRD

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be displayed. Once both files have been specified, the following dialog box will be displayed.

The **No Coordinate Conversion** option converts the file format while leaving the coordinate values unchanged.  
**Convert From Meters to Feet** will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** pacsoft2crd  
**Prerequisite:** PacSoft crd file
Convert Carlson Points to Eagle Point

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.

Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** `2eds`

**Prerequisite:** Carlson points

Convert Eagle Point to Carlson Points

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read into the current CRD file by using the command `Update CRD File from Drawing`, found in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** `2surv2`

**Prerequisite:** Eagle Point points

**File Name:** `\lsp\2surv2.lsp`

Chapter 8. Points Menu 249
Shown here is the COGO menu of Carlson Field.
Draw-Locate Points

This command is described in the Points chapter of this manual. Go there for full details. Within Carlson Software, this important command is located in both the COGO menu and the Points menu, near or at the top.

Inverse

This command reports the bearing/azimuth and horizontal distance between two points. The command prompts for a series of points. Use the appropriate object snap mode to select the points from the screen, or use the point numbers to reference coordinates stored in the current coordinate (.CRD) file. The results are then displayed. This command is also used in conjunction with the Traverse and Sideshot commands to occupy and backsight two points. The last two points you Inverse to are the Backsight and the Occupied point for the Traverse and Sideshot commands. An attractive feature of Inverse is that you can enter T or SS within the command and go directly to Traverse or Sideshot. Even a single S will transmit to Sideshot. Hotkeys are not case sensitive. Press [Enter] at the point prompt to end the command.

You can also inverse around an arc by inversing to the PC, and then entering an A for Arc option. The program will ask for the radius point, the curve direction left or right and the PT point. The curve data is then reported. There is an unequal PC-Radius and PT-Radius distance check. The tolerance for this is set in the Area Label Defaults command.

There are several input options for Inverse that are set by entering O for Options on the command line. Sideshot inverse holds the current occupied point and calculates the bearing/distance to each entered point. The Pairs option reports the bearing/distance between pairs of points and not for every entered point. For example, if points 1,2,11,12 were entered, the bearing/distance would be reported for 1,2 and 11,12 but not 2,11. The Auto Increment option uses the next point number by just pressing Enter. To exit the routine with Auto Increment active, End must be entered.

There are also several angle output options that are set at the second prompt in Options. The angle can be reported as either Bearing, Azimuth, Gon or Angle Right. You can also specify to report angles with decimal seconds. There's a setting for the number of decimals for distances and a setting to report distances in feet and inches format. The Report Elevation Difference option will report the delta Z between the pairs of points. The Report Second Scaled Distance option will report a second distance value that is scaled from the first distance value using the scale factor defined in Drawing Setup. When the Second Scaled Distance option is on, there are settings for the suffix to use for both the first and second distance to help identify them separately in the report.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter.

Prompts

Calculate Bearing & Distance from starting point?
Traverse/SideShot/Options/Arc/Pick point or point number: pick a point
Traverse/SideShot/Options/Arc/Pick point or point number: 9

PtNo. Northing(Y) Easting(X) Elev(Z) Description
9 4909.25 4648.37 0.00

Bearing: N 81d8'54'' E Azimuth: 81d8'54''
Horizontal Distance: 261.17407461
**Occupy Point**

This command sets the occupied point and backsight angle for other COGO commands such as *Traverse*. For setting the occupied point, you have the option of picking a point on the screen, entering coordinates at the command line or typing in a point number that will be read from the current coordinate (.CRD) file. Four options are available for determining the backsight direction: Azimuth, Bearing, None and Point. For the default Point option, you may pick a point on the screen, input coordinates, or type a point number that will be read from the current coordinate file. For the Azimuth and Bearing option, you enter the backsight angle in the selected format. The None option sets the backsight to an azimuth of 0 (zero) or North. You can also set the occupied point by using the *Inverse* command. If you inverse from point 3 to point 1, you have set point 1 as the occupied point and point 3 as the backsight. For more information, see the *Inverse* command.

The current occupied point and backsight are shown in the lower right hand corner of the AutoCAD status bar just below the command line.

**Prompts**

**Set Occupied Point**

*Pick point or point number:* *pick a point* (5000 5000 0.0)

*Set backsight method* [Azimuth/Bearing/None/Point]? *press Enter*

**Set Backsight Point**
**Pick point or point number:** *pick a point (5184.76 5381.3 0.0)*

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location:** COGO
**Keyboard Commands:** occpoint, op
**Prerequisite:** None
**File Name:** \lsp\occupypnt.lsp

---

**Traverse**

This command allows the user to input any combination of turned angles, azimuths or bearings to define a traverse or figure. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. This command always occupies the last point it calculated and backsights the point before that.

Codes 1 through 4 define the bearing quadrants:
1 = Northeast
2 = Southeast
3 = Southwest
4 = Northwest

The remaining codes define as follows:
5 = a north based azimuth
6 = an angle turned to the left
7 = an angle turned to the right
8 = a deflection angle left
9 = a deflection angle right

For both the Angle-Bearing Code and the Distance prompt, the user can enter point-defined responses: two points separated by an asterisk, as in 2*3 for the bearing (or distance) defined by 2 to 3. You can also add math expressions. For angles, 2*3+90 would deflect 90 degrees right from 2 to 3. For distance, 2*3/2 would mean half the distance of 2 to 3. You do not need to enter N before entering a number-defined distance. Just bring up the number inverse prompt.

The command draws lines between located points (if the Line On/Off in the COGO menu is set to on) and plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. The point settings are defined in the *Point Defaults* command. If Point Protect is turned on, *Traverse* checks if the point numbers are already stored in the file. Point Protect is set in the *Coordinate File Utilities* command.

There are Angle-Bearing code input options for *Traverse* that are set by entering O for Options. The Angle Right option prompts for the angle right and skips the angle-bearing code prompt. The Azimuth option prompts for the azimuth and skips the angle-bearing code prompt.

---

**Prompts**

**Occupied Point ?**
**Pick point or point number:** *pick a point*
You will only be prompted for the occupied point the first time you use the command.
Use the *Inverse* command to set the occupied and backsight points.
**Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <=: o**
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? p

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter Pressing Enter uses the default angle right code.

Enter Angle (dd.mmss) <90.0000>: 88.1324 You can also enter L or R to define an angle 90 degrees Left or Right.

Backsight Point?
Pick point or point number: pick a point
Number inverse/<Distance>: 100

Select Coordinate (.CRD) File This dialog only appears if there is not a current coordinate (.CRD) file.
Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: 14*9-45.2045 Uses the bearing defined by point numbers 14 & 9 and subtracts the angle 45 degrees, 20 minutes, and 45 seconds. You can use a + or - in this type of entry.

Number inverse/<Distance>: N (note: you can enter 14*9/2 here, as well)
Point number inverse (i.e. 10*20): 14*9/2 This causes the command to recall the distance from point number 14 to 9 and divide it by 2.

Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: L
Select Line or Polyline that defines Bearing: select line that defines bearing
Number inverse/<Distance>: 100

Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: E Enter E to end the command. Enter S or SS to execute the Side Shots command or I to execute the Inverse command.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: T, Traverse
Prerequisite: None
File Name: \lsp\trav.lsp

Side Shots

This command allows the user to input any combination of turned angles, azimuths or bearings while remaining on an occupied point. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. Codes 1 through 4 define the bearing quadrants; 1 being North-East, 2 South-East, 3 South-West, and 4 North-West. Code 5 is a north-based azimuth, 6 an angle turned to the left, 7 an angled turned to the right, 8 a deflection angle left and 9 a deflection angle right. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already...
stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.

**Prompts**

**Occupied Point ?**
**Pick point or point number:** screen pick a point or enter a point number
**Exit/Options/Traverse/Inverse/Enter Azimuth (ddd.mmss) <A>:** O for options
**Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]?** P for prompt
**Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>:** 6 Code 6 for angle turned to left.
**Pick point or point number:** pick a point
**Enter Angle (dd.mmss) <6>:** 22.3524 Angle of 22 degrees, 35 minutes, 24 seconds.
**Points/<Distance>:** 120.91
**Enter Vertical Angle (dd.mmss) <0.0000>:** 88.2548

These prompts only come up if you have Instrument and Rod height prompting turned on.

**Instrument Height <5.000>:** 5.12
**Rod-Target Height <5.120>:** press Enter
**Enter Point Description <>:** Topo Shot
**Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <6> E**

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location:** COGO
**Keyboard Commands:** sideshot, ss
**Prerequisite:** None
**File Name:** \lsp\sideshot.lsp

**Enter-Assign Point**

This command creates a point at the user-entered coordinates. The point is both stored to the current coordinate (.CRD) file and drawn on the screen. The program will prompt for the northing and easting. This routine will prompt for point number, elevation and description, depending on the settings in the Point Defaults command. Point Defaults also allows you to set the point symbol and layer. Point Defaults is found under the Points pulldown.

**Prompts**

**Enter North(y):** 5000
**Enter East(x):** 5000
**Select/<Enter Point Elevation <0.00>:** Enter 100 for elevation, or press S and enter to select text to set elevation.
**Enter Point Description <>:** START
**N: 5000.00 E: 5000.00 Z: 0.00**
**Enter North(y):** press Enter to end

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.
Raw File On/Off

This menu selection toggles raw file (.RW5) creation. When this option is active, commands such as Traverse create entries in the current raw data (.RW5) file. If Raw File is turned on, the pulldown menu option will have a check mark character in the menu. A dialog will appear, allowing you to create a New, Append an existing, or Close the .RW5 file.

To begin this routine, select the COGO pulldown and observe the Raw File (On or Off) toggle for check. Click the command and the dialog appears.

New: Allows you to create a new raw traverse file (.RW5).
Append: Allows you to append an existing raw traverse file.

Pulldown Menu Location: COGO
Keyboard Command: openraw
Prerequisite: None
File Name: \lsp\openraw.lsp

Pick Intersection Points

This command locates points at screen picked intersections. The AutoCAD object snap mode is set to intersection. This routine is similar to the Locate Point command, with an additional check that makes sure there is an intersection at the picked point. If there is not an intersection at the picked point, then no point is created.
Prompts

Pick Intersections Points dialog
APParent intersection on [<Yes>/<No]>: Y
This first prompt is very important. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space, but may appear to intersect in the current view. This allows you to locate a point at the theoretical intersection of two 3D entities. You should answer No to this prompt if you want to ignore theoretical 3D intersections.
[app on] Pick intersection Point: pick a point
[app on] Pick intersection Point: press Enter to end
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: pickint
Prerequisite: Intersection of two entities
File Name: \lsp\pickint.lsp

Bearing-Distance Intersect

The Bearing-Distance Intersect command prompts the user for a base point from which the known bearing intersects. It then defines the bearing by one of three methods. The bearing can be defined by picking two points, selecting a line with the same bearing or by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for a base point from which the known distance radiates. After entering the known distance a circle is drawn radiating from the selected base point, and a line defined by the bearing is extended to intersect the circle. The user then picks the correct point for the solution desired and a point symbol is located at the selected intersection. The command then erases the temporary circle and line. The Options choice allows you to be prompted for angle method or for offsets, or both.

Prompts

[Enter] to use preview point or select known Bearing base point
Options/Pick point or point number: pick point
Define 1st bearing by (Line/Points/Azimuth/Bearing)<Bearing>: l
Select Line or Polyline that Defines Bearing: pick entity
Enter 1st Offset Distance <0.0>: press Enter
Known distance base point.
Pick point or point number: pick point
Points/<Enter Distance>: 40.41
Enter 2nd Offset Distance <0.0>: press Enter
[int on] Pick Intersection point ([Enter] to cancel): pick point
Enter Point Number <55>: press Enter This prompt appears only if Automatic Point Numbering is turned off.
See Point Defaults
Enter Point Symbol Number <4>: press Enter This prompt appears only if point symbol prompting is turned on. Symbol number 4 is located at the computed coordinate and labeled point number 55.

Pick correct solution

When Options (O) is selected

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bdint
Prerequisite: None
File Name: \lsp\bdint.lsp

**Bearing-Bearing Intersect**

This command locates a point at the intersection of two lines. The lines can be defined by picking two points, selecting a line or typing in a bearing. After the lines are defined a point symbol is located at the point of intersection.

**Prompts**
Distance-Distance Intersect

This command creates a point at the distance-distance intersection from two base points. The program prompts for two distances and two base points. The two possible intersections (A,B) are shown on the screen. You can either pick near the desired intersection or type in the letter A or B. The A intersection is clockwise from the first point. The Options choice brings up a small dialog that allows you to be prompted for angle method or for offsets, or both.

Prompts
Select 1st base point
Options/<Pick point or point number>: 1
Points/<1st distance>: 46.72
Enter 1st Offset Distance <0.0>
Select 2nd base point
Pick point or point number: 2
Points/<2nd distance>: 38.96
Enter 2nd Offset Distance <0.0>: press Enter
Pick near solution or Enter [A] or [B]: pick a point

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: DD
Prerequisite: None
File Name: \lsp\ddint.lsp

Divide Between Points

This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

Prompts

Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1
Point No. Northing (Y) Easting (X) Elev (Z) Description
1 4252.76 4158.32 0.00

Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: press Enter
The command then locates two points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divlin
Prerequisite: 2 points
File Name: \lsp\divlin.lsp

Divide Along Entity
This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

Prompts

Interpolate Elevations [Yes/<No>]: press Enter
Select Entity to Divide: pick point on entity
Number of Divisions/Segments: 15
The command then locates 14 points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations
File Name: \lsp\divent.lsp

Interval Along Entity
This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example,
you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. When Create Point at Endpoint is checked, points will also be located at the endpoints of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

For improved descriptions on the points, there is an option, in this main dialog, allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that allows you to set the same description to all of the points. For more options related to points, see *Point Defaults* under the Points pulldown.

![Interval Along Entity](image)

Create Points at Endpoints turned on

**Prompts**
Select entity near endpoint which defines first station.
[nea on] Select Entity to Interpolate Points: select entity
[nea on] Select Entity to Interpolate Points: Locating 13 Points
The command locates points along the selected entity.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptint
Prerequisite: An entity
File Name: \lsp\ptatint.lsp

Tape Baseline

This command creates points or linework along a baseline that is defined by two points. After specifying the baseline start and end points by either entering point numbers from the coordinate file or screen picking points, the program has a dialog with different methods for creating the points. The Tape method creates points at the specified chainage (distance) and offset from the baseline. reports the cut or fill between your current position and a design surface. The design surface can be one flat elevation, a grid file, a triangulation file, a road design file, or a section file. The Rectangle method draws a rectangle as a closed polyline using two points specified by chainage and offset from the baseline. The Square method draws a square as a closed polyline with a starting point at a baseline endpoint and the other corner specified by a distance along the baseline. The Divide method creates points at an interval between the baseline endpoints.

Pulldown Menu Location: COGO
Prerequisite: None
Keyboard Command: tape_bline
File Name: \lsp\gpsutil.arx

Chapter 9. COGO Menu
Create Points from Entities

This command will create Carlson Survey points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the **Prompt for Elevations** toggle and select the **Locate on Real Z Axis** toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the **Description Settings**, **Prompt for Description At Each Point** will prompt you at the command line for a description for each individual point. **Prompt Per Entity** will ask you for a description per each highlighted entity. **Use Entity Layer for Description** will assign the layer name to the description. **Same Description For All Points** will prompt you for a single description for all points.

The second options dialog has processing settings. When **Entity Layer for Description** is checked, the layer name of the entity will be used as the description for the created point. When **Avoid Duplicates with Existing Pts** is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.

### Prompts

**Create Points From Entities Dialogs** Choose settings

Select arcs, faces, points, text, lines and polylines.

Select objects: *pick entities*
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pulldown Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities

---

**SurvCE/SurvStar Data Transfer**

Before starting this routine, the SurvStar or Dozer 2000 program should be in file transfer mode. In SurvStar, go to File Utilities and choose File Transfer. In Dozer 2000, go to Transfer and choose Transfer with Computer.

When selecting the routine for the first time the Options dialog will appear. From this first popup window, make sure that all of your communication and transfer settings are correct. Especially check that your COM Port is set correctly, as this is the most critical and most often incorrect setting. If you plan to transfer large files, you may wish to increase the baud rate setting for faster transfer. SurvStar will automatically adjust on the data collector end and reconnect at the new baud rate. Be sure to click **Save Options** before going on so that all settings are
remembered the next time and you can bypass this options screen. Also, keep in mind that you can always bring this window back and modify your settings later by clicking the Options button from the File Transfer Utility screen.

The main screen displays files from your local PC directory on the left and files from your data collector on the right. If you wish to change the directory of either system, click the Set Path button. Select Local PC or Remote, then type in the path name of the desired directory. Click OK. You may also choose to make a new directory or delete an existing directory from either computer by using the Make Directory and Remove Directory buttons. Click on the file you wish to transfer and you will see it highlighted in the screen. You may select multiple files at once by holding the Ctrl key and clicking on additional file names. Once you have highlighted your files, simply click the Transfer button to copy them from one machine to the other. Once the transfer is complete, the Transfer Complete message will appear. If you do not get this message, the transfer was not successful. Check all your cables, COM Port settings and available Disk Space (displayed on the File Transfer Utility screen).

You may also choose to Delete highlighted files. To avoid accidental deletion of files, ensure that the Confirm Delete prompt is set to YES. Finally, when you have finished your file transfer session, click Quit to return to Carlson.
Edit-Process Raw Data File

This program reads or creates a raw data (.RW5) file that contains various lines of data (records) that could be likened to a surveyor's field book. You can specify point coordinates, job information, notes, and the angles and distances that make up traverse or sideshots records. Once the raw data is created or read it can be processed/reduced to coordinates that are stored in the current coordinate (.crd; .cgc; .mdb; .zak) file.

The raw file can also be created or appended using the Locate Point, Traverse, Sideshot, and Inverse commands on the COGO menu. To store the data inputs from these commands into a raw file, first toggle on the Raw File ON/OFF command on the COGO menu. It is possible to always have the raw data file open to store data inputs. To enable this option, choose Configure from the Settings menu, then choose Survey Module, then choose General Settings. Turn on the Automatic Raw File toggle in this dialog.

The raw files created by TDS data collector programs are also compatible without conversion. The command Data Collectors on the Tools menu has options for reading other data collectors native file formats and converting them to raw data (.RW5) format. Within the raw data editor, the File menu includes an import menu for converting raw data from other formats.

When you select the Edit-Process Raw Data File command you are prompted to specify the name of the raw data (.RW5) file. The current coordinate file is used automatically. To change the current coordinate file, use the Set Coordinate File command in the Points menu before starting this command. If no coordinate file is current, the program will prompt you to set the current coordinate (.CRD) file.

Edit-Process Raw Data File uses a spreadsheet for editing the raw data as shown. Each row of the spreadsheet is represented by a number located at the far left side of the editor. Various messages and reports often reference possible problems with the data by this row number. Each row of the spreadsheet represents one record of data. There are 14 types of data records. The type of data record is shown in the first column. Different record types use different numbers of columns. Whenever the data record type changes between rows, a record header is added to the spreadsheet that describes each column of data in the following row. To edit the raw data, simply highlight the cell and type in the new value. To change the type of record, pick on the down arrow in the first column and choose a new data type from the list. To delete a row, highlight any cell in the row and hit the Delete key or choose Delete Row from the Edit menu. Records can be added pressing the Insert key, pressing the down arrow key from the last line in the spreadsheet, or by choosing one of the add records from the Add menu.
The different record types are described below.

**TR (Traverse)**
The traverse record contains the occupied point number, foresight point number, angle mode, horizontal angle, distance, vertical angle and description. When processed, this record will calculate and store the coordinates for the foresight point. Traversing also moves the setup by making the traverse foresight point the next occupied point and the traverse occupied point becomes the next backsight point. The different angle codes are NE for northeast bearing, SE for southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle right, DL for deflection angle left and DR for deflection angle right. To set the angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical angles should be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes and 5 seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90 degrees level) or elevation difference. The vertical angle mode is set in the Display menu. The distance mode is also set in the Display menu as either slope or horizontal distance. The description field is used as the foresight point description.

**SS (SideShot)**
The sideshot record is the same as the traverse record except that sideshot does not move the setup.

**HI (Instrument and Rod Height)**
This record sets the instrument and rod heights used in elevation calculations. This record should precede any traverse and sideshot records that you want the heights applied to.

**BK (BackSight)**
The backsight record contains the occupied point number, backsight point number, backsight azimuth and the set azimuth. This record should precede any traverse and sideshot records that use this setup. If no backsight point is entered, the program uses the backsight azimuth to turn angles from. The Set Azimuth is the circle reading of the instrument when sighting the backsight. A Set Azimuth of zero is the default.

**PT (Store Point)**
The store point record consists of a point number, northing, easting, elevation and description. When processing,
this data will be stored as a point in the coordinate file. If the first Occupied point and/or the initial Backsight point are not defined in the coordinate file set for processing to, both points will need to be added to the rw5 file as PT (Store Point) records.

**DS (Description)**
The description record is an additional note that appears in the spreadsheet editor and printouts. This record can contain various information that is recorded in data collectors during field operations. This data can vary from user, temperature and general data to each line of data associated with "Set Collection". When "Sets" of data collected using various brands of data collection software is converted/imported into the raw editor, the actual measurements made during the spinning of the angles and distances are recorded as DS records and the mean value of the angle and distance is recorded as a SS record. DS records are not used in processing.

**CL (Closing Shot)**
The closing shot record is the traverse record where the foresight point is the closing point for the traverse. This record is used by the adjustment commands in the Process menu. There should be only one CL record in each Traverse loop (Name Record) in the raw file. If there is no CL record, the process adjustment routines will prompt for which shot is the closing shot. The closing shot can also be define in the field by using special codes defined in the Open Settings found under the File pulldown within the editor. Please refer to the "Open Settings" documentation below for more information on these codes.

**AB (Angle Balance)**
The Angle Balance record is the measurement data observed that closes the angles of the traverse. Typically this record is the measurement data recorded from the closing shot to the initial backsight point. The backsight could be either external or internal to the traverse. Angle Balance routine in the Process menu uses this record and compares the angle between the occupied point and foresight point of this record with a user-specified reference angle. There should be only one AB record in the raw file. If there is no AB record, then the Angle Balance routine will prompt for which shot to use as the angle balance.

**CL + AB (Closing Shot and Angle Balance)**
This record is used as both the closing shot and angle balance records.

**FD (Foresight Direct)**
The foresight direct is a traverse record used in a direct and reverse set. When the program finds one of the direct-reverse measurement records, it will look for the other three records to complete the set.

**FR (Foresight Reverse)**
The foresight reverse is a traverse record used in a direct and reverse set.

**BD (Backsight Direct)**
The backsight direct is a traverse record used in a direct and reverse set.

**BR (Backsight Reverse)**
The backsight reverse is a traverse record used in a direct and reverse set.

**EL (Elevation Only)**
This record sets the elevation in the CRD file for the specified point number. Often used when an existing point with good vertical control is being traversed through. Using this record type for the point would keep the elevation from changing on the existing point regardless of the measurement data.

**AZ (Azimuth Only)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**CSE (Control Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**SSE (Set-up Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**MSE (Measurement Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**NAME (Traverse Name)**
This record acts as an identifier for the group of records that make up a traverse. All the records after the NAME record belong to that traverse up to the next NAME record or the end of the file. This record allows you to have multiple traverses in one raw file. When running one of the Process commands, the program will bring up a list of all the traverse names. Simply choose which traverse to process. If you have only one traverse in the raw file, then you don't need the NAME record.

**GPS**
This record contains the Latitude and Longitude of a point as measured by GPS surveying equipment using Carlson SurvCE data collection software. This record has additional information tied to it such as localization files, geoid files, coordinate projection systems etc. This record has its own processing routine in the Process pulldown within the editor. Processing procedures are discussed in the Process (Compute Pts) pulldown documentation.

**Raw Data Editor Pulldown Menus**

**File Menu**

![File Menu screenshot]

**Open RW5 File**
This command prompts for a rw5 file to load into the editor.

**New RW5 File**
This command clears the editor spreadsheet.
**Save RW5 File**
This saves the rw5 file. If the file hasn't been named you will be prompted for the file name and the location to save the file. After you perform the first save, this command acts as a quick save and saves the file to the name and location specified during the initial saving of the file.

**Save RW5 As**
This command saves the raw editor data in the spreadsheet to a rw5 file and always prompts for file name and location to save.

**Open CRD File**
This command prompts for an existing coordinate file to set as the active coordinate file for the raw editor.

**New CRD File**
This command prompts for a new coordinate file to set as the active coordinate file for the raw editor. The coordinate data will be initialized as empty.

**Save CRD File**
This command saves the current coordinate data in the raw editor to the current coordinate file.

**Save CRD As**
This command saves the current coordinate data to a specified coordinate file name.

**Report/Print**
There are three types of reports: Raw Data, Coordinates and Summary. A sample of the raw data report is shown below. This report shows the data from the raw editor spreadsheet. The Coordinates report lists the point data (point number, northing, easting, elevation, description) from the current coordinate file. The summary report groups the traverse, sideshot and store point numbers along with a list of the setups and the shots from each setup.

---

Raw File> c:\data\survey.rw5
CRD File> c:\data\survey.crd

Note
Survey Example
PntNo Northing Easting Elevation Desc
1 5000 5000 100 START
OcPt BsPt SetAzi
1
InstHgt RodHgt
5.32 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 1 2 AR 268.5330 711.420 89.4050 P2
InstHgt RodHgt
5.43 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 2 3 AR 262.5448 457.760 89.3236 P3
InstHgt RodHgt
5.4 6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 3 4 AR 208.5710 201.310 89.1803 P4
TR 4 5 AR 247.1657 497.120 88.5235 P5
TR 5 6 AR 277.4835 223.980 90.2926 P6
TR 6 7 AR 261.2756 387.250 91.4405 CLOSE

---

Chapter 9. COGO Menu 271
Report/Print Settings
This dialog has settings for the report functions.

Import
These routines convert raw data from other formats into the current Carlson RW5 format. The converted raw data will be added to the end of any existing data in the editor. In many cases, the raw data file to import can be downloaded directly from the data collector or instrument using the Data Collectors command. The following supported formats (along with their standard file extension) are listed here. Some Sample File Formats are listed at the end of this section.

C&G (.CGR;.RAW;.TXT;*)
CalTrans (.DMP)
Carlson (.RW5)
Fieldbook (.FBK): From Softdesk, Land Development Desktop or Civil 3D.
Geodimeter (.OBS; .RAW; job;*)
LandXML (.XML)
Leica (.GSI; .RAW; GRE): This reads the Leica raw file in Wildsoft, Liscad, 10-20-30-40, C&G, or GeoComp format. There are options to specify direct-reverse shot order if any and to convert from International Feet to Leica US Feet.
Maptech (.FLD)
MDL Laser (.CDS)
Nikon (.TRN; .RAW)
PC Cogo (.BAT)
SDMS (.prj;*)
SMI (.RAW)
Sokkia SDR (.SDR; .RAW;*)
SurvCOGO (.RAW or .TXT)
SurvCE Archive (.SC5) When downloading a rw5 file from SurvCE using SurvCOM, there's an option to copy the rw5 file to a sc5 file as a read-only backup.
Survis (.RAW)
TDS (.RW5; RAW)
Topcon (raw;*)
Trimble (.dc)
3TA5 (.TXT)
Zeiss (.DAT)

Export

These routines convert the Carlson raw data (.RW5) file to other formats. The following file formats are supported.

CalTrans (DMP)
Fieldbook (.FBK): This export routine provides an option to "Setup Fieldbook Codes". This allows the user to substitute the raw description contained in the rw5 file with the fieldbook code used in AutoDesk Land Desktop or Civil 3D.
This export routine provides an option to "Setup SDMS Codes". This allows the user to substitute the raw description contained in the rw5 file with the SDMS codes used in SDMS program.

Sokkia (.SDR)
TDS (RW5;RAW)
VA Dot (TOP)

Open/Save Settings
This option allows for defining codes that represent the closing shot and angle balance shot of a traverse. These codes can be entered in the description of a point while in the field. When the rw5 is opened in the raw file
editor, the measurement data containing the closing shot code will be set to a CL record and the measurement data containing the angle balance code will be set to an AB record. This allows for quick processing of the survey data and saves the time spent setting up the file for processing.

**Exit**

Exits the raw file editor.

**Edit Menu**

**Undo**: This command undoes the last data entry or the last copy, cut or delete command performed on keyboard entered data only. This will not undo a change to the Type or Code columns, nor a cut or copy command to a row.

**Cut**: Standard windows cut command. Removes data from editor and places it in the windows clipboard.

**Copy**: Standard windows copy command. Copies selected data to windows clipboard.

**Delete**: Deletes selected data or row of data. Will not delete headers if data is present below the header.
**Find:** Tool to search and find a particular word, letter, numeric value or a combination of all. Provides options to Match whole word only and/or case. Allows for a up or down directional search from the active cell in the editor.

![Find dialog box](image)

**Replace:** Tool to search and replace a particular word, letter, numeric value or a combination of all. Options to Match whole word only and/or case is provided for the search criteria. Provides further options to Replace individual items one at a time or to Replace All.

![Replace dialog box](image)

**Go To:** Tool to advance the focus of the active cell to a specified line number.

![Go To dialog box](image)

**Delete Row:** This command deletes the row containing the active cursor or cell. You can delete a row by placing the cursor in any of the cells in the row that you wish to delete, or by picking on the row number at the far left of the editor.

**Modify Measurements:** This option allows for a change in distance, horizontal angle or vertical angle by a specified
amount for the entire file or for a specified point number or line number range. To modify a measurement, choose which field to modify, enter the change in either distance or angle in dd.mmss format. Next choose how to apply the modification. If all is selected, the change will be applied to all records in the specified field. If By Point Number is chosen, enter the point number or range of numbers in the Range of Points field. If by Line Number is chosen, then define the area for the change by specifying the Starting and Ending line.

**Convert Points To Notes Records:** This function converts point (PT) records to note (DS) records. This leaves the information of the point coordinates in the rw5 file as display only and without having the point coordinates stored to the coordinate file when the file is processed. The point data in the DS records can be converted back to PT records by picking the Code field in the spreadsheet and switching DS to PT.

**Edit Coordinate File:** This option allows for editing and/or listing of the coordinate data in the active coordinate file. The active coordinate file is displayed in the Header of the raw data editor. This routine brings up the edit point dialog and allows editing of the points one at a time.
Display Menu

**Angles:** This option chooses the angle format between degrees/minutes/seconds (dd.mmss) and Gons-400 decimal degree circle (dd.dddd). This setting applies to the angles in the spreadsheet editor as well as the angle format for reports.

**Vertical:** The options contained in this menu allow for specifying the type of vertical measurement information you will input or is contained in the rw5 file. The Vertical Angle selection assumes the barrel or scope of the instrument is level when reading 0 (zero). With this setting, the vertical component of a measurement record will have a header of VertAng. The Zenith Angle selection, most commonly used, assumes the barrel/scope to be level when reading 90. Using this setting results in a header of ZenithAng. Elevation difference displays the elevation difference between the occupied and foresight points. If the Distance option is specified as Slope, this elevation difference will be used.
to calculate the horizontal distance of the measurement. The header for this record is ElevDiff. The None selection assumes all distances are horizontal distances and removes the vertical component for a measurement from the editor. Switching modes can be performed at any time.

<table>
<thead>
<tr>
<th>Vertical</th>
<th>Vertical Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔ Zenith Angle</td>
</tr>
<tr>
<td></td>
<td>Elev Difference</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

**Distance:** This option controls the display of either Slope or Horizontal Distances. Changing the display results in the distance data adjusting to reflect the correct value for the selection made. The Vertical data, VertAng, ZenithAng or VertDiff, is used to convert the distance value when changing this display option.

<table>
<thead>
<tr>
<th>Distance</th>
<th>✔ Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horizontal</td>
</tr>
</tbody>
</table>

**Graphics:** The Raw Data Editor uses an optional graphics window to display the points and traverse lines in real time. As data is entered or edited, the graphics window will be updated to show the configuration or new configuration of the traverse. The option of whether to show sideshots is also available. When a cell is selected, the traverse or sideshot line in the display window will change to the color yellow for a graphical reference. The graphics window is toggled on or off from the Display — Graphics Window menu inside the raw file editor.

**Graphics>>On:** Turns the graphics window on.

**Graphics>>Off:** Turns the graphics window off.

**Graphics>>Show Sideshots:** Controls the display of the sideshot data in the graphics window. Figure 1 shows the graphics window with sideshots on. Figure 1A shows the graphics window with sideshots off.
Graphics>Zoom Mode: Within the graphics window, real time zoom is available. To zoom in press and hold the left mouse button and drag in the direction of the + symbol. To zoom out, press and hold the left button and drag in the direction of the - symbol.
**Graphics > Pan Mode:** Real time pan is available within the graphics window. To pan, set the graphics window to pan mode, then press and hold the left mouse button and then drag to desired position.

**Graphics > Resize Text:** With this option on the text becomes smaller/larger in the view when you zoom in/out.

**Graphics > Fixed Text Size:** With this option on, the text stays a fixed size while zooming in and out.

**Spreadsheet Colors:** This option allows for the assignment of colors to record types. To change/define the color for a particular record, select Spreadsheet Colors from the Display pulldown within the raw editor. From the Color Settings dialog select the record to edit by clicking on the select button next to the desired record.

The color slide beside the select button shows the current setting for the record. After selecting the record, the Select Color dialog box will be display. Select the Set button next to the desired color for the record.
Display>Hide Row: This option allows for hiding single or multiple rows. This could be used to prevent crucial information from being accidentally altered during editing of data or data entry. Hiding a record does not exclude it from processing. To hide a record click on the row number at the far left of the editor. The entire row of data will highlight, now select the Hide Row option. Multiple rows or data can be selected by selecting the first row of data to hide then while holding down the shift key on the keyboard, select the last row to hide. All rows in between these two selections will be highlighted, now select Hide Row. When a row or rows of data are hidden, the row numbers will reflect the hidden rows. For example, Figure 2 below shows a multiple selection of rows 10-17 to hide. Figure 2A shows the editor with the rows hidden. Notice that the row numbers indicate hidden rows by showing a gap from rows 9-18.

![Figure 2](image-url)

Chapter 9. COGO Menu
Show Row: This option shows rows that have been hidden. To show hidden rows, the row above the first hidden row and the row below the last hidden row must be selected by using the shift key selection method described in Hide Row above. After selecting the appropriate rows, select the Show Row option. Figure 2B shows the selection of rows 9 & 18 in order to show the hidden rows 10-17. Figure 2C shows the editor after the Show Row option has been selected.
Figure 2C

**Hide Description Records:** This option controls the visibility of the Description records contained in a rw5 file. The description record is an additional note used to store useful information in addition to typical point data. Sometimes these records clutter the raw file and make it hard to review actual survey data. The ability to control the description record visibility is a useful tool when reviewing survey data.

**Show Description Records:** This option shows (unhides) description records contained in the rw5 file.

**Hide Record Headers:** This option hides the in-line headers such as the PntNo, OcPt, FsPt, etc. The editor contains "Smart Headers" that changes with the type of data that is in the active row. These headers are not in-line and are always displayed at the top of the editor. Figure 2D shows the editor with the record headers hidden and the Smart Header active. Row #21 contains the active cell, the automatic header at the top of the editor shows traverse (TR) record headers.
Add Menu

**Traverse:** Adds a traverse record (TR) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**SideShot:** Adds a sideshot record (SS) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Backsight:** Adds a backsight (BK) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.
the current row.

**Instrument Height:** Adds an instrument height (HI) record to the editor. This record contains both the instrument and rod height setting.

**Point:** Adds a point (PT) record to the editor. Provides options to either add a Blank Point Record or Import From Coordinate File.

Inserting a blank record allows for manual input to define the coordinates for the point. Import From Coordinate File imports the coordinate values from an existing point or range of points contained in the coordinate file. Enter the point number or range of points and select OK. The points will be read into the rw5 file at the top of the file.

**COGO Command:** Adds COGO Command (CC) record with a field to specify the command (Translate, Rotate, Scale or Align) and a field for entering the parameters. The COGO commands are executed in sequence as the rw5 file is processed from top to bottom by any of the process methods in the Process menu. The COGO commands are all transformation commands that are applied to the points in the current coordinate file. The following list is the syntax of the COGO commands:

- **Translate:** Range Dx Dy Dz Process_Zero_Z
- **Rotate:** Range Angle Base_Y Base_X
- **Scale:** Range Scale Base_Y Base_X Use_Z
- **Align:** Range From1 To1 From2 To2

All the parameters are entered into one spreadsheet cell next to the COGO function. The parameters use space separators. The following list is the parameter definitions:

- **Range:** point numbers
- **Dx:** delta easting (X)
- **Dy:** delta northing (Y)
- **Dz:** delta elevation (Z)
- **Process_Zero_Z:** toggle for whether to process points with elevation of zero (0=No, 1=Yes)
- **Angle:** rotation angle in dd.mmss format
- **Base_Y:** base point northing
- **Base_X:** base point easting
- **Scale:** scale factor
- **Use_Z:** toggle for whether to scale the elevations (0=No, 1=Yes)
- **From1:** point number of first source point
To1: point number of first destination point
From2: point number of second source point
To2: point number of second destination point

For example, to translate points 1-10 by a delta Z of 6.0 while filtering out zero elevation points, set the parameters for the COGO Translate record as "1-10 0 0 6.0 0".

_Elevation_: Adds an elevation (EL) record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

_Note_: Adds a note (DS) record to the editor. Note records are for information display and do not effect processing except for two special notes which are:
- Elevation: 2D
- Elevation: 3D

These special notes set the elevation mode for processing for the records that follow the note. The raw editor starts in 3D mode. The "Elevation: 2D" note will switch processing to 2D mode and the "Elevation: 3D" note will switch the mode back to 3D. In 2D mode, the processing will not set the elevations in the coordinate file.

_Data On/Off_: Adds a data on/off (DO) record to the editor. This record toggles the raw data between processing on and off modes. The raw data starts in processing on mode. Working from top to down, when a DO record is reached, the processing mode is turned off. Then next DO record will turn processing back on, and so on. Data records that are in processing off mode and skipped when running the routines in the Process menu.

_Traverse Name_: Adds a traverse name (Name) to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

_GPS_: Adds a GPS record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

_Reference Azimuth_: Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

_Control Standard Error_: Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

_Setup Standard Error_: Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

_Measurement Standard Error_: Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

_Process (Compute Pts) Menu_
This menu contains tools to process raw data by various methods. The calculated coordinates, and notes if specified, are stored to the active specified coordinate file. The coordinate file can be specified using Set Coordinate File, under the Points pulldown within the drawing screen, or from the Tools menu of the editor, discussed later in this section. The options for processing are specified within either the Process Options dialog box or the Closure Options dialog box, depending upon . This dialog box is displayed before processing data, using any of the available methods, with the exception being the Least Squares method.
Multiple Measurements To Same Point: This option sets the method of how to handle multiple measurements to the same point. There are three available options, Use Last, Average or Use First. Use last uses the last measurement to calculate the position of the point. Average uses the average of all the measurements for the position calculation and Use Last takes the last measurement to the point as the data to use.

Use Backsight Reciprocals: The Backsight Reciprocal options treat reciprocal measurements "special". A foresight to point 15 from a setup on 14, followed by a backsight from 15 to 14, makes a pair of "reciprocal" measurements. The backsight "reciprocal" measurement can be ignored for its impact on recalculating the occupied point (None Option), or the elevation of component of the reciprocal measurements can be averaged (Average Elevation option), or both the elevation and distance can be averaged (Average Elev & Dist) to recalculate the setup (occupied point) coordinates.

Calculate Elevations: This option determines whether the elevations of the points will be calculated and written to the coordinate file. Options of whether to calculate All elevations or just the Sideshots Only are provided.
Direct-Reverse Vertical Angles: Specify whether to balance all or process the direct-reverse shots and use only the foresight direct shot.

Report Angle Format: Specifies the angle format for the report. The By File option makes the report use the angle format in the raw data (.RW5) file.

Calculate Elevations: This option controls which point elevations will be calculated. For example, if the traverse point elevations have already been adjusted and you need to recalculate the sideshot elevations, then use the SideShots Only option.

Report SideShots: Specify whether to include the sideshot data in the process results report.

Point Protect: This option will check the coordinate (.CRD) file for existing point data before processing. If the foresight point number for any traverse or sideshot record already is a stored coordinate in the coordinate (.CRD) file, then the program shows a list of conflicting point numbers. You can either continue processing and overwrite the coordinate (.CRD) file coordinates with the calculated raw file coordinates or cancel the processing to go back to the editor to change foresight numbers.

A report of the conflicting point numbers can be generated to the standard report viewer in Carlson by selecting the Report option on the Point Protect dialog box. From the report viewer, the report can then be printed, sent to the screen or saved to a file.
Create Point Notes: This option will generate a note (.NOT) file named after the coordinate file. The note file contains additional descriptions for points. With this option active, the text from all note records (DS records) will be stored in the note file for the foresight point number preceding the note records.

Calculate Grid Scale Factor at Each Setup: This option will calculate a scale factor for each TR and SS record. This scale factor is calculated as the average of the scale factors at the occupied and foresights points. At these points the scale factor is calculated as the projection grid factor multiplied by the elevation factor which is the earth radius divided by the elevation plus the earth radius \[ SF = \text{Grid Factor} \times \left( \frac{\text{Earth Radius}}{\text{Elevation} + \text{Earth Radius}} \right) \]. In order to calculate these projection grid factors, the traverse coordinates must be in grid coordinates. When this option is selected, the program will prompt for the projection and zone to use. The elevation for the scale factor can be adjusted by the geoid height using the geoid specified in the Geoid To Apply list. The geoid height is added to the point elevation to adjust the elevation value used in the scale factor equation. The geoid surface files are not installed by default due to the large size of these files. To install the geoids to use with this option, go to the Carlson Software webpage and download the Geoid Grid Files from the Support Downloads section.

Report Each State Plane Scale: This option becomes available if the Calculate State Plane Factor at Each Setup has been selected. With this option on, the scale factor at each point will be shown in the process results report.

Scale Factor: This value is multiplied by the slope distance for the traverse and sideshot records.

Correct for Earth Curvature: This option adjusts the calculated points for the effect of the Earth's curvature. Typically this adjustment is small and adjusts the elevation more than the horizontal.

Report Angle Format: This option controls the angle format displayed on the process result report. The option of By Raw File will display the angles in the format that is contained in the raw file. The Bearing option will display the angle in a bearing format. The Azimuth option will display the azimuth of the measurement and the Angle Right option will display the angle right measurement of the observation.

Decimal Places for Report: This option controls the number of decimal places for the reported data.
**Report Closure:** This option determines whether the closure report will be displayed after processing. If processing a topo survey where the traverse has not been closed, then turn this toggle off for quick processing.

**Report Sideshots:** Controls whether the sideshot data is shown on the process report.

**Reference Closing Point:** This is an optional field for entering the coordinates to compare the ending traverse point with. This reference closing point is used to calculate the closure. Without using this option the program will by default use the starting coordinate as the reference closing point.

**Report Output:** There are three report output options contained in the raw editor, the *Standard Report Viewer*, the *Custom Report Formatter* and the *Tabular Report Viewer*. Each is documented below.

The *Standard Report Viewer* is the default report viewer throughout the program. Any routine that generates a report has this option and the data contained in the report depends upon the routine executed. The report viewer is also a text editor. It allows for addition and deletion of text in order to customize the report for printing or for saving to a particular format for a file. Options to print, send to the screen in the drawing window as text or save to a file are available.

The *Custom Report Formatter* allows for customization of the process results by selecting the fields and the layout of the fields to display. The settings can be saved to a format name and recalled when needed. Options to Delete, Export and Import saved Formats are also available.
To create a report, select data from the Available list and then select the Add button. This will populate the Used field with the selected data. Standard window selection methods can be used when selecting the data to report. Holding the ctrl key while selecting data allows for making random selections. Holding the shift key while selecting data will select the first item picked, last item picked and all items between.

The Tabular Report Viewer displays a report viewer consisting of tabs. Each tab organizes and displays different data depending upon the process option chosen. The process results using the No Adjust method results in three tabs the Report Header, Unadjusted Data and the Store Points tabs. Each of these tabs display different information which corresponds to the tab title. Using an adjustment method results in five tabs. In addition to the three listed above, an Angle Balance and Compass Closure tab is added. From the Tabular Report Viewer, the Standard Report Viewer can be switched to by pressing the Report option at the bottom of the dialog. This is useful when wanting to combine all tabs into one report for printing or saving to a file. An example of a Tabular Report for a compass rule adjustment is shown below.
Processing Methods

No Adjust: No Adjust means that no angle balance or traverse adjustment will be applied. Options are specified in the Process Options dialog. After picking OK for the process options dialog, a Traverse Points dialog appears for entering the starting and ending point numbers.

The program reads the raw file to set the defaults for these point numbers which are used to calculate the closure. The difference between the ending point and the reference closing point is the closure error and the sum of the traverse distances from the starting to the ending point is used as the total distance traversed. After picking OK for the second dialog, the program starts processing the raw file from the top record down. The result is displayed in the Standard Report Viewer which can save, print or draw the report.

Angle Balance: This process method applies an angle balance to the traverse lines when calculating the coordinates.
The angle balance takes the angular error divided by the number of traverse lines and adjusts the angle of each traverse line by this amount. The angular error is the difference between the angle balance shot and a reference angle. The angle balance shot is specified as a type AB or CL+AB record in the raw file. If no AB record is found in the raw file, then the program will prompt for which traverse shot to use as the angle balance shot. The angle from the angle balance shot is calculated as the angle from the occupied point to the foresight point. The reference angle can be specified as a bearing, azimuth or by two point numbers in the dialog shown.

The angle balance report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted points and then the adjusted closure. Typically but not always, applying the angle balance correction will improve the traverse closure.

Compass, Crandall, Transit: These process methods apply the selected rule to the traverse lines when calculating the coordinates. After adjusting the traverse, the sideshots are also recalculated. The closure error is calculated as the difference between the closing shot and a reference point. The closing shot is specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file, then the program will prompt for which traverse shot to use as the closing shot. The foresight point is used as the closing coordinate. The reference point can be specified by point number or by entering the northing, easting and elevation. The process results report shows the unadjusted points, closure error, adjustments to each traverse point and adjusted point.

Prepare Least Squares Data: From the raw file data, this routine makes initial calculations for the coordinate points in the traverse.
This data, along with the control point coordinates and the angle and distance measurements, is stored to a data file with the same name as the current RW5 file except with a .LSQ extension (ie: survey.lsq goes with survey.rw5). The constraints of the routine are:

**All angle readings must be in angle right mode.**

**The coordinates of the starting and the ending points must be known.**

The routine begins with a dialog for specifying the reference closing coordinates and any scale factors to apply to the distance measurements. The Reference Closing Point is the last point in the traverse, whose coordinates must be known. If an angle balance shot is used in the traverse, the Reference Angle Balance Angle must also be specified, either as a value or as the angle between known points.

Since angles and distances have errors of different magnitudes, they are normalized using weights, based on the accuracy and confidence with which these quantities have been measured. There is a dialog for specifying the estimated measurement errors. The Reading Error is the horizontal angular error in the instrument. For example, for a "5-second" instrument this error would be 5. The Pointing Error accounts for several factors in the horizontal angle reading including accuracy lining up the crosshairs on the target, the target size and the optical quality of the instrument. The Target and Instrument Centering Errors are the distance off the point due to faulty centering. The EDM Constant Error is the accuracy of the instrument distance measurements. The EDM Scaler Error is entered in parts per million for the increased error in longer measurements. These settings can be saved and loaded as a way to store settings for different equipment.
The program will calculate the weights for each distance and angle measurement using these measurement errors. The control points, points to adjust, distance and angle measurements with weights are reported. You can edit these measurements and weights using the Edit Least-Squares Data routine or go directly to the Process Least-Squares Data routine.

**Edit Least Squares Data:** This routine edits the points, measurements and weights stored in the .LSQ file associated with the current RW5 file. The editor works through the dialog shown. You can edit, add or remove the control points, adjust points, angle measurements or distance measurements. The program does not check that the editing is valid. So you need to make sure that your changes keep a good set of least-squares data (i.e. don't delete a needed control point). The Distance Error button allows you to set the distance standard error weights for all the distance measurements to the same value. Likewise the Angle Error button sets the standard error weights for all the angle measurements.

![Edit Least Squares Data](image)

**Least-Squares Input Data:**

<table>
<thead>
<tr>
<th>Control Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point# Northing Easting</td>
</tr>
<tr>
<td>1 5000.000 5000.000</td>
</tr>
<tr>
<td>8 5000.000 5000.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Distance Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Occupy FSight Distance StdErr</td>
</tr>
<tr>
<td>1 2 711.409 0.018</td>
</tr>
<tr>
<td>2 3 457.745 0.017</td>
</tr>
<tr>
<td>3 4 201.295 0.017</td>
</tr>
<tr>
<td>4 5 497.024 0.018</td>
</tr>
<tr>
<td>5 6 223.972 0.017</td>
</tr>
<tr>
<td>6 7 233.872 0.017</td>
</tr>
<tr>
<td>7 8 387.073 0.017</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Angle Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From At To Angle Std-Error</td>
</tr>
<tr>
<td>7 1 2 268.5330 15.18443&quot;</td>
</tr>
<tr>
<td>1 2 3 262.5448 13.68258&quot;</td>
</tr>
<tr>
<td>2 3 4 208.5710 30.36335&quot;</td>
</tr>
</tbody>
</table>

Chapter 9. COGO Menu
### Process Least Squares Data

This routine applies a least-squares adjustment to the data stored in the .LSQ associated with the current raw data (.RW5) file. The closing errors are distributed among the other points, using the "Method of Least Squares" (Ref: Wolf, P.R. and Ghilani, C.D., 1996, "Adjustment Computations", John Wiley and Sons, NY, Third Edition). After the adjustment, the rest of the raw file is processed to recalculate the sideshots. There is an option to draw standard error ellipses around the adjusted points. The ellipse axes are multiplied by Ellipse Scale Factor to make the ellipse larger for easier viewing.

The least-squares process report shows the input data and the results. For each point, the amount adjusted and the standard error in X and Y are reported. The Reference Standard Deviation is based on the sum of the residuals and the initial estimated standard errors. The Chi-Squares test is a goodness-of-fit test that checks the reference standard deviation with the least-squares model. If this test fails, there may be a blunder in the measurement data or the initial estimated standard errors were too low or too high.

### Stadia Processing Method

Provides functionality to process Stadia surveying notes. Stadia sighting depends on two horizontal cross-hairs, known as stadia hairs, within the telescope. These hairs are parallel to the horizontal cross-hair and are equally spaced above and below it. The distance between the two stadia hairs is known as the intercept. The distance from the instrument to the rod is 100 times the intercept. For example, an intercept of 3.10 would represent a distance of 310 (3.10 X 100). For entering in stadia notes, you would enter the horizontal angle, the distance (entered as the intercept X 100) and the vertical angle.

### GPS

The process GPS routine allows for reduction of GPS records that reside in a raw (*.RW5) file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates. When selected, the GPS Settings dialog will appear as shown below.
GPS Projection Type:
Defines the datum coordinate system to be used for converting the latitude, longitude and WGS84 ellipsoid height collected from the GPS receiver into Cartesian coordinates. The supported projection types are State Plane 83, State Plane 27, UTM, Lat/Long, Great Britain-OSGB36, Australia, New Zealand-NZGD2000, New Zealand-NZGD49, and France NTF-GR3DF97A. A User-Defined option is also available for defining a user projection.

The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and )SGM02 (Britain). GeoUser-Defined projections are supported. To define a new projection select the Define Projection option. This will bring up the following dialog.
Enter a name for your system (e.g. PRVI for Puerto Rico/Virgin Islands), then select a Projection type and enter the appropriate parameters. Note that all latitude and longitude values are in Degrees Minutes and Seconds (dd.mmss) and False Northing and False Eastings are always presented in meters. Define a Datum shift by selecting the Select Datum radial button. You may select a predefined Ellipsoid or set your own parameters by typing in a new ellipsoid name in the Ellipsoid field and entering values for a and 1/f. When you enter in a new Ellipsoid name, the Datum name field will be blank. The values for Dx, Dy, Dz, Rx, Ry, and Rz and scale are "to WGS84". If the values you have are "from WGS84", simply reverse the sign of each value (positive becomes negative and vice versa).

You may save your system to a "udp" file. To Load a user defined coordinate system from a file, select the Load radial button. A list of user defined systems will be displayed. Select the desired system and press OK.

**GPS>Zone:** for State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

**GPS>Use Alignment File For Localization:** With this option toggle on, a prompt for the Alignment File to Process will be displayed. This file is typically created by SurvCE (Carlson's Data Collection System) using the Localization routine or by Carlson Field Using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.crd) file and a report will be presented in the Carlson editor for saving or printing purposes.

**GPS>Transformation:** The transformation in the align Local Coordinates command can either be by plane similarity or rigid body methods. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale. The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates or the Localization routine in SurvCE.

**GPS>One Point Alignment Azimuth:** This option applies to the rotation when using one point in Align Local Coordinates or the Localization routine in SurvCE. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

**GPS>Two Point Alignment Method:** There are two option when using this method, Fit & Rotate and Rotate Only. Fit & Rotate will use the second point in the localization file for direction and scaling. The Rotate Only option allows you to use the second point in the localization file for direction but not for scaling. When using the Rotate Only option, any scale factor entered in the Project Scale Factor will be used.

**GPS>Project Scale Factor:** For most applications, the Scale Factor should be set to 1.0. The scale factor represents the "combined" grid/elevation factor that reduces ground distances to grid. After converting the LAT/LONG from the GPS records to state plane coordinates and applying the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X, Y, and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a
base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in the alignment (Localization) file. If there are no points specified in the alignment file, then 0,0 is used as the base point. If using an alignment file (Localization File) this value will be automatically calculated and displayed. Manual entry of a scale factor is also permitted and is often used with the Two Point Alignment Method when a scale factor is known.

**GPS>Geoid to Apply:** The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain).

This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the national Geodetic survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (E0), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This corrections is the geoid undulation (Ug). The formula is He=E0 + Ug.

Carlson applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a know point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson can model the elevation difference which can generally pick up the local Geoid undulation.

**GPS>Units:** Coordinates can be reduced into one of three available units, Metric, US Feet or International Feet.

**Process>Process Settings:** This option allows for the setting of user preferences and tolerances to be used during processing and generation of reports.
Multiple Measurement Settings: These options provide control for managing how multiple measurements to the same point are handled and reported.

Distance Tolerance Horizontal and Vertical: Allows for user input of desired tolerance values for multiple measurements. Exceeded tolerances will be displayed on the process results report. With the Report Residuals option ON, the residual values of the measurements will be shown on the process results report. The data to be averaged can be either the Distance Measurements or the Coordinates.

Check Point Settings: These options provide user controls for survey check points. With Report Check Points ON, any point coded as a check point in the raw data file, will be reported. When selected the Check Point Code and Distance Tolerance fields become active and allow for editing. The Check Point Code is a user specified code entered in during the survey that tells the program to check the coordinates of a particular point with the coordinates of another point. This code is configurable by the user. An example of a point description coded as a Check Point would be as such, "trav=8". This description tells the program that the description of the point is "trav" and to check the coordinates of the this point with that of point #8. The Distance Tolerance Horizontal and Vertical are user specified tolerances for the check point. If either of these tolerances is exceeded it will be reported on the process results report.

Instrument/Rod Height Ranges: These settings are used to check the instrument and rod heights when the raw file is processed. The program will report warnings if there are any heights that exceed the specified min/max ranges.

Angle Only Measurements: The Combine Elevations Method applies to points calculated from Angle Only measurements. Angle Only points are calculated as part of the processing for the No Adjust, Compass, Crandall, Transit and Angle Balance process methods. To calculate points from Angle Only measurements, there needs to be multiple SS records with horizontal and vertical angles and no distance with the same target foresight point number from setups at different occupy points. The elevations can be set as the average from the multiple measurements, using the highest measured elevation, or using the lowest measured elevation. For example, to survey the top of a tree, you could have a SS to foresight point 99 from occupy point 1 with a horizontal and vertical angle and another SS to foresight point 99 from occupy point 2 with a horizontal and vertical angle. Then point 99 can be calculated by angle-angle intersect which determines the horizontal distances from 99 back to occupy points 1 and 2. These distances are then used with the vertical angles and occupy point elevation to calculate the elevation at point 99.

Store Point Records: These options control how any store point (PT) record is handled during processing of the raw data file. There are three options for storing Store Point (PT) records, Never, Always, and When CRD Empty. Never prevents any Store Point (PT) Record Report in the raw file from being written to the crd file. With this option on no existing point in the crd file would be overwritten. Always will write to the coordinate file and will overwrite any existing point with the same number of the Store Point (PT) records. The When CRD Empty option will only write Store Point (PT) records to the coordinate file when it is empty. Report Store Points displays all store points in the process results report. The Hold Store Points option will hold the coordinate values for the store point record when measurements are taken to the store points. This will prevent the coordinates of the point from changing if measurements to the point dictate a change in coordinate position.

Direct-Reverse Settings:

Direct-Reverse Vertical Angles: This option determines how to handle direct-reverse vertical angle measurements when processing. Balance Direct-Reverse will take the mean of the direct-reverse measurements and
use this value when processing the file. Direct Only will only use the direct measurement to the point for processing.

**Foresight-Backsight Measurements:** Balance Foresight-Backsight allows for averaging in the Foresight and backsight measurements when using direct-reverse sets. The Foresight Only option will average the foresight measurements only of a direct-reverse set.

**Horizontal Angle Tolerance (Seconds):** This is the tolerance that the angle measured by the direct measurements and the angle measured by the reverse measurements in a direct-reverse set must fall within.

**Flip Angle Tolerance (Seconds):** User specified value for the acceptable difference in measured horizontal angles determined from the direct (BD-FD) and reverse (BR-FR) observations.

**Distance Tolerance:** User specified tolerance for the difference in distance measurements to the same points. When this value is exceeded on a measurement, it will be displayed on the process results report.

**Measurements To Control Points:** The Store To Current Coordinate File option applies when a control coordinate file is used in addition to the active coordinate file. When processing the raw file, measurements to point numbers that are in the control coordinate file will not be stored into the active coordinate file when this option is on.

**Drawing Points and Linework:** This option controls the drawing of points and linework using Field to Finish. It differs from the draw traverse and sideshot lines under the Tools Menu of the Raw Editor by using a field to finish code table (*.fld) to define how the points and linework are to be drawn and layerized. There are three settings for this option, Manual, Auto and Prompt. Manual means that the file will not be processed using the field to finish codes and no points or linework with be drawn upon existing the raw editor. The Auto option will use the current or last used field to finish file (*.fld) to draw the points and lines on the drawing screen when the raw editor is existed. The option of Prompt will give the option to draw the points and lines to the screen. With this setting specified, the following prompt will be displayed when existing the editor.

![Field To Finish](image)

**Tools Menu**
**Direct-Reverse Report:** This routine creates a report of direct and reverse shots along with the resulting averaged shots. Any tolerance specified in the Process Settings > Direct-Reverse Settings section, that is exceeded will be displayed in this report. The residuals are the difference between the measurement and the final average.

**Reduce Direct-Reverse:** This routine processes the direct and reverse shots and simplifies the raw file by replacing the sets of direct and reverse shots with the resulting average traverse record.

**Update Raw from Points:** This routine is used to update the raw data based upon the coordinates of the points contained in the coordinate (*.crd) file. For example if the raw data has been processed using the compass rule adjustment method, the points in the crd file are now adjusted. However the raw data remains unchanged. If a record of the rw5 file reflecting the angles and distances between the points after an adjustment has been ran is desired, this routine can be run thus updating the raw data to reflect the adjusted angles and distances. Another application for this routine is that of building a rw5 file for future processing and adjustment. For example if a point file or text file has been received from another engineering firm or fellow surveyor and you would like to build a rw5 file for future reference and processing this option can also be used to accomplish this. The rw5 file would be set up with the occupied points, foresight points and the desired angle type to use specified for the traverse. This would be all the manual entry of the data necessary. After creating the "shell" of the traverse then run the update raw from points routine and the raw data, as contained in the coordinate file, will be imported into the rw5 file thus filling out the horizontal angle, distance and vertical components specified.

**Find Bad Angle:** This routine prompts for another raw data (.RW5) file which is read and the data added to the end of the existing raw data (.RW5) file. For example, if you are editing the raw file from the first days work and have a separate raw file with a second days work, you can use this routine to add the second raw data to the first raw file.

**Draw Traverse-Sideshot Lines:** This routine draws lines for all the traverse and sideshot records. Sideshot Traverses are traverses that do not lead to the closing or ending point. There are different layers so that the lines can be drawn with different colors. This command does not process the raw file. Instead it reads the raw file and for each traverse and sideshot record, the program looks up the coordinates for the occupied and foresight points in the CRD file. So it may be necessary to run Process > No Adjust before running this routine. With the Erase Previous Traverse-Sideshot Lines toggled on, any previous linework drawn using this method will be erased from the drawing screen before drawing the lines again.
**Renumber Points:** This routine renumbers points in the raw file. This applies to all point numbers including: TR, SS, and PT records.

**Range of Points to Renumber:** Enter in the range of points to change, i.e., 1-4.

**Line Number to Begin Renumbering:** This corresponds to the line number located at the far left or the raw data editor. Enter the line number to begin the renumbering.

**Line Number To End Renumbering:** This also corresponds to the line number located at the far left on the raw data editor. Enter the line number to end the renumbering. If the range of numbers specified does not occur between the beginning line number and the ending line number, no changes will be made.

**Numbers to Add to Point Numbers:** Enter in the value to add. This number will be added to the existing point number to create the new point number. For example, if the number to add is 10 and the existing point numbers 1 and 6, the new renumber points will be 11 and 16.

**Point Groups:** This option can be used to organize the survey data into point groups. There are three options for the creation of point groups, **Create All Point Group**, **Create Traverse Point Group** and **Create Sideshot Point Group**. The **Create All Point Group** option, creates a user-specified group containing all of the points defined in the rw5 file. **Create Traverse Point Group** creates a user-specified group containing only the points defined in the traverse records (TR) of the rw5 file. The **Create Sideshot Point Group** creates a user-specified group that contains only the points defined in the sideshot records (SS) of the rw5 file.

**Format of the raw data (.RW5) file**

The Carlson raw data format is a comma-delimited ASCII file containing record types, headers, recorded data, and comments. The format is based on the RW5 raw data specification, with the exception of angle sets. Angle sets are recorded as BD, BR, FD, and FR records to allow reduction of all possible combinations. Essentially, these records are identical to a sideshot record.
**Backsight Record**
Record type: BK
Field headers:
OP Occupy Point
BP Back Point
BS Backsight
BC Back Circle
Sample(s):
BK,OP1,BP2,BS315.0000,BC0.0044

**Line of Sight Record**
Record type: LS
Field headers:
HI Height of Instrument
HR Height of Rod*
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
LS,HI5.000000,HR6.000000
LS,HR4.000000

**Occupy Record**
Record type: OC
Field headers:
OP Point Name
N Northing (the header is N space)
E Easting (the header is E space)
EL Elevation
– Note
Sample(s):
OC,OP1,N 5000.00000,E 5000.00000,EL100.000,–CP

**Store Point Record**
Record type: SP
Field headers:
PN Point Name
N Northing
E Easting
EL Elevation
– Note
Sample(s):
SP,PN100,N 5002.00000,E 5000.00000,EL100.000,–PP

**Traverse / Sideshot Record / Backsight Direct / Backsight Reverse / Foresight Direct / Foresight Reverse**
Record type: TR / SS / BD / BR / FD / FR
Field headers:
OP Occupy Point
FP Foresight Point
(one of the following)
AZ Azimuth
BR Bearing
AR Angle-Right
AL Angle-Left
DR Deflection-Right
DL Deflection-Left
(one of the following)
ZE Zenith
VA Vertical angle
CE Change Elevation
(one of the following)
SD Slope Distance
HD Horizontal Distance
– Note
Sample(s):
TR,OP1,FP4,AR90.3333,ZE90.3333,SD25.550000,–CP
SS,OP1,FP2,AR0.0044,ZE86.0133,SD10.313750,–CP
BD,OP1,FP2,AR0.0055,ZE86.0126,SD10.320000,–CP
BR,OP1,FP2,AR180.0037,ZE273.5826,SD10.315000,–CP
FD,OP1,FP3,AR57.1630,ZE89.4305,SD7.393000,–CP
FR,OP1,FP3,AR237.1612,ZE270.1548,SD7.395000,–CP

GPS
Record type: GPS
Field headers:
PN Point Name
LA Latitude (WGS84)
LN Longitude (WGS84, negative for West)
EL Ellipsoid elevation in meters
– Note
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
GPS,PN701,LA42.214630920,LN-71.081409184,EL-21.8459,–C
P /Brass Disk
Alphabetical listing of Record Types
BD Backsight Direct
BK Backsight
BR Backsight Reverse
FD Foresight Direct
FR Foresight Reverse
GPS GPS Position in Lat (dd.mmss) Lon (dd.mmss - Negative for West) and WGS84 Ellipsoid Elevation in meters

Alphabetical listing of Field Headers
AD Azimuth Direction ( 0 for North, 1 for South)
AL Angle-Left
AR Angle-Right
AZ Azimuth
BC Back Circle
BP Back Point
BR Bearing (this field will be recorded as N123.4500W)
BS Backsight (when back point is not defined)
CE Change Elevation
DL Deflection-Left
DR Deflection-Right
DT Local Date (MM-DD-YYYY)
E Easting (the header is E space)
EC Earth Curvature (0 for off, 1 for on)
EL Elevation (GPS value is ellipsoid elevation in meters)
EO EDM Offset
FE Foresight Elevation
FP Foresight Point
HD Horizontal Distance
HI Height of Instrument
HR Height of Rod
LA Latitude
LN Longitude
N Northing (the header is N space)
OC Occupy Point Coordinates
OP Occupy Point
PN Point Name
SD Slope Distance
SF Scale Factor
TM Local Time (HH:MM:SS)
UN Distance Unit (0 for feet, 1 for meter, 2 for US feet)
VA Vertical Angle
ZE Zenith
– Note

Traverse Examples
This first example is a closed traverse with an internal backsight of azimuth 178°04′22″.

Use the functions under the Add menu to create and fill out the raw file as shown here.

Notice that the record from point 7 to 8 is set as a CL+AB record. This tells the program that point 8 is the closing point and that the angle from 7 to 8 is the closing angle. For traverse adjustment, the closing reference point is 1 and the closure error is the difference between point 1 and point 8. For angle balance, the reference closing angle is...
358d0'42" (178d0'42" + 180). The angle balance error is the difference between this reference angle and the angle from points 7 to 8.

Now let's process using Compass adjustment with Angle Balance. Choose Compass under the Process menu and fill out the dialogs as shown.

First half of process report:

Process Results 05/23/2002 10:06
Raw file > c:/scadxml/data/example.rw5
CRD file > C:/scadxml/DATA/example.crd

Scale Factor: 1.00000000
Correct for Earth Curvature: OFF
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

<table>
<thead>
<tr>
<th>No.</th>
<th>Angle</th>
<th>Dist</th>
<th>HT</th>
<th>HT</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5330</td>
<td>89.4050</td>
<td>711.32</td>
<td>5.32</td>
<td>6.00</td>
</tr>
<tr>
<td>P2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AR262.5448</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
</tr>
<tr>
<td>P3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AR208.5710</td>
<td>89.1803</td>
<td>201.31</td>
<td>5.40</td>
<td>6.00</td>
</tr>
</tbody>
</table>
Closure Results (Before Angle Balance)

Starting Point 1: N 5000.00 E 5000.00 Z 100.00

Closing Reference Point 1: N 5000.00 E 5000.00 Z 100.00
Ending Point 8: N 5000.09 E 4999.97 Z 100.06
Azimuth Error : 341°38'22''
North Error : 0.09061
East Error : -0.03007
Vertical Error: 0.05953
Hz Dist Error : 0.09547
Sl Dist Error : 0.11251
Traverse Lines> 7
SideShots> 1
Horiz Dist Traversed: 2712.29
Slope Dist Traversed: 2712.62
Closure Precision: 1 in 28409

Remainder of process report:

Compass Closure
Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Northing</th>
<th>Easting</th>
<th>Dist</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5038.445</td>
<td>5710.269</td>
<td>5038.440</td>
<td>5710.294</td>
<td>0.025</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>3</td>
<td>4587.914</td>
<td>5791.222</td>
<td>4587.907</td>
<td>5791.263</td>
<td>0.042</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>4</td>
<td>4397.319</td>
<td>5726.469</td>
<td>4397.310</td>
<td>5726.517</td>
<td>0.049</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>5</td>
<td>4363.044</td>
<td>5230.628</td>
<td>4363.032</td>
<td>5230.693</td>
<td>0.067</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>6</td>
<td>4586.509</td>
<td>5245.681</td>
<td>4586.496</td>
<td>5245.755</td>
<td>0.075</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>7</td>
<td>4613.178</td>
<td>5013.335</td>
<td>4613.163</td>
<td>5013.416</td>
<td>0.083</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>8</td>
<td>5000.017</td>
<td>4999.905</td>
<td>5000.000</td>
<td>5000.000</td>
<td>0.097</td>
<td>S 79°46'08'' E</td>
</tr>
</tbody>
</table>

Max adjustment: 0.097
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

Point Horizontal Zenith Slope Inst Rod Northing Easting Elev
No. Angle Angle Dist HT HT
Description

<table>
<thead>
<tr>
<th>No.</th>
<th>Northing</th>
<th>Easting</th>
<th>Dist</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5326</td>
<td>89.4050</td>
<td>511.34</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5434</td>
<td>89.3236</td>
<td>457.76</td>
<td>S 79°46'08'' E</td>
</tr>
</tbody>
</table>
Shown above is the resulting process report. The angle balance had an error of 39 seconds which was divided among the 7 traverse sides. The Compass Closure shows how each traverse point was adjusted and then the resulting adjusted angles and distances.

Here is another layout of the last example that shows an external backsight setup. In this case there are two known points. Point 1 is the starting point and point 21 is the initial backsight. The setup could also use a backsight azimuth (ie north azimuth for example) instead of a backsight point number.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Example of an open traverse

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Here is an example of an open traverse.

**Compass Report from Open Traverse example:**

<table>
<thead>
<tr>
<th>Process Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw file&gt; d:/scdev/data/tsurvey.rw5</td>
</tr>
<tr>
<td>CRD file&gt; d:/scdev/data/tsurvey.crd</td>
</tr>
</tbody>
</table>

**Adjusted Point Comparison**

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Adjusted Northing</th>
<th>Adjusted Easting</th>
<th>Distance</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5013.76</td>
<td>5711.18</td>
<td>5013.78</td>
<td>5711.13</td>
<td>0.047</td>
<td>N 63d21’19’’ W</td>
</tr>
<tr>
<td>3</td>
<td>4560.69</td>
<td>5776.42</td>
<td>4560.72</td>
<td>5776.35</td>
<td>0.078</td>
<td>N 63d21’19’’ W</td>
</tr>
<tr>
<td>4</td>
<td>4372.46</td>
<td>5705.08</td>
<td>4372.50</td>
<td>5705.00</td>
<td>0.091</td>
<td>N 63d21’19’’ W</td>
</tr>
</tbody>
</table>

**Point Horizontal Vertical Slope Inst Rod Northing Easting Elev**

<table>
<thead>
<tr>
<th>No.</th>
<th>Angle</th>
<th>Angle</th>
<th>Dist</th>
<th>HT</th>
<th>HT</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR133.5324 89.4050</td>
<td>711.27</td>
<td>5.32</td>
<td>6.00</td>
<td>5013.78</td>
<td>5711.13</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5506 89.3236</td>
<td>457.74</td>
<td>5.43</td>
<td>6.00</td>
<td>4560.72</td>
<td>5776.35</td>
</tr>
<tr>
<td>4</td>
<td>AR208.5712 89.1803</td>
<td>201.30</td>
<td>5.40</td>
<td>6.00</td>
<td>4372.50</td>
<td>5705.00</td>
</tr>
</tbody>
</table>

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
Portion of typical Sokkia/SDR raw data file:
00NMSDR20 V03-05 Jan-22-98 19:14 122211
10NMW970709A
13CPSea level crn: N
02TP00015000.000005192.9200081.7450000MN-SET
07TP00011000390.000000.000000
09F100010003193.10000092.40416660.00000000MN-SET
09F100010100193.00000000.00000000SN-REC

Portion of typical Wild/Leica raw data file:
410001+000000SB 42....+00000000 43....+00000000 44....+00000000 45....+00000000 110002+00000000
21.12+35959590 22.10+08748240 31....+00000000 51...0.+0012+000 110003+00000000
21.12+00000000 22.10+08748240 31....+00000000 51...0.+0012+000 110004+00000000
21.12+00420390 22.10+08702570 31....+00168234 51...0.+0012+000 110005+00000000
21.12+26029130 22.10+09311370 31....+00206133 51...0.+0012+000 110006+00000000
21.12+25827090 22.10+09504550 31....+00106228 51...0.+0012+000 110007+00000000
21.12+27151500 22.10+09312240 31....+00106066 51...0.+0012+000

Portion of typical SMI raw data file:
CM Definitions: SS: Side Shot; TR: Traverse; OC: Occupied Coordinates;
PC: Point Coordinates; CM: Comment; OS: Occupied Station;
TS = time stamp; e = electronic; m = manual; CM TS TUE 04/09/91 09:41:25P
PC 1 5000.00000 5000.00000 0.00000
SS e Hi:4.000 HR:5.000 PIPE/F
0 1 2 BAZ:0.00000 AR:0.00000 ZA:91.24330 SD:92.020
SS e Hi:0.00000 HR:0.00000 BC/BR FRAME 1ST
0 1 3 BAZ:0.00000 AR:28.47220 ZA:91.20250 SD:65.240

Portion of typical PC COGO raw data file:
* NEW SET UP INST. AT 1 359 59 59 ON 4
L ANG 1000 4 1 77 18 52.444 = 1000 WALL# 283.22
L ANG 1001 4 1 55 44 28.9 = 1001 WALL# 283.28
L ANG 1002 4 1 38 37 8 15.89 = 1002 WALL# 283.48
L ANG 1008 4 1 27 18 34 123.82 = 1008 WALL# 287.75

Portion of typical Nikon raw data file:
MP,NOR,,5000.0000,5000.0000,100.0000,1
ST,NOR,,1.,5.0000,0.0000,0.0000
SS,1,5.000,131.0605,91.3744,88.4935,10:36:15,CL1
SS,2,5.000,137.6770,90.2923,88.5236,10:36:50,CL1

Portion of typical MDL/Laser raw data file:
D052097F04P52I494P01P02
H32473V-0639R016202P03
H03840V-0483R017380

Portion of typical Geodimeter raw data file:
Field to Finish

This command turns data collector field notes into a final AutoCAD drawing by matching the descriptions of the field points with user-defined codes. The points are brought into the drawing with attributes defined by the code, including the layer, symbol, size and linetype. Draw Field to Finish also uses an improved coding method.
Example drawing results using the example points and example code definitions

Two files are used in Draw Field to Finish - a coordinate file and a field code definition file. The coordinate file consists of x,y,z points with text description fields. The description fields contain codes for the Draw Field to Finish processing. The coordinate file can be a Carlson coordinate (.CRD) file, C&G CRD file, C&G CGC file, Land Desktop MDB file or Simplicity Systems ZAK file. An ASCII data file can be converted into a coordinate file using the Import Text/ASCII File command. The field code definition file defines the layer, symbol, size and other actions to apply with each code. These file names are displayed at the top line of the Draw Field to Finish dialog box.

Draw Field to Finish can translate the field points into Carlson points (also called coordinate geometry points or cogo points) with a symbol, layer, and size defined by the code. The point settings of whether to label the description, point number, and elevation and whether to locate the point at zero or at the real Z can be found in the Additional Draw Options of the Draw Field to Finish dialog box. The Draw-Locate Points command has these point settings stored separately in the Point Defaults menu. Draw-Locate Points provides a simpler method for drawing points compared with Draw Field to Finish.

There are two different methods for connecting linework. One method creates line work by connecting points with the same code. The linetype is defined by the code as either points only (no line work), lines, 2D polylines, both 2D and 3D polylines, or 3D polylines (breaklines). Distinct lines with the same code are defined by adding a group number to the end of the code name in the data file. With this method, all points with the description CODE1 will be one line while points with CODE2 will be another line. Both CODE1 and CODE2 use the definition for CODE. For example, the code EP could be a code for edge of pavement that is to be connected as 3D polylines. If there are two separate edge of pavement lines on the left and right sides of a road, all the points for the left side could have the description EP1 and the points on the right side could be EP2.

The second method is the PointCAD format. This method also connects points with the same code. The difference is that instead of using a number after the code for distinct lines, you use the same code with an additional code for starting and ending the line. For example, +0 is used to start a line and -0 to end. So the coding for a segment of edge of pavement could be EP+0, EP, EP, EP-0. Another special code that has been added to Field to Finish is +7, -7. This 7 code will use the linetype definition of line, 2D polyline or 3D polyline defined by the Draw Field to Finish.
code. For example, if EP is defined as a 3D polyline, then the coding EP+7, EP, EP, EP-7 will create a 3D polyline. Otherwise codes like -0, -0, which is defined as start and end line, will draw EP as a line. Other PointCAD special codes are: +4 starts a curved 2D polyline, *4 starts a closed curved 2D polyline, +1 begins a 3-point arc, +5 starts a 3D polyline, *5 starts a closed 3D polyline, +6 starts a 2D polyline, *6 starts a closed 2D polyline, +7 starts a line whose type is specified by the field code definition, -05 starts a curved 3D polyline section, -50 ends that section, +8 starts a 2D and 3D polyline combination, *8 starts a closed 2D and 3D polyline combination, -08 starts a 2D and 3D polyline combination curved section, -80 ends that section. //, followed by a field code, concatenates that field code's description on to the point's description. For example, OAK//04 might become LIVE OAK TREE 4" if the field code OAK translates to LIVE OAK TREE and the field code 04 translates to 4".

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.
**Range of Points:** Specify the range of points to draw.

**Point Group:** Specify the point group(s) to process.

**Entities To Draw:** The Points option draws only the points and point attributes. The Lines option draws only the linework and the Symbols draws only the symbols. Any combination of these options can be processed as well as individual processing of each entity.

**Point Label Settings:** Specify whether you want Draw Field to Finish to label the Point Numbers, Descriptions, and/or Points Notes which are contained in the note (.NOT) file that is associated with the coordinate (.CRD) file.

**Elevation Label Settings:** Specify the elevation labeling options. The Label Zeros option will label the elevations of points with z=0. Use Parentheses will place parenthesis around the elevation text. Use ‘+’ and Use ‘-’ will place the appropriate symbol in front of the elevation.

**Locate Points on Real Z Axis:** Choose between locating all the points at real Z elevation, all at zero elevation or to use the real Z setting as defined in the individual codes.

**PC-PT Curve Type:** Sets the method for drawing curves with more than 3 points. The Bezier option draws a smooth polyline through all the curve points. The Sequential Arcs method draws multiple arcs with arc end points at each of the curve points. These arcs are tangent to the preceding line segment. The Best Fit method creates a single best-fit curve for all the curve points between the PC and PT.

**Layer Prefix:** Optional layer prefix added to all entities drawn with Draw Field to Finish.

**Erase Existing Draw Field to Finish Entities:** When checked, this option will erase from the drawing any old entities created by previous Field-To-Finish runs before drawing the new entities.

**In Range:** This option only erases and redraws those Draw Field to Finish entities that are within the specified range of points to process.

**Creating Point Groups:** Point Groups can be created in one or two different ways. Each field code definition can specify a Point Group that all point numbers that use that code will be added to. Multiple field codes can use the same Point Group name. Check the By Code Definition checkbox for that option. The second method is to automatically create Point Groups for each code that is processed. Check the Automatically By Code checkbox for that option. Ignore Code Suffix, if checked, will cause the codes to be considered after removing the numeric suffix. For example, points with the EP10 and EP11 codes will both be automatically added to the Point Group named EP. No matter how the Point Group is created, the Group Name Prefix can be used to add a prefix to the group name. Note: if the Point Group already exists, it will be erased first before being created again by either of these two methods.

**Pause on Undefined Codes:** When checked, Draw Field to Finish will pause if it encounters a description that is not defined in the code table.

**Abort without drawing anything:** This stops the command. Run Draw Field to Finish again to correct the code table.
Use the default settings for this point: This option draws a point in the "MISC" layer with no linework. To set your own default, define a code called "SC_DFLT".

Use default settings for all undefined codes: This option will draw all undefined codes in the "MISC" layer by default or a user specified layer as defined in the "SC_DFLT" code. A good way to check the data file for unmatched descriptions is to use the Print Table command and choose the Data Points and Distinct Code options. This command will print the different codes in the data file and identify any undefined codes.

Draw (continued)

Preview Only: When checked, this option will temporarily draw the points and linework and allow you to review it with zoom and pan.

Auto Zoom Extents: When checked, this will force a zoom extents after Draw Field to Finish is done.

Report Codes/Points: This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

Edit Codes / Points: The Field to Finish dialog box allows you to load the coordinate and field code definition files, view and edit the code definitions, view and edit the coordinate file, view reports, and then return to the Draw Field to Finish dialog box to process the files. The top section displays the code definitions. The bottom section has three columns of functions each pertaining to controls for different elements of the command. The Code Table section provides controls for settings, sorting and reporting of codes. The Code Definitions section provides tools for the creation and editing of codes. The Coordinate File section provides controls for coordinate files and points. It also contains the Draw controls which starts the processing of the data using Draw Field to Finish.
**Code Table**

**Code Table Settings:** These options provide tools for defining the coding method to be used for processing of the point data. Various import tools allow for the importing of codes from different software packages. Controls for handling multiple codes are located on this dialog. All special codes can be replaced to other characters defined by the user. The special codes are listed and edited on this dialog.

**Set:** Choose this button to specify a new code table. The name of the current table is shown in the field to the right of this button.

**Process Carlson Coding:** When checked, this option interprets and processes coordinate files based upon the Carlson Coding method and data collection method.

**Process Eagle Point Coding:** When checked, coordinate files are processed based on the Eagle Point Data Collection method. When selected the **Eagle Point Codes** button becomes available for selection and displays the following dialog. This dialog allows for customization of the eagle point special designators.
Currently the supported designators include, "Field Code", "Point-On-Curve", "Close Line", "Line End", "Insert Description" and "Bearing Close". Also supported is the ability to recognize overwriting of descriptions just as Eagle Point does by using the space separator instead of the "Insert Description" designator. Examples of supported coding are as follows:

- .TC Places a node and or line per the field code library.
- TC Places a node and or line per the field code library.
- -TC Specifies a point on a curve.
- TC- Specifies a point on a curve.
- ..TC Stops the line.
- TC! Stops the line.
- .TC+ Closes the line back to the starting point.
- TC+ Closes the line back to the starting point.
- ..TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
- TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
- WV.W1 Places a node as specified by the code "WV" in the field code library and then begins a line as specified by code "W" in the field code library.
- .TC.EP.FL Results in three lines coming together.
- TC1.TC2.TC3 Results in three lines coming together. All three lines are specified by the definition of the single code "TC" in the field code library.
- TC.TC1 When used in conjunction with the "Draw Field Codes Without a Suffix as Points Only" toggle, "TC" will be recognized as the node and "TC1" will be recognized as the line so that if the code "TC" in the field code library is defined as a polyline, line or 3D polyline, duplicate lines will not be unintentionally placed when this shot only pertains to a single element. Keep in mind that all line work must have a numeric suffix when using this toggle.
- TREE * OAK Result on screen would be: TREE OAK
- TREE OAK * Result on screen would be: OAK TREE
- TREE OAK Result on screen would be: OAK
- TC1.TC2-.VLT6# Stops "TC1", continues "TC2" as a point on a curve and closes VLT6 as a rectangle using the "Bearing Close" code.

Note: The use of the "Use Multiple Codes for Linework Only" toggle is recommended when using Eagle Point Coding.

Process CAiCE Coding: When checked, coordinate files are processed based on the CAiCE Data Collection method. Examples of supported coding are as follows:

- 169 is just the code 169.
- 145C10 is the code 145 and line #10.
- 169C25C is the code 169, line #25, and the point is on a curve.
- 172C12B is the code 172, line #12, and this point closes the line.

Split Multiple Codes:

Multiple codes are defined by including each code in the point description field separated by a space. A single data point can be used in different lines by assigning it multiple codes. For instance, a point might be part of both a
curb line and a driveway line with a description of "CURB DRW". Field-to-Finish uses spaces as the delimiter for multiple codes. You should avoid spaces in the descriptions except for where multiple codes are intended or after the "/" character. For example, a code for light post should not be "LGT POST" but instead should be "LGTPPOST".

There are three options for the handling of multiple codes when encountered. The All option will split all multiple codes and process each code based upon their code definition. When None is selected, both codes will be processed based upon their code definition. If the Prompt option is checked on, when Field-to-Finish detects multiple codes on a point the following dialog will be displayed with options for handling the codes.

**Possible Multiple Codes Found**

- Multiple codes may have been found on a single point.
- BLDG FACE
- Split all multiple codes.
- Split no multiple codes.
- Split this one for now.
- Don't split this one.

**Import Land Desktop Desc Key:** This option imports and converts a Land Desktop Description Key into a Carlson Draw Field to Finish (fld) code definition file. The Land Desktop Description Key file is a mdb file and is found in the Land Desktop Project file path. It is located in the under the COGO/DescKey directory.

**Import TDS Codes:** This option imports TDS codes into the Carlson Field to Finish (fld) code definition file.

**Import Eagle Point Codes:** This option imports Eagle Point codes into the Carlson Field to Finish (fld) code definition file.

**Import C&G Description Table:** This option imports C&G code tables (tbl) into the Carlson Field to Finish (fld) code definition file.

**Import SurvCE Codes:** This option imports a SurvCE Feature Code List (fcl) into a Carlson Field to Finish (fld) code definition file.

**Draw Field Codes Without a Suffix as Points Only:** This option is useful for when wanting to use a field code sometimes for linework and sometimes for just points but it is preferred to number the lines rather than using start and stop codes. For example, if the field code EP is defined to use the Line Entity type, then EP25 will be drawn as a Line, however if just EP is used, no linework will connect to that COGO point.

**Use Multiple Codes for Linework Only:** When checked, and multiple codes are detected, only linework will be drawn for the secondary codes. Points are only created based on the primary code. If you want symbols for all multiple codes, then this setting should not be checked.

**Max Delta-Height for Linework:** Use this option to specify the maximum elevation difference that Draw Field to Finish should draw any section of linework. This option is for use with 3d polylines and lines.

**Max Length for Linework:** Specify the maximum length that Draw Field to Finish should draw any section of linework.

**Special Codes:** This section allows you to substitute the existing predefined special codes and characters with your own. Draw Field to Finish recognizes several special codes. A special code is placed before or after the regular code with a space separating the code and special code. Here is a listing of the default special codes and characters.
Special Characters

The characters (*, -, +, /, and _) can be used and substituted in Draw Field to Finish. The way these characters are used is that when the file is processed the description field is searched for these characters. If the "+" symbol was changed to "-" then the program would look for "-" and change it to "+". This is useful when a particular data collector may not have all the symbols available. With these substitutions you can make a character that is provided on the data collector generate the symbol needed. Multiple characters can also be used. For example "–" can be used in order to produce a "/" character or any of the characters listed above.

Special Codes

"/"

Carlson points in the drawing have point attributes including a description. When Field-to-Finish draws the points, the point description from the coordinate file is processed to match a code. The code then defines the description that is drawn with the point. For example, consider a code of "UP" with a description of "POLE" and a data point with the description "UP". The data point description "UP" would be matched with the code "UP" and the point would end up being drawn with the description "POLE". A special character "/" (the forward slash or divide key) can be used for an unprocessed description to append. Everything after the "/" is added directly to the point description and is not considered a code and no further substitution is done on it. For example, a data point with the description "UP / 150" with the same code "UP" definition above would be drawn with the description "POLE 150".

"//"

This special code causes text after the "/" to be interpreted as a field code. That field code's description is then appended to the first field code's description. For example, if the field code 02 has the description 2" and the field code OAK has the description oak tree, then 02//OAK will result in the point having the description of 2" oak tree. If the "/" character has been replaced with a different character, for example with a & character, then the "/" code would become "& &".

PC
This code begins a three point arc or a curved line when used with the "PT" code (see below). The point with this special code is the first point on the arc. The next point with the code is considered a point on the arc, and third point with the code is the arc endpoint. For example (in point number, X, Y, Z, description format),

10, 500, 500, 0, EP PC - start curve
11, 525, 527, 0, EP - second point on curve
12, 531, 533, 0, EP - end point of curve

**PT**

This is a special code that can be used with "PC" to define a curve with more than three points or a tangent two-point curve. Starting at the point with the "PC", the program will look for a "PT". If the "PT" is found, all the points between the "PC" and "PT" are used for the curve which is drawn as a smoothed polyline that passes through all points and only curves the polyline between points. If no "PT" is found, then the regular three point arc is applied as explained above. If no points are found between the "PC" and "PT", then the point prior to the "PC" and the point after the "PT" are used to create tangents for the resulting curve.

**CLO**

This code forces the lines drawn between a series of points with the same code to close back to the first point with the same code. For example, shots 1-4 all have the BLD description with the exception of point 4. Its description is BLD CLO. This will force the linework drawn for the BLD code to close back to point 1 which is the first point with the description of BLD.

**NE**

This code represents no elevation. A point with this special code is located at zero elevation.

**NOS**

This code indicates that the point should be "non-surface"; that is, that it should be ignored when contouring or creating surfaces. This can also be controlled per-field code by turning on the Non-Surface toggle in the Edit Field Code Definition dialog box.

**OH & OV**

The codes "OH" and "OV" stand for offset horizontal and offset vertical. These offset codes apply to 2D and 3D polylines. A single set of offset codes can be used to offset the polyline a set amount. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP
12, 531, 533, 103, EP

This would create a polyline connecting points 10,11 and 12 and an offset polyline with a 2.5 horizontal and -0.5 vertical offset. The direction of the horizontal offset is determined by the direction of the polyline. A positive horizontal offset goes right from the polyline direction and a negative goes left. The horizontal and vertical offset amounts apply starting at the point with the offset codes until a new offset code or the end of the polyline. Only one horizontal and vertical offset can be applied to 2D polylines. For 3D polylines, multiple offset codes can be used to make a variable offset. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP OH5.5 OV-.75
12, 531, 533, 103, EP OH7.5

This would offset the first point horizontal 2.5 and vertical -0.5, the second point horizontal 5.5 and vertical -0.75 and the third point horizontal 7.5 and vertical -0.75.

**SZ**
This code is used to set a different symbol size. The value of the new symbol size is specified after the SZ (example SZ0.2). This value is a size scaler that is multiplied by the current drawing scale to determine the actual drawn size. For example, a drawing scale of 50 and a symbol size scaler of 0.2 would make the drawn symbol size 10. Two dimensional scales can be accomplished by using an ‘X’ between the horizontal and vertical scales (e.g., "SZ0.2X3.5"). If no number follows the SZ special code, then the next point with the same field code as the current point will be used to determine the scale factor.

**ROT**

This code is used to set the rotation of the point symbol. If a point number follows the ROT code, then angle from the current point to this point number is used for the rotation. For example, "ROT45" would rotate the symbol towards point number 45. If there is no point number after the ROT code, then the rotation point is the next point number with the same code as the current point. ROT can also be used to rotate towards an angle clockwise from north by using ‘+’ or ‘-’ in front of the number. For example ROT+45 rotates the point symbol to the northeast and ROT-90 rotates the point symbol to the west.

**SMO**

This code is used to smooth the polyline.

**AZI & DIST**

The AZI and DIST codes are used together to locate an offset point. The AZI sets the offset azimuth and DIST sets the distance. The values should directly follow the code. For example, AZI25 DIST4.2 would draw the point offset 4.2 at an azimuth of 25 degrees.

**JOG**

The "JOG" special code allows for additional points to be inserted into the line work at perpendicular or straight offsets. Only offsets should follow the JOG code. Positive numbers indicate a jog to the right and negative numbers indicate a jog to the left. Alternatively, "R#" and "L#" can be used where # is the distance to either the right or the left. Finally, "S#" can be used to make an offset straight ahead by using a positive # or behind by using a negative #. For example, "BLDG JOG S10.1 R5 L12.2 L5 L12.2" or equivalently "BLDG JOG S10.1 5 -12.2 -5 -12.2" advances 10.1 units and then draws a closed rectangle on the right hand side of an existing line. The offsets are always done in the X-Y plane. If the current line is vertical, an offset to the right is along the positive X-axis.

**JPN**

The "JPN" (Join to Point Name) special code joins to the point named immediately after the code. For example, "JPN205" causes a line to be drawn from the current point to the point "205".

**RECT**

The "RECT" special code causes a rectangle to be formed on a 2D or 3D polyline using one of two different methods. If a number follows "RECT" (e.g., "RECT10"), a rectangle will be drawn 10 units to the right of the last two points ending on the point with the "RECT" code. Use a negative offset to place the rectangle on the left side (e.g., "RECT-2.5"). For example if locating the left side of a 10’ rectangular concrete pad using the code conc for concrete, the description of the two left points would be (conc) for the first point and (conc rect10) for the second. If no number follows "RECT", then the polyline will be closed by shooting right angles from the first point of the polyline and the current point and creating a new point where those two lines cross. This method requires three points be established on the pad.

**CIR**

The "CIR" special code stops the linework on the previous point and causes this point to create a circle in one of three different ways. The first way uses just the current point as the center with the CIR special code followed immediately by the radius. For example "CIR5.0" will create a circle centered on this point with radius 5 and at the elevation of the current point. The second method uses two points, the first point specifying the center and the
elevation, and the second point specifying the radius. The third method uses 3 points that specify the perimeter of
the circle in 2D with the first point specifying the elevation. The "CIR" code can be used with all of the linetypes
including "points only". The circles are always parallel to the X-Y plane.

For Multi-Point 2ND Code

When used on the first point of a multi-point symbol, the "2ND" code indicates that the second point of the sequence
(i.e., the next point after the current one) should be used as the second symbol insertion point for a multi-point
symbol. Please refer to Symbol Pts in the Edit Field Code Definition section below.

For Multi-Point 3RD Code

When used on the first point of a multi-point symbol, the "3RD" code indicates that the third point of the sequence
should be used as the third symbol insertion point. The "3RD" code should be used with the "2ND" code. Please
refer to Symbol Pts in the Edit Field Code Definition section below.

3D Special Codes

Below are the special codes that can be used for the easy creation of 3D surfaces. The resulting AutoCAD 3D face
entities can be viewed in the Carlson 3D viewer by entering "cube" on the command line.

FACE3D

Makes a triangle mesh of 3D face entities by triangulating points starting with the current point and contin-
uing until the line ends or another 3D special code is found. The points must be ordered along the perimeter.
Although the mesh will be built if the points are clockwise or counterclockwise along the perimeter, the visible side
in the Carlson 3D viewer, "cube", is the clockwise side by default. On the Advanced tab, the shading mode may be
set to Shade both or Shade back if you would prefer to see both sides or just the counter-clockwise side.

HOLE3D

Makes an exclusion area within the triangle mesh identified by the point number following this code (e.g.,
"HOLE3D101" will start a hole in point # 101). If no point number is given ("HOLE3D"), the exclusion area is
applied to the last mesh or if there is a mesh in the process of being constructed by the current sequence of points, it
is ended and the hole is applied to it. Note that a hole can only be applied to a mesh that was created by FACE3D
(not BLOCK3D or WALL3D). Note also that it can be difficult to predict what the "last mesh" was if it used a
different field code since the points of the coordinate file are processed by order of field code first and then point
number. There is no limit to how many holes can be applied to a FACE3D mesh. The points of the hole itself are
not added to the FACE3D mesh; they are projected on to the best plane that contains the FACE3D mesh and then
the hole is cut-out.

Example 1:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 VENT1 HOLE3D2500 /applies 2505-2508 as a hole to last mesh that uses point #2500. So any point in the
range 2500-2504 would have the same effect.
2506 VENT1
2507 VENT1
2508 VENT1

Example 2:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 HOUSE1 HOLE3D /stops the above mesh and applies 2505-2508 as a hole
2506 HOUSE1
2507 HOUSE1
2508 HOUSE1

Example 3:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D HOLE3D2503 /applies 2505-2508 as a hole to above mesh 2500-2504 and starts a new
mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1

Example 4 (same result as Example 3):
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D /starts a new mesh using the WINDOW field code.
BLOCK3D

Makes a set of 3D faces to make a 3D block using the height value entered after the code (e.g., "BLOCK3D2.3" with height 2.3). Heights can be positive or negative. With 3 points, makes a parallelogram base that is extruded up (or down if height is negative) to form a 6-sided block, including top and bottom. With 4 or more points, makes a closed polygon for the base that is then extruded by the height. The points can be laid out in clockwise or counterclockwise order around the perimeter. The perimeter or base does not have to be a convex polygon.

WALL3D

Makes a set of 3D faces above the polyline using a height value entered after the code (e.g., "WALL3D2.3" with height 2.3). The height can be negative if the points on the top of the wall have been shot. If no parameter exists, then the height is determined by the distance from the current point to the next point. This is a signed distance so the surveyor can shoot either the top of the wall or the bottom of the wall. Both sides of the wall will have triangles and so both sides will always be visible in the Carlson 3D viewer "cube".

Example 5 – 6’ high wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0 /wall 6'
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example 6 – 6’ high wall, height specified by 1st to 2nd point, shot along the top:
2020 1100.000 1160.000 100.000 WALL2 WALL3D /height by 2nd pt
2021 1100.000 1160.000 106.000 WALL2
2022 1000.000 1160.000 106.000 WALL2

**Code Table (continued)**

**Sort Table** - This sorts the code table by either code name or layer.

**Report Codes/Points** - This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

**Code Table by CRD** - This command will create code table definitions based on the coordinate file field descriptions. This is useful when creating a code table from scratch.
**Save:** Saves the Draw Field to Finish field code definition (.FLD) file.

**Save As:** Reacts the same as Save but allows for specification of file name and location to save to.

**Code Definitions**

**Edit:** If only one field code is selected, then this command opens the Edit Field Code Definition dialog box. If multiple field codes are selected (by holding down the control key or shift key and clicking on the rows), then the Multiple Set dialog box will open.

Field-to-Finish will layerize the points and linework according to the code definitions. If the layers to use are not already defined, Field-to-Finish will create the necessary layers and assign different colors. To have the same colors for these layers in all your drawings, define the layers in the prototype drawing. The prototype drawing is the default drawing that is loaded whenever a new drawing is created. To define layers in the prototype drawing, save your current drawing and then start a new drawing with the New command. Don't give the new drawing a name, just click OK. Then define the layers as desired with the *Layer* command. When you are done creating layers, use the
Save As command and change to Drawing Template (.DWT) under Save as Type. The default drawing template that is used is named 18SCDRAW.DWT. This template name will correspond to the version of AutoCAD that is being used, for example 16SCDRAW for AutoCAD 2004 users. You can overwrite this default template or make a new drawing template. If you make a new one, you may want to edit the Carlson icon to use the new one. To edit the icon, highlight the icon with one click and then click the right mouse button. Choose Properties and then Shortcut and change the drawing template name.

**Category:** This is an optional field that can be used to help organize your codes. A category is not used for processing and only is useful in viewing and printing.

**Processing ON:** This toggle controls whether this code will be processed.

**Sequence:** This specifies a sequence type code. Sequences are a way to simplify field entry of a sequence of codes. For example, a road cross-section could be SHD1 EP1 CL EP2 SHD2. Instead of entering these different descriptions, one sequence definition can store these descriptions in order. Then just the sequence code (such as RD) is used in the field. The cross-section can be shot in left to right then left right order, right to left then right to left order, or alternating left to right then right to left order. The alternating method is known as the Zorro style. The one restriction is that the shots always start from a right or left edge.

To set up a sequence, choose the Sequence toggle in the Edit Code dialog. Then pick the Define Code Sequence button. This brings up a dialog for entering the sequence codes in order. These sequence codes should be defined as normal codes somewhere else in the Draw Field to Finish code table (ie SHD as a 3D polyline). In the field, the one template code is used for all the cross-sections shots (ie RD for all the points). Then Draw Field to Finish will substitute this template code with the sequence codes (ie substitute RD with SHD).
Resulting points and linework showing Zorro style template

**Define Code Sequence:** This sets the code names that make up the sequence.

**Companion Codes:** This option allows different codes to connect when defined as line, polyline or 3d polyline. For example, a main line power pole code may be defined as PP while a service utility pole may be defined as UP. When processing Draw Field to Finish, it may be desired to connect all PP and UP codes together. This could be accomplished by defining a companion for UP as PP and a companion code for PP as UP. Each code needs to reference the other as a companion code.

**Code:** This is the key name that identifies the code and is matched with the field data descriptions. It is important to note that the * character, used in this field, is regarded as a wildcard or "match anything" code. For example, a field code definition with the code defined as TREE* will be used for any raw description of TREE. Raw descriptions of TREEA, TREE12, TREE, etc. will match the TREE code definition. This will always be the case unless there is a more specific code is found. For example is there was a code TREEA in the code definition file, then that code would be used instead of the TREE code.

**Full Name:** This is an optional field that describes the code for viewing.

**Layer:** The point and line work for the code will be created in this layer.

**Description:** This value is assigned to the point description attribute when the point is drawn. This description can be different than the field description. An additional description can be added to a point by entering it after a forward slash in the data description field.
Use Raw Description: This option turns off the Description field described above. Instead the points will be drawn with their original unprocessed descriptions.

Dual 3D Polyline Layer: Displays the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer name can be typed in this field.

Set 3D Layer: Sets the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer can be selected from the list or typed in at the bottom of the dialog box.

Set Linetype: Line work can be drawn in any of the special linetypes or with the linetype for the layer ("BY-LAYER"). The spacing and size of the special linetypes is determined by the AutoCAD LTSCALE system variable and by the field code settings Line Type Spacing Scaler and Line Type Text Scaler. The special linetype "hedge" is drawn with a user specified width. The special linetype "userdash" is drawn with user specified distances for the length of the dash and the length of the gap between dashes. You will be prompted for this information when you select that linetype.

Set Symbol: This is the point symbol for the code. To avoid drawing a symbol, use the Carlson symbol named SPT0.

Symbol Pts: For each code definition, the symbol insertion points can be defined with up to three points. To define the symbol insertion points, choose the Symbol Pts button in the Edit Code Definition dialog box. By default, the symbol insertion is defined by one point at the symbol center (0,0). A one point insertion definition can be used to insert a symbol offset from the center. With a two insertion point definitions, the program will rotate and scale the symbol. For example, two insertion points can be used to insert a tree symbol to size the tree, where the first point is for the tree center and the second is for the drip line. With three insertion point definitions, the program will rotate and scale the symbol in both X and Y. For example, three points can be used to insert a car symbol with the first point being the front drivers side, the second point as the back driver side (to rotate and scale the length) and the third as the back passenger side (to scale the width). Besides the insertion point coordinates, you can define a description for each point which is used for the drawn point description and is used for prompting in the Insert Multi-Point Symbol command and in Carlson Field data collection.
Three Point Symbol Drawing

The coordinates for the insertion point definitions are for the symbol at unit size. To figure these coordinates, you will need to open the symbol drawing (.DWG) file. By default, the symbols are located in the Carlson SUP directory. For example to make an insertion point for the tree drip line, open the tree symbol drawing and find the coordinate at the edge of the tree symbol (in this case 0.5,0.0).
Two Point Symbol Drawing

Not all of the symbol insertion points need to be used when drawing the points. If a code definition has a three insertion points, it is possible to use just the first two or first one. There are special codes to associate multiple points to the same symbol. The first code point is used as the first symbol insertion point. The "2ND" code is used to specify the second symbol insertion point. A point number can follow the "2ND" to identify a specific point. Otherwise without the point number, the program will use the next point with the current code. The "3RD" code is used to specify the third symbol insertion point and similar to the "2ND" code, a point number after the "3RD" is optional. The "2ND" and "3RD" codes should be assigned to the first point. For example, consider a code of "CAR" with a three point symbol insertion definition. If point #1 has a description of "CAR 2ND 3RD", then point #1 will be used as the first symbol insertion point and the next two points with the "CAR" description will be used as the second and third symbol insertion points.
Multi Point Symbol Drawing

**Custom Attributes:** This feature allows you to use customized blocks that have customized attributes (the tag/value pairs). This feature works for both point attribute blocks and symbols. For attribute blocks, Field-to-Finish looks for attributes with the tags "PT#", "ELEV2", and "DESC2". The custom attributes feature allows you to define up to an additional 5 attributes in their custom blocks on a per-field code basis. For example, the custom block could have an attribute with the tag "TREE_SPECIES" and there's a separate field code for each species of tree. Each of those field codes can specify the value that should be assigned to the attribute that has the TREE SPECIES tag. Then when the points are drawn, the tree species is shown. Note that the custom attributes must have their Constant and Preset properties set to "no". The custom attributes settings in F2F should not use those tags that the software already handles (PT#, ELEV2, and DESC2), or the setting will be ignored.

![Custom Attributes dialog box](image)

**Set Color:** The line work will be drawn in this color. The default is BYLAYER.

**Text Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size.
**Symbol Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size in AutoCAD. The horizontal scale can be set in *Drawing Setup*.

**Line Width:** This controls the width for the linework. Only applies to 2D polylines.

**Line Type Spacing Scaler:** This is a scaler value that is multiplied by the AutoCAD LTSCALE system variable to give the distance between symbols in the line.

**Line Type Text Scaler:** This is a scaler value that is multiplied by the AutoCAD LTSCALE system variable to give the size of the text in a line.

**Unit Symbol:** This option will draw the point symbol at unit (1:1) scale. For example, this option could be used for a symbol that is already drawn to actual dimensions such as a car symbol.

**Set Template:** For 3D polyline codes, this option allows you to assign a template (.TPL) file to the code. The code points act as the centerline for the template and the program will draw parallel 3D polylines for each break point (grade ID) in the template. The template file is defined in the Civil Design module.

**Entity Type:** This defines the line entity to be created. Points only does not create any line work. 3D Polyline can be used for breaklines. 3D and 2D entity type selection creates a 3d polyline in the layer specified in the Dual 3d polyline layer setting and a 2d polyline in the layer identified in the Layer setting. Since 3d polylines do not display linetypes, this is useful when needing linework in 3d for design work while also needing to display linetypes for final plotting of the drawing. This provides an easy and quick way to turn off all 2d polylines or all 3d polylines by using the layer control dialog or the appropriate toggles in the Draw Points dialog.

**Attribute Format:** This chooses the type of point entities to create. The Attribute Block format creates the Carlson point entity which is block with attributes for point#, elevation and description. The Text Attribute format creates text entities for each of the point attributes. When the Text Attribute format is selected, the Set button is available where you can control which attributes to draw as text and the position, decimals, style, prefix, suffix and layer for each attribute.

**Separate Attribute Layers:** This controls the layers of the point and symbol attributes. With "None" the point layers are the standard layers, "PNTNO", "PNTLEV" and "PNTDESC", and the symbol layer is "PNTMARK". With "Points" or "Both" the point attribute layers begin with the layer for the code followed by the attribute type. For example, the "DWL" code shown in this dialog has a layer name "DRIVEWAY". The point attributes would then be "DRIVEWAYNO", "DRIVEWAYELEV" and "DRIVEWAYDESC". With "Symbols" or "Both" the symbol attribute layer begins with the layer for the code followed by "MARK".
**Hard Breakline**: This will tag the 3D polylines created with this code as hard breaklines. In *Triangulate & Contour*, contours are not smoothed as they cross hard barriers.

**Smooth Polyline**: This applies a modified Bezier smoothing to the polyline. The smoothed polyline will pass through all the original points.

**Connection Order**: The points of a distinct code can be connected in their point number order or by nearest found which makes the line by adding the next closest point.

**Tie**: When checked the linework drawn with this code will always close. For example if you have points 1, 2, 3, and 4 with the code BLDG and Tie is checked on for the code BLDG, then the linework will be drawn from point 1 to 2 to 3 to 4 and then back to point 1, closing the figure.

**Elevation Integers**: This controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals**: This controls the display precision for the elevation label.

**Elevation Prefix/Suffix**: These set the prefix and suffix for the elevation label per code. In the Draw function under Additional Draw Settings, there is an override to set the elevation prefix/suffix for all the codes.

**Attribute Layout ID**: Controls the location of the point number, elevation and description. These attribute layouts are defined in AutoCAD drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Locate Pts on Real Z Axis**: This option will draw the points at the actual point elevation. Otherwise the points are drawn at zero elevation. For example, you could turn this option off for the FH for fire hydrant code to drawn them at zero. Then the GND code could have this option on to draw the ground shots at their elevations.

**Random Rotate**: This option will randomly rotate the symbol. For example, this option could be used for tree symbols to have the trees drawn in various orientations.

**Random to Line**: This option applies to points that are part of Field-to-Finish linework. This option will align the point attributes and symbol to the associated linework.

**Distinct Point Layer**: When this toggle is selected, the line work is created in the layer defined in the Layer field and the points are created in the specified distinct point layer. For example, you could have DRIVEWAY for linework and DRIVEWAY_PNT for the points.

**Code Definitions** (continued)

**Select All**: This option selects all the codes. This can be used when only wanting to process a couple of codes. For example, use the select all option to select all the codes and then turn them off. Now select the codes for processing and turn them on. Also it can be used to make a global change to all the codes.

**Add**: The new code definition is inserted in the list in the position after the currently selected one. If none are selected for positioning, the new code is placed at the top. Only one code definition may be highlighted before running this routine.

**Copy**: This option copies the definition of a selected code. It opens the Edit Field Code Definition dialog and copies the definition of the selected code to the appropriate settings. It does not copy the name of the code. It is a time saving tool to use when creating codes that are similar with only a couple of differences.

**Cut**: This command will remove the highlighted code definitions from the list and puts them in a buffer for retrieval with Paste.
**Paste:** This command will insert the code definitions put in the buffer by the Cut command. These codes will be inserted after the row of the currently highlighted code or at the top.

**Search:** Allows you to search for a specific code in the list.

**Coordinate File**

**Set CRD File:** This command allows you to specify a coordinate (.CRD,.CGC,.MDB,.ZAK) file to process.

**Edit Points:** This command opens the *Edit Points* spreadsheet editor. See *Edit Points* for more details.

**Draw:** This command returns to the Draw Field to Finish dialog box.

**PointCAD Coding**

Field-to-Finish supports an early Carlson style of linework coding called PointCAD. The PointCAD codes use numbers with +,-,* symbols as follows:

- +0 Starts a regular 2D line (not a polyline) that is open.
- *0 Starts a regular 2D line that is closed.
- +4 Starts a curved 2D polyline that is open.
- *4 Starts a curved 2D polyline that is closed.
- +1 Begins a 3-point arc.
- -0 or -1 or -3 or -4 or -5 or -6 or -7 Ends a line.
- +5 Starts a 3D polyline that is open.
- *5 Starts a 3D polyline that is closed.
- +6 Starts a 2D polyline that is open.
- *6 Starts a 2D polyline that is closed.
- +7 starts line whose type (2D line, 2D polyline, 3D polyline) is specified by the point’s field code definition. If the field code definition is to use points, then a 2D line is started.
- +2 Middle point of 3 point arc
- -05 starts a curved 3D polyline section.
- -50 ends a curved 3D polyline section.
- +8 starts a 2D and 3D polyline combination that is open.
- *8 starts a 2D and 3D polyline combination that is closed.
- -8 ends a 2D and 3D polyline combination.
- -08 starts a 2D and 3D polyline combination curve that is open.
- -80 reverts back to a straight 2D and 3D polyline combination.
PointCAD linework coding examples

**Pulldown Menu Location:** Survey

**Keyboard Command:** fld2fin

**Prerequisite:** A data file of points with descriptions

**File Names:** \\lsp\finish.arx, \\lsp\field.dcl, \\lsp\deffield.lsp

### 4 Sided Building

Often only two sides of a building are surveyed in the field. This routine completes the building by drawing the other two sides. *4 Sided Building* creates a parallelogram given two connecting lines, or given a polyline with two segments. With two lines, there is an option to make the parallelogram as a polyline or as four lines.

**Prompts**

**Options/<Pick a line or polyline>:** *pick a line*

Pick another side (Enter for none): *pick a line*

Convert the lines into a polyline [<Yes>/No]? *press Enter*

Options/<Pick a line or polyline>: *press Enter*

Entering O for options lets you choose whether or not to be prompted to set the new polyline width.
Inverse with Area

This command generates a report of the bearing and horizontal distance between a series of points, and calculates the area of the closed figure defined by the points. Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error. There is an option in Area Label Defaults to report the distances in both feet and meters. The area can be labeled in the drawing using the settings from the Area Label Defaults command. If you don't want to label the area, press Enter at the pick label point prompt. This command creates a polyline of the figure which can be erased or kept in the drawing.

Prompts

Station/<Pick Starting point or point number>: pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): R for radius
Radius point number or pick point: pick a point
Curve direction [Left/<Right>]: press Enter
Pick End of Arc or point number (U-Undo,Enter to end): pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): pick a point

Chapter 9. COGO Menu 340
Station/Polyline Centerline

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.
**Distance for Stations** is the primary interval for stationing.

**Distance for Intermediate Stations** is the intermediate interval for stationing.

**Beginning Station** is the beginning station of the centerline for stationing.

**Locate Even Stations** labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

**Locate Odd Stations** labels the non-interval stations at the polyline/centerline end points and PC and PT points.

**Locate User-Entered** prompts you for individual stations to label.

Without the **Increment Station Labels from Beginning Station** option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

**Label Deflection Angles** adds this annotation to the stationing. Settings for this are specified in the **Label Deflections Setup**, accessed by the **Deflections Setup** button.

![Deflections Setup dialog]

When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **Setup PC Lines** button accesses the **PC Lines Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the polyline/centerline.
Draw PC Lines controls whether lines are drawn from the PC and PT points.

When Label PC On Centerline is checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.

Draw PC Symbols controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the box to the right.

Label PC Radius controls whether this point is labeled.

Max Length controls the maximum length for the PC lines to be drawn described above.

Back in the main Station Polyline/Centerline dialog box:

Draw PI Lines draws a 2 segment polyline in both tangent directions from the PI as a marker for the PI.

When Label PI Stations is checked, the PI station is labeled at the PI point.

When Locate PI Points is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When Label Station Text is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection. Select it to configure the label settings as desired. Select the Marker Setup options to modify the size of the markers for certain types of stations. See definitions following the dialog box.
Label Setup

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.
- **Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.
- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.
- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.
- If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.
- **Label Intermediate Stations:** If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.
- **Station + at Tick Mark** labels the station text along the polyline with the '+' of the station text at the station's location on the polyline. See Marker Set up for marker size manipulation settings.
- **Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.
- Use **Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.
- Specify the **Position** of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option.
- **Align** determines the alignment of the station label, either left or centerline, centered along the centerline or...
to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The Marker Setup options control the size of markers for different station types as well as the layer the markers will be drawn on.

![Marker Setup dialog box]

Specify whether to define the Centerline By picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- Using a 2D Polyline will result in horizontal distance stationing along the polyline.
- Using a 3D Polyline will result in the slope distance stationing along the polyline.
- Using a CL File will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.

Use Station Type to specify the stationing format to use.

Use Type of Curves to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

Locate Centerline Points will locate points and store them in the current CooRDinate file.

Locate Radius Points will locate the radius points of any arc segments.

Starting Point Number determines the starting point number for the points to be located.

There are two ways to Set Elevations for the centerline points and offset points to be created.

- The 3D Polyline option gets the elevation of the point from a specified 3D Polyline within the drawing.
- The Profile option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.
• With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point.

**Description Prefix** is an optional user-specified prefix to be added to the point description.

**Description Suffix** is an optional user-specified suffix to be added to the point description.

When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

![Offset Setup](image)

• When **Use Slopes** is on, it makes available the Percent Slopes fields for defining the slope from centerline both right and left for determining the elevations of the offset points.

• Enter the desired **Offsets** left and right.

• Enter the desired **Percent Slopes** from centerline to the left and right offset points.

**Prompts**

**Station Polyline Dialog**

**Polyline should have been drawn in direction of increasing stations.**

**Select polyline that represents centerline:** select a polyline
Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Labels with Draw PI Lines, Label PI Stations and Locate PI Points all checked on

Labels using Centerline By 2D Polyline (Horizontal Station)

Labels using Centerline By 3D Polyline (Slope Station)

Keyboard Command: stapl

**Prerequisite:** A polyline or CL file

**File Name:** \lsp\staent.lsp

### Offsets Point Entry

This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.
The **Store Points to Coordinate File** option will store any points the current coordinate (.CRD) file. This includes centerline points and offset points.

When **Locate Points on Centerline** is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When **Label Stations & Offsets** is checked, the program will label the station-offset as the point description attribute.

When **Locate Intersection Points At Line Corners** is checked, the program will locate points along the centerline at the intersection points of selected lines with that of the centerline. This routine is to be used along with Locate Points on Centerline. This is a good option to use when the exact station of where the offset points are to be created is not known but is referenced by an existing line on the drawing.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use **Centerline from** to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use **Reference Elevation** to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. **Profile to 3D polyline** can be used to transfer the profile data to the polyline before calculating the final grade points.
**Cross Slope %**: This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in **Input Station-Offset from** will prompt for the station and offset distances. The Read File option will read the stations and offsets from a text file. The text file format is comma delimited with point number, station, offset and elevation. The station should be just the station number without the ‘+’ (i.e. 250 instead of 2+50). The elevation is optional. The Read File option is a quick routine to convert a station-offset data file into coordinates.

When **Offset Prompt** is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curve** to specify whether the curves are for a roadway or railroad.

**Prompts**

**Offset Point Settings Dialog**
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline to Station-Measure: *select a polyline*
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
Distance from beginning station along centerline (Enter to end): 110
Starting Segment Station: 0.0 Ending Segment Station: 228.633
Working Line segment...(5413.4 4879.64 0.0)
Left offset distance <10.0>: 15
Right offset distance <15.0>: 20
Distance from beginning station along centerline (Enter to end): press Enter

Keyboard Command: offpts
Prerequisite: A centerline (.CL) file, polyline, or two points
File Name: \lsp\offpnts.lsp

**Calculate Offsets**

This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example).
Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

Maximum Offset to Calc: This is the maximum distance from the Centerline for which offsets are calculated.

Report Offsets Ahead/Behind Centerline: When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

Label Station and Offsets: When checked, the station offsets will be labeled in the drawing.

Sort Report by Stations: When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

Report Point Coordinates: When checked, this option will include the point northing and easting in the report.

Report Point Notes: When checked point notes will be included on the calculate offset report.

Create Point Notes: When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

Use Report Formatter: When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft® Excel or Microsoft® Access. You must check this option on in order to use the Report Grade Elevation From option.

Round Stations: When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.
**Store Station Text to CRD File:** When checked, the station offset text is appended to point numbers that are selected.

**Report Grade Elevation From:** When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

**Define Centerline by:** Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

**Station Type:** Specify the stationing format to use.

**Decimals:** Specify the display precision for the stations and offsets.

**Type of Curve:** Specify whether the curves are for a roadway or railroad.

**Prompts**

**Calculate Offset Settings Dialog**
Polylines should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
PtNo. North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00
Station on Line>
1+10.00 Offset> 10.00 Left
PtNo. North(y) East(x) Elev(z) Description
141 4870.15 5416.55 0.00 1+10.00R10.00
Station on Line>
1+10.00 Offset> 10.00 Right
+ before station denotes point is ahead of line segment, - denotes beyond.
Pick point or point numbers (Enter to End): 22-28

<table>
<thead>
<tr>
<th>Station</th>
<th>Offset</th>
<th>Description</th>
<th>Elev</th>
<th>Pt#</th>
<th>North</th>
<th>East</th>
</tr>
</thead>
<tbody>
<tr>
<td>4+95.89L</td>
<td>15.48</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>22</td>
<td>4811.00</td>
<td>4454.00</td>
</tr>
<tr>
<td>5+78.43L</td>
<td>58.18</td>
<td>Power Pole</td>
<td>0.00</td>
<td>23</td>
<td>4839.00</td>
<td>4548.00</td>
</tr>
<tr>
<td>6+77.26L</td>
<td>57.28</td>
<td>Power Pole</td>
<td>0.00</td>
<td>24</td>
<td>4868.00</td>
<td>4656.00</td>
</tr>
<tr>
<td>9+01.55R</td>
<td>16.81</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>25</td>
<td>4745.00</td>
<td>4887.00</td>
</tr>
<tr>
<td>10+50.51L</td>
<td>25.39</td>
<td>Traffic Sign</td>
<td>0.00</td>
<td>27</td>
<td>4872.00</td>
<td>5043.00</td>
</tr>
<tr>
<td>4+03.48R</td>
<td>22.15</td>
<td>Light Pole</td>
<td>0.00</td>
<td>28</td>
<td>4657.00</td>
<td>4454.00</td>
</tr>
</tbody>
</table>

Pick point or point numbers (Enter to End): press Enter

**Keyboard Command:** calcoff

**Prerequisite:** A centerline (.CL) file, polyline or two points

**File Name:** \sp\pstaoff.lsp

**Cut Sheet Spreadsheet Editor**

This command edits and reports cut sheet data that is stored in an Excel (.xls) file. To create this data with Field stakeout routines, the option to Store Cutsheet Data In Spreadsheet must be set active in Configure Field-Stakeout Settings.
Cut Sheet Report

This command creates a report of the elevation difference between points and a design elevation which can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported, if a centerline is specified.

Note the Report Formatter option in the dialog box below. This option can be used to customize the report layout, and to output the report data to Microsoft® Excel or Microsoft® Access. The standard report can be formatted to allow for the Cut/Fill difference to be reported in Feet-Inches, and for user specified decimal place setting for X/Y and Z values. These options are available from the main Cut Sheet Report dialog box shown here.
The **Points** option reports the horizontal distance and cut/fill between two points. The points to compare can be in the same coordinate (.CRD) file or separate files. The Output Options for the cut sheet report include **Bearing-Distance** which reports the bearing and distance difference, if any, between the points selected. The **DeltaX-DeltaY** reports and labels positional difference of the reference and selected points in x, y values. The same can be said of the **North-South-East-West** option. This option will report the positional difference of reference and selected points to compare but will label the differences as either North-South-East-West. With the None option selected only cut/fill values will be reported. If the Report Coordinates option is checked, the coordinate values of the points will be shown on the cut sheet report.

When comparing points in the same file, the Points to Compare dialog appears as shown below. The goal in this dialog is to establish in the upper window all the point pairings that you wish to compare for the cutsheet.
The selection of the points to compare is accomplished in 4 ways:

1) By manually specifying what points are to be compared by picking the survey and design points and then pressing the add button to add them to the selected points field at the top of the dialog. This allows for the assigning of multiple design points to the same survey point if needed. With this method each pair is selected and added individually to the list.

2) By specifying a range of survey and design points to be compared. This is accomplished by entering in the range of points in the Survey Range of Points field and the Design Range of Points field and then pressing add. With this option the points will be compared sequentially for each range. For example, if points 2000-2004 made up the survey range, and points 2001-2005 made up the design range, point 2000 will be compared with point 2001 and so on.

3) By point group. This option will compare the points of the defined survey group with that of the defined design group. The points will be compared sequentially in the same manner as comparing ranges of points described in item 2 above. Once the groups are specified, press the add button to verify the selection of the groups. If points in the coordinate file have been categorized by groups to define surveyed and design surfaces, this option makes it very quick to calculate cut and fill data.

4) By matching points that are within a distance tolerance from each other, using Match by Tolerance. This option can be a time-saver, particularly when office personnel are not familiar with the pairings to analyze. When comparing points, there is an option to flag points in the report that exceed the specified distance tolerance.
The pairs, ranges or group of points to compare can be saved for later recall and further cut/fill analysis by selecting the Save button. The file to be saved will have a prf extension. To recall a comparison set of points for a cut sheet report press the Load button and specify the desired *.prf file.

For the separate file option, the point numbers are used to match points between the files. If point numbers are missing in the comparison (e.g. points 1 to 3 in the current coordinate (.CRD) file are being compared to points 1 and 3 in the design coordinate (.CRD) file), then there is an option for reporting the missing points, as seen in the Compare Points dialog.

When using a 3D Polyline for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values. For Grid and Triangulation surface files, the design elevation is determined by the elevation of the surface file at the point selected. With Section Files, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

The Note File option reads the grade elevation from the note (.NOT) file that is associated with the current coordinate file. For example, if the current coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software’s data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can
display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET_X, TARGET_Y, TARGET_Z, TARGET_DESC, TARGET_PT, STATION, OFFSET, VOFF1 and VOFF2.

The Runway Clearance option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.

The Template Design option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. Grade to Process is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in Cut Sheet is similar to the Process Road Design command.
If the Station-Offset method is selected as an Input Method, then only the final grade elevations are produced in the report. This is useful for writing final grades on the stakes prior to taking field shots. You are first prompted for the desired offset and starting station, as shown in the Station Offset dialog. Specify left offsets with the negative sign (-).
After filling out the Station-Offset dialog with the desired information, selecting the OK button will result in the following report showing only the final grade elevations of the specified station-offsets.

Examples of Cut Sheet reports comparing points are shown next.
Example 1: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.

Example 2: Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points.

Example 3: Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.
4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.

Pulldown Menu Location: Survey
Keyboard Command: cutrprt
Prerequisite: A coordinate (.CRD) file
File Name: \lsp\cutrprt.lsp
Shown here is the Field menu. There are many commands listed here for your field control.
Carlson Field Icon Menu

Function

The Carlson Field Icon Menu lets you select Carlson Field functions by pressing a function key F1-F10 or by picking the icon button. The set of commands that are available in this menu depends on the type of survey equipment that you are configured to. Before running these Carlson Field functions, you need to run Configure Field to set the equipment type and communication parameters.

There are two ways to bring up the icon menu. One way is by picking the Start Carlson Field icon. This start icon is displayed in the lower right of your screen when the Show Startup Icon option is on as set in Configure Field under General Settings. You can close the Start Carlson Field icon for the current drawing session by clicking the X in the icon title bar. To bring back the Start Carlson Field icon you can use the F11 key. The Start Carlson Field icon is only displayed when no commands are running. The other way to show the Carlson Field function menu is to pick the Menu(F11) button while running other Carlson Field commands. This method allows you to switch between Carlson Field functions without having to exit back to the CAD menu. For example, you can switch from Point Store directly to Stakeout.
Configure Field

This command sets the equipment type, communication parameters and other Carlson Field options. Make sure the Equipment Type box shows the correct GPS or Total Station equipment that you'll be using. The down triangle button to the right of this box brings up a list of the equipment types to choose from. The eight buttons in Configure bring up the dialog boxes which are used to change Carlson Field's default settings. Explanations for each are shown below.

### General Settings

If you are using a total station, Rod Height is the distance from the prism to the ground. For GPS, Rod Height is the distance from the center of the GPS antenna to the ground.

The Show Carlson Field Startup Icon controls whether the Carlson Field Startup Icon is displayed in the lower right of the screen. This startup icon brings up the Carlson Field function menu for launching Carlson Field commands without having to pick them from the pull-down menu.

The Use Bold Font toggles between using standard or bold font for the Carlson Field dialogs.

The Twist Screen In Direction Of Movement will rotate the drawing view so that your current direction of movement is facing straight up in the view. This rotate is for the view only and does not change the coordinates. This option only applies to GPS and robotic total stations in commands that show the arrow icon such as Track Position.

The Station Type chooses the format of centerline station labels. Typically 1+00 is used for feet units, 1+000 is used for metric and 100 has no plus symbol in the number.

Serial COM Port - The GPS receiver or total station attaches to your Carlson Field computer using a serial cable. This cable is plugged into a serial COM port on your computer called 1, 2, 3 or 4. Check the circle denoting the COM Port to be used.

The Baud Rate, Parity, Char Length and Stop Bits are the serial port communication parameters for the Carlson Field computer. These parameters need to match the parameters on the instrument that you are using. The Defaults button will set these communication parameters to the standard parameters for the current equipment type.
GPS Settings

The RMS Tolerance checks the RMS values when reading GPS positions. The RMS is the accuracy value reported by the GPS receiver. There are separate settings for the horizontal and vertical RMS values. The RMS (root mean squared) value means that the reported coordinate is within +/- the RMS value of the true coordinate to a certain confidence level. The confidence level depends on the GPS receiver. Typically it is a 98% confidence. If either RMS value exceeds the user-defined tolerance while storing points, Carlson Field will default to "No" when it asks if you want to store the point. You are required to choose yes to override the tolerance check and store the point.

Suggestion: When GPS RTK systems lose lock and go "Float", both the horizontal and vertical RMS values typically jump up to sub-meter (1' or higher) values. In Carlson Field, one foot is the default for the GPS RMS Tolerance. Some operators set the GPS RMS Tolerance low to 0.2 to check for high RMS values while still "Fixed".

Store Fixed Only - The position of the GPS rover is considered either "Autonomous", "Float" or "Fixed" based on the solution status from the GPS base corrections. When you are storing points and the Store Fixed Only box is checked, Carlson Field will only store points if your position is "Fixed". We suggest you leave this box checked. It ensures that you do not record inaccurate points.
Suggestion: When walking in light to heavy canopy, the rover might remain "Float" and display RMS accuracies of over a foot, sub-meter or more. Setting your GPS RMS Tolerance high and turning off Store Fixed Only will allow storing wetland and LOD (limits of disturbance) points under canopy that require only sub-meter tolerances. (USCG beacon DGPS sub-meter RTK GPS will always use these settings.)

**Projection Type** - defines the datum coordinate system to be used for converting the latitude/longitude from the GPS receiver into cartesian coordinates. For the United States two separate horizontal control systems have been developed by the Federal Government: State Plane 1927 and State Plane 1983. For international use the UTM (Universal Transverse and Mercator System) should be selected. The Lat/Lon option will convert the latitude/longitude from degrees minutes seconds format into decimal degrees. This option is useful when working in a decimal degrees lat/lon coordinate system.

**Zone** - For State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

Important: Coordinates of surveyed points will be inaccurate if the Projection Type and Zone settings are wrong. If you have done survey work and then realize that they are set wrong, then your point coordinates are wrong, but your work is not wasted. Carlson Field records the latitude, longitude and height of every point in a *.RW5 file. You can input the correct projection zone settings later and reprocess your data using the Edit-Process Raw File command.

**Model** - For UTM, this option sets the ellipsoid constants for converting the lat/lon to UTM coordinates. The following is a list of the models:

**Model Earth Radius(m) Flattening factor**
Airy 1830 6377563.396 0.00334085064038
Modified Airy 6377340.189 0.00334085064038
Bessel 1841 6377397.155 0.00334277318217
Clarke 1866 ellipsoid 6378206.4 0.00339007530409
Clarke 1880 6378249.145 0.00340756137870
Everest (EA-India 1830) 6377276.345 0.00332449299666
Everest (EB - Brunei & E.Malaysia) 6377298.556 0.00332449299666
Everest (ED - W.Malaysia & Singapore) 6377304.063 0.00332449299666
International 1924 6378388.0 0.00336700336700
Helmert 1906 6378200.0 0.00335232986926
Hough 1960 6378270.0 0.00336700336700
Geodetic Reference System 1980 6378137.0 0.00335281068118
South American 1969 and Australian National 6378160.0 0.00335289186924
World Geodetic System 1972 6378135.0 0.00335277945417
World Geodetic System 1984 6378137.0 0.00335281066475

Transformation - The transformation in the Align Local Coordinates command can either be by plane similarity or rigid body methods. Both methods use a best-fit least squares transformation. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale. The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates.

One Pt Align Azimuth - This option applies to the rotation when using one point in Align Local Coordinates. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

Two Point Align Method - This option applies only two point alignments. Possible values are Fit & Rotate and Rotate Only. Fit & Rotate (the default) will use the second alignment point for rotation, translation, and scale (depending on the value set for Transformation). The Rotate Only option will use the second point of a two point alignment for rotation only.

Geoid To Apply - This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the National Geodetic Survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (Eo), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This correction is the geoid undulation (Ug). The formula is He=Eo + Ug.

The Geoid models are essentially large elevation difference models in grid format. Carlson Field has two geoid models available. Geoid99 covers the United States at 1 minute grid intervals. EGM96 covers the entire globe at 15 minute intervals. These Geoid models are huge and take a lot of disk space and memory. The Geoid model files are not installed automatically and instead need to be installed by going to the Geoid folder on the Carlson Field installation CD. Once installed onto Carlson Field, you then need to specify your location by lat/lon so that the program only needs to load a local portion of the Geoid model. To set your local Geoid area, pick the Set Geoid Area button. Setting the Geoid area will carve out a Geoid model around the specified lat/lon covering a square area of 2 degrees by 2 degrees which is about 100 miles by 100 miles.

Carlson Field applies the Geoid model by subtracting the Geoid undulation from the GPS elevation.

The resulting elevation is then used and displayed. In the Monitor function, the Geoid undulation is displayed.

In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a known point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson Field can model the elevation difference which can generally pick up the local Geoid undulation.
**Project Scale Factor** - After converting the LAT/LONG from the GPS to the state plane coordinates and applying the Align Local Coordinates, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X,Y and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in Align Local Coordinates. If there are no points specified in Align Local Coordinates, then 0,0 is used as base point. The Project Scale Factor can be entered directly or calculated using the grid factor and elevation for the current position. When using the current position, the program will read the LAT/LONG from the GPS receiver. The scale factor is then calculated as: (State Plane Grid Factor - (Elevation/Earth Radius)).

**Default Alignment** - This option sets the alignment file to use by default for new drawings. This feature applies when you will keep working at the same site with the same base receiver setup.

**Helmert 7-Parameter Transformation** - These settings apply when the Transformation is set to Helmert. The Helmert 7-parameters can either be calculated by the program using the control points in the localization or user-entered.

**Laser Offset Settings** - There is an option to use a laser for reading the distance and angle for offset points. When this option is enabled, you can choose the laser equipment type and communication parameters. The serial port for the laser must be different than the GPS which requires at least two serial ports on the computer. When using a laser for offsets, the program will read the current position from the GPS and then read the laser for the distance and angle to the point. This combination allows you to calculate points that cannot be directly reached by the GPS. There are two methods in the Point Store command to use the laser when this option is enabled. The Point Store dialog will have a new Laser button which will bring up another dialog that allows you to take multiple shots from the laser. The other method is to click on the Offset toggle in the Point Store dialog. Then when you do the Read function, the program will read the GPS position and then pop-up a dialog for taking one offset shot.

**Point Settings**

**Beep for Store Point** - This option will make a triple beep to indicate when a point is stored in the coordinate file.

**User-Entered Point Notes** - Point Notes are additional descriptions that can be stored with a point. A regular point consists of a point number, northing, easting, elevation and 32 character description. These points are stored in a .CRD file. Point Notes are a way to add an unlimited number of lines of text to a point number. With Point Notes ON in the Store Point command, the program will prompt for notes after collecting a point. The notes are stored in a file that uses the name of the coordinate file with a .NOT extension. For example, a coordinate file called JOB5.CRD would have a note file called JOB5.NOT.
Coordinates in Point Notes - When storing a point, this option will store the point number, northing, easting, elevation and description in the point notes as well. This may be used as a backup or reference to coordinate data as it was originally stored.

GPS RMS in Point Notes - When storing a point, this option will store the horizontal and vertical RMS values in the note field for the point. This offers a good check on the quality of the shot.

GPS DOPs in Point Notes - When storing a point, this option will store the DOP (dilution of precision) values as reported from the GPS receiver.

Rod Height in Point Notes - When storing a point, this option will store the rod height value in the note field for the point.

Project Scaler in Point Notes - When storing a point, this option will store the project scale factor in the note field for the point.

Time/Date in Point Notes - This option will store the time and date that the point was stored in the note file. Carlson Field will read the time from the computer.

Drawing Options control how points are drawn by default. It controls the layer, symbol number and whether points will be drawn with descriptions and elevations. Carlson Field's Field to Finish code table can override these defaults.

The symbol used for default points is displayed. You can choose another symbol by changing the Symbol name or by selecting one from the table that the Select Symbol button brings up. Default point settings are used for points whose descriptions don't correspond to any category on the Field to Finish code table.

Label Descriptions and Label Elevations Control whether these two items of information appear on your drawing next to each point.

Locate on Real Z Axis will record points with their true elevations. If this setting is off, all points recorded will have an elevation of zero.

Layer for Points indicates the layer where all default points will be drawn. For points using a code on the code table, the code table will determine their layer.
Number of Readings specifies how many times Carlson Field will read from the instrument in the Read function of the Point Store command. This applies to both GPS and total stations. The readings will be averaged to find a more accurate position.

Direct-Reverse Tolerances are used with total stations to check the pairs of direct and reverse horizontal angles, vertical angles and distances. When these values are off by more than the tolerance, the program will display a warning.

Field to Finish is explained fully in the Field to Finish command definition. Basically it uses a code table which holds information on types of points (ie. Man Hole or Edge of Pavement). When the settings Use Code Table...For Symbols, For Layers and For Descriptions are selected, Carlson Field will look to the code table for how to draw points of a particular code description.

The file containing the active code table appears after Code File: You can change this with the button Select File.

The Split Multiple Codes option will draw multiple points from the same point when that point description has multiple codes. For example, a point with description "EP DR" will draw the point twice: once with the properties of code EP and a second time using code DR. When this option is off, the program will use the first code and draw the point once.

The Check Descriptions With Code Table option will display a warning before storing a point if that point description is not found in the code table. With this option off, the program will go ahead and store the point and the point will be drawn using the default point properties.

Stakeout Settings
Display GPS RMS in Stakeout causes Carlson Field to report the constantly updating horizontal RMS accuracy values while staking a point. The only disadvantage to having this option active is that it slows down a little the stakeout position update.

Draw Trail displays a line in the stakeout screen showing where you've been as you move towards the stakeout point. This option only applies to GPS.

Auto Zoom will zoom the drawing display in or out so that both your current position and stakeout target are visible on the screen.

Zero Horizontal Angle To Target will set the horizontal angle of the total station to zero in the direction towards the stakeout point. When stakeout is completed, the horizontal angle is set back to the original value. This option only applies to total stations.

Store Cutsheet/Stakeout Data in Note File will store stakeout data in the note file (.NOT) for the current coordinate file. At the end of staking out a point, there is an option to store the staked coordinates in the current coordinate file. This stakeout note file option allows you to store more stakeout data in addition to the staked coordinates. This additional data includes the target coordinates and horizontal and vertical difference between the staked and target points. This stakeout note data can be used in reports with the List Points or CutSheet Report commands.

Store Cutsheet/Stakeout Data in Excel Spreadsheet will display a cutsheet report in an Excel spreadsheet. The spreadsheet will pop-up at the end of each point stakeout. The report can be saved in Excel format and processed by Excel.

Store Stakeout Points To Separate Coordinate File will store the staked points to a different coordinate file besides the current coordinate file. This allows you to use the same point number for the target and staked points. The staked point coordinate file can be specified by picking the Select Coordinate File button.

Check Total Station Turn Angle will compare the angle from the instrument and the angle to the target point. If this difference is greater than the specified tolerance, then Carlson Field will display a warning message.

Stakeout Tolerance controls the maximum difference between the target location and actual staked point. When the staked point is beyond the tolerance, Carlson Field displays a warning dialog.
GPS Number of Reads for Final Avg specifies how many times Carlson Field will read the GPS receiver position for the final staked point. These readings are averaged. Averaging several readings while occupying one point yields a more accurate result, but inevitably takes longer.

**Total Station Scale Settings**

These settings apply only to total stations. The Project Scale Factor is multiplied by the measured distance from the total station when calculating the foresight point coordinates. A typical project scale factor for working in state plane coordinates is slightly less than one. Factors greater than 2.0 or less than 0.5 are not allowed. The Project Scale Factor can be entered directly or choose the Calculate button. The Calculate function takes a state plane coordinate and calculates the project scale factor as the state plane grid factor minus the elevation factor (Grid Factor - elevation/earth radius). The state plane coordinate is specified by a point number from the current coordinate file.

The Calculate State Plane Scale Factor At Each Setup option will calculate the scale factor for each shot as the combined grid and elevation factors (see above equation). The scale factor is calculated at both the occupied and foresight points and then averaged. To use this option, you must be working in state plane coordinates and set the state plane zone in this dialog.

The Correct For Earth Curvature option adjusts the horizontal distance and vertical difference to the foresight point to account for the earth curvature.
Depth Sounder Settings

Carlson Field can use depth sounders in combination with GPS to collect points of underwater surfaces. Carlson Field supports depth sounders that output standard NMEA data, the Odom Digitrace model and the Hydrotrac model. For the Odom Digitrace, you also need to specify the depth unit mode that the instrument is set to.

The depth sounder must be connected to a separate serial port than the GPS. The Baud Rate between the computer serial port and the depth sounder is also specified here. The Store Depth In Notes option will record the water depth in the current note file (.NOT) when a point is stored to the coordinate file. The Debug number can be used when contacting technical support if the depth sounder is not communicating to Carlson Field.

Elevation Difference Settings

These setting apply to the Elevation Difference command. Grading Tolerance is the target difference between the actual elevation and the design surface. Carlson Field can use an external Light Bar to indicate whether your current position is in cut, fill or on-grade. Currently Carlson Field supports light bars made by Apache and Mikrofyn. The
Light Bar must be connected to a separate serial port than the GPS.

GIS Settings

A standard point is stored in the coordinate file with a maximum 32 character description. The GIS Settings allow you to store more data with each point.

The Store Data In Note File option will record additional fields for each point in the note file. The note file has the same name as the current coordinate file except with a .NOT instead of .CRD file extension. The fields that are recorded are defined by the GIS File (.GIS). This file defines a sequence of field names and prompts. For example, a GIS file for manholes could contain Location, Depth and Condition fields. Choose the Select File button to choose the GIS file to use. Or use the Select GIS File Automatically by Point Description to use different GIS files depending on the point description. With this option, the program will look for a GIS file with the same name as the point description. For example, if the point description is MH, then the GIS file will be MH.GIS. See the Define Note File Prompts command for more information.

The Store Data Direct To Database option will store additional fields for each point in a Microsoft Access database. The database to store the data is set in the Output File line. The Template File is a database that defines the fields to record. See the Define Template Database command for more information.
Equipment Setup

Function with Total Stations

Selecting the Equipment Setup command will send the user directly to a settings window that corresponds with the instrument selected in Configure Field. Equipment Setup for total stations will be discussed first, followed by GPS equipment.

This function for Total Stations lets you tell Carlson Field how you have positioned your total station. The setup information in this command is required before taking shots. Besides running this command from the Field pull-down menu, you can also reach this command with the Setup(F3) button from many of the other Carlson Field functions.

*Occupied Point* refers to the point your total station is setup on. This point is defined by a point number that references the current coordinate file. The coordinates and description of this point are displayed below the point number. The *List* button will bring up a list of the points in the coordinate file which you can review or select from. If the coordinates for the occupied point are not yet in the coordinate file, then you can pick the *Create Point* button to enter these coordinates.

The backsight can reference either a point or an azimuth. *Backsight Point* is only used if *Point Number* is selected as your *Backsight Method*. If you want to use an azimuth instead of a backsight point, select the *Azimuth* toggle and specify the azimuth in the *Bksight Azi* box.

Set the *Instrument Height* and *Rod Height*. These values will use whatever units your drawing uses: feet or meters. Carlson Field expects the instrument to have the horizontal angle zeroed on the backsight. Part of the station setup procedure needs to include zeroing the instrument on the backsight. To do this, first specify the occupy point and backsight in this dialog. Then orient the instrument to the backsight and pick *Zero Hz* to zero the gun.

![Total Station Setup Window](image)

The *BS Check* button runs a backsight check. The program will take a shot and compare the calculated point to the expected backsight point and report the results to you. This will help you establish if the point you are using as the backsight point is really the point that you think it is. For some robotic total stations, the Backsight Check routine has an option to automatically turn the instrument to the backsight. Then after the check is done, the instrument
can be automatically turned back to the previous direction. The purpose of this auto turn is to speed up the steps to
check the backsight in the middle of surveying points in a different direction.

For some types of total stations, the Total Station Setup dialog will also contain different options that are specific to
that type of total station.

**Geodimeter Total Station Setup**

The three methods of connecting to the Geodimeter include: *Station, RPU* and *GeoRadio*. The Station option is
for connecting directly to the instrument. The RPU is a remote control panel. The GeoRadio is a radio for remote
control of the instrument. For the GeoRadio, the *Station Address* and *Remote Address* set the radio addresses and
the *Radio Channel* sets the radio channel.

<table>
<thead>
<tr>
<th>Total Station Setup</th>
<th>Backsight Point</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Occupied Point</strong></td>
<td><strong>Backsight Point</strong></td>
</tr>
<tr>
<td>North: 2035000.000</td>
<td>North: 2035000.000</td>
</tr>
<tr>
<td>Easting: 1095000.000</td>
<td>Easting: 1095000.000</td>
</tr>
<tr>
<td>Elevation: 108.000</td>
<td>Elevation: 108.000</td>
</tr>
</tbody>
</table>

The intensity of the instrument Tracklight can be set to Off, Low or High.

The Geodimeter *On* and *Off* buttons are for putting the instrument in sleep mode to save power.

There are four different read methods. STD mode has a 3.5 second measurement time for each point. It is usually
used when a normal degree of angle and distance accuracy is required. TRK mode uses automatic, measured values
that are updated 0.4 seconds after making a contact with the prism. Rep STD mode measures distance automatically
every 4 seconds. Fast STD mode measures distance in 1.3 seconds. It is used when the demands on precision are
low.

**Leica Total Station Setup**

The *Connection Mode* chooses between connecting Carlson Field directly to the instrument or to a radio for remote
control.

The *EDM Mode* sets the instrument distance measurement mode for standard shots. All the possible modes are listed
in this dialog including tracking and reflectorless. Be sure to choose a mode that is supported by your instrument.
When using the reflectorless mode, the Rod Height should typically be set to zero. When tracking is selected
in Carlson Field functions, the program will automatically put the instrument in IR Rapid Tracking mode during tracking and then return to the specified EDM Mode when tracking is done.

The intensity of the instrument *Tracklight* can be set to Off, Low, Medium or High.

---

### Topcon 800 Remote Total Station Setup

The *Radio Type* can either be Satel 3AS, Satel 2AS or Other. With Other, Carlson Field does not send any radio setup commands. So these radios must be configured before running Carlson Field. For the Satel 3AS radios, you can set the radio frequency by Channel ID or by manually typing a frequency between 468.5 and 470.5.

The *EDM Mode* sets the instrument distance measurement mode for standard shots. When tracking is selected in Carlson Field functions, the program will automatically put the instrument in Coarse mode during tracking and then return to the specified EDM Mode when tracking is done.

*Wait Time* is switched on when the instrument cannot track a prism due to an obstruction. If after the wait time have elapsed the instrument does not switch back to tracking mode, then searching mode is set.

*Vertical range and Horizontal range* set the search area. Vertical range can be anywhere from 0-90 degrees, and horizontal range can be anywhere from 0-180 degrees.

*Track Indicator On* if checked turns on the light which is mounted below the telescope.

*Joystick Speed* sets the instrument turning speed from the arrow keys in Robotic control.

---

![Topcon 800 Remote Total Station Setup](image_url)
Equipment Setup with GPS

Carlson Field works with the following RTK GPS manufacturers: Ashtech, Javad, Leica, Novatel, Sokkia and Trimble. Each RTK GPS brand has its own GPS Setup control window. To get the window which matches the GPS equipment you are using, go to Configure Field and under the Equipment Type pulldown menu select the correct equipment. A brief explanation is given below for each brand's controls.

For RTK (real-time kinematic) GPS work, the base sends GPS corrections to the rover. To setup a base receiver, you should attach the computer running Carlson Field to the base receiver and run the Equipment Setup. After this is done and the base is outputting corrections, you should detach the base receiver and attach the rover receiver and do Equipment Setup again.

If your base radio has a TX light, it should be flashing while it's sending out corrections. This is a convenient way to tell if the base is configured.

Ashtech GPS Setup

The *Ashtech Type* specifies the model of Ashtech equipment to be used. Carlson Field works with the following Ashtech high precision, centimeter accurate RTK GPS equipment: Z12/Sensor, Z-Surveyor, GG24 and Z-Extreme. Carlson Field also works with the Ashtech Reliance USCG/DGPS RTCM sub-meter RTK GPS receivers.
The previous Ashtech Control settings are default. Changing these settings will change the internal settings of the Ashtech receiver.

**Ashtech Data Port** is the port on the GPS receiver where the Carlson Field computer is connected, usually Port A.

**Ashtech Radio Port** is the port on the receiver where the radio modem is connected, usually Port B.

**Message Type** for high precision centimeter RTK GPS set message type to Ashtech (CPD). If you are using the USCG/RTCM DGPS message type for sub-meter accuracy then set the message type to RTCM (USCG).

**Multipath Type** is used to filter out interference in the satellite signals caused by nearby objects. The choices are No Multipath, Low: Open Field, Medium: Default, High: Building and Severe: Forest, Urban.

**Dynamics** settings are Static, Quasistatic, Walking and Automobile. Static is selected only when the Rover receiver is stationary. The default is Walking.

**Elevation Mask** is the cutoff vertical angle above the horizon. Any satellites below this angle will be left out of calculations.

**Site Name** and **Record Interval** are all setting for post processing use only, not for use with RTK GPS. Site Name is the Point ID name for post processing. Record Interval is the epoch interval to record post processing information. RTK GPS updates every second but post processing epochs are usually 5, 10, 15, 20 or 30 second intervals.

**Ambiguity Fixing Parameter (90 - 99.9):** controls the confidence level of fixed positions. The default is 99.0. At a lower confidence interval the system solves much faster. If the system incorrectly solves the position, then the position error will be much greater than the reported RMS value.

**Position Update Rate** is the frequency that GPS positions are calculated and reported.

**Fast CPD** is a toggle On or Off. Fast CPD toggled On will allow approximating the rover's position if your position is lost briefly. Off is the default. Fast CPD is generally toggled on when Dynamics is set to Automobile.

When Carlson Field functions start, the program uses the settings specified in Equipment Setup to configure the GPS receiver. The **Save Settings to Receiver** uploads the settings in the Carlson Field dialog to the receiver so that the next time the receiver is turned on these settings are still set even without connecting to Carlson Field. Otherwise,
Carlson Field must be connected to the receiver to setup these options. 

*Send Command to Receiver* allows experienced users to type in commands using Ashtech GPS receiver commands to set or report internal settings. (See the Ashtech operations manuals for a complete list of Ashtech GPS receiver commands.)

*Reset Sensor Memory* will reset the receiver memory, reinitialize the communications ports and reset the modem. Saved settings on the receiver will be returned to their default values.

*Radio Baud Rate* allows you to change Pacific Crest radio baud settings through the receiver. The default baud rate is 9600. (Note: If there are communication problems with either port A or B on the Ashtech ZSurveyor receiver, turn off receiver and turn it back on with both keys depressed to reset receiver to factory defaults.)

For the Z-Extreme, the *Configure Internal Radio* button allows you to change the radio channel and settings. This function will attempt to establish a connection with the internal radio, reporting an error if it is unable to do so. Otherwise, it will open a dialog which will display the current radio channel as well as the valid range of radio channels. Enter the desired radio channel in the edit box and then click on "Program Radio" to set the changes to the radio. Carlson Field will communicate with the radio for a few seconds, and will then request that you power the receiver down, then turn it on again before continuing. It is very important that this is done, or else Carlson Field will be unable to communicate with the ZExtreme. Also note that if the programming of the radio is canceled for any reason, the receiver will still need to be powered down, then powered up again in order for Carlson Field to be able to communicate with it.

*Create Base REF File* takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

*Configure Base Station* initiates the receiver connected to Carlson Field to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

### Topcon GNSS/Javad GPS Setup

*Radio Port* on the Javad base and rover receiver is usually C. Data Port is always A. When using Pacific Crest radios, Javad recommends the new PDL Pacific Crest radios. These must be set to 38,400 baud rate. Javad also uses Spread Spectrum radios which work at 119,200 baud rate.

*Receiver Model* selects between Legacy, Odyssey and Regency. Currently the Receiver Model does not effect the Carlson Field interface except to determine the default Antenna Type.

*Position Update Rate* sets the frequency that the receiver calculates and reports position. The faster rates are an option that must be purchased for the receiver.

*Antenna Type* chooses between an internal and external GPS antennas. This option applies to receivers with built-in antennas.

The *RTK Message Type* determines the format of the GPS correction message that is used from the base to the rover.

*RTK Calculation Mode* chooses between Delay and Extrapolate. The Extrapolate mode is needed for fast Position Update Rates.

*Satellite Elevation Cutoff* is the cutoff vertical angle above the horizon. Any satellites below this angle will be left out of calculations.

*Ambiguity Fixing Parameter (95 - 99.9):* controls the confidence level of fixed positions. The default is 99.0. At a lower confidence interval the system solves much faster. If the system incorrectly solves the position, then the position error will be much greater than the reported RMS value.
Power Cycle Receiver is the same as turning the Javad receiver off and then on.

Restore Factory Defaults resets the Javad receiver to factory settings the receiver stops acting as base or rover. The baud rate of Port A will be set to 115,200. Reset this to 9600 by turning the receiver off and then on while holding down the FN button. Watch the REC light go from orange to green to red and then let up the FN button. This method can be used if Carlson Field cannot establish communications at any time.

Clear Non-Volatile Memory does everything Restore Factory Defaults does and also wipes out the almanac data that tells it where to look for the satellites. The receiver then downloads a new almanac from the satellites.

Send Command to Receiver allows experienced users to type in commands using Javad GPS receiver commands to set or report internal settings. (See the Javad operations manuals for a complete list of Javad GPS receiver commands.)

Create Base REF File takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

Configure Base Station initiates the receiver attached to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

Leica GPS Setup

Carlson Field works with the following Leica GPS receivers: System 500, GS50, MC1000 and MK31. The type of Leica receiver is set in the Configure Field command. The options available in the GPS Setup dialog depend on the current type of receiver.

Leica Radio Port is the port on the receiver where the radio is attached, usually 2 or 3. Port 1 is usually the one attached to the computer. For the System 500 receivers, you can also set the radio baud rate, stop bits and parity parameters.
For the system 500 receivers, you need to specify the antenna types used at both the base and rover receivers. This antenna type sets the phase center offsets for the antennas which can effect the reported elevations by as much as 0.25 foot if not set properly.

Cell phones can also be used with Leica GPS equipment instead of radios for RTK work.

For GS50 receivers, you can choose between US Coast Guard or Racal for the corrections.

*Power Cycle Receiver* shuts the receiver off and turns it back on. This forces the receiver to reinitialize tracking satellites and the position solution. This routine is useful if the receiver is stuck in float solution.
Send Command to Receiver allows experienced users to type in Leica commands or send a file to set or report internal settings. (See the Leica operations manuals for a complete list of Leica GPS receiver commands.)

Create Base REF File takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

Configure Rover sets the receiver to rover mode.

Configure Base Station initiates the receiver attached to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

Novatel GPS Setup
Carlson Field works with the original Novatel Outriders and the just released Outrider DL's including the centimeter accurate RT-2 RTK receivers and the sub-meter accurate Gismo USCG/satellite RTCM/DGPS beacon receivers.

Radio Port for external radio connection is typically COM 2 on the receiver. The Data Port connected to Carlson Field is typically COM 1.

Differential Mode toggles the Novatel GPS receiver to use RTCA, RTCM or CMR message types. RTCA is proprietary to Novatel and is used only for centimeter accuracy RTK GPS surveying. RTCM can be used with USCG/DGPS beacon signals for sub-meter accuracy. Novatel receivers work with Trimble CMR proprietary message signal type and can be either a base or rover working with Trimble RTK GPS receivers.

Dynamics toggles the rover between Kinematic or Static. The base is always in Kinematic mode. Kinematic is used for surveying while walking with the receiver. Static is for stationary use only at the rover and gives better accuracies. Since Static mode is for more precise measurements, it can be used for GPS alignment points and for any control points. The receiver should not be moved while in Static mode.

Elevation Cutoff is the vertical cut-off angle above the horizon. Any satellites below this limit will be ignored in calculations. 15 is a common setting.

Elevation Type chooses between Mean Sea Level or Ellipsoid for the elevation model used by the receiver.

Solution Reset (Soft Reboot) resets the Novatel receiver in a few seconds. This is used when the rover receiver is locked up or not properly reporting its position in the Monitor function.

Receiver Reset (Full Initialize) essentially does a factory reset and a power off and on cycle.
A Receiver Reset (Full Initialize) takes three to five minutes to get back on line and become fixed after a full initialize.

*Set Radio Channel* allows you to change Pacific Crest radio channels through the receiver. The base and rover must operate using the same radio channel.

*Send Command to Receiver* allows experienced users to type in commands using Novatel GPS receiver commands to set or report internal settings. (See the Novatel operations manuals for a complete list of Novatel GPS receiver commands.)

*Check Communication Status* checks the radio port operation and reports the status as working or not communicating.

*Configure Base Station* initiates the receiver connected to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

**Sokkia Radian GPS Setup**

*Radio Port* for external radio connection is typically COM 2 on the receiver. The Data Port connected to Carlson Field is typically COM 1.

*Differential Mode* toggles the Sokkia GPS receiver to use RTCA, RTCM or CMR message types. RTCA is proprietary to Sokkia and is used only for centimeter accuracy RTK GPS surveying. RTCM can be used with USCG/DGPS beacon signals for sub-meter accuracy. Sokkia receivers work with Trimble CMR proprietary message signal type and can be either a base or rover working with Trimble RTK GPS receivers.
Dynamics toggles the rover between Kinematic or Static. The base is always in Kinematic mode. Kinematic is used for surveying while walking with the receiver. Static is for stationary use only at the rover and gives better accuracies. Since Static mode is for more precise measurements, it can be used for GPS alignment points and for any control points. The receiver should not be moved while in Static mode.

Elevation Cutoff is the vertical cut-off angle above the horizon. Any satellites below this limit will be ignored in calculations. 15 is a common setting.

Solution Reset (Soft Reboot) resets the Novatel receiver in a few seconds. This is used when the rover receiver is locked up or not properly reporting its position in the Monitor function.

Receiver Reset (Full Initialize) essentially does a factory reset and a power off and on cycle. A Receiver Reset (Full Initialize) takes three to five minutes to get back on line and become fixed after a full initialize.

Set Radio Channel allows you to change Pacific Crest radio channels through the receiver. The base and rover must operate using the same radio channel.

Send Command to Receiver allows experienced users to type in commands using Sokkia GPS receiver commands to set or report internal settings. (See the Sokkia operations manuals for a complete list of Sokkia GPS receiver commands.)

Check Communication Status checks the radio port operation and reports the status as working or not communicating.

Configure Base Station initiates the receiver connected to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

Trimble Controls

Carlson Field works with the following Trimble receivers: 4000 series, 4700, 4800, 7400, NT300D, GeoExplorer and Pathfinder. The type of receiver is set in the Configure Field command. The options available in the GPS Setup dialog depend on the current type of receiver.

For the Pathfinder and GeoExplorer, the Altitude Measurement Type chooses between using Ellipsoid or Mean Sea Level as the elevation model in the receiver.

With the Pathfinder, Carlson Field will activate the receiver when the first Carlson Field command is run and the receiver will stay active until Carlson Field is exited. The reason is that the Pathfinder will turn off as soon as the
COM port is turned off. If you need to make Carlson Field turn off the receiver, then use the Close Communication With Pathfinder button.

With the Pathfinder, *DGPS Correction Source* selects whether the Pathfinder will get its Corrections from a local Coast Guard Radio Beacon or from the Racal Satellite Correction service. Note that the Racal option must be enabled on the receiver in order to use Racal satellite corrections. (See your dealer for details as to how to do so). If *Racal Service* is selected as the correction source, the *Racal Region* selection will be enabled. The region corresponding to the relative location of the receiver should be selected to ensure proper reception of corrections.

The Pathfinder and 4700/4800 also feature the ability to select a *Satellite Elevation Cutoff*. All satellites with elevations below this setting will not be used in the final position calculations, even if they are otherwise visible to the receiver.

For 4700/4800 series receivers, the *Receiver Type* option must be set to the correct model in order for Carlson Field to communicate with the receiver. *RTK Correction Type* selects what format of RTK corrections between the Base and Rover receivers. CMR and RTCM formats are available. *Radio Baud Rate* should be set to the same setting as the communication port of the radio connected to the receiver. 4800 bps, 9600 bps, 19,200 bps and 38,400 bps rates are supported. *Configure Base Station* will configure the receiver as a base and begin transmitting corrections via the radio.

**Configure Base for All RTK GPS Brands**

Within Equipment Setup, the Configure Base Station button is the command that starts the base receiver broadcasting GPS corrections to the rover. You must click the *Configure Base Station* button in Equipment Setup while your are connected to the base receiver. The base needs a set of coordinates to use as its stationary position. There are five methods to set the stationary base position: Read from GPS, Enter Lat/Lon, Enter State Plane Coord, and Read From Reference File and Read From Alignment File.

*Read from GPS* - This method takes one GPS reading from the base receivers autonomous position and uses it as its "true" position. The autonomous position can be off of the actual position by 200 feet. The base will calculate corrections based on this autonomous position. If you set up the base with this method, the rovers must be aligned since the corrections they are using are based on a "true" position that is not really true.
Enter Lat/Lon - requires you to enter the latitude and longitude for the position of the base antenna. This is useful if you are setting up over a USGS monument whose lat/lon you know. It can also be used over a control point whose position is known from GPS post-processing.

Enter State Plane Coord - requires you to enter the State Plane northing and easting for the point that the base is occupying. This is useful if you are setting up over a USGS monument whose coordinates you know.

Read From Reference File - reads a previously saved base position file. All of the other methods of setting up the base let you save the base position at the end of setup. If you return to a site, set up the base in exactly the same position, use Read From Reference File to use the same base position and you don’t have to re-align the rover: the old alignment is still valid.

Read From Alignment File - reads a position file from one of the control points in an alignment file. This allows you to setup the base on one of the control points from the alignment. Then you don't have to re-align the rover: the old alignment is still valid.
Method 1 - Read from GPS

Step 1
Pick Read from GPS Step 2 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the correct port.

Base GPS receiver’s autonomous position
Carlson Field takes a reading and displays the latitude, longitude and ellipsoid height. This is the position that the base will use as its “true” position. The base is now configured. If you are using Pacific Crest radios, the TX light on the radio should begin blinking.

Error Message if incorrect
If the GPS receiver is not properly connected, is turned off, or hasn’t determined a position yet, you will see an error message. Check all connections and try again.

Step 3 - Save Settings to File?
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 2 - Enter Lat/Lon

Step 1
Pick Enter Lat/Lon.

Step 2 - Enter Lat/Long/Ellipsoid Height
Input the Latitude, Longitude and Ellipsoid Height for the base position. Pick North or South for the Latitude and East or West for Longitude. Important Note: The Latitude and Longitude entered must be within 100 meters of its true location on the globe. Ideally the entered base position should be a Latitude, Longitude and Ellipsoid Height from an accurate post processed static GPS point or a published NGS monument.

Step 3 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the proper port.

Base's Lat/Lon/Hgt position
The Lat/Long and Ellipsoid Height for the base position are displayed. These will be used for corrections and broadcast to the rover. If your radio has a TX light, it should begin flashing.

Step 4 - Save Settings to File?
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 3 - Enter State Plane Coord Step 1
Pick Enter State Plane Coord.
**Reminder Pop-Box - Current Zone & Datum**
You are reminded what State Plane Zone and Datum is loaded. If this is incorrect, exit Equipment Setup and input correct State Plane Zone and Datum in Configure Field > GPS Settings.

**Step 2 - Enter Northing/Easting/Elevation**
Input the State Plane coordinates (northing, easting and elevation) for the base position. Important Note: The State Plane coordinates entered must be within 100 meters of its true location on the globe. Ideally, the entered State Plane coordinates (N,E,Z) should be from an accurate post processed static GPS survey point or from a published NGS monument data sheet.

**Step 3 - Station ID (Optional)**
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit *OK*.

**Reminder Pop-Box**
You are reminded to connect the radio to the correct port.

**Base's Lat/Lon/Hgt position**
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used for the corrections that are sent to the rover. If your radio has a TX light, it should begin flashing.

**Step 4 - Save Settings to File?**
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 4 - Read From Reference File

Step 1
Pick Read From Reference File to select an existing base position REF file.

Step 2 - Select Base Reference File to Load
Pick the base position REF file to be loaded. Use the up arrow folder to browse elsewhere for the REF file.

Position as Read from File
The latitude, longitude and elevation are read from the selected file and displayed.

Step 3 - Base Antenna Height
Enter the vertical height of the base antenna.

Step 4 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the selected port.

Base's Lat/Lon/Hgt Position
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used to calculate the correction that are sent to the rover. If your radio has a TX light, it should begin flashing.
Method 5 - Read From Alignment File
Step 1
Pick *Read From Alignment File*.

**Step 2 - Select Alignment File to Load**
Pick the alignment DAT file to be loaded. Use the up arrow folder to browse elsewhere for the DAT file.

**Step 3 - Select Alignment Point**
The program will display a list of points in the alignment file. Pick the point from this list.

**Step 4 - Base Antenna Height**
Enter the vertical height of the base antenna.

**Step 5 - Station ID (Optional)**
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit *OK*.

**Reminder Pop-Box**
You are reminded to connect the radio to the selected port.

**Base's Lat/Lon/Hgt Position**
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used to calculate the correction that are sent to the rover. If your radio has a TX light, it should begin flashing.
Saving Base Settings to a File

It is always recommended to save the base position to a file if you are going to return to the same site survey again. You can setup on the same base position, recall the base REF file and enter the new antenna height. Then you can use the alignment file from the first day in the rover and not have to re-align.

When you save the base antenna position to a file it is stored with a REF extension denoting base reference file. By default, it goes in the Data directory. Input reference filename and pick Save and OK.

Configuring the Rover

After the base is configured, unplug the base receiver from the Carlson Field computer and plug in the rover receiver. In Equipment Setup, toggle the Station Type from Base to Rover. Then pick Exit. This will configure the receiver as a rover.

From the Field drop-down, pick the command Monitor GPS Position. The Status is reported as either Autonomous, Float or Fixed.

If the rover is Autonomous, it is not getting any corrections from the base.

If the status is Float, the rover is receiving corrections, but has not found the fixed solution. Once the solution becomes Fixed, the rover is locked on to the base corrections and is calculating an accurate position.
Align GPS To Local Coordinates

Carlson Field reads a latitude, longitude and height position from the GPS rover receiver and converts these values to State Plane or UTM coordinates for the current zone as set in Configure Field. Using local coordinates and their corresponding GPS position, Align Local Coordinates applies a transformation to convert the state plane or UTM coordinate to the local. Carlson Field can operate in three different modes depending on the Align Local Coordinate settings:

1) No points - No Adjustment
2) One point - Translation Only
3) Two or more points - Translate, Rotate and Scale
Without any alignment points set, Carlson Field will operate with no alignment which directly uses the state plane or UTM coordinates. In order for the coordinates to be the true state plane coordinates in this alignment mode, the GPS base receiver must be set up over a known point and the true Lat/Long for the point must be entered in the base as the base position. Otherwise, if the base is set over an arbitrary point, then the coordinates will not be true state plane.

In one point alignment mode, one pair of GPS and local coordinates is specified. The differences between the GPS and local northing, easting and elevation for these points are used as the translation distances in the transformation. The rotation will use either the state plane grid or the geodetic as north. No scale is applied in this transformation.

A two or more point alignment is used to align to an existing local coordinate system. At least two pairs of local and GPS coordinates must be entered.

In addition to the northing and easting transformation, SurvStar will also translate the elevation from the GPS system to the local. The elevation difference between the two systems is modeled by a best-fit plane.

An alignment is only valid if the base receiver setup has not changed since the alignment points were recorded. In order to use an alignment when returning to a site, you must set up the base receiver in the same position and enter the same LAT/LONG coordinates for the base.

The Align GPS to Local Crds menu item brings up the alignment dialog box. There is more information than to fit in one window, so use the View button to switch between viewing the local coordinates and the GPS Lat/Lon.

Each line in the box represents one alignment point. Each point in an alignment file relates a specific Lat/Lon/Elv to a specific Northing/Easting/Elevation for your local coordinate system. Carlson Field will use the current alignment file every time that the GPS is read. It provides the necessary adjustment to properly convert that position to your coordinate system.

In the local points view, the HRes column shows the horizontal residual and the VRes column shows the vertical residual. The residual is the difference between the actual point and the point calculated using the alignment transformation. In GPS points view, the HRMS and VRMS columns show the horizontal and vertical RMS values when that point was recorded.

The On/Off buttons allow you to switch whether the highlighted point is used for the horizontal and/or vertical alignment. The HV column shows a ‘Y’ if this point is used in the calculations. Otherwise it shows an ‘N’. The H column represents horizontal control and the V column vertical control. For example, you may wish to use 2 points for horizontal alignment and one for vertical.

The Optimize button will find the combination of turning alignment points on/off for horizontal and vertical such that the horizontal and vertical residuals are minimized.

The Desc field shows an optional description of the alignment points.

The scale factor and average horizontal and vertical residuals appear at the top of the window. These values serve as a check that the alignment is valid. The scale factor should be closed to 1.0 (in range of 0.9 to 1.1). The average residuals should be less than 0.2.

XY On/Off toggles the highlighted alignment point horizontal component off or on. Alignment points with the horizontal component toggled off will not use the northing and easting of that point for adjustment calculations.

Z On/Off toggles the highlighted alignment point vertical component off or on. Alignment points with the vertical component toggled off will not use the elevation of that point for adjustment calculations.

Note: When you toggle either the XY or Z component off or on for any alignment point the scale factor and Horiz/Vert residuals are recalculated automatically. Briefly toggling XY or Z components off or on and reviewing the scale factor and residuals changes is a quick approach to finding the best alignment points. Carlson Field can handle an unlimited number of alignment points.

Highlight an existing alignment point entry and pick Delete to delete that alignment point.
Pick the *Add* button to create an alignment point. The Add Alignment Point dialog box appears. There are two ways to enter the local coordinate points: by entering the N, E, Z, or by using an existing point number stored in the current coordinate CRD file. The GPS values can also be specified by two methods: by entering in the Latitude, Longitude and Height or by occupying the control point with the rover and taking a GPS reading at this location. Manually entering the Lat/Lon can only be done when the base is setup on a known location using a true lat/lon position. Otherwise Carlson Field needs to use the Read GPS method. For this method, the base can be setup with a lat/lon that only needs to be close (within 100 feet) of the actual lat/lon. This type of position can be read from an autonomous GPS position. With the base setup on this approximate lat/lon, go with the rover to the control points and use the Read GPS option in the Add function. The rover GPS solution must be in “fixed” status when the alignment point is added. By reading the rover GPS position for the alignment points, the alignment will transform the coordinates from the GPS system of the current base setup to your local coordinate system.

*Load* allows you to open an existing alignment file. Only one alignment file can be open at a time. Alignment files have a DAT extension and stored in the Data directory by default.

*Save* stores alignment files (DAT extensions) to a file. Files are by default stored to the Data subdirectory.

The *OK* button will set the current alignment to the settings in the dialog.

**Alignment Methods**

Carlson Field can operate by the following Alignment methods:

Alignment Method 1) - No alignment points
Alignment Method 2) - One point alignment
Alignment Method 3) - Two or more alignment points

**Alignment Method 1**

With no alignment of the rover, Carlson Field will report Northing and Easting as State Plane or UTM coordinates. In order for this method to give accurate State Plane or UTM coordinate values, the GPS base receiver must be set up over a known point and configured using the true Lat/Long/Hgt or true State Plane coordinates. If the base is set over an arbitrary point, configured by reading the GPS, the RTK GPS stored coordinates will be translated up to a 200 feet but accurate in relation to each other.

When using this method, you can skip *Align GPS to Local Crds* and start surveying immediately once the base is configured and transmitting its position and the rover is fixed.

In most cases, you cannot use Method 1 because you will not have setup the base on a point whose exact true position you know. Therefore the base corrections are going to be off a certain distance north/south and a certain distance east/west. This is why you want to do an alignment. You are showing Carlson Field how to correct for the north/south and east/west offsets. Any points surveyed with the alignment file active will be translated to their proper position.

To gather alignment points, you put the GPS antenna over a point with known coordinates and Carlson Field records the GPS Lat/Lon/Elv and the Northing/Easting/Elevation you give it. This point can be a local coordinate, for example a stake you are calling 5000,5000. It can also be a true State Plane point. Using one or more State Plane points will give you an alignment to true State Plane (even if your base is not using its own true position.)

**Alignment Method 2**

This method uses one alignment point to translate the GPS coordinates to local or true State Plane coordinates.

Remember that if the base is set up over an arbitrary point, the GPS coordinates can be off from true state plane by up to 200 feet. This alignment method can be used to correct for this by translating the system onto true state plane coordinates.

You can choose if you want the coordinate system North to be Geodetic North or State Plane Grid North under Configure Field>GPS Settings. If you specify a scale factor in that dialog box, it will be applied to all points.
recorded.

One point alignment is useful for data collection on a new site. In this case you can set up the GPS base receiver anywhere convenient. Then position the rover over a point (preferably one you can find again) and add this point as your one alignment point by reading the GPS point and entering a local coordinate like 5000,5000,100. Now the local coordinate system is set around this first point at 5000,5000,100.

This method is commonly used for small topo or stockpile RTK GPS surveys. When collecting or staking data at distances greater than 2 miles from the base, both the horizontal and vertical errors will begin to increase gradually. Therefore, you should use a multiple point alignment for large projects.

Alignment Method 3

This method is useful if you are arriving on a job which has already been surveyed. It assures that your survey is in the same coordinate system as the original survey.

Using control points, this method transforms the GPS coordinates to an existing local coordinate system. This method takes pairs of GPS coordinates and the corresponding local coordinates to define the translation, rotation and scale of the alignment.

In Configure Field>GPS Settings, there is a choice for the transformation as Plane Similarity or Rigid Body. Plane Similarity will apply a scale factor to the transformation. The scale factor will be based on the alignment points and should always be very near 1.0 to be correct. The Rigid Body option will align by translate and rotate but no scale. Any difference in scale between the GPS and local coordinate systems will be distributed equally between the two alignment points. These differences will appear as horizontal residuals in the Alignment dialog.

Two pairs of points are sufficient to define the translation, rotation and scale for the transformation. But adding more alignment points yields the most accurate results for aligning to existing coordinate systems. Since two pairs of coordinates are sufficient to define the transformation, there is extra data when there are three or more pairs. The program uses a least-squares best-fit routine to find the transformation that minimizes the residuals. This one best-fit transformation is used to convert from the GPS to the local coordinate system for all the points. The residuals are the differences between the transformed GPS coordinates and the actual local coordinates.

A multiple point alignment is especially helpful on a survey which covers a large area. The error in raw GPS coordinates increases as you get farther from the base. Taking alignment points around the perimeter of your job site as alignment points will give you the best geometry for the alignment.

Typical Alignment Scenarios

Scenario: New site. In this case, there are no established coordinates on the site.

Alignment: Choose a point on site and do a one point alignment. For the local alignment point, enter the coordinates that you would like to use (ie 5000,5000,100). Under Configure Field>GPS Settings, The One Pt Align Azimuth option chooses between using true north (geodetic) or state plane north (grid). To use real world ground distances, set the Project Scale Factor under Configure Field>GPS Settings. Otherwise the default scale factor of 1.0 will collect points on state plane distances.

Scenario: One known state plane coordinate and you want to work in the state plane coordinate system.

Alignment: Either setup the base over the known state plane coordinate or do a one point alignment on this known state plane point. In Configure Field>GPS Settings, set the One Point Align Azimuth to Grid and set the scale factor to 1.0.

Scenario: Multiple known control points.
**Alignment:** Choose two or more control points to align to. It is best to use control points around the perimeter of the site. Use as many control points as are available or enough to envelope the site. In Configure Field>GPS Settings, set the Transformation to Plane Similarity to fit the GPS points onto the control points and set the Project Scale Factor to 1.0. After making the alignment, stake out another control point (ideally one that is not used in the alignment) to make sure the alignment is good.

**Point Store**

This function creates points by reading from GPS or total station equipment. The new points are stored in the current coordinate and simultaneously drawn in the drawing. The measurement data is also stored to the current raw file which has the same name as the coordinate file except with a .RW5 instead of .CRD file extension.

The Point Store dialog docks on the side of the drawing window. This allows you to see the drawing view as you collect points. You can use the arrow keys to pan the drawing and the Page Up/Page Down keys to zoom out and in. There are also icons for the pan and zoom functions at the top of the dialog. Also, besides clicking the function buttons, most buttons have an associated function key such as F1 that you can use to run the routine.

Before taking measurements, make sure that the rod height is correct.

To take a measurement from the survey equipment, pick the *Read* button. The calculated northing, easting and elevation will be displayed in the dialog and a temporary icon will be shown in the drawing at the point location.
Before storing the point, make sure that the point number and description are set in the **Point Number** and **Description** fields. The point number is a required field for storing to the current coordinate file. If the point number specified already exists in the coordinate file, then a dialog will pop-up with options to overwrite the existing point number, to use another point number or to cancel storing the new point. The **Point Number** field will automatically increment after storing the point.

The **Description** is an optional field for identifying the point. The maximum length of the description is 32 characters. Besides naming the point, the description can also be used to with Field-To-Finish to draw linework and to determine the symbol of the point in the drawing. When the Field-To-Finish option is set on in **Options**, the program will lookup the description in the current code table. If the description matches one of the codes, then the code can determine the symbol, layer, format of the point when it is drawn. Otherwise the defaults in the Point Setting section of the Options dialog are used for the point symbol, layer and format.

To store the new point to the coordinate file and draw the point, pick the **Store** button. At the time that Store is applied, the program uses the point number, description, linework options and special options currently set in the dialog.

You can also use the **Read & Store** button to do both functions in one step. With this method, the program will take a measurement and if the measurement is successful, then the point will be stored immediately.

The **Code** button brings up a list of point descriptions from the current Field-To-Finish code table. You can select a code from the list to set this code as the current point description. This function also shows a list of all the descriptions of currently active linework. You can end a currently active linework by highlighting the linework description from the Active Linework list and pressing the End Linework button.

Many of the options for storing points can be set in the Configure Field>Point Settings command. The **Options** button in this dialog is a shortcut to these point settings.

If you want lines or polylines to connect the points that you are about to record, select the **Start** button under **Linework**. After the first point, the **Linework** selection will change itself to **Cont** meaning continue. Leave this selected while you are recording points in the same line. Before shooting the last point in your line, change it to **Cont**.
If you want the line to close itself onto its first point, check the Close button.

The Field-To-Finish Linework option is an automatic way to start linework. The program will lookup the point description in the code table. If the description matches a code and the code is defined to create linework, then the Start toggle in the Linework options is turned on. Otherwise you can begin new linework by toggling on Start manually.

When a point is stored and Start is on, Carlson Field pops-up a dialog for choosing between a line, 2D polyline or 3D polyline. A 3D polyline can contain points with different elevations, but a 2D polyline always has an elevation of zero. The Smooth Polyline option will create Bezier smooth polyline through the points.

Carlson Field can keep track of several lines being drawn at once. Each line corresponds to a set of points with a different description. Let's say you are shooting a line of points called "fence" and you want to shoot some points on a curb, but you're not finished with the fence. You change the Desc box from "fence" to "curb". Carlson Field lets the fence line go for now. It changes the Linework selection to No. You want a line for your curb, so you select Start. The points you shoot now will form a new curb line. To go back to recording fence points, change the description back to "fence". The fence line you were working on will continue to include any new fence points you shoot. If you want to end this fence line, select End under Linework and Carlson Field will not connect any future
"fence" points to this line. If you start a new linework with a description that already has linework, then Carlson Field pops-up a dialog with three options as shown. The Continue Existing Code option is the same as using Cont instead of Start. The End Existing and Start New option will end the active linework and start the new linework with the same description. The Use New Description option will keep the existing linework and start another linework with another description. For example if you are surveying two edge of pavement lines, you can have one with the description "EP" and the other with "EP2".

The PC and PT options are for drawing curves. If you want to plot a curve, check the PC box before recording the first point on your curve. Shoot as many points along the curve as you need. Carlson Field can handle compound curves as well as simple curves with this function. Before shooting the last point on the curve, check the PT button. If you don't specify a PT, Carlson Field will assume a three point curve.

The Undo button will remove the last point number created. The point is removed from both the coordinate file and the drawing.

For GPS and tracking total stations, there is a Start Continuous button which makes Carlson Field continuously read from the instrument. The coordinates are displayed in the dialog and your position is shown with an arrow icon in the graphics view. To store a point, you can use the Store button without using the Read button first. Once continuous reading is active, the button changes to Stop Continuous which will put you back in standard reading mode.

Point Store with GPS

When using GPS equipment, Carlson Field will also report the RMS values and solution status when you take a reading. If Carlson Field gives you a message that your RMS values are too high when you try to read a point, you can click on the Monitor button to bring up the Monitor window which will give you information on how accurately your position is determined and how many satellites you are tracking. The Skyplot button will bring up the window showing you where in the sky the satellites are.

For points that are hard to reach directly by GPS, you can use the Offset option. This option can be used in areas of limited satellite communication such as high walls or under a tree. This allows you to setup the rover in a clear area and read the coordinate. The point that is actually stored is offset from the rover position. To create an offset point, turn on the Offset toggle and then choose Read. The offset direction can be entered as left, right or azimuth. The left and right offset is relative to the rover position at the previous read. The offset distance is entered in the dialog. A Vertical Offset can also be specified. Choose Store to store this point after the offset is done.

Offsets can also be done with laser guns when the laser option is setup in Configure Field>GPS Settings. There are two methods for taking laser offsets. One method is to use the Offset toggle and the Read button. In the Offset dialog, there is button for Read Laser for using the laser measurement for the offset distance and/or angle. This method creates a single offset point.
The other method is to use the Laser button which can create many offset points. This method brings up another dialog. The Setup button can be used to set the Laser Alignment Azimuth. This alignment applies to laser guns that use a magnetic compass for the horizontal angle. The magnetic north can vary from the north of your coordinate system. The Laser Alignment Azimuth is added to the measured laser azimuth to adjust for the difference. To set the alignment azimuth, specify a reference backsight direction by either entering an azimuth or by point number. Then choose the Read Laser For Alignment button and take a laser shot towards the backsight. The program will compare the azimuth from the laser with the reference backsight to figure the alignment azimuth. When the alignment azimuth is set, pick the Go button. Carlson Field then listens for measurements on the laser gun port. To take a shot, sight the target point and press the laser trigger. Carlson Field will read the laser measurement and read the GPS position. The laser angle and distance are combined with the GPS position for the new point coordinates. To return to regular GPS Point Store, choose the Exit button.

Point Store with Total Stations
Before taking measurements with total stations, you need to specify the occupied point coordinates of the instrument, the backsight and the height of the instrument. This current setup data is shown in the "OC:# BK:# HI:#" line in the
dialog. Also icons are draw to show the occupied point and backsight direction in the drawing view.

The Setup button at the top of this dialog brings up the Total Station Setup dialog, where you can change your occupied point, backsight and instrument height.

For robotic total stations, there is also a Joystick button to turn the instrument, search for the prism and set tracking or standby mode.

Carlson Field can shoot points with offsets. To shoot a point with an offset, check the Offset button on the Point Store dialog box. Click Read or press F1. A window appears to let you choose the type of offset to shoot. The choices are Distance/Angle and Enter Offset Distances. The Offset Vertical option will prompt for an elevation difference to apply to the point.

To do a Distance/Angle offset, you first take a distance shot and then angle shot. For the distance measurement, have the rodman stand to the side of the point. The prism and the point should both be the same distance from the total station. Carlson Field takes the first shot and gets the distance from it. It then prompts you to read the angle. Turn the gun so that it is aimed at the point. The prism is not needed for this step. Click OK and Carlson Field reads the horizontal angle from the gun and combines this with the distance from earlier to calculate the coordinates of the point. Also for combining these shots, there is an option whether to use the vertical angle from the distance or from the angle shot.
With the Enter Offset Distances method, you can supply both a left/right offset and an in/out offset. To do a In/Out offset, have the rodman stand a measured distance in front of or behind the point. The total station will take the shot and then Carlson Field will ask you how to move the point: in or out and the distance. If the prism is in front of the point, choose out. If it's behind the point, choose in. To do a Left/Right offset, have the rodman stand a measured distance to one side of the point. After taking the shot, Carlson Field will ask whether to offset right or left. If you are at the total station, looking at the prism, and the point you are after is to the right of the prism as you're looking at them, choose right offset. Otherwise, choose left offset.

Choose Store to store this point after the offset is done.

The D&R option stands for Direct and Reverse. When this box is checked, Carlson Field will take sets of four shots to determine the coordinates of the next point. Two shots are taken for both the backsight point and the foresight point: one direct shot, one shot with the total station reversed. This yields a more accurate reading. Two options are available for the order of shots when doing a D&R. The first is Backsight Direct, Backsight Reverse, Foresight Reverse, Foresight Direct. The other option is Backsight Direct, Foresight Direct, Foresight Reverse, Backsight Reverse. Carlson Field also offers the option of shooting multiple sets of Direct & Reverse for even greater accuracy. The Shoot Distances For Reverse Shots option determines whether to take distance measurements on the foresight reverse and backsight reverse shots. When this option is off, the program will still use the reverse shots to mean the angles. Otherwise the program will also use the reverse shots to mean the distances. The Use Robotics To Auto Flip Instrument option applies to robotic total stations to have the program automatically turn the instrument for reverse shots.

To shoot a point as a Direct & Reverse, check the D&R box and click on Read. A dialog box appears, offering the choice of orders for the shots. Before each shot, Carlson Field tells you what kind of shot is being taken. After each shot, Carlson Field reports the measurements and allows you to confirm the measurement or to re-shoot. After all four shots are taken, Carlson Field does the math and reports the accuracy of each part of the measurement.
Choose *Store* after completing the Direct & Reverse to store this new point.
Stakeout

Function

The Stakeout function is used to find a specific point in the field. Once you tell Carlson Field the point that you are looking for, pick Start and the program draws an X-marks-the-spot bullseye on that point in the drawing. Carlson Field also draws a triangle on the drawing for where you are currently standing. These icons help to guide to the target point graphically. Carlson Field also reports in the dialog box how far you need to move to reach the point.

There are several options for Stakeout defined in Configure Field>Stakeout Settings. These options should be set by Configure Field before running Stakeout. See the Configure Field section of the manual for a description of the stakeout options.

There are four ways to define the target point for stakeout. The first method is to specify a point number from the current coordinate file. To do this, click on the Point Number button and type in the point number in the dialog. The second method is to give a station and an offset from a centerline. The program will prompt for a centerline file (.CL) and then the station and offset. You can also specify the station interval for automatically incrementing to the next stakeout point. See the Roads section of this manual for how to create centerline files. The third method is to graphically pick the point from the drawing. Select Pick Point and a dialog box allows you to pick different snaps: endpoint, midpoint, center, node (point), or intersection. This will help you pick your desired point more accurately. For example, you can select endpoint and then pick on a polyline corner to stakeout that the polyline endpoint. See the Object Snap command in this manual for more on snaps. The fourth method is to simply type in the target point coordinates in the Northing, Easting and Elevation fields.

Once the stakeout point is set, click the Start button and Carlson Field begins the stakeout routine. The format of the stakeout screen that appears depends on whether you are using total stations or GPS as described below.

When you reach the target point, click the Store button. Carlson Field reports the difference between your current position and your target position. At this point you can choose to store this staked-out point as a new point in the coordinate file.
When the target stakeout point has an elevation, Carlson Field also reports the elevation difference between the target and current elevations. This cut/fill is also in an edit box that allows you to change the value for labeling. For example, you may want to round the cut/fill number to an even number to label on the stake with a mark to indicate where this even number occurs. When you change the cut/fill label from the original value, Carlson Field will report the offset for this mark. For total stations, Carlson Field will also report the zenith angle for locating this mark. There are also fields in the report dialog for entering vertical offsets to get additional cut/fill values. For example, if the target point is for the road surface and you want to also get the cut/fill to an 18 inch subgrade, then enter -1.5 as the vertical offset.

**GPS Stakeout**

After you click Start to begin staking the point, Carlson Field changes the dialog box to the one shown below. The dialog shows the target point, the current position northing, easting and elevation and the GPS HRMS/VRMS. The distance, azimuth and cut/fill from the current position to the target are also reported. Carlson Field also breaks down this distance into how far north/south and how far east/west to go. Finally based on your current heading, the program tells you whether to turn right, turn left or that you are on-line.

In the graphics view, the large "X" shows the point being staked-out and the triangle represents your position. A temporary line is drawn between your current position and the target. In Configure Field > Stakeout Settings, there is an option to auto zoom in as you approach the target point. Otherwise you can use the arrow keys to pan the display and the Page Up/Down keys to zoom out and in.
Total Station Stakeout

Before starting the stakeout, be sure that the instrument is setup with correct occupied point, backsight and instrument height. This setup data is displayed in the third line of the dialog. You can pick the Setup button to change the instrument setup.

After you click Start to begin staking the point, Carlson Field changes the dialog box to the one shown below. The dialog shows the angle to turn the gun and the horizontal distance to the target. Turn the instrument to this angle and position the rodman at this angle and distance. Then pick the Read button to take a measurement. Carlson Field will then report the horizontal distance and cut/fill from the current position to the target. This distance is also reported as how far north/south and how far east/west to go and as how far in/out and left/right to go. To in/out and left/right distances are relative to the rodman facing the instrument. Keep moving the rodman and picking the Read button until you reach the point. Then pick the Store button.
For robotic total stations operating remotely, there is a Continuous button that puts the instrument in tracking mode with continuous measurements.

In the graphics view, the large "X" shows the point being staked-out and the triangle represents your position. Also the location of the instrument is shown with an icon and the backsight is shown as temporary line.

**Auto Points at Interval Function**
This command stores a point whenever the distance or time from the previous point exceeds the user-specified interval. This command only applies to GPS and robotic total stations. If you will be collecting a large number of points at once, *Auto Points at Interval* can be a useful tool. For example, you may want to plot the edge of a road. Once you start *Auto Points*, you can walk along that edge of road and let Carlson Field record your position automatically.

The *Auto Points at Interval* dialog box resembles the *Point Store* dialog box with the addition that you can set the interval to record points. You can set it to store a point every time you move a certain distance by selecting *Distance* and entering the distance you choose in the *Interval* box. The distance will be taken in feet if your project is using English units, or meters if your project is in Metric. If you select *Time*, the number in the *Interval* box will refer to the number of seconds between creating points.

Check the *Draw Linework* box to have your points connected by a line or polyline. You can enter a description or choose from the code table just like in *Point Store*.

The *Offset* toggle will apply an offset to the calculated coordinates. The horizontal offset is applied perpendicular either left or right to the direction of movement. There is also an option for a vertical offset.

Pick *Start* to begin storing points. Carlson Field will take a reading and store the first point. Then Carlson Field will continuously read the GPS or total station. For distance interval method, as each point is read the distance from the last point is calculated. When the distance is greater than the specified interval, a point is created and the point number is displayed in the dialog. In practice, the actual distance between stored points will be greater than the distance interval. For example, if the distance interval is 10 and the current distance is 8.9, then no point is stored. Then you keep moving and the next distance is 11.4 which will store a point.

For time interval point storing, after reading and storing the first point, Carlson Field will wait for the interval time to pass, then read and store again.
The new points are both stored to the current coordinate file and drawn in the drawing.

When using GPS, if the RMS values of the position read are above the tolerance set in Configure Field, then the point will not be stored.

Carlson Field will continue to record points until you click on Stop.

**Track Position**

**Function**

This command shows the coordinates of your current position in a dialog and draws an arrow icon in the drawing view. This command only applies to GPS and robotic total stations. As you move along, the arrow icon will move through your drawing showing your position in real-time. If the arrow icon gets near the edge of the screen, Carlson Field will automatically pan over.

A dialog box also appears in Track mode. The dialog shows your current northing, easting and elevation. For GPS mode, the dialog displays the HRMS and VRMS values and solution status. There are buttons to take you to Monitor and Skyplot. There is also a Store button which will store your current location as a point and plot it, similar to the Point Store function.
Satellite SkyPlot

Function

When using GPS, it is important to know how many satellites you are tracking and their position in the sky. Satellite Skyplot’s visual and graphical screen aids in identifying when satellites are being masked by surrounding structures, trees and mountains. Satellites close to the horizon, under fifteen degrees, are less helpful resolving the rover position because of extra atmospheric interference. If there are too few satellites present, the receiver will be unable to resolve its position. Typically five satellites are required to resolve position and four are needed to maintain locked solution. Satellite Skyplot can be an invaluable tool to help you monitor the current satellite configuration.

The skyplot screen appears at left. The top half of this window displays the visible satellite information in chart form. PRN is the satellite identification number. Az is an abbreviation for azimuth; the horizontal angle from due north, in degrees measured clockwise, to the satellite position (0 to 360 degrees). Elv is an abbreviation for elevation; the vertical angle above the horizon where the satellite can be found (0 to 90 degrees). One entry appears for each satellite that the receiver is tracking.

The image on the lower half of the window displays the same information graphically. It shows a map of the sky with North at the top, East to the right. The centerpoint, where the lines cross, is straight up. Each satellite appears as a symbol resembling an "H". As you can see, most of the visible satellites were in the Northeast when this image was captured. The inner circle represents an elevation of sixty degrees. The outer circle is the horizon. Roughly speaking, any "H" touching this circle is too low in the sky to be of much use. For GPS receivers that support GLONAS satellites, Skyplot will show these satellites with a "G" symbol.

For some types of GPS receivers, the receiver will report which satellites are being used for calculating the position and which are only being tracked. A satellite might be only tracked and not part of the solution if the satellite is too low on the horizon or when the signal is not clear. The skyplot will highlight the satellites that are part of the calculations.
Monitor GPS Position

Function

This command reports the current GPS Lat/Lon, local coordinates and GPS solution status. The latitude and longitude are reported in the DD.MMSSSSSS format. In this example, the latitude is 42 degrees, 21 minutes, 46.4414 seconds north. The longitude is 71 degrees, 8 minutes and 31.5699 seconds west. Negative longitudes indicate longitudes west.

The next three items are state plane or local coordinates depending on the transformation in the Align Local Coordinates command. The HRMS and VRMS are measures of the reliability of the position that the receiver has calculated. They correspond to the position horizontally and vertically, respectively. If the receiver is autonomous, not receiving corrections from a base, the RMS can be up to a few hundred feet. If this rover is computing a “Fixed” position, the RMS values should be less than one foot, probably close to a tenth of a foot. If the receiver loses the fix and becomes “Float”, the RMS values will jump to between one and ten feet.

Depending on the type of GPS receiver, the Monitor screen will also show more values like radio link status and receiver battery status.

The Skyplot button will jump you to that window so you can see the satellites the receiver is using.

Benchmark

Function

This command takes a measurement to a benchmark point with a known elevation in order to calculate the elevation at the occupied point. This command only applies to total stations.

In the Benchmark dialog, fill in the instrument and rod heights. The benchmark elevation is specified in the Target Elevation field. This field can be filled out by entering a target point number which reads the elevation from the current coordinate file for the specified point. Or you can simply type in the target elevation directly. There is a choice between calculating the occupied point elevation or the instrument height. For calculating the instrument height, you need to enter the occupied point elevation. When calculating the occupied point elevation, there is an option to store this elevation to the coordinate file for the occupied point number. When all the options are set and the target benchmark is sighted, pick the Read button to take a measurement. After the reading, the program will
display in the dialog the calculated occupied point elevation or instrument height depending on the calculation mode.

Resection

Function

This command calculates point coordinates given the angle and distance measurements to two or three reference points. This command only applies to total stations. The reference points are specified by point number. These reference points need to be stored in the current CRD file before running this command. This function can be used when setting up the Total Station on an unknown point.

The command starts with a dialog to choose between using two or three reference points. Then for each reference point, there is a dialog to enter the reference point number, instrument height and target height. After entering this data and sighting the target, pick the Read Gun button to take a measurement. The measurement angles and distance are reported for a check in a dialog. When all the measurements are done, the results are show in a dialog. The results include the calculated coordinates and the residuals. The program calculates the coordinate by averaging the distance-distance and angle-angle solutions. Since there is redundant data, the final calculated coordinate will differ slightly from the individual measurements. For example in a 3-point resection, there are two different distance-distance solutions (between the first-second point and between the second-third points). The program reports the difference between the final coordinate and the individual solutions as the residuals which act as an indicator whether the data is good. High residuals suggest a problem with the input data. In the dialog that displays the final coordinates and residuals, there is a button to store the coordinates to the current CRD file with a specified point number.
Building Face Surface

Used to project all points onto a surface or plane. Upon executing the function, a menu will open, prompting the selection of three points to define the plane/surface. Note that there must already be three points along the plane in the CRD file in order for this function to work properly. After selecting the three points (the "List" buttons will bring up a list of available points), select "OK" to proceed. A screen similar to the Store Points dialog will now open. Every point which is read will be plotted along the plane defined by the three points selected, even if it is at a different distance. When finished, simply exit out of the menu as with any other function.

Pattern Point Survey

Used with a reflectorless Total Station. This function is used to shoot a regular, rectangular "pattern" of points across an area. It is useful when periodic measurements of an area are required. Upon starting the function, a query box
will ask for two point defining a rectangle, the lower left corner and the upper right corner. For each of these, aim
the gun at the corner of the area to be scanned and click "Read". After reading both points, a menu will prompt
for several other parameters. Enter the first point number to shoot, as well as any desired description for the points,
and both horizontal and vertical increments. These are angle increments, given in seconds. Once all of the above is
entered, select "OK" to begin the survey. The total station will now begin turning automatically to the bottom-left
corner of the area, and will begin shooting points. Upon reaching the right-hand limit of the area, it will begin a new
row of points, starting at the left.

Point Check By Robotics

This command works with robotic Total Stations made by Leica, Topcon or Geodimeter. This function is used to
shoot and record a series of known target points. Before running this command, the instrument setup must be set
(occupy point, backsight) with the Equipment Setup commands. After selecting Point Check by Robotics you will
be prompted with a dialog box. Choose the points you want to check and click process. The Total Station will
then go from point to point and take new measurements. When it is all done, a report will be given with the new
measurements and any deviation.
Shown here is the Carlson Field DTM menu. This menu provides many tools for working with elevations, grid files, triangulation and contouring.
Elevation Difference

This command reports the cut or fill between your current position and a design surface. The design surface can be one flat elevation, a grid file, a triangulation file, a road design file, or a section file.

The type of design surface is set in the dialog shown. The Vertical Offset in this dialog can be used to modify the design surface by adding this value to the design surface. For example, if you have a design surface for the top of a road and you want to get cut/fill values to a 1.5 subgrade, then enter -1.5 in the Vertical Offset field. The Use Centerline For Station-Offset option will report the station-offset of your current position in addition to the cut/fill. When this option is active, the program will prompt you for the centerline file (.CL) to reference. For GPS and robotic total stations, the Auto Store Points At Interval will creates points whenever your position moves by more than the specified distance or time interval. This option is similar to the Auto Points At Interval command with the addition that the default description will include to cut/fill to the design surface. When all the options are set, pick OK and the program will then prompt you for a grid file or triangulation file if you have selected these types of design surface.

Elevation Difference with GPS

Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position. Carlson Field finds the design elevation for this point and compares it to the elevation being reported by the GPS receiver. It then tells you how much cut or fill is required to reach the design elevation from your current position. An arrow icon will appear on the drawing showing your location. You can move around the site while in Elevation Difference mode and Carlson Field will report the necessary cut or fill in real-time. If you move off the area covered by the design surface, then the program will stop reporting cut/fill and instead will report "Off Surface".
The Store button will create a point at the current position. The default description will include the current cut/fill. When Store is selected, a dialog box will appear for entering the point number and description.

**Elevation Difference with Total Stations**

Elevation Difference uses a dialog box that is very similar to the *Point Store* dialog. Under the Setup button, make sure that the occupied point, backsight and instrument height are set. Then have your rodman set the prism over the point you are interested in. Pick *Read (F1)* or *Read & Store (F5)* and the total station will take a shot.

After the shot is taken, the dialog box looks like the one at right. Carlson Field found the design elevation for this point (557.535) and compared it to the actual current elevation (530.0). Based on the current and design elevations, Carlson Field reports to how much cut or fill is required to get to design elevation. In this case, it is fill 27.535. The cut/fill also appears in the *Desc* box. If you click *Store*, Carlson Field will record this point and plot it on the drawing, including the *Desc* as a label.
Pull-Down Menu Location: DTM
Prerequisite: None

**List Elevation**

**Function**

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex.

Pull-Down Menu Location: DTM  
Keyboard Command: LSTELEV  
Prerequisite: a polyline or line  
File Name: \lsp\lstelev.lsp

**Assign Contour Elevations**

This command can be used to quickly and accurately assign the elevation of series of AutoCAD polylines that have been converted from raster or digitized without correct elevations. The routine will automatically assign elevations to the polylines crossing the fence line selected by two points. At the same time the elevations are changed, the program can assign it a new layer, color, linetype, and polyline width. This process usually works best if contours are in a temporary (white) layer to start. When they are processed, they will take on the color of the new layers making it easy to distinguish which polylines have been processed.
Prompts

**Settings/First Point:** press S to change settings or pick first point  
**Second Point:** pick second point  
**Beginning Elevation <0.00>:** 1020  
**Increment Direction U/D <U>:** press Enter  

**Pulldown Menu Location:** 3D Data > Assign Contour Elevations  
**Keyboard Command:** grpcelev  
**Prerequisite:** Digitized polylines  
**File Names:**
Make 3D Grid File

This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.

Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.

Grid superimposed over triangulated features

The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.
The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Range of Elevations/Values to Process**: Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.
- **Modeling Method**: The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.
- **Triangulation Mode**: When using Triangulation and Polynomial methods, there are four triangulation modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.
  - **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise, the Triangulation Only method is used.
  - **Triangulation Only** method builds a triangulation surface out of all the selected points, lines and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.
  - **Triangulation with Subdivision** method uses the subdivisinal surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.
  - **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and polylines. The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped and any selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.
- **Grid Resolution**: The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the...
"number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grids cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt \textit{Extrapolate grid to full grid size?} Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. \textit{Grid File Utilities} can be used to apply and save extrapolation to a grid file. The \textit{Plot 3D Grid} command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

Line 1 is the lower left Y coordinate  
Line 2 is the lower left X coordinate  
Line 3 is the upper right Y coordinate  
Line 4 is the upper right X coordinate  
Line 5 is the X direction grid resolution  
Line 6 is the Y direction grid resolution  

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter 'N' is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.
Griding from Contour Maps

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

Prompts

Grid File to Create File Selection Dialog
Enter a name for the grid file.

Use position from another file or pick grid position [Pick>/File]?
Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid
Pick Upper Right grid corner <8366.88,4195.08>: pick a point

Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you to set the X and Y size for each grid cell.

Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Reading points ... 980
Finding points on breaklines ...
Ignored 2729 duplicate points.
Inserting breaklines 3480 ...
Triangulating points ... 980
Assigning grid values > 1800

Writing grid file: C:\Carlson 2008\WORK\example1.grd

Pick the Lower Left grid corner: pick a point for the lower left limit of the grid
Pick the Upper Right grid corner: pick a point

Pulldown Menu Location: Surface
Keyboard Command: mkgrid
Prerequisite: Entities that define the surface
Draw 3D Grid File

This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a 3D Face entity, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: 3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.

If Use Vertical Exaggeration is checked, grid elevations are multiplied by the value specified.

Exaggeration Method specifies whether to use an Absolute exaggeration method or Relative to Base, which uses the specified base elevation.

Specify the type of entities to draw in Draw Method. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in VG for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in Layer Name.

Specify the initial viewing direction in View.

When Color by Elevation is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.
When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation, it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the **3D Viewer Window** command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.

When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.

When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

![Drawn grid file using inclusion perimeter and side faces option viewed with Viewpoint 3D](image)

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** plotgrid  
**Prerequisite:** a grid (.GRD) File  
**File Names:** `\lsp\plotgrid.lsp`, `\lsp\cntr_grd.arx`

**Two Surface Volumes**

**Two Grid Surface Volumes** calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the **Make 3D Grid File** routine. When creating the second grid file, choose **Use position of another file** and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.

There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by **One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes**. These routines have special prompting and calculate the grid surfaces and volume in one step.
Volumes by Two Surface Volumes has three steps:

1. Creating the first grid file with Make 3D Grid File
2. Creating the second grid file with Make 3D Grid File
3. Running Two Grid Surface Volumes

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the Volumes by Triangulation commands. Cross section end area is another volume method that is used by the Calculate Sections Volume command in the Civil Design module.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. **Important:** Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.

**Write Difference Grid File** creates a grid (.GRD) file of the elevation difference of the two grid files.

**Draw Difference Contours** creates a contour map of the difference or depth between the two grid files.

**Draw Elevation Difference in Each Cell** plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.

**Draw Volume in Each Cell** plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.

**Calculate Elevation Zone Volumes** calculates the cut and fill between different elevation ranges.

**Draw Cut/Fill Color Map** fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells.
at zone transitions. Also, there is an option to control the zone intervals and range.

**Use Report Formatter** allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.

**Process Another Area with Current Grids** runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The **Cut Swell Factor** value is multiplied by the cut volume in the report.

The **Fill Swell Factor** value is multiplied by the fill volume in the report.

**Report Tons** allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with Draw Surface >> Draw 3D Grid File and viewing them with the 3D Viewer or by contouring the grids with the Contour Grid File command.
Contours from the Draw Depth/Difference Contours option
Cut contours are red, fill contours are blue, daylight contours are green.
This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

Sample Two Surface Volumes report:

Volume Report

Comparing Grid: C:\scad2006\data\simo.grd
and Grid: C:\scad2006\data\final.grd
Lower left grid corner : 186551.67,57624.98
Upper right grid corner: 186828.81,57897.09
X grid resolution: 75, Y grid resolution: 75
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

Volumes by elevation zone
Zone 20.00 to 30.00
Cut volume : 0.30 cubic ft, 0.01 cubic yards
Fill volume: 107.90 cubic ft, 4.00 cubic yards
Zone 30.00 to 40.00
Cut volume : 4.88 cubic ft, 0.18 cubic yards
Fill volume: 73021.14 cubic ft, 2704.49 cubic yards
Running total:
Cut volume : 5.18 cubic ft, 0.19 cubic yards
Fill volume: 73129.05 cubic ft, 2708.48 cubic yards
Zone 40.00 to 50.00
Cut volume: 65044.26 cubic ft, 2409.05 cubic yards
Fill volume: 0.25 cubic ft, 0.01 cubic yards
Running total:
Cut volume: 65049.44 cubic ft, 2409.24 cubic yards
Fill volume: 73129.29 cubic ft, 2708.49 cubic yards
Zone 50.00 to 60.00
Cut volume: 17786.85 cubic ft, 658.77 cubic yards
Fill volume: 0.00 cubic ft, 0.00 cubic yards
Running total:
Cut volume: 82836.29 cubic ft, 3068.01 cubic yards

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/No)? press Enter
Volume Report Options dialog

<table>
<thead>
<tr>
<th>62.9</th>
<th>92.1</th>
<th>63.2</th>
<th>31.0</th>
<th>7.5</th>
<th>15.1</th>
<th>47.2</th>
<th>59.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>61.2</td>
<td>-70.6</td>
<td>61.2</td>
<td>53.6</td>
<td>11.6</td>
<td>-0.1</td>
<td>60.6</td>
<td>54.9</td>
</tr>
<tr>
<td>-77.2</td>
<td>-73.9</td>
<td>60.4</td>
<td>50.3</td>
<td>-16.1</td>
<td>0.6</td>
<td>60.7</td>
<td>50.4</td>
</tr>
<tr>
<td>-71.7</td>
<td>-65.6</td>
<td>-53.3</td>
<td>-56.9</td>
<td>-18.7</td>
<td>-2.1</td>
<td>55.5</td>
<td>45.8</td>
</tr>
<tr>
<td>-64.1</td>
<td>-53.0</td>
<td>-40.3</td>
<td>-25.7</td>
<td>-12.7</td>
<td>-1.1</td>
<td>41.7</td>
<td>41.6</td>
</tr>
<tr>
<td>-53.2</td>
<td>93.0</td>
<td>-26.8</td>
<td>13.3</td>
<td>2.1</td>
<td>14.0</td>
<td>29.5</td>
<td>44.4</td>
</tr>
</tbody>
</table>

This shows a grid drawn by *Plot 3D Grid File* and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

**Pull down Menu Location:** Surface >> Volumes By Grid Surfaces
**Keyboard Command:** volcalc2
**Prerequisite:** Two grid files
**File Names:** \lsp\volcalc.lsp, \lsp\volcalc.arx
**Run Off Tracking**

This command draws 3D polylines starting at user picked points downhill until they reach a local minimum or the end of the grid or TIN. In effect it simulates the path of a rain drop. The surface is modeled by a grid file as created by Make 3D Grid File or a triangulation file created by Triangulate & Contour. The program also reports the horizontal and slope distances, average slope, maximum slope, and vertical drop. These values can be used for time of concentration calculations. Runoff tracking is a convenient way to identify distinct watershed areas and is an alternative to the automated Watershed Analysis command.

**Prompts**

Enter the run off path layer <RUNOFF>: press Enter

Select Surface Model dialog box

Choose the grid file or triangulation file that models the surface. If a grid is selected, it will prompt:

**Extrapolate grid to full grid size (Yes/<No>)? Yes**

If the limits of the surface data doesn't cover the entire grid area, then the values for the grid cells beyond the data limit must be extrapolated in order to compute slopes in that area. This prompt only appears if there are grid cells without values.

**Local pond spillover depth <4.80>: press Enter**

This allows the runoff line to continue past flat or low points in the grid or TIN, by allowing these area to fill up with water, in essence, up to the specified depth, thus letting the runoff polyline continue on.

**Draw tracking for all grid cells or pick individuals [All/<Pick>]: press Enter**

Pressing Enter leads to individual picking of runoff tracking lines, while A for All would fill draw runoff polylines starting from each grid cell or each triangulation triangle.

**Pick origin of rain drop:** pick a point at the top of the run off polyline

**Pick origin of rain drop (Enter to end): press Enter**

---

**Pulldown Menu Location:** Watershed

**Keyboard Command:** runoff

**Prerequisite:** A .grd file created by Make 3D Grid File or a .flt (TIN) file created by Triangulate & Contour.

**File Name:** \lsp\cntr_grd.arx
Triangulate & Contour

This command provides a complete set of functionality for contouring, labeling, and creating tin surface models. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2D polylines, 3D polylines, elevation text, 3D faces, and points from ASCII or coordinate (.CRD) files.

*Triangulate & Contour* has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force *Triangulate & Contour* to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3D polylines and lines with elevation are treated as breaklines.

If *Triangulate & Contour* reports zero points found and fails to do anything when you're using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable *Triangulate & Contour* to read the elevation from the elevation attribute of the point.

**Triangulate Tab**

When **Draw Triangulation Lines** is turned on, the program will draw the triangulation as simple AutoCAD lines with elevation. Specify the layer for these lines in the box to the right.
When **Draw Triangulation Faces** is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD's modeling routines such as *HIDE* and *SHADE* or in Carlson routines such as *3D Viewer Window, 3D Surface FlyOver and Slope Zone Analysis*. Specify the layer for these 3D Faces in the box to the right.

**Write Triangulation File** stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file(s) can be used by several commands such as *Volumes By Triangulation, Spot Elevations, and Profile from FLT File*. Either type in the file name to create or press the Browse button to select a file name.

When **Use Inclusion/Exclusion Areas** is activated, the program will prompt you for inclusion and exclusion polylines. These are used to define the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and must be drawn before using **Triangulate & Contour**. The command line display must be set to show at least two lines to see the prompting for the selection of the Inclusion/Exclusion perimeters.

Only the parts of the contour lines and triangles that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings. When **Ignore Zero Elevations** is activated, this setting will filter out all data points at an elevation of zero from the data set.

If you would like to manually set the range over which to contour, select one of the **Specify Input/Output Elevation Range** options, one for source data and one for contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

When **Erase Previous Contour Entities** is activated, this setting will erase previously drawn contour entities.

The triangulation network is based on the x,y position of the points. **Pick Reference Plane** allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the **Viewpoint 3D** command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines** highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys** creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3d polylines along ridges and valleys.

**Interpolate Summits and Pits** creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

**Simplify Surface** is designed to reduce the digital size of a surface, without significantly compromising the integrity or accuracy of the surface. The most common application is for surfaces derived from very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized. **Simplify Surface** reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the **Tolerance** factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the **Tolerance** factor, so the higher the **Tolerance** factor, the more vertices are removed, the lower the **Tolerance** factor, the fewer vertices are removed.
If Simplify Surface is selected, the Preserve Breaklines option is activated. Preserve Breaklines further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Weight factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Weight factor, so the greater the Weight factor, the fewer vertices that are removed, the lower the Weight factor, the more vertices that are removed.

A good rule of thumb that can be used when deciding whether or not to use these options is: if the surface contains no man-made features, use Simplify Surface only, if it contains man-made features, such as roads, use both Simplify Surface and Preserve Breaklines.

![Surface made from an existing contour map. Note the flat spots in the bottom of the valley (bottom center of the image) when Interpolate Ridges and Valleys is disabled.](image-url)
After: The same surface with Interpolate Ridges and Valleys enabled. Note the smooth flowline at the bottom center of the image.

The **Max Triangle Mesh Line Length** value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The **Exterior** value applies to triangulation lines around the perimeter of the triangulation area and the **Interior** value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

An **Error Log** is generated if the *Triangulate and Contour* routine finds a vertical conflict between breaklines or other surface entities, opening the following dialog box. Three types of conflicts are reported; Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertexes of differing elevations have the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.
**Zoom** pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

**Zoom In** zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

**Zoom Out** zooms out away from the highlighted area.

**Report All/One** toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.
Draw All/One toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

Continue closes the Error Log and proceeds with the contouring operation.

Layer Name specifies the layer name for the "X" entities drawn with Draw One/All. This also sets the layer name for the "Draw Lines" option.

Symbol Size specifies the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

In the case of crossing polylines, Draw Lines will trace over the polylines responsible for the conflict. The polylines will be created in the layer specified in the layer field.

**Contour Tab**

<table>
<thead>
<tr>
<th>Northing</th>
<th>Easting</th>
<th>Elev. Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>4490.42714</td>
<td>4477.18376</td>
<td>3.0000</td>
</tr>
<tr>
<td>4189.75556</td>
<td>4337.40338</td>
<td>3.0000</td>
</tr>
<tr>
<td>4280.68117</td>
<td>4021.28227</td>
<td>3.0000</td>
</tr>
</tbody>
</table>
When the Draw Contours box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

Contour by Interval or Contour an Elevation determines whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

Use Contour Interval to specify the interval to contour. Note: If the previous option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

Contour lines whose total length is less than the Min Contour Length value will not be drawn.

Reduce Vertices attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON

When the Reduce Vertices option is enabled, the Offset Distance value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

When activated, the Hatch Zones option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Clear clears the all of the Elevation fields in the dialog.

Load loads previous settings from a saved .pat file.

Save saves the current setting configuration to a .pat file.

Auto opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

**Starting Zone** sets the zone with which to begin the application of the setting defined in this dialog. For Instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

**Set Values** enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

**Starting Value** sets the elevation of the beginning zone to define.

**Value Interval** sets the elevation increment for subsequent zones.
Set Colors enables the Starting Color and Color Increment fields.

Starting Color sets the starting color number, based on the AutoCAD standard color chart.

Color Increment sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern sets the hatch pattern for the defined zones.

Set Scale enables the Scale option.

Scale sets the scale for the selected hatch pattern.

Draw Index Contours creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

Use Contour Smoothing Method to select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

Bezier Smoothing Factor The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

Subdivisional Surfaces / Subdivisions Generation causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance's sake, consider enabling Reduce Vertices.

Labels Tab
When **Label Contours** is activated, contours will be labeled based on the settings below.

**Label Layer** specifies layer name for intermediate contour labels.

**Index Label Layer** specifies layer name for index contour labels.

**Label Style** specifies the text style that will be used for the contour label text.

**Label Text Size Scaler** specifies the size of the contour labels based on a multiplier of the horizontal scale.

Contours whose length is less than the **Min Length to Label** value will not be labeled.

When **Break Contours at Label** is checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

When **Label Contour Ends** is checked, contour ends will be labeled.

When **Draw Box Around Text** is checked, a rectangle will be drawn around contour elevation labels.

When **Label Index Contours Only** is checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with
the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

When **Align Facing Uphill** is checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the top of the text label will always be toward the uphill side of the contours. So as the labels are read right side up, the contours will be progressing uphill.

Use **Internal Label Intervals** to choose between Label Intervals or Distance Interval. Label Intervals will label each contour with a set number of labels. Distance Interval lets you specify a distance between labels.

**Selection Tab**

![Triangulate and Contour Interface](image)

When **Specify Selection Options** is checked, you can control what type of entities **Triangulate & Contour** uses. This is an excellent method of "filtering out" unwanted entity types.

Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard AutoCAD entities types.

Carlson Point Inserts refer to Carlson points which include the block SRVPNO* with the point number, elevation, and description attributes.

Spot/Bottom Elevation Inserts include text entities that start with 'X'.

From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source.
Chapter 11. DTM Menu
Contours without triangulation network

The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pulldown Menu Location:** Surface

**Keyboard Command:** tri

**Prerequisite:** Data entities in the drawing, including points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

**File Names:** \lsp\tri4.lsp, \lsp\tri4.dcl, \lsp\tri4.arx

### Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Fast TIN Intersect:** When checked, this command will perform a simple and fast check for overlapping triangles, so is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked, so that a complete and thorough check and repair of the TIN is performed.
**Fill-in-holes:** When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

**Region Mode:** This option deals with nested or overlapping boundaries. When checked, AutoCAD hatch pattern logic is applied, in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired operation/s will be performed on the entire TIN.
Add Value: Prompts for a value to Add to the subject area of the TIN.

Subtract Value: Prompts for a value to Subtract from the subject area of the TIN.

Multiply Value: Prompts for a value to Multiply to the subject area of the TIN.

Divide Value: Prompts for a value to Divide to the subject area of the TIN.

Add TIN: Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

Subtract TIN: Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

Min TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

Max TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

Merge TIN: Merges the current subject TIN into a second user-specified TIN file. There are three methods:

**Current TIN inside/Second TIN outside boundary:** This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. The current TIN file should be the smaller of the two surfaces since the
subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN.

**Second TIN inside/Current TIN outside boundary:** This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines where selected in the initial dialog. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN.

**Wipe, combine and repair Current TIN where overlaps Second TIN:** This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don’t have matching have elevations on their common boundary. Then this method will create a transition zone between the TINs.

---

**Enhance Flats:** This routine eliminates flat triangles by adding a data point inside the triangle at a different elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.

**Offset:** Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount.

**Simplify:** Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

**Tolerance:** This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Hold Breaklines:** Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Breakline Weight** factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Breakline Weight** factor, so the greater the **Breakline Weight** factor, the fewer vertices that are removed, the lower the **Breakline Weight** factor, the more vertices that are removed.
**TIN Statistics:** Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z value.

**Subdivide:** Subdivides triangles to make them more equalateral.

**Set New Elev:** Sets all TIN faces in the subject area to the elevation specified.

**Set NULLs to Elev:** Sets all NULL values in the subject area to the elevation specified.

**Set Elev to NULL:** Sets all of the elevation values in the subject area to NULL.

**Set Elev by Surface:** Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

**Output Options:** The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be toggled on.

- **Insides:** If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border:** When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides:** If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.

**Save As TIN:** Saves the current TIN as an .flt or .tin file.

**Save As DXF:** Saves the current TIN as a .dxf file. This format can be used by many other CAD programs.

**Draw As 3DFaces:** Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.
Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.

Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis.

Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.

Toggles shading on and off.

Restores the graphics to plan view.

Reverses the effects of all operations performed on the TIN and reverts it back to its original status.

This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** TINUTIL  
**Prerequisite:** 3D Faces, a TIN file or a DXF file.  
**File Name:** \SP\tri4.arx

### Draw Triangulate Mesh

This command draws a triangulation (.flt or .tin) file as either 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.

Triangulation (.flt or .tin) files can be created by *Triangulate & Contour.*

**Prompts**

**Select TMESH File to Draw**  
Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:
If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

Loading edges...
Loaded 198 points and 234 edges

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window.

Pulldown Menu Location: Surface >> Draw Surface
Keyboard Command: drawtri
Prerequisite: A triangulation (.flt or .tin) file
File Name: \lsp\contour4.arx
Roads Menu

Shown here is the Carlson Field Roads menu. Here you can work with staking, edit centerlines, create profiles and design templates.
Centerline Position

This function determines the station and offset relative to a centerline for a point. The centerline can be defined by a centerline file (.CL), a points, or by a polyline. The centerline file can be created with commands in the Roads menu. One advantage of centerline files is that it allows you to use profile files which can report cut/fills. For the points method, you can either give two points or a starting point and azimuth. The points can be defined by a point number from the current coordinate file or by simply entering the northing and easting. The first dialog for Centerline Position has the choice for centerline file or points method. With the centerline file option, the dialog shows the last centerline file name used. If this file is correct, then click OK. Otherwise use the Select button to choose the centerline file name.

Light bars are useful for left-right guidance. To enable the light bar option go to Configure Field, then to Centerline Position Settings and pick Use Light Bar.

Centerline Position with GPS

Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position. Carlson Field finds and displays in the dialog the station/offset for this point.
An arrow icon will appear on the drawing showing your location. You can move along the centerline and Carlson Field will report the station/offset in real-time. If you move beyond the ends of the centerline, then the program will stop reporting station/offset and instead will report "Off CL".

The Store button will create a point at the current position. The default description will include the current station/offset. When Store is selected, a dialog box will appear for entering the point number and description.

**Centerline Position with Total Stations**

Centerline Position uses a dialog box that is very similar to the *Point Store* dialog. Under the Setup button, make sure that the occupied point, backsight and instrument height are set. Then have your rodman set the prism over the point you are interested in. Pick Read(F1) or Read & Store(F5) and the total station will take a shot.

After the shot is taken, the dialog box looks like the one at right. Carlson Field reports the current coordinates and the station/offset. The station/offset also appears in the *Desc* box. If you click *Store*, Carlson Field will record this point and plot it on the drawing, including the *Desc* as a label.
**Pulldown Menu Location:** Roads  
**Prerequisite:** None

## Offset Stakeout

This function stakeouts a point at a given station and offset of a centerline and reports the cut or fill to a design elevation. The centerline and design elevation can be defined by four methods as set in the dialog show. The Design Files method uses a centerline file (.CL) for the horizontal alignment and a profile file (.PRO) for the vertical alignment. A template file (.TPL) for the design cross section is optional for the cross slope. Without a template file, the program will use the elevation of the profile along the centerline. A superelevation file (.SUP) and a template transition file are optional. These design files can be created with the routines in the Roads menu. The Section File method uses a centerline file for the horizontal alignment and a section file (.SCT) for the design elevation. The section file consists of cross sections of offset/elevation points for a series of stations. Section files can be used instead of the Design Files method when a road design is too complicated to model using design files. For example, if the road contains special ditches at various offsets and varying lane widths, then it may be easier to enter a final section file than to define the template and template transitions. The Points method uses two points to define both the horizontal alignment and design elevations. The design elevation is linearly interpolated between the points. The points to used are specified in the next dialog by entering point numbers from the current coordinate file or by directly entering the coordinates. The 3D Polyline method uses a 3D polyline for both the horizontal and vertical alignment. With this method, the program will prompt you to select the 3D polyline from the drawing. For both the Points and 3D Polyline methods, you can specify the starting station of the horizontal alignment. When using the Design Files and Section File methods, the horizontal alignment starting station comes from the centerline file.
After specifying the offset stakeout method, Carlson Field prompts for the station and offset to stakeout as shown in the dialog. The station should be entered as a number without the "+" symbol. The Next Interval field is used to increment the stakeout station for the next stakeout point. In addition to incrementing to the next interval, Carlson Field will also pick up special profile or centerline points between intervals. Centerline special points include: start point, end point, curve (PC, PT) and spiral (TS, SC, CS, ST). Profile special points include: start, end, vertical curve (VC, VT), high points and low points. For example, if the current station is 100 and the interval is 50 and there is a centerline PC at 112.4, then the next station after 100 will be 112.5 followed by 150. The Station List button brings up a list of all the station intervals and special stations. You can select a station to stakeout by selecting the station from the list and pressing OK.

There are two offsets to allow for separate offsets for the design elevation and stake location. The Side For Stakeout toggle selects between left and right offsets. The Design Offset is where the stake point elevation is calculated. The Stake Offset determines X,Y position of the stakeout point by finding this offset at the stakeout station along the horizontal alignment. Having Design and Stake offsets applies, for example, to staking the back of a curb, where the Design Offset is 12, but the stake offset is 17 (5' behind the back of curb, with the elevation reference to the actual back of curb design elevation). The Stake Offset can be specified either as an offset from the design point or as an offset from the centerline. There is also an optional vertical offset that applies to the elevation of the design point. With the Design Files and Section File methods, the vertical offset works as an offset from the template or cross section surface. For example, a vertical offset of -0.5 could be used to stakeout the bottom of a 0.5 subgrade. With the 3D Polyline and Points methods, the vertical offset adjusts the elevation from the along the centerline at the stakeout station.

The Read Current Position button will take a measurement from the GPS or total station to find the station of your current position. This current station is put in the Station field.
The Pick Point button will prompt you to pick a point in the drawing view. The station and offset of this point are used to fill out the Station and Offset fields.

After specifying the stakeout stations and offsets, Carlson Field uses the same stakeout function as used in the Stakeout command. This stakeout function guides you to the stakeout point and reports the cut/fill to the design elevation. You can store the stakeout point. When the stakeout is done, the station/offset dialog appears for staking the next point. Either enter the next station/offset or pick Exit to end Template Stakeout.

For total stations, you should run the Equipment Setup command before Template Stakeout to set the occupied point, backsight and instrument height.

Stakeout dialog for GPS
Slope Staking

This command guides you to the catch point where the cut/fill slope intersects the existing ground. Coordinates from the GPS receiver or total station are used to model the existing ground. There are four methods for defining the cut/fill slopes:

Design Files
Section File
User Entry
3D Polyline

Design files include a centerline file (.cl), profile file (.pro) and template file (.tpl). The centerline defines the horizontal alignment, the profile defines the vertical alignment and the template defines the cross slopes and cut/fill slopes. Superelevation (.sup) and template transitions (.tpt) files can also be used. Using the design files, any station along the centerline can be slope staked. These design files can be created with commands in the Roads menu.

Section files (.sct) can be used instead of design files when the road is too complicated to model using design files. For example, if the road contains special ditches at various offsets and varying lane widths, then it may be easier to enter a final section file than to define the template and template transitions. A section file consists of offset-elevation points at different stations. At a minimum, each station should contain the pivot point offset-elevations. The slope staking routine will start the cut/fill slope from the furthest offset point in the section.
For example, when staking the right side, the right most offset will be used as the pivot point. The section file can optionally contain additional offsets such as centerline and edge of pavement. The program can then report the horizontal and vertical distances from the catch point to these additional offsets. The section pivot offsets can also be assigned a description which the program reports before starting the slope staking. For example, a pivot offset could be "2:1 from flat bottom ditch" which is reported to the operator. When using section files, a centerline file is also required to establish the horizontal alignment. Any station along the centerline can be slope staked because the program will interpolate between entered section stations. The cut/fill slopes from the section can be either User-Entered or Continue Last Slope. The User-Entered option will use the cut/fill slope ratios as entered in the dialog. The Continue Last Slope option will use the last two points in the section file as the cut/fill slope. This Continue Last Slope option applies to section files that contain pivot point to ground segments whereas the User-Entered option is for section files that end at the pivot points.

User entry is a simple method for slope staking that only requires a centerline file. With this method, the program prompts for the cut/fill slopes and the pivot offset and elevation. The program finds this offset-elevation for the stake station along the centerline and begins the cut/fill slope from this point.

The 3D Polyline method uses a 3D polyline for both the horizontal and vertical alignments. The program will prompt you to select the 3D polyline from the drawing. There are two polyline methods. The Station Along Polyline method does slope staking perpendicular to the polyline like the other slope staking methods. The Endpoint Projection is a special method that slope stakes from the selected end of the polyline. This method is described at the end of this section.

The first dialog in Slope Staking chooses the design method. For Design Files method, the files are specified in this dialog. For the other methods, the cut and fill slope ratios are also defined in this dialog.

The next dialog sets the station to slope stake. The station should be entered as a number without the "+" symbol. For the 3D Polyline method, the starting station of the polyline is specified in the first dialog. For all the other methods, the starting station of the alignment is set in the centerline file. The Next Interval field is used to increment the stakeout station for the next stakeout point. The Read Current Position button will take a measurement from the
GPS or total station to find the station of your current position. This current station is put in the Station field. The Pick Point button will prompt you to pick a point in the drawing view. The station of this point is used to fill out the Station field. For the User-Defined method, this dialog also contains the offset and elevation of the pivot point. For the 3D Polyline method, this dialog also contains the pivot point offset and vertical offset from the 3D polyline to the pivot point.

For the design file method, the centerline elevation at the stakeout station is calculated using the design profile and then the template is applied to calculate the pivot point. For the section file method, the pivot offset is interpolated from the section file. For example, if the stakeout station is 75 with offset right and the section file has offset-elevation of 18.0 right, 100.0 elevation at station 50 and has 20 right, 102.0 elevation at station 100, then the pivot offset for station 75 would be 19.0 right, 101.0 elevation. For the user entry and 3D polyline methods, the pivot point is specified Station For Slope Stake dialog.

After the slope stake station and pivot point are specified, Carlson Field begins to read the GPS receiver or total station to get the current position. The existing surface to tie into is defined by the elevations from these current position coordinates. The point where the cut or fill slope from the pivot point intersects the existing ground is called the catch point. As each coordinate is read, an existing surface cross section is built and the catch point is calculated. Carlson Field will automatically determine whether to find the catch point on the right side or left side of
the centerline depending on the side of your current position. The program displays, in real-time as you move, the
northing-easting and station-offset-elevation of your current position and the offset of the catch point. The distance
from the current position to the catch point is reported as the offset difference as either "IN" or "OUT". The OUT
means you should move out from the centerline. The IN means that the catch point is closer to the centerline. Based
on this offset difference, you move perpendicular to the centerline either towards or away from the centerline to
reach a new offset from the centerline while maintaining approximately the same station. The difference between
your current station and the stakeout station is reported as the "UP" or "DOWN" distance. The UP means that your
current station is less than the stakeout station and you should move up the centerline. Likewise, the DOWN means
that your current station is greater than the stakeout station and you should move back down the centerline.

When the catch point is located, press the Store button to end the slope staking. A report dialog is then displayed.
The Catch Pt is the actual station, offset and elevation of the target catch point. The Stake Pt is the as-staked station,
offset and elevation of your current position. The dialog also reports the horizontal and vertical distances from the
catch point to the pivot point and the other template points. The Store Catch Point option will record the as-staked
coordinates of the catch point to the current coordinate file. The Stake Offset Point is an option to locate an offset
point. The offset to stake can be entered as a distance from the catch point or as an offset from the centerline.
To locate the offset point, the same stakeout function from the Stakeout command is used. This function will guide you to the offset point. When the offset is reached, pick the Store button. Then an Offset Point Report dialog pops up containing the station, offset and elevation of the offset point and the horizontal distance, vertical distance and slopes from the offset point to the catch point, from the catch point to the pivot point and from the pivot point to the template points.

After locating the offset point, the station to stakeout dialog appears. You can enter the next station to stakeout or pick the Exit button to end Slope Staking.

**Endpoint Projection**

This is a special case of the 3D Polyline method that slope stakes from the end of the polyline. The program will prompt to pick a polyline and the end to stake from is the end nearest to the pick position. The direction of slope staking is in the direction of the polyline as if extending the polyline. The program prompts for the elevation of the pivot point which defaults to the elevation at the polyline endpoint. There is also an option to offset the pivot point along the polyline back from the endpoint.

After the pivot point is specified, the program starts the stakeout routine to guide you to the catch point. Then there is a report to show the difference between the staked and the calculated catch point.

**Pulldown Menu Location:** Roads  
**Prerequisite:** A centerline file or 3D polyline

**Slope Inspector**

This command reports the azimuth, distance and slope between your current position and a starting point. The command starts by prompting you to move to the starting point and take a reading. This sets the starting point.

**Slope Inspector with GPS**
Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position and the azimuth, distance and slope from the starting point to your current position. An arrow icon will appear on the drawing showing your location. Pick the New Start button to set a new starting point.

**Slope Inspector with Total Stations**

Before running Slope Inspector, make sure that the occupied point, backsight and instrument height are set correctly in the Equipment Setup command. Then start Slope Inspector and read a measurement for the starting point. A dialog box appears displaying your current position. Pick the Read button to take another measurement. Carlson Field will calculate the new point and report the azimuth, distance and slope from the starting point to the new point. An arrow icon will appear on the drawing showing your location. Pick the New Start button to set a new starting point.

**Prepare Story Stake**

This command creates points with cut/fill information stored in the note fields for the points. Beginning at a point and facing a specified direction, the cut/fill information describes a design surface that is defined by contours and 3D polylines in the drawing. The program prompts you to pick the starting point followed by a direction point. Then the intersections for all the contours and 3D polylines between these two points are calculated and the resulting horizontal distances and slopes are shown in a dialog. In this dialog, you can edit, add or remove these slopes descriptions. The Point Description can also be specified. When OK is clicked, a point in the coordinate file is created at the starting point with this information stored in the note file. An offset point is also created at the specified offset distance back from the starting point. At the end of Prepare Story Stake, a report of all the created points and the corresponding cut/fill data is shown if the Create Report option was set. Prepare Story Stake does not draw the points in the drawing. These points can be drawn using the Draw-Locate Points command.

The cut/fill information in the note file can be used in the Stakeout routine. In Configure Field>Stakeout Settings there is an option to Display Point Notes in Stakeout Report. With this option active, the cut/fill data in the note file will be displayed when the point is staked out.

Prepare Story Stake is not a prerequisite for Story Stake By Points or Story Stake By Polyline. In fact, working in...
combination with Stakeout, Prepare Story Stake is an alternative to these other routines.
Story Stake By Points

This command creates a report of cut/fill slopes and distances of a design surface from a starting point. First you move to the starting point and then take a reading from the instrument to get the starting point coordinates. This starting position is shown in the drawing. Next you pick a point in the drawing to define the direction. The drawing should contain the design surface entities. The program will then calculate all the intersections with contours and 3D polylines between these two points. The resulting horizontal distances and slopes are shown in a report dialog. From this dialog, there is an option to stakeout one or two offset points set back from the starting point at the specified offsets.

![Story Stake Dialog](image)

Story Stake Along Polyline

This command creates a report of cut/fill slopes and distances of a line across a design surface. The line is defined as perpendicular from a polyline starting at a specified station and going a specified distance. The drawing should contain design surface entities. The program will calculate all the intersections with drawing contours and 3D polylines along the line. For example, the polyline could be a toe of slope and this routine would be used to create story stakes at an interval along this polyline.

The routine starts by selecting a 3D polyline from the drawing. Then there is a dialog to specify the settings. The Station is the distance along the polyline for the starting point of the story stake. The Next Interval is used to increment the station for the next default station. The Story Offset is the length of the story stake line from the

Chapter 12. Roads Menu 468
starting point. To have the story stake line go perpendicular right from the polyline, enter a positive offset value. To go left, enter a negative offset. The Read Current Position button will take a measurement from the instrument to find the station of your current position. This current station is put in the Station field. The Pick Point button will prompt you to pick a point in the drawing view. The station of this point is used to fill out the Station field.

After specifying the stakeout station and story offset, then program runs the stakeout routine to guide you to that station on the polyline. When that point is staked, the program calculates the story stake and the resulting horizontal distances, cut/fill and slopes are shown in a report dialog. From this dialog, there is an option to stakeout one or two offset points set back from the starting point at the specified offsets.

![Story Stakeout](image)

![Story Stake Report](image)

**Input-Edit Centerline File**

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc.). For creating a new centerline, it is ideal for entering
data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.

**Up/Down:** Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45 degrees NE, moving the last element up would create a line at 45 degrees after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45 degrees.

**Draw:** This button draws the centerline in the drawing on the specified layer.

**Drag Action (Zoom and Pan):** In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

**Load:** Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

**Add:** Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

**Edit:** Allows you to edit the highlighted segment.

**Remove:** Removes the highlighted element from the centerline.

**Assign Point Numbers:** This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

**Reverse:** Reverses direction of Centerline.

**Save:** Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

**SaveAs:** Prompts you for a file name for the saved file.
Exit: Exits this routine, prompting to save changes if necessary.
Help: Goes to the Help screen for the Input-Edit Centerline command.
Station Equations: At any number of locations on a centerline, you can set the back station and forward station for
the re-stationing of the centerline. The station equation dialog appears below:

If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump
forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range
is repeated.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the
element. It then allows the user to modify or define the parameters specific to the type of element. The following
are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and
spirals.

Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would
evaluate the difference of the values. This is particularly convenient where only the stations of the start and end
points of the element are known.

When the station is specified, the program takes the length of the element as the difference between the
station of the start point of the element and the station specified.

All bearings should be specified by entering the angle between 0 and 90 degree (in dd.mmss format) and
selecting the quadrant.

When entering the delta angle of a curve, only the absolute value (between 0 and 360 degree) is to be
entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered
in (dd.mmss) format.

Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified
has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the
radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for
that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line
can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential
to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to
be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the
bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length.
The other parameters of the curve that can be edited are the bearing of tangent-out and the "Station to", which also
defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point
(PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station
and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be
defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right).

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Example
Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Here is the starting dialog.

You start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only).
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
Spiral Segment: Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, (3) the tangent-out bearing and (4) the PI station (1835.67). Everything else will calculate when you press Enter for the PI station.

Curve Segment: Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

Final Line Segment: All you need to enter in the final dialog for the line (tangent) segment is its length. All other
items will calculate when you press Enter.

The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
**Keyboard Command:** cledit  
**Prerequisite:** A CRD file to put points or take points from  
**File Name:** \lsp\eworks.arx

**Polyline to Centerline File**

This command writes a centerline (.CL) file from a polyline. The northing and easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve.

**Prompts**

- **Centerline file to Write dialog** Enter the .CL file name to create.  
- **Beginning station** <0+00>: press Enter Or, type in the beginning station then press Enter.  
- **Select polyline that represents centerline:** pick the polyline that represents your centerline

**Keyboard Command:** clpline  
**Prerequisite:** A polyline  
**File Name:** \lsp\quikcl.lsp

**Draw Centerline File**

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an Options choice that allows you to specify whether to draw PI lines, and specify the length of same.

![Draw Centerline Options](image)

Next you are prompted for the file name of the centerline to plot.
The .CL file can be made with the following commands on the Design menu: Polyline to CL File, Input-Edit Centerline or Design Centerline. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

Prompts

Options/Layer Name for Centerline <CLINE>: press Enter Enter the layer name to plot the polyline on.
Centerline File to Plot file selection dialog: Select the .CL file name to read and plot.

Keyboard Command: cl2pline
Prerequisite: a centerline file
File Name: \lsp\clpline.lsp

Centerline Conversions

There are twelve Import options available in Carlson Civil to convert other applications' centerline files to Carlson Civil centerline files (.CL), and five Export options to convert Carlson Civil centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create, each Export option prompts for .CL file to convert and a file name for the new file.

Pulldown Menu Location: Centerline > Centerline Conversion
Keyboard Commands:
File Names: \lsp\cogoutil.arx

Input-Edit Profile File

This command is a spreadsheet type editor for profile (.PRO) files. Besides editing a profile, this routine can be used to just view the contents of a profile. Also, a new profile can be entered by editing a previously empty or non existing file.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. You can change the look of the profile more by using the vertical exaggeration multipliers. The station, elevation and slopes are also shown at the lower left of the dialog, fluctuating with the movement of the cursor. Then there are between five and nine columns for the possible fields in a profile. Which columns are active depends on the type of profile: generic, road, sewer, pipe, crossing or circular. Six rows are visible at a time. To view different rows, use the scroll bar on the right. When a greater amount of columns are in use, use the scroll bar at the bottom. The Profile Name edit box is an optional identification name used by multiple profiles in Draw Profile. The Add Row and Remove Row buttons, when used, will dynamically and immediately make changes to the profile image at the top.

On the right is a column for Check Stations which report the elevation at the specified stations. The Check Stations are not stored in the profile. This is a design tool for viewing the elevations at certain stations while adjusting the profile data. The last line has eight action buttons.
**Add Row:** Adds a new row into the profile after the current row.

**Remove Row:** Removes the current row.

**Type of Profile:** Choose. Column titles and the amount of columns will change accordingly.

**Hold Next Slopes:** A toggle that may applied or left blank.

**Use K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.

**Select Reference profile:** An option to show a second profile as reference. When a reference profile is active, the Check Stations and graphic window report the cut/fill with the current profile and the elevation of the reference profile. Also with a reference profile active, the spreadsheet adds a column for depth.

**Vertical Speed Tables:** This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

**Next:** Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

**Previous:** Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

**Transform:** Allows you to either Translate or Scale the profile. Translate globally adds or subtracts value to stations and/or elevations within the specified range of stations, while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.

**Load:** Used for loading another, existing .PRO file for editing.

**Save:** Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

**SaveAs:** Allows you to save the profile under a different profile file name.
Keyboard Command: profedit
Prerequisite: None
File Names: \lsp\profile.dcl, \lsp\profedit.arx

**Draw Profile**

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or without a grid or with just tick marks. The vertical curve annotations, for a road profile, and manhole annotations, for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw.
The Draw Profile dialog box appears, and contains all of the settings for creating the profile.

**Draw Grid:** This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.

**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs east to west and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate. Unavailable when Draw Sheet is checked.
**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Vertical Grid Adder to Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile.

**Draw Elevation Labels Only On Left Side:** This option eliminates elevation labels on the right side of the profile.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Grid Type:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:

![Station Text Orientation - Vertical](image1.png)

![Station Text Orientation - Horizontal](image2.png)

**Draw Sheet:** When checked, the profiles will be drawn in paper space. Plan Only, Profile Only, or Plan and Profile sheets can be created. Each plan and profile sheet is created in it's own layout tab. When the plan and profile is drawn, you are placed in tilemode=0 and paper space. Click the "model" space tab (shown below) to return to model space to edit the plan view features, for example. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog:
**Layout Name:** Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1. If you enter "ms" to go to model space within a layout tab, you can pan to alter the plan view position. Its best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

![Layout Setup](image)

**Block Name:** This is the drawing name for the plan and profile sheet to be inserted. Carlson provides a standard plan and profile drawing in the form of Profile.dwg located in the Support subdirectory. You may wish to revise Profile.dwg, add your company logo, and re-save it as Profile1.dwg or you could add your own complete version of a Plan and Profile sheet. If you choose the latter, you should examine the scale, dimensions and the lower left corner of Profile.dwg, and try to duplicate those dimensions and corner coordinates in your own drawing. It is also important to store all your standard profile sheets in the Support subdirectory. You cannot draw Right to Left in Sheet mode. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the *Flip Text* command under the Edit menu.

**Sheet Width:** This is the profile width, in inches, on the sheet. Even though the sheet is a fixed size, you can limit the length of the plot to 32 inches or less with this entry. If we used an entry of 16 for the example profile above, two plan and profile sheets would be created, because the first sheet would go from station 0+00 to 3+20 (16 inches at a 20 scale) and the second sheet would finish from 3+20 to 4+51.91. In English units, a typical entry here would be 30 for 30 inches.

**Overlap Station:** In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.

**Sheet Contains:** This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.
**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view.

**Draw Layout Plan View Borders in Model Space:** This draws the borders in Model Space.

**Plot at 1:1:** With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

**Fit Each Vertical:** With this option turned on, the command will recognize the lower and upper vertical elevations of the profile and set the vertical axis elevation range to enclose the actual elevation limits of the profile. With this option turned off, you can enter the lower vertical elevation range, dropping it down further to increase the lower margin. Whether or not the Fit Each Vertical option is turned on or off, you are always prompted for the top elevation range.

**Tile Sheets:** If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.
Prompts (Draw Sheet option)

You are first asked to select the polyline that represents the centerline, and the program best fits the centerline in the plan view portion of the plan and profile sheet, then captures all of the associated drawing that will fit in that paper space window. If the length of the polyline divided by the scale exceeds the Sheet Width entry (for example, 5000 feet of road divided by 50 Horiz. Scale is 100, which exceeds the sheet width), then multiple plan and profile sheets will be automatically created. A 5000 foot road at 50 scale with a 30-inch sheet width, would lead to 3 full sheets of 1500 feet each and a "leftover" fourth sheet showing the last 500 feet.

Bottom Vertical Spacing <0.0>? press Enter

The program places the profile plot flush against the bottom of the vertical grid, by default. This prompt allows for an offset, moving the profile plot up off the bottom of the grid. If the lowest elevation of the profile is 940 by default, entering 10 would start vertical axis labeling at 930, and if the vertical scale was 5 units, this would push the vertical plot up 10 units or 2 standard grid intervals.

Top Elevation of Profile Grid <945.0>: press Enter
Cl File/Select polyline that represents centerline: Select the centerline polyline (if Draw Plan has been clicked on).
Beginning Station <0.0>: press Enter

The items below refer again to the profile options that are independent of the Draw Sheet option:

Draw Horiz Axis Elev: This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog.
**Draw Horiz Label Box:** This option draws a boxed area underneath the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog. An example of the resulting plot is shown here:
Draw Break Point Sta: Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Station Setup dialog.

<table>
<thead>
<tr>
<th>Station</th>
<th>0+00.00</th>
<th>0+13.45</th>
<th>0+24.43</th>
<th>0+50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>140.09</td>
<td>139.95</td>
<td>140.66</td>
<td></td>
</tr>
</tbody>
</table>

Draw Break Point Elev: Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.
**Draw Break Point Desc:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.

**Starting Station:** This field defaults to the starting station in the selected profile(s). If changed, the starting station can move forward, clipping out the first part of the profile. When you are not plotting sheets, you must set the starting station to the end of the previous sheet's ending station to force a multiple sheet layout.

**Ending Station:** This field defaults to the ending station in the selected profile(s). A profile that is 3000 feet in length could be plotted in 2 parts, first station 0 to 1500, then station 1500 to 3000, using the Starting Station and Ending Station options.

**Label Text Scaler:** This sets the size of text used for vertical curve annotation to the horizontal scale times the scaler, when you are working in English units. In metric units the text height would be 0.01*horizontal scale*scaler.

**Link To Files:** This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s). If set to Off, there is no linkage, Prompt will
ask whether to update the plotted profile(s) when the file changes, and Auto will automatically update the plotted profile(s) when the file changes.

**Match Line Elevations:** For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion with its own vertical scale, as seen above.

**Elevation Range:** This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range above is 20), the program will break the profile and draw the remainder with a separate vertical axis range.

**Grid Scale and Interval Settings**

**Horizontal Scale:** This scale applies primarily to text size. If the text scaler is 0.1 and the horizontal scale is 50, then text size will be $0.1 \times 50 = 5$.

**Horizontal Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.

**Horizontal Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. When using a large "Axis Text Scaler", the horizontal axis text can become too large, and it often necessary to space the horizontal text interval at twice the horizontal scale.

**Vertical Scale:** This scale sets the vertical exaggeration of the profile. If the horizontal scale and vertical scale are the same, then the vertical is not exaggerated. Profiles are often plotted with a 5 or 10 vertical exaggeration. For example, the horizontal scale may be 50, but the vertical scale may be 5.

**Vertical Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.

**Vertical Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.

**Label Settings:** These 4 buttons are where you gain access to control over specific label settings for different profile types.

Layers, Colors, Text Styles and Linetypes buttons provide access to settings for each of these features of the profiles.
Chapter 12. Roads Menu
Load Settings: Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.
Save Settings: Saves all Draw Profile settings in a (.PFS) file.

When OK is clicked at the base of the dialog box, the prompting at the command line continues. In this example, assume that a road profile has been selected, since more prompts will occur with road profiles than with generic profiles.

Prompts (Road profile example)

Erase existing profile from drawing [<Yes>/No]? N This prompt appears only if you have previously drawn the profile.
Next a dialog appears to set the Profile Grid Elevation Range by specifying the Top and Bottom Elevations. Adjust as desired, pick OK.

Pick Starting Point for Grid \(8779.55 , 5716.36\): *pick a point for the lower left corner of the grid*

Assuming a road profile has been selected, the following dialog box appears:

**Include K-value:** This option is a function of the change in slopes on either side of the point of vertical intersection.

**Include Sight Distance:** This option is computed by the delta slope and is a function of whether the vertical curve is a sag or a crest.

**Include Grade:** This option draws slopes along the tangent portion of the vertical curves, with slope direction arrows.

**Draw Vertical PVC and PVT Lines:** This option draws vertical lines emanating from the PVC and PVT of all vertical curves.

**Position Text Below Line:** This option draws the PVC, PVI, and PVT information under the picked location for the vertical curve labeling.
**Pick Each Label Position:** If there were more than one vertical curve in the profile, this option allows you to pick a vertical position for each of the vertical curve’s annotation.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Number of Decimal Places:** Choose the decimal precision used in the elevation and stationing annotation for vertical curves.

Next, select a point vertically that corresponds to the position of the left-right lines under which is written percent grade and above which is written the vertical curve length, sight distance, and K-factor, if requested. The PVC, PVI, and PVT stations and elevations are written above or below this picked point depending on dialog box settings.

Sewer Options:
Additional Prompting for Multiple Profiles

Detected multiple profiles within C:\CARLSON PROJECTS\2006-0124\DATA\PRO\EXAMPLE.PRO

Note that the Profile from Surface Entities command can store additional profiles into the same profile file.

**Draw profiles on same or different grids (Same/<Different>)? press Enter** This determines whether the multiple profiles will be drawn together on the same grid or drawn on separate grids.

**Uniform or variable grid size (Uniform/<Variable>)? press Enter** This selects between one-size-fits all grids or
individually sized grids for each profile.

**Keyboard Command:** drawprof  
**Prerequisite:** A .PRO file  
**File Names:** \lsp\drawprof.lsp, \lsp\profile.dcl, \lsp\vcplot.lsp, \lsp\endsewer.lsp

### Profile Conversion

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.

### Import Columnar Text

Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.

![](import_profile.png)

### Import CAiCE Profile

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** caice2pro  
**File Name:** \lsp\profedit.arx

### Import Leica Profile

*Chapter 12. Roads Menu*
Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

**Choose Leica/Wild File to Readdialog** Select existing file.
**Choose Profile to Writedialog** Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** wildpro2
**File Name:** \lsp\profedit.arx

### Import MOSS Profile

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

**Choose MOSS Profile File to Readdialog** Select existing file.
**Choose Profile to Writedialog** Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** moss2pro
**File Name:** \lsp\profedit.arx

### Import Softdesk Profile

Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** dcapro2
**File Name:** \lsp\profedit.arx

### Import Sokkia/SDR Profile

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** sdr2pro
**File Name:** \lsp\gisutil.arx

### Import Spanish ALZ Profile

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

**Choose CLIP File to Readdialog** Select existing .ALZ file.
**Choose Profile to Writedialog** Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** alz_to_pro
**File Name:** \lsp\eworks.arx

### Import Spanish RAS Profile
Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

**ISPOL File to Read dialog** Select existing .RAS file.
**Choose Profile to Write dialog** Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** ras_to_pro
**File Name:** `\lsp\eworks.arx`

### Import Terramodel Profile

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** tm2pro
**File Name:** `\lsp\gisutil.arx`

### Export Softdesk Profile

**Choose Profile File to Read dialog** Select existing .PRO file.
**Choose Softdesk File to Write dialog** Enter new Softdesk file name.

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Command:** dcapro1
**File Name:** `\lsp\profedit.arx`

### Export Leica Profile

**Choose Profile File to Read dialog** Select existing .PRO file.
**Choose Wild File to Write dialog** Enter new .GSI file name.
**GSI file format [<8>/16]?** press Enter

**Pulldown Menu Location:** Profiles > Profile Conversions
**Keyboard Commands:** wildpro1
**File Names:** `\lsp\cogoutil.arx`

### Design Template

This command creates a template definition file (.TPL file). The template file can then be applied in the *Process Road Design, Draw Typical Template, Locate Template Points* or *Design Pad Template* commands. The template is designed using the dialog shown below. The top portion shows the template as you create it. In the middle is a row of icons which are the building blocks of the template. They can be chosen in any order by picking on the icon. In the bottom of the dialog are four list boxes that list the elements of the template. The surface elements are listed in order starting from the center. The subgrades are listed from top to bottom order. To add a template element, highlight the position in the list above where to insert the element. Then pick one of the element icons. To change the order of an element, highlight the element and pick the Move Up or Move Down buttons. The Edit button edits the dimensions of the highlighted element. The Remove button erases the highlighted element from the list. There is no limit to the number of surface or subgrade elements. Note that there is a Right Side Same as Left option. When active this option only requires template design for the left side and will automatically mirror the design for the right side.
The template surface can be composed of three types of elements: medians, grades and curbs. The median is a flexible closed figure defined in a clockwise direction. Each median point consists of an X and Y offset. The median must be closed and the program will automatically create the closing segment. In the Median Design dialog, the median is shown in the top display and bottom has a list of median points. The display shows the median in magenta and the grade lines in and out in green. For the display the grade in comes from the left and the grade out goes to the right. The median must define the Grade In point which is the point that ties into the incoming surface grade. Also the Grade Out point must be specified for where the surface grade continues out from the median. These Grade In and Grade Out points emanate from the starting or "from" position in the coordinate dialog where they are specified. Since a single median must be placed on the left or right side (and is typically not used symmetrically with right side same as left), you will need to offset the template centerline one-half the median width within the command Process Road Design in order to center the median. You will also have to move the "C/L" designation, to obtain centering, when using Draw Typical Template.
You can design a median for "mirroring" to create a centered effect, as shown below. The only negative to this method is the appearance of a vertical line in the median plot. Medians can be saved and loaded for re-use in other templates.
Surface grades can be entered by selecting the Grades icon which brings up the dialog shown. Downhill slopes are negative and the Distance is the horizontal distance. The text ID serves 4 purposes: (1) The ID will be applied as a description to all final template points generated in the form of a coordinate (.CRD) file, (2) The ID can be used as a design point, as in EP+5 indicating 5 feet or meters right of edge of pavement, (3) Points of common ID may be connected by 3D polylines as an output option of Process Road Design and (4) Quantities can be generated with reference to the ID and material (gravel, concrete, etc.) entered elsewhere within this command.

To add a curb, select the Curb icon. The dialog box below appears where you can fill in the curb dimensions. There are three curb types to choose from. The curb dimensions can be specified in feet, inches or meters in metric mode. The Rounding option will smooth the surface of the curb which only shows when the template is applied in commands such as Process Road Design. The Integral/Separate option determines whether to draw the front line of the curb to separate the curb from the subgrade. For example, fully concrete pavements that contain a curb would be drawn with the "integral" curb option. The slope of the curb can either be flat, set to the slope of the incoming grade or set to a user-specified slope. The material name is used in the Process Road Design report:

- Straight & rounded curbs
- Integral and separate curbs
To specify cut treatment, pick the Cut icon. There is room to specify up to five cut slopes which can be slopes in series or slopes to use at different depths. In a simple case of one cut slope, you can just enter the one slope value and leave the depth and other slope boxes blank. For Slopes in Series, each slope is used up to the specified depth until an intersection with the ground. If the intersection is not reached by the first slope, then the next slope continues from where the first ended. If you have more than five slopes, pick the Repeat Slopes option which will repeat the sequence of entered slopes until the ground is reached. The Bench Between Cuts option allows you to enter a bench width and percent slope to be inserted between each cut slope. Besides running the cut slopes to specific depths,
Cut To Section option can be used to have each cut slope intersect a surface from a section (.sct) file. With Cut To Section on, the Process Road Design command will prompt for these cut slope section files. For example, this Cut To Section option could be used when you have a cut bench that occurs at a set elevation but different cut depths as the road profile changes. In this case, you could create a section (.sct) file at this set bench elevation.

With Slopes in Series off, just one of the slopes is used depending on the depth. For example, set the dialog as shown to use 4 to 1 slopes at depths up to 4 feet, 3:1 up to 10 and 2:1 if deeper. The effect is 4:1 if shallow and, by contrast, 2:1 if the fill is deep. The Smooth Transitions option will gradually transition the slopes from one range to the next. In this example, if the depth is 5 feet the slope will be between 4:1 and 3:1. The graphic in the Design Template dialog will explicitly show slopes in series versus individual slope depending on setting (shown below are individual slopes, with slopes in series off):

The Pivot at Subgrade option will position the cut pivot point where the bottom subgrade intersects the template grade. The ditch or upslope conditions will then occur from this special subgrade "daylight" pivot point, instead of from the outer shoulder surface pivot point. The Tie to Existing Point will draw the cut slope from the cut pivot point to either the outside offset-elevation or an offset-elevation point with a specified description from the existing section file. This method is used when survey crews take sections and designate the specific slope tie points.

The Slope to Rock applies in Process Road Design when using a Rock Section File. There are two slope order modes for rock slopes: Slope TO Rock and Slope FROM Rock. For the Slope TO Rock mode, the cut slope will be the Slope To Rock up to the rock surface. After reaching the rock surface, the regular cut slopes apply. For the Slope FROM Rock mode, the regular cut slopes apply up to the rock surface. Then from the Slope From Rock applies from the rock surface to the ground surface.

Ditch Grades can be inserted prior to the application of the cut upslope. For curb and gutter roads, there is typically no ditch. But for roads with drainage downhill to the outside and no curbs, ditches are typically used in cut conditions. The Ditch Grades list contains each ditch grade in order from the regular template. Any number of ditch grades can be added by picking the Add Ditch button. To create a V ditch, add just one ditch grade such as slope ratio -1, distance 1. This makes one side of the V. The pivot point for the cut slopes will be the bottom of the V.
and the other side of the V will be made by the cut upslopes. For a ditch with a flat bottom, you could have two ditch grades such as slope ratio -2, distance 4 and then slope percent 0, distance 2. If a minimum depth for ditch is entered, no ditch will be applied unless the cut exceeds that depth. The Force Berm will apply the Berm (defined using the Fill icon) in cut instead of a ditch up to a certain depth of cut.

Fill treatment is similar to cut. Up to five slopes for different depths can be specified. Slopes in Series and Smooth Transitions work the same way as cut. Berm Grades are the fill equivalent to Ditch Grades. Fill treatment does have some extra options. Guardrail Expansion will extend the last template surface grade the specified Shoulder Distance when the fill is greater than the Min Depth. The Force Ditch option has two different methods to apply the Ditch Grades from the cut definition. With "At Base Of Fill" on, Force Ditch creates the ditch where the fill slope hits existing ground. With "At Base of Fill" off, the Force Ditch method applies the ditch grades from the template pivot point. The Minimum Depth for Berm Grades will only draw the Berm Grades when the fill depth is greater than the specified value.

The Right of Way icon brings up the dialog shown which allows you to specify whether to use a retaining wall to keep the cut/fill slopes from crossing the right of way. The right of way data is stored in a centerline file (.cl file) as stations and offsets for the left and right sides of a centerline. When the retaining wall option is active, the cut or fill slope will go at the design slope up to the right of way and then the slope will tie into the ground by going...
straight up or down. Without the retaining wall option, the cut or fill slope will become steeper in order to tie into the ground at the right of way. For example, if the cut slope is 50% but this slope ties into the ground past the right of way, then the slope will be modified to something steeper such as 65%. The Offset ROW options will force the tie in the offset distance before the right of way.

The Shoulder Super Elevation icon specifies where on the template the slopes will transition between super elevation slopes and normal slopes. The transition point is identified under Pivot Point by the template id for the grade, curb or median. Note that the pivot point can be specified as an ID plus a distance as in "EP+2". Starting from the center, the template grades will be in super up through this template segment. For example, based on the template shown in the first dialog of this command, the EOP Pivot Point the Super Elevation Settings dialog will create the first EOP grade in super while the curb and grade S will be at normal grade. The High and Low Pivot Point options allow for different transition points depending on which side is raised by the super elevation. The Max Percent Slope Difference is the maximum difference between the super elevation grade and the normal grade at the pivot point. For example with a Max Percent Slope Difference of 7%, if the super elevation grade is 6%, then the slope after the pivot on the high side will be -1% even if the normal design slope is steeper than -1%. If the grades do not start from the center in super, then the Divided Roads option can be used. With this option, the grades start from the center as normal and then transition to super at the Normal to Super Pivot Point.
Example of super elevation of 4% to the right for a divided road with a Max Difference of 7%. The normal template is shown above. The Normal to Super Pivot Point is MED and the Super to Normal Pivot Point is EP. The result is that the EP segment is in super and the SH and MED segments are at normal slope. On the left, the SH segment is at the normal -10%, the EP segment is at the super elevation slope of -4% and the MED segment wants to be at 4% but ends up at 3% because this meets the Max Difference requirement. On the right side, the MED segment starts at the normal -4%, then the EP segment transitions into the super -4% and then the SH transitions back to normal which results in a 3% slope because of the Max Difference requirement.

To add subgrades click the SubGrades icon which brings up the dialog shown. The subgrades are areas below the template surface. There can be any number of subgrades stacked one below another or side by side.

The subgrade starts from the surface at the distance from the center set under Horizontal Offset. To start from the centerline, enter 0 in Horizontal Offset. First the subgrade moves straight down from this Horizontal Offset. The depth down is specified in Vertical Offset in feet units or meters in metric mode. The Vertical Offset normally should be set as a negative number. The bottom of the subgrade then either moves away from or towards the center depending in the Direction In or Out setting. The distance to move is specified under Distance. The Slope Type for
the subgrade bottom can be either set to a specified slope or set to match the grades of the surface. After moving
the specified distance, the subgrade will tie back into the template surface either by going straight up, by continuing
at the subgrade slope until intersecting the surface or by wrapping around. The commonly used "continue slope"
approach will extend the slope until it hits something (like a curb or another surface segment). It will not trim. So
if the pavement segment is 12 feet to a curb, it is better to enter 10 and "continue slope" than to enter 12 exactly,
as a "tilted" curb may place the curb edge at 11.98' from the start of the subgrade, causing the subgrade to go past
face of curb and intersect back of curb. Also, for angled tie-ins of subgrade from base of curb to the surface, such
as the example shown below, be sure the distance entered is less than what would intersect the surface, so that the
"extend" effect will create the intersect. In this example, the first subgrade (asphalt) is "continue slope", the second
(gravel) is "straight up" and the third (gravel tie in behind curb) is "continue slope".

The Material field is an optional description that is used in the Process Road Design report. Special super
elevation pivot points may optionally be specified. The values for Horizontal Offset, Distance and Pivot Offset
can be specified by template ID. For example, EP could be used in Distance to have the subgrade have a width
of the EP grade. Also expressions can be used such as EP+5 to go the distance of the EP segment plus 5. This
is especially useful for template transitions so that if the EP grade varies the subgrade width will automatically adjust.
Keyboard Command: template
Prerequisite: None
File Name: \lsp\tplmake.arx

**Draw Typical Template**

This command draws a template and labels the slopes and distances. The cut and fill treatment can be shown on the left and/or right sides. All the cut/fill slopes are shown for the different depths when multiple slopes are defined. There are options to draw the normal template, super elevation or details of different sections.

You will be prompted to select the template (.TPL) file first, then the Typical Section dialog appears. Specify the parameters and press the Draw button.
Prompts

Template File to Read Specify a template file.

Typical Section dialog Set your options then click Draw.

Pick Starting Position: pick a point

Curb Detail

Normal Typical Template
Typical Template with Left Super Elevation

**Keyboard Command:** typical

**Prerequisite:** A template file (.TPL file)

**File Name:** \lsp\eworks.arx

## Template Transition

This command creates a template transition file (.TPT file) that can be used for the commands *Locate Template Points* and *Process Road Design*. The template transition is associated with a typical template (.TPL) file. The template transition file defines changes in grade distances or slopes for a specific template ID through a specified range of stations. Lane widths, for example, can be made to expand and contract. You can only modify existing template grades. Template Transition does not allow curbs, medians, subgrades or cut/fill treatment to be modified. Also new template elements cannot be added and existing elements cannot be removed. For this reason, lanes of road that "emerge" and slope distinctly from standard road lanes would need to be entered as small (0.001 in width) segments in the original template, available for expansion using Template Transition. Template Transition offers one of 3 ways to change template widths and slopes. Another way involves use of Template Point Profile and Template Point Centerline, where a particular template ID can be directed to follow a specific profile and centerline of its own. The third method is template-to-template transitions using Input-Edit Template Series, where distinct templates transition one to another. All three methods require that template IDs "pre-exist" in order to be expanded, or to follow profiles and centerlines, or to transition between template files. So the technique of making very short phantom segments for emerging and disappearing "lanes" or roads with distinct grades is universal. If special slopes are not involved, lanes can expand and contract without creation of phantom segments in the original template. Only clever use of Input-Edit Template Series, where templates with no curbs could "end" and templates with curbs can begin at specified stations, can effectively make "new" features like curbs and medians materialize.
Reviewing the below plan view, when you are given stations and offsets that define a template position like edge-of-pavement (above), you can use Template Transition effectively.
The first Template Transition dialog shows a list of the transitions, covering the above right-lane variable width. To add a transition, click the Add button. This brings up the second Template Transition dialog which shows the transition template for the second segment. The middle sections list the template grades that can be changed. To modify a grade, highlight the grade and click the Edit button.

The Begin Transition Station is where the normal template begins to transition to the modified template. The Begin Full Template Station is where the modified template is used entirely. The End Full Template Station is where the template starts to transition back to normal. The End Transition Station is where the template has returned to normal. This method is designed for elements like passing lanes which expand from normal then contract back to normal. But you can also use this method for roads that start off or end expanded or altered. For example, to start off the road at a 40' edge-of-pavement dimension, it is necessary to transition up from 12.5' (normal dimension). If you need to have 40' at station 0, then enter station -0.01 as the "Begin Transition Station", and enter station 0 as the "Begin Full Template Station". Select the EP grade in the dialog, and change it to 40'. Then click "Link to next transition". The Link to Next Transition option joins the current transition to the next transition without returning to the normal template. This takes you to the second dialog, shown above. You sustain the 40’ width from Begin Transition Station 125.29 and transition at station 215.08 to a 24.23’ dimension. Then quickly end the transition at station 215.081 for the "End Full Template Station". Finally, transition back to normal 12.5’ by entering 335.51 for "End Transition Station".

There is another "trick" to using Template Transition with templates that include subgrades. The subgrades will not automatically extend and follow the expanded grade IDs such as EP for "edge-of-pavement", unless the subgrades are defined in terms of the IDs themselves within Design Template. Subgrades that expand "at slope" to intersect a curb, for example, can expand naturally as the curb position moves outward on the right side. But subgrades that go "straight up" at back of curb at offset 14.5’ in this example will stay at 14.5’, unless defined as shown below by referencing the "EP ID:

![Sub-Grade Dimensions](image)

Cut and Fill slopes can also be transitioned by picking the Cut and Fill buttons. Ditch and Berm grades can also be modified here.
Transitions can also be applied to the left, right or both sides. This allows you to have separate overlapping transitions for the left and right sides.

**Prompts**

**Template Transition to Edit/Create** Choose New to create a transition file or Edit to modify a transition file
**Template File to Edit:** Specify a transition file
**Template Transition dialog**

**Keyboard Command:** tpltrans

**Prerequisite:** A template .TPT file

**File Name:** \lsp\tplmake.arx

**Input-Edit Super Elevation**

This command is an editor for super elevation stationing. The super elevation data is stored in new or existing super elevation (.SUP) files. When creating a new super elevation file, there is an option to read a centerline file and build the super elevation stationing based on the curves and spirals in the centerline using AASHTO-based stationing or optionally, the Virginia DOT method. The AASHTO calculations are based on the equations in chapter 3 of the 2004 Green Book titled Geometric Design of Highway and Streets. The length of the transition from normal crown to superelevation will be automatically computed by the program using either method based on the design speed and other settings, but the user can control what percentage of this transition to and from superelevation occurs in the tangent leading up to the curve or in the curve itself.
The main superelevation dialog displays a list of each super elevation transition. These entries should be sequentially entered from lowest to highest stations. To edit the super elevation stationing, highlight the entry line and click Edit. The Add button creates a new entry below the current highlighted row or at the top of the list if no row is highlighted. The Delete button removes the highlighted row from the list. The Save button saves the super elevation file. To exit the program without saving, click the Cancel button.

The super elevation stationing is entered in the Input/Edit Superelevation dialog. The View Table button shows a table of the super elevation slope for the delta angle and radius at different design speeds. The Calc Super button calculates the slope of full super given the design speed. The station entries are defined as follows:
Station to begin transition: where normal crown rate begins to transition
Station to begin super run-in: where slope becomes flat
Station for super at normal crown rate in: where slope equals negative of normal crown rate
Station to begin full super: where slope reaches full super slope
Station to end full super: where slopes begins to transition from full super back to normal
Station for super at normal crown rate out: where slope equals negative of normal crown rate
Station to end super runoff: where slope becomes flat
Station to end transition: where slope returns to normal crown rate

Given these various Station settings, an unequal rate of change can occur between any two stations. However, the program can calculate the stations to set an even rate of transition, as long as it knows the max superelevation, the normal crown slope and the station to start transition, start full super, end full super and end transition. The Calculate Stations button therefore calculates the stations for begin run-in, normal crown rate in, normal crown rate out and end super run-out. To calculate these stations the values with an "*" must be entered.

The Compound Curve option allows you to specify a second superelevation slope for a compound curve. In addition to specifying the second slope, the starting and ending stations for this slope must also be entered. The Reverse Curve option is similar to the Compound Curve option. A typical Reverse Curve is shown below in plan view and as it would appear in the summary dialog:
Station 399+00 is the "pivot" where superelevation left flattens and turns into superelevation right.

**Prompts**

**New or Existing Super Elevation File dialog**
Superelevation File to Process Specify a superelevation file.

**Superelevation Editor dialog**

Keyboard Command: super
Prerequisite: None
File Names: \\lsp\eworks.arx, \\lsp\makesup.lsp
Draw Section File

This command will plot the section data from up to six section (.SCT) files at once. The section file can be created by several methods including Input-Edit Section File, Sections from Surface Entities, Digitize Sections or Process Road Design command. A range of sections can be plotted in a vertical stack, on section sheets, or by selecting a point that corresponds to the grid bottom elevation.

When drawing sheets format in metric mode, be sure to set metric On (clicked) in the Drawing Setup command. Then in the Sheet Parameters dialog, set the Block Name to SCTSHT2 and set your metric sizes.

In the initial dialog, specify up to six section (.SCT) files to plot, the layer for each, and the layer names and text styles for the overall grid text, grid lines, and subgrade. There is also a toggle to Prefix Layer Names with Section Name, so that all layers created for the sections begin with the section name. At the bottom of the dialog is a button to Load Settings, loading a set of previously saved settings, and buttons to set the Colors and Linetypes for the section components.
The second dialog box presents the next level of settings for the generation of sections.

**Horizontal Scale**: Specify the horizontal scale.

**Vertical Scale**: Specify the vertical scale.

**Link Sections To Files**: This setting controls the linkage of the plotted sections to the actual section file(s) (.SCT), determining how changes to the file affect the plotted sections. If set to Off, there is no linkage, Prompt will ask whether to update the plotted sections when the file changes, and Auto will automatically update the plotted sections when the file changes.

**Type of Plot**: Specify how the sections will be plotted, either as a Vertical Stack, Pick Location, selecting the datum point of each section, or Sheets, which will plot the sections on a block section sheet.

**Fit Each Vertical Grid**: When checked, the grid bottom elevation and grid height are set automatically, and you may specify values to add to the top and bottom of each grid. See Vertical Grid Adder to Top and Vertical Grid Adder to Bottom. When not checked, the Vertical Grid Adder to Top and Vertical Grid Adder to Bottom options change to Grid Bottom Elevation and Grid Vertical Height.

**Scan File to Set Defaults**: This button allows the program to set the minimum and maximum parameters. If you choose this option the program will automatically set the range of stations, vertical spacing distance, right and left grid distances and starting/datum elevation. This option writes a file called "sectsrt.tmp" that is read and used to set the defaults the next time you use the program. Therefore, if you are selecting a different .SCT file to plot you should use this option to update the .TMP file.

**Range of Stations to Draw**: Specify the range of stations from the file which will be drawn.

**Interval of Stations to Draw**: Specify the interval of stations to draw. For example, perhaps you sampled every 25 feet with the *Sections from Surface Model* command for more accurate quantities but only want to plot 50 foot stations. ALL is the default value for this field.

**Vertical Grid Adder to Top**: Specify the distance that will be added to the highest elevation of the section for the sheets and pick location options. Only available when Fit Each Vertical Grid is checked ON.

**Vertical Grid Adder to Bottom**: Specify the distance that will be subtracted from the lowest elevation of the section for the sheets and pick location options. Only available when Fit Each Vertical Grid is checked ON.

**Grid Bottom Elevation**: Specify actual bottom elevation for each section grid. Only available when Fit Each
Vertical Grid is checked OFF.

**Vertical Grid Height:** Specify actual grid height for each section grid. Only available when Fit Each Vertical Grid is checked OFF.

**Vertical Space Between Grids:** Specify the distance the sections are stacked above the last one plotted when drawing multiple sections.

**Maximum Sections Per Column:** Sets the maximum number of sections allowed per column.

**Label Elevation at Zero Offset:** Will label the section elevation at offset zero. The label is drawn on the section grid just above the section line. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels. There is also an option to draw the elevation on a 45 degree diagonal, otherwise the elevation label is draw vertically.

**Label Break Pt Offsets:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.
**Label Break Pt Elevations:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.

**Label Break Pt Descriptions:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the text size scaler, layer, and description match for these labels.
Label Slopes: Will draw in the slopes.

Label End Areas: Will label cut and fill quantities on each section.
Use Table: Puts end areas cut/fill values in table.
Grid Line/Text Drawing Controls

**Plot Grid:** Uncheck this toggle if you do not want the grid to plot.

**Text Only:** Check this toggle if you only want to plot the cross section polyline and the grid text. This can be useful for plotting on a section sheet that has pre-plotted grid lines and you want to plot only the section and text.

**Circle Stations:** Will draw the station number with a circle around it on the left and right sides of the section grid.

**Label Scale:** Will label the horizontal and vertical scale on each section.

**Left Grid Offset Limit:** Specify the length the grid lines are plotted to the left from the centerline or zero offset.

**Right Grid Offset Limit:** Specify the length the grid lines are plotted to the right from the centerline or zero offset.

**Station Text Size Scaler:** Specify the text size scaler for the station text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Station Text Size to 0.10 and the horizontal scale is 100.0, then the text height will be (0.10 X 100) or 10.0.

**Grid Text Size Scaler:** Specify the text size scaler for the axis text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Axis Text Size to 0.08 and the horizontal scale is 50.0, then the text height will be (0.08 X 50) or 4.0.

**Horiz Grid Spacing:** Specify the distance the vertical lines of the grid will be spaced.

**Horiz Text Spacing:** Specify the interval that text will be plotted below the grid lines.

**Vert Grid Spacing:** Specify the distance the horizontal lines of the grid will be spaced.

**Vert Text Spacing:** Specify the interval that text will be plotted to the left and right of the grid lines.

Select the OK button at the bottom of the dialog to begin plotting. For the Vertical Stack and Pick Location options, you are prompted to specify a starting point for the sections. If Sheet option was selected, another dialog appears to specify all the settings for sheet plotting, see details below.

**Prompts**

Select Starting Point for Row of Sections *pick a point*
The Pick Location type of plotting has the following prompts:

Station > 4000.000 Min Elev > 462.849 Max Elev > 472.091
Change datum elev/<Select point that represents 0 offset elev 460.0>: C
Starting-Datum Elevation: 450
The program scans the station data and determines the minimum and maximum elevations, and proposes a datum elevation. If you have pre-plotted a grid sheet and want to reference another local grid coordinate, then change the datum elevation appropriately.
Change datum elev/<Select point that represents 0 offset elev 460.0>: pick a point
Station > 4025.000 Min Elev > 463.332 Max Elev > 472.385
Change datum elev/<Select point that represents 0 offset elev 460.0>: pick a point
The program continues to prompt until the last station in the range specified is drawn. You can use the Cancel function ([Ctrl] + [C]) to stop plotting, if necessary. If you chose the Vertical Stack option you will be prompted for the starting point for the row of sections. If you selected the Sheets option, and press the OK button, the Section File Sheet Drafting Parameters dialog appears, allowing you to set up how you want the section sheets plotted.

Sheet Parameters
Block Name: Specify the AutoCAD drawing name that will be inserted for each sheet. The default is SCTSHT1 which is included with Carlson 2008, and is stored in the \SUP directory. You can use this or use a sheet block of your own design. The block should be drawn at a 1 = 1 scale since the program inserts it at the horizontal scale setting from the previous dialog.
Distance Between: Controls the distance from the bottom of one sheet and the bottom of the next.

Rows of Sections
Per Sheet: Controls how many sections will be stacked on top of each other on a sheet.
Distance Between: Controls how much space will be placed between the top of the last section plotted and the
bottom of the next section. The distance between and other values in this dialog are in AutoCAD units. In our above example we are set to 20 horizontal scale so 20 would equal 1 inch when plotted. It is recommended that you set the horizontal and vertical scales in the previous dialog before accessing the sheet parameters dialog so that reasonable defaults will be set automatically.

Columns of Sections
Per Sheet: Controls how many rows of sections will be plotted on each sheet.
Distance Between: Controls the distance that the rows of section will have between the centerline of the one section row and the next centerline of rows. This edit box can only be accessed if you have a number of columns greater than one. For example, if you want 15 inches between the columns, specify 300 (15 x 20).

1st Section Offset from
Lower Left of Sheet to CL: X and Y edit boxes allows you to specify where the first section of the first row will be placed relative to the lower left of the section sheet. In our example we specified 160 (8 inches at 20 scale) and 15 (1.5 inches at 20 scale). The Block SCTSHT1 has a half inch border before the 1st grid line and we want to plot starting at the second grid line, which is another inch from the bottom of the sheet. We want the centerline of the first section to be slightly left of the center of the sheet which is 33.5 inches wide so we specify 15 inches (300 at 20 scale).

Previous: This button allows you to return focus to the main dialog and make changes to settings or cancel the program. One thing to remember when plotting sheets with grid lines on them is to switch on the Text Only toggle on so you don't get duplicate grid lines.

Label Grid Zero Offset:
Save Settings: This button allows you to save all the parameters settings to a file so you can easily recall them for another project.
Load Settings: This button allows you to recall the settings saved with the option explained above.

When you select the Layers button this dialog appears allowing you to specify the layer that the files are plotted on. If you are specifying a new layer to create, type the name into the edit box. If you want to select a layer that already exists from the layer list, then click on the Select... button to the right of the edit box. When you select the OK button the program prompts for the starting point for the row of sheets. The default is coordinate 0, 0 though you can select any point you like. With the settings shown in the example dialogs the sections would be plotted as shown below.

Drawing Metric Section Sheets
First, be sure that you are set to metric mode in Drawing Setup under the Settings menu. Then set the scales and spacing as shown in the dialog below. This example is 1:1000 scale. When the first dialog is set, click OK to reach the second dialog. There is a different block name for metric sections called schsht2.dwg. This file is located in the Carlson 2008 SUP directory. Choose the parameters for the second dialog as shown. In this case the sheets will have two rows and two columns of sections.
Drawing Setup dialog with metric 1m=?m setting from Settings menu
First dialog with metric settings

Second dialog with metric settings

Keyboard Command: `drawsct`
Prerequisite: An .SCT file
File Names: `\lsp\drawsct.lsp`, `\lsp\scadprof.dcl`, `\lsp\drawsct.arx`
Section Conversion

All Import commands in this submenu are designed to convert other section file formats to the Carlson section (.SCT) file format. The Import Columnar Text has some options to make the program match the import data. This routine can be used for section text files that have station, offset, elevation and optionally description separated by spaces or commas. All the other Import routines read specific formats from other software. The Export commands are designed to convert the Carlson section (.SCT) file format to other section file formats. You will be prompted to specify the file name to convert, then specify a section (.SCT) file name.

Note: The Import/Export LandXML Files routine in the File menu supports section data as well as other survey and civil data types.

Another Note: The Section Report routine can be used to Export section data from Carlson and this command includes an option to use the Report Formatter which allows you to select the fields to export and their order. Plus the Section Report report formatter has functions to export to Excel and databases.

Prompts

Prompts and commands vary for importing and exporting section file data.

Importing:
Import Columnar Text
Type of delimiter [<Space>/Comma]? C for comma. Choose the type of separator between fields in the import file.
Section data contains description field [Yes/<No>]? N for no. This option specifies whether the import file contains descriptions for the section points.
Add description to section data [Yes/<No>]? Y for yes. This option will assign a specified description to the section points.
Description for section data: TOPO
Import Agtek Reads .ROG and .RDS format section files (ASCII only).
Import Arkansas DOT Imports Level Note File
Import Ceal Reads CEAL section files.
Import GEOPAK Reads .XRS, .XSR, and .TXT format section files (ASCII only).
Import Georgia DOT Reads .END files.
Import IGRDS Reads .LIS, .RDS, and .TXT files.
Import Moss Reads MOSS section files.
Import NC DOT Reads .ORI and .TXT files.
Import Pizer Reads .TXT files.
Import RoadCalc Reads RoadCalc (Eagle Point) sections files.
Import SMI Reads .CUT format section files (ASCII only).
Import Softdesk Reads .SEC format section files (ASCII only).
Import Spanish SC1 Reads ISPOL .SC1 section files.
Import Spanish TRV Reads CLIP .TRV section files.
Import Terramodel Reads .XSC files.

Exporting:
Export GEOPAK Converts Carlson .SCT files to .TXT format.
Export IGRDS Converts Carlson .SCT files to .RDS format. Prompts for section surface type - original ground or final surface.
Export RoadCalc Converts Carlson .SCT files to RoadCalc (Eagle Point) format.

Pull-down Menu Location: Sections > Section Conversion

Keyboard Commands: xsecread, agtek, level, ceal, geopak2sct, gadot2sct, igrds2sct, moss, ncdot2sct, pizer2sct, inroadcalc, smiset, softsct, sc1_to_sct, trv_to_sct, tm2sct, sct2geopak, sct2igrds, outroadcalc

Prerequisite: Sections files; formats vary by command

File Name: \lsp\drawsct.arx
The GIS menu shown below has commands for managing and reporting data attached to drawing entities.
GIS Settings

This command sets the current Template and Output MDB files. The Template MDB file defines the GIS codes and the field names for each code. The Output MDB file is the database file where any new data will be stored. The MDB files for the Template and Output MDB files can be set up as either new MicroSoft® Access '97 or new Microsoft® Access 2000 database format files, or part of an existing MDB file. Either existing or new MDB files may be chosen or created for this GIS Database Setting routine.

![GIS Settings dialog](Image)

Prompts

**GIS Setting dialog** Click both file buttons and select new or existing files.

![New or Existing File](Image)

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** gis_config  
**Prerequisite:** None  
**File Name:** \lsp\gisprt.lsp

Define Template Database

This command prepares the fields for prompting to attach data to objects. The prompts are stored in the form of an .MDB file. A feature, such as a manhole, can have several prompts, such as Number of rungs, Type of material, Number of inlets, etc. Features can be organized into Categories: Utilities, Roads, Properties. The Category designation is an arbitrary way of organizing the features. Features and the prompts can be imported from Object Data found within the drawing in AutoCAD Map, or from tables within standard MDB database files, or from the Carlson .GIS files that are used by SurvStar, Carlson Field and other Carlson products to generate prompts. A Carlson GIS file works by triggering prompts when a description such as "mh", for manhole, finds a corresponding MH.GIS file.
with pre-defined prompts and default responses. But the most common way to develop features, and the associated prompting, is to enter them directly here in Define Template Database, rather than using the three import options. From a database standpoint, features are the same as tables.

To create GIS prompting for ASCII and MDB GIS features, you need to input the following fields in the dialog box:

1) The first field to set is the Template Database, or MDB file. All MDB GIS prompting is stored in one template Microsoft® Access MDB file named here. To create a new MDB, choose the Template Database pulldown from the top of the Define Template Database dialog, then New, and then select which type of new MDB file you would like to create. Your choices are New Access ’97 format or New Access 2000 format. You can also load an existing MDB Template file by choosing Open under the same pulldown.

2) The next field is the Category Name, found within a pulldown called Category. GIS feature codes can be categorized (e.g. STRUCTURES, UTILITIES, ROAD FEATURES, etc.). At least one category must be created. This is because in order to Export a GIS File to the Template MDB file, this routine requires a category to export the GIS code under. After selecting New and inputting a category name, click OK to create this category in the template MDB file.

3) The next field is Feature, which has a pulldown as well. A category such as UTILITIES might have features such as manholes, light poles, fire hydrants, water valves, etc. The GIS feature name needs to be input by selecting New. This GIS feature name is very important because it identifies the group of data fields.

4) You can upload features to SurvCE, GISCE or FAST Survey using a GIS File pulldown option. Using this option you will be able to choose a .FLD file.

5) The GIS prompting is input under ATTRIBUTE (abbr), ATTRIBUTE (full name), LIST VALUES, REQUIRED and TYPE. Once values are specified, only these values can be used. Values are entered by typing them under the List column and hitting Enter, then typing another, hitting Enter and continuing until complete. The default value is the one displayed when the GIS Code is stored to the MDB template file using Save As in the Feature pulldown. Fields, when created, can be designated Char, Int or Real. Fields with pre-set responses will default to Char type. To add a new attribute, click on the first available blank cell in the first Attribute row of the list, shown in the Define Template Database dialog, and click Insert.

6) To store the new prompts and field names, click Save As under Feature.

7) To use this dialog to "back-door" create a GIS File for the ASCII method of prompting (the .GIS file method), click Export under the GIS File pulldown at the top of dialog. This ASCII .GIS file will then be available to SurvStar for field prompting.

8) To import the attributes and jump start the completion of attribute full names, attribute prompts and other table elements, you can use Import under the GIS File pulldown. This will read a Carlson .GIS file.
Automatic versus Prompted Values

It is possible to assign data to objects automatically, without any prompting. The automatic items are pre-set responses the program knows, such as date, time, currently configured instrument, etc. When the cursor is located in the List Values column, press the down arrow on the right side of one of the cells. You will see the available known data fields. Here you can select variable. The list may expand with new builds of Carlson.

[Diagram of the Define Template Database window]

Template Database pulldown option
Input-Edit GIS Data

This routine creates, reviews and appends GIS data linked to entities stored in the AutoCAD drawing.

The GIS Smart Prompting dialog has a spreadsheet format for editing the data fields. The GIS table to process is selected in the pull-down list in the upper right of the dialog. The GIS tables that are available depend on the tables that are defined in the current template database. Use the GIS Database Settings and Define Template Database commands to setup the tables. Once you select a table to process, the fields for that table are displayed in a spreadsheet format. If a field is related to a field in another table in the database, a "+" character is shown next to the field name. Picking the "+" will open another dialog box with the related data in the other table. The data in this related table is not editable, only the data in the initial linked table.

The bottom portion of the dialog has features for attaching images to the entity. Existing image files (BMP, JPG or GIF) can be linked by choosing the New option. The Update option will replace the current image with a newly selected image. The Delete option will remove the current, attached image. The Capture button will take a shot in the field using a configured camera and then attach the image to the entity. Different digital cameras can be used by picking Pick or Set Camera.

The Input-Edit GIS Data command is an excellent way to simply review the data associated with an entity. If the entity has GIS data, the banner line at the top of the dialog will display "Entity has GIS Data". If not, the banner line will display "Entity has no GIS Data". Even when the entity has no data, the default values for the prompts will appear. Pressing OK will assign this data to the entity. To avoid assigning data to the entity (if it has none), press Cancel. Alternately, you can use the commands GIS Inspector Settings, followed by GIS Data Inspector, to review the data with no possibility of editing or inputting data in the process.

There are three methods for selecting the drawing entities to process: S for Select, P for Pick and N for Number:

Select Object method: With this method, you pick the drawing entity to process the data attached to that entity.
When selecting a Carlson point, the point number is used to link to the database.

**Pick method:** For this method, you pick inside a closed polyline to process the data attached to that polyline.

**Number method:** Here you simply input the point number from the current CRD file to process.

**Prompts**

Select object (Number/Pick/\(<Select>\)): \(P\)

Pick a point inside polygon (Select/Number/\(<Pick>\)): \(\text{pick a point}\)

GIS Smart Prompting dialog *make selections*

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** gisdata  
**Prerequisite:** MDB GIS prompting must be created in *Define Template Database* and points or entities must exist to link GIS information to.  
**File Name:** `\lsp\gisprt.arx`

### GIS Inspector

This command displays all or portions of the data attached to drawing entities in real-time. How much of the attached data is displayed is set by the command GIS Inspector Settings. When you move the cursor over an entity with GIS data, selected fields are displayed in a tooltip box next to the cursor. For data attached to closed polylines, you can move the cursor anywhere inside the polyline to show the data. Polylines that are closed will highlight with a solid fill as you inspect each one. Open polylines, such as road centerlines, will highlight with a solid fill generated along the length of the polyline. The solid fill color for all highlighting is set in GIS Inspector Settings.

The routine starts by prompting you to select entities. The entities that you select will be used by GIS Inspector. In the case of a large drawing, this selection allows you to limit the entities for inspector to a local area instead of having to process the whole drawing. Then after reading the entities, you can move the cursor around the drawing to inspect the GIS data. You can also use the arrow, page up and page down keys to pan and zoom the display. Pressing enter ends the routine.

**Prompts**

Select objects: *select entities with attached data*  
Arrow keys=Pan; PageUp/Down=ZoomOut/In;
Pulldown Menu Location: GIS Data
Keyboard Command: gis_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and entities must have linked GIS information.
File Name: \lsp\gisview.arx

GIS Inspector Settings

This command sets up the fields to be displayed when using GIS Data Inspector. Each GIS table code can have different display options stored in the GIS Inspector Settings command.

GIS Inspector Settings reads all the points and entities with GIS information currently linked in the drawing and displays a list of the linked data tables under the Available GIS Table column. When a GIS Table code is highlighted (i.e. 0001 or Road), the fields for this GIS table are displayed to the right in the Select Fields column. Up to 6 fields or lines of GIS data can be defined for display for each GIS code table, including one picture. To add a field to the display list, double-click on the field name. To remove a field from the display list, highlight the GIS table to remove from and then use the Clear Settings buttons. The Last Option button will remove the last field to display from the current GIS table. The Picture Name will remove the image from the display list. The Entire Line button removes all the fields from display for the current GIS table.
**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** set_inspector  
**Prerequisite:** MDB GIS Prompting must be created in *Define Template Database* and points or entities must have linked GIS information.  
**File Name:** \lsp\gisview.arx

### GIS Query/Report

This command applies a user-defined query on a data table or related tables with the database. Records in the table that pass the query can be reported or the associated entities can be highlighted in the drawing. The *Query Using* option in the main dialog box sets the source of the data table to process as either GIS data attached to selected drawing entities or from the current Output MDB file.

The query is defined in the dialog shown here. To add a query, enter a new query name in the in the space underneath Current Query. If there is already a name there, just highlight and type over it with a new name, then hit Clear all to clear out existing query lines and get full access to all Table Names. Set the Current Output MDB. Under Table Name, a list of all tables in the Current Output MDB with GIS links is available. Choose the table for the initial query. Once a table is selected, add a parameter is created and added, the Table Names list becomes unavailable because any additional query parameters must come from that table, or relate through that primary table.

The top portion of the dialog contains a list of the query parameters. To add a parameter, select a table name from the Table pop-up list. The available tables will either be all the tables found in the GIS links of the drawing or all the tables from the Output MDB file depending on the *Query Using* option. Once the table is specified, the Field Name pop-up list contains all the available fields in the table. Choose a field from this list. Next choose the operator (\(=\), \(>\), etc.) from the operator list. The Value pop-up list contains all the different values for that field that are found in the current data set. You can either select one of these values or type in another value into this field. If a Field Name relates to another Table, when you select that Field, an additional button will appear allowing you to add a
query parameter from the related table.

When all the parameter values are set, pick the Add Parameter button.

When all the parameters are defined for the query, you can save these settings by filling out a name Current Query field and then picking the Save Query button. This query can be recalled later by highlighting the query name and clicking the Load Query button.

Pick the Execute button to process the query. With the Generate Report option, the program will bring up the Report Formatter which allows you to choose the fields to include in the report and the report format. If the Highlight Screen Entities option is on, then the program will highlight the entities with GIS data that pass the query. Point entities are highlighted by drawing a box around the point and polylines are highlighted by solid fill. Shown here is the report for all manholes with a Condition of Good.
Pulldown Menu Location: GIS Data
Keyboard Command: gis_query
Prerequisite: MDB file with data or entities with linked GIS information
File Name: \lsp\gisview.arx

Label GIS Polyline: Closed Polyline Image

This command draws images inside the selected closed polylines with attached GIS image files. Images can be assigned to polylines by the Input-Edit GIS Data command.

The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the image to draw. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process. Then the image fields defined for this table are displayed in the lower list. Only one image can be draw inside the polyline. The Erase Images button will erase any existing images inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.gsf) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the images. The images are drawn in the centroid of the polylines.
Example of images drawn inside closed polylines

**Pulldown Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** display_polygon_image  
**Prerequisite:** Closed polylines with linked GIS images  
**File Name:** \lsp\gislab.arx
Label GIS Polyline: Closed Polyline Data

This command draws text labels for the specified fields inside the selected closed polylines with attached GIS data. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn center justified in the centroid of the polylines.

![Image of the dialog box showing fields and options for labeling closed polylines with GIS data.](image-url)
Label Closed Polyline Data result of country name and population fields

**Pulldown Menu Location:** GIS > Label GIS Polyline

**Keyboard Command:** display_polygon_image

**Prerequisite:** Closed polylines with linked GIS information

**File Name:** \lsp\gislab.arx

### Label GIS Polyline: Open Polyline Data

This command draws text labels for the specified fields along the selected polylines with attached GIS data. The program starts by selecting polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels for the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn along the polylines.
Example of text labels along polylines with GIS data

**Pulldown Menu Location:** GIS > Label GIS Polyline
**Keyboard Command:** label_arc_text
**Prerequisite:** Polylines with linked GIS information
**File Name:** \lsp\gislab.arx
Create Links

This command makes GIS links between blocks in the drawing and a database table using a key field that is in both the block attributes and the database table. Both the block entities and database records must exist before running this routine.

The routine starts by prompting you to select the block entities to process. Then a dialog appears for choosing the block attribute and table to link. The current template and output database file names are shown at the top of the dialog. Use the GIS Database Settings command to set these file names before running Create GIS Links. The dialog lists all the block names that were found in the entity selection. Choose a block name to process. Then in the lower left of the dialog, there is a list of the attributes for the selected block. Highlight the attribute name that contains the point ID key field for the blocks and then pick the Select First Key Value button. For each block entity, the program will use the value of this attribute to link to the record in database table. This value is matched to the database record using the PT_ID database table field. For example, a block with an attribute value of 402 for the specified attribute name will be linked to the database record with a value of 402 in the PT_ID field.

Next, the database table needs to be specified to either one fixed table name or to table names defined by a block attribute. A list of the available tables in the current output database is displayed. To link all the blocks to one table, highlight the table name from the list and pick the Select Second Key button. Or to link the blocks to various table names based on a block attribute, highlight the attribute name and pick the Select Second Key button. This attribute value for the blocks will then need to contain the database table name. For example, consider a block for electric utility data with two attributes: ID and TABLE. The ID is a number to use as the first key and the TABLE is the table name (i.e. POLE, BOX). Once the key fields are set, pick the OK button to create the links.

Pulldown Menu Location: GIS Data
Keyboard Command: create_links
Prerequisite: Block entities with attribute IDs and a database table with matching IDs.
File Name: \sp\gisprt.arx

Chapter 13. GIS Menu
Erase Links

This command removes all the GIS links from the selected entities (polylines, blocks, etc.).

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** erase_links  
**Prerequisite:** Entities with GIS links  
**File Name:** `lsp\gisprt.lsp`

Audit Links

This command checks the GIS links for the selected entities in the drawing to make sure that the template database, output database and table exist. Any invalid links can be erased from the entities or be fixed by selecting another database or table. For example if a database file (.mdb) has moved to another directory, then you can use this command to specify the new location.

The routine starts by prompting you to select the entities to check. If no errors are found, then the routine is done. When there are errors, a dialog box appears. Each GIS link is defined by a template database, output database and table. For each combination of these three settings that have an error, this dialog displays the template database, output database and table name from the entities. The number of GIS link combinations with errors is shown in **Table Used for Links** field (i.e. 1 of 2). The template database is shown at the top. If the template database link is broken, then use the Select New Template MDB button to assign another template database file. The output database also has a Select New Output MDB to set the output database file. In the lower left of the dialog is a list of the table names from the output database. You can choose the table to use for the link from this list. The Fix Links for Current Table button will assign the template database, output database and table name from the dialog to all the selected entities. The Erase Links from Table button will remove these broken links from the entities. The Go to Other Table button will process the next GIS link combination with errors.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** audit_links

---

*Chapter 13. GIS Menu*
Import SHP File

The Import/Export SHP file routines convert ESRI SHP files into Carlson GIS links and back. The Import SHP command reads database information from ESRI ArcView SHP files, and loads these SHP files into Carlson with the database information intact. You can read SHP files into Carlson and after completing all mapping convert these GIS features back into ESRI SHP files. The SHP Export command converts drawing entities and GIS links in Carlson into SHP files for input into ESRI's ArcView product.

These routines are useful GIS data collection tools since the majority of surveying and civil engineering maps are created in the AutoCAD drawing (.DWG) format and the majority of GIS produced maps are made in the ESRI shape (SHP) format. Carlson combines these two formats effortlessly and seamlessly. The GIS professional can stay with ESRI's ArcView SHP format while all field and GIS mapping can still be done in the AutoCAD drawing environment.

The Import SHP File dialog displays the Output MDB file to add data to and the source SHP file to be imported. SHP files are similar to entities in one layer in AutoCAD. You must specify the table name to store the data in the MDB database and the layer name for the entities to be created. Typically these names are the same or near equivalent as the SHP file name. Once these names are entered, the Import Polylines from SHP button becomes available. Pick this button to import the SHP files entities and database. You can also assign elevations by a specified data attribute.

ESRI ArcView creates primarily three types of SHP files: Points, Arcs and Polygons. Both Arc and Polygon SHP files are brought into Carlson as polylines in the drawing and data stored in a table in an MDB database file. Point SHP files are imported in a three step process. The first step uses the Import SHP File command to create a coordinate file (.crd) for the points in the SHP file and a corresponding table in the output MDB file for the points database. The second is to use Draw Locate Points to draw the points from the CRD file into the drawing. The third step uses Create Links to select the points in the drawing and link the database to these plotted points. Once the SHP file is selected, Carlson detects the data contents of the file and sets the dialog options for importing either polygons, arcs or points.

Pulldown Menu Location: GIS Data
Keyboard Command: import_shp
File Name: \lsp\gispr.arx
Export SHP File

This command creates a SHP file from the selected entities in the drawing. After selecting entities to be converted, a dialog shows the number of Points, Polylines (Arcs) and Closed Polylines (Polygons) found in the drawing selection set. Those Points, Arcs and Polygons with database information linked are displayed with their database table names. Any Points, Arcs and Polygons without linked database information display as unknown.

Highlight the Point, Arc and Polygon tables to output or selects Export All to select all entities including the UNKNOWN entities to export into SHP files. The Export SHP File commands outputs all entities selected into SHP files with the same name as their table name into a subdirectory selected. Also Points can be stored in the ESRI Arcview database as 3D X, Y and Z coordinates when Include Z Coordinates is toggled on. SHP files do not have arc entities. So the export routine will convert arcs and polyline arcs into a series of small chords segments. The Offset Cutoff field sets the maximum horizontal shift allowed between the original arc and the chord segments.

These SHP files can be imported into ESRI's Arcview product. Database GIS links in Carlson are converted to SHP files by storing the GIS database information into DBF files for ESRI's Arcview product to read and link to.

Prompts

Specify Name for SHP File dialog select .SHP file name
Select objects select entities
Export Carlson Entities to SHP File dialog choose settings, click OK

Image Inspector

This command views images attached to entities. At the start, the program highlights all entities that have attached images. When you move the cursor over these entities, the attached image is displayed in a window. If you click within the image window, the program will start the image application editor that is setup for your system.
This application, such as Microsoft Internet Explorer, depends on your Windows system setup. Also while moving the cursor over drawing entities, you can use the arrow, page up and page down keys to pan and zoom the display.

Prompts

Arrow keys=Pan; PageUp/Down=ZoomOut/In; Pick Image Box = Open Image!
Move pointer over entity with image (Enter to End): press Enter

Keyboard Command: view_image
Prerequisite: drawing entity with attached image
File Name: /lsp/gisutil.arx

Attach Image to Entity

This command attaches an image file to a drawing entity. The possible image file formats are .bmp, .jpg and .gif. Any type of drawing entity can be used such as polyline, points or symbols. To run the command, first pick an entity on the screen. Then a dialog appears for selecting the image. First set the image directory and then highlight the image file name. A graphic of the image should appear in the preview window. Then click OK.

The Capture Image button can be used to trigger an attached digital camera to take an image. The Pick Camera and Set Camera buttons can be used to configure the camera to use.

The View Image button will display in the preview window any image already attached to the entity. Also any image already attached to the selected entity is displayed in the Current Image field at the top of the dialog.

Prompts

Select object to attach symbol to: pick an entity
Attach Image to Object Dialog
Done.
Select object to attach symbol to: press Enter

Keyboard Command: set_image
Prerequisite: A drawing entity and an image file
File Name: \lsp\gisutil.arx

Define Note File Prompts

This command allows the user to create a .GIS file for use in several other routines in Carlson GIS and other Carlson Software products, such as SurvCE or SurvStar.

The program starts with the main Define Note File Prompts dialog, as shown below. The Load button allows the user to load an existing GIS file for editing or review. The list box shows the various data capture items in the GIS file, showing the field name, the prompt, the default value and the various options for that field. The Edit button allows the user to edit the highlighted field. The Add button allows the user to add new fields after the highlighted field. The Move Up and Move Down allow the user to change the order in which fields appear in the GIS file, while the Remove button completely removes the highlighted field. The Save button saves the GIS file that is currently being edited, while SaveAs allows the user to save the current GIS file under a different name. The Quit button checks to see if the current GIS file is saved and quits the routine.

When the Edit or Add button is clicked, the dialog box shown here appears, allowing the user to enter and edit data with respect to a particular field in the GIS file. The Field Name is a unique identifier of the field in the GIS file and hence a GIS file cannot have repeated field names. The Prompt is what appears at the command prompt while waits for user input. The Default Value is the value that would be used among various options, if the user presses Enter at the command prompt without typing anything in response to the prompt. The list box, Options for value, contains a list of options that can be selected for the particular field. A new option can be added to the list or removed from the list by clicking the appropriate button. The Add Option button brings up a small dialog and accepts the option to be
included in the list. Press OK to accept the values set here. At the minimum, the Field Name and Prompt must be specified.

![GIS Field Record dialog](image1.png)

**Define Note File Prompts dialog** Load a file, or change variables as required.

![New GIS Option dialog](image2.png)

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** defnote  
**Prerequisite:** None  
**File Name:** \sp\cogoutil.arx

### Database File Utilities

This command is designed to import GIS data from SurvCE, GISCSE and FAST Survey files, as well as from user-defined text/ASCII file fields. It also exports data from Carlson Note files (.NOT or .VTT) to Microsoft® Access (.MDB) database tables. The .NOT extension is used when data transfers from desktop. The .VTT extension files are data transfers from data collector.

*Chapter 13. GIS Menu* 548
Note files are associated with Coordinate files (.CRD) and contain additional data for point numbers. For example, the Coordinate file for a manhole point could contain the point number, northing, easting, elevation and 32 character description, while the corresponding note file for that point contains additional data on the manhole such as diameter, depth, condition, etc. A Carlson Note file for a Coordinate file will have the same name as the Coordinate file, except with a .NOT or .VTT extension instead of the .CRD extension (e.g. PARK.NOT goes with PARK.CRD). The Carlson Note file is a text file which consists of a point number (PT_ID) followed by field names with values. This group of point number and fields can also have a GIS_FILE name, which is used to identify this group of fields. This GIS_FILE name comes from the Note file prompting definition file (.GIS), which defines the field names for the group and is created in the Define Note File Prompts command.

You can select the Note file to process by using the Import Note File button. The program will then list all the GIS_FILE names that were found in the Note file. If a set of data for point number does not have a GIS_FILE name, then this group will appear in the list as UNKNOWN.

The name of the Microsoft® Access database to add the data to is the output database file, listed at the top-left of the Database File Utilities dialog. You can change the output database by using the Open Database button and selecting an existing database, or by clicking New Database to create a new database. The database tables will automatically have the same name as the GIS_FILE. This dialog also allows you to preview and edit a spreadsheet editor, which in turn allows you to modify values in the table. Each set of note file data for a point is displayed on one row with the corresponding record from the database shown on the next row. You can export the Note file data and create a new Access database .MDB file, in Access '97 format or in Access 2000 format, by doing a SAVEAS into .MDB format. You can rename and delete a table as well.

Database File Utilities can be combined with the Create Links command to make GIS links between the point entities in the drawing and the Microsoft® Access database records. The point entities can be drawn with the Draw/Locate Points or Field to Finish commands.

Initial dialog at start of command with primary functions

Available Table from Output Database: Selection list. Pick a table from the Output Database.
Import Note File: Imports a Carlson Note File (.NOT).
Import ASCII File: Imports ASCII file.
**Preview/Edit Table:** Displays a spreadsheet editor, allowing you to preview/edit values from table.

**Rename Table:** For renaming a table as needed.

**Delete Table:** For deleting a table as needed.

**Current Table:** Displays the selected table from above list.

---

![Import ASCII Data Dialog](image)

Dialog seen after choosing Import ASCII File and selecting file name

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** noteutil

**Prerequisite:** A note file (.NOT from desktop or .VTT from data collector)

**File Names:** `\lsp\gisprt.arx`
Field to Finish

When collecting field data, the Field-to-Finish process can be used to draw the points with distinct layers, symbols and other settings based on the point description. Each point description is looked up in the Field-to-Finish code table which defines the layer, symbol and other properties for that description. The code definition can also be used to draw linework between the points. This code table is created using the Field to Finish command in the COGO menu. Codes can be alpha, numeric or alphanumeric. The Carlson Field data collection functions Point Store and AutoPoints at Interval can use a Field-to-Finish code table.

Field-to-Finish - Use Code Table ...

For Field-to-Finish mapping while collecting field data, go to Configure Field, select Point Settings. Under the Field-to-Finish heading check the boxes to the right of Use Code Table For. This activates Field-to-Finish so that points stored with descriptions that are defined as codes in the code table are drawn using the code symbol, description, linetype and layer.

Field-to-Finish - Code File

The currently active code table file is displayed next to Code File. Only one Field-to-Finish code table is active at a time. Several code tables can be created for different clients or applications. Use the Select File button to set which code file is active.

Selecting a Code

Both functions Point Store and Auto Points at Interval can use Field-to-Finish capabilities. Each of these data collection functions can display a list of the codes from the currently active Field-to-Finish code table. This alleviates you from having to guess code abbreviations. When you pick Code or press F7, a summary of the currently active code table appears. Use Page Down or Page Up to scroll quickly though the code table. Use the Up or Down arrow
keys to highlight the code description desired and double click or press Enter to select. If you already know the code, you can just type it in the Desc field.

Field-to-Finish - Options (F6)

If you are using the Point Store or Auto Points at Interval functions, you can change your Field-to-Finish settings by clicking Options or hitting F6. This brings up the Point Settings window. You can toggle the Field to Finish options on or off, or you can select a different code table. You can also change the default point settings here. All of this can be done without leaving Point Store or Auto Points at Interval.

Field-to-Finish - Editing the Code Table

The code table can be displayed using the command Field to Finish under the COGO menu. Each line corresponds to a code. All of the code's parameters (layer, symbol type, description, size,
linetype) are controlled from here. Clicking on a code will bring up a window which will let you change the settings for this code. New codes can be added using the Add button on the code table.

Field to Finish - Linework

Linework includes all mapping by 2D or 3D polylines with line and arc segments. The Field-to-Finish code table controls the linetype, color and layer for all linework. It does not control where polylines, lines or arcs start or end. Starting and ending linework is controlled directly in Carlson Field’s data collection commands Point Store and Auto Points at Interval.

2D Polylines are always drawn at zero elevation. Their linetypes can be defined in the code table. A simple curve requires three points: a PC, one point on the curve and a PT. The simple curve is drawn as an arc. Complex curves can be shot using multiple points along the curve between the PC and PT. There is no upper limit to how many points can be used. Carlson Field does a Bezier fit to join all these points. The complex curve is actually drawn as a series of very short chords.

3D Polylines are a series of connected 3D points. All curved sections of 3D polylines are drawn as series of very short chords. Elevations of these chords are interpolated from the elevations of the curve endpoints. 3D polylines can be used as breaklines for surface modeling of curving curb lines, retaining walls or any other structure. Using Carlson Field’s Triangulate and Contour command, operators can create a contour map in the field using the data they just gathered and thus check that no areas or breaklines lines are missing or incomplete prior to leaving the site.

Nesting Linework & Points

Both Point Store and Auto Points at Interval allow you to be drawing multiple polylines at the same time. Without ending your current line, you can start another line by simply changing the description code. As long as you didn’t select End under Linework for your first line, you can come back to it later. Carlson Field will always recognize if a code next to Desc refers to a line currently active. If it does, Carlson Field continues that line to the new point. To stop a line from being active, you can choose End under Linework before storing the point number.

If two or more polylines are drawn in the same session using the same code, you must add a number after the code to differentiate between two lines. (e.g. EP, EP1, EP2...)

If you use the same point number twice, Carlson Field will allow you to select a new number, override the previous coordinates, or average the two measurements together.
**Field-to-Finish Quick Overview**

Point Store - Steps to draw using Field-to-Finish:

1) Configure Field - Select the GPS or Total Station equipment in the first dialog.

2) In Configure Field-→Point Settings, select the code table to be used. Enable "Use Code Table For" by checking "Symbols", "Descriptions", "Linework" and "Layers".

3) Initiate "Point Store" in Field.

4) Press F7 for the Code button to select the defined code "UP" from the Field-to-Finish code list.

5) Press F8 to start linework or check "Start" under linework.

6) Press F1 for the Read button to take a shot.

7) Press F2 for the Store button to store this point.

Now move to the next location and hit F1 then F2 again to repeat steps 6 and 7. Notice a line between points 7 & 8 draws with a "T" for telephone line and the symbol drawn is a utility pole symbol. The symbol, linework and layer are predefined for the "UP" code in the Field-to-Finish code table. If a line between the two points does not draw, simple click in the join box and a line is drawn between the two points.

Remark: In "Linework", after picking "Start", the next shot with the same description defaults to "Cont"(continue) automatically and the line continues to this next point. When finishing linework, you must select "End" to stop the linework. Linework for breaklines should always be 3D polylines with elevations, unless you select the "No Elev" option. 2D polylines are always drawn at zero elevation and their linetype is defined in the Field-to-Finish code table.
Special Characters and Conditions

When collecting points with additional description information besides the code, use a forward slash (/) after the code and before the additional description. All text after the forward slash is appended text that does not affect the code table (e.g. UP/#531, BLD/COR, PIPE/24", 14D/OAK). When drawing the point in the CAD drawing, the forward slash disappears and UP/#531 will plot as POLE #531. The original code, with forward slash and appended text, is stored in the coordinate and raw file.

Multiple codes are allowed in Point Store. In collecting a point such as a "T" intersection in a fence, the point can be collected once, but with two codes (separated by a space) as the Desc (e.g. FP1 FP2). This also applies when storing a point that contains two or more distinct ground features (e.g. Edge Of Pavement and Catch Basin). Here also you can collect one point and store this point with two codes separated by a space (e.g. EOP CB). The point plots twice: once in the EOP layer and a second time in the CB layer. The point is plotted on two layers in the drawing, but is stored only once in the coordinate file. Points collected in this fashion can have multiple symbols and have multiple lines drawn through them.
Undefined Codes

All points stored without descriptions or with descriptions not stored in the Field-to-Finish code table are drawn using the default Drawing Options in Configure Field->Point Settings.

**GIS Data Collection**

1. **GIS Information - GIS Predefined Prompting Files and Data Storage**
   
   Carlson Field can store GIS information with points collected with total stations, pulse lasers and GPS surveying equipment. When storing field data, Carlson Field can be set to prompt for additional GIS information for each stored point. There are two separate GIS prompting and data storage methods that can be employed within Carlson Field. The Note File method uses ASCII (.NOT) files. The other method uses Microsoft Access database (.MDB) files. Both methods can use the descriptions of stored points (e.g. SCO for Sewer Cleanout, FH for Fire Hydrant ...), to look for a corresponding GIS prompting file, to prompt and store GIS information. Both the Note File and MDB File methods require creating GIS predefined prompting files prior to collecting field data.

2. **Storing GIS Information in Carlson Field**
   
   The steps to toggle On GIS prompting and storage for either method ASCII or MDB in Carlson Field are detailed and numbered below:

   Step 1) From the main menu pick the Field drop down menu then pick Configure Field.
   
   Step 2) Click on the button GIS Options. This brings up the GIS Options dialog box.
   
   Step 3) The GIS Options pop-up box allows you to choose from the two GIS methods. The two methods are Store Data in Note File (ASCII method) and Store Data Direct to Database (MDB method). These two GIS prompting and data storage methods are described fully in the two sections 4 and 5.

   When storing points in Carlson Field using Point Store or Auto Points at Interval, you can toggle GIS prompting and data storage on and off by picking Options to access Point Settings->GIS Options.

![GIS Options dialog box](image)

3. **Storing GIS information using the ASCII or MDB method**
The recommended method for GIS data storage in Carlson Field is the MDB method. The MDB method stores GIS information directly to a Microsoft Access Database. Only the MDB method can attach digital photographs to points. Carlson Field can create, display, query, input and edit the MDB information. Another important feature that only the MDB method can accomplish is maintaining database connectivity when importing and exporting ESRI Arcview (2D or 3D) shape files.

The ASCII (Note File) method was developed to work with our DOS based data collection package, SurvStar. There are conversion routines to convert between MDB data files and GIS Note files. The only limitation with the ASCII method is that digital photographs cannot be linked to points or entities.

4 Two File Types are used by the ASCII method - GIS & NOT

The two file types for the ASCII method have GIS and NOT file extensions. The GIS files define the GIS prompting and fields. The Note file (.NOT) stores the GIS data for the points.

Each GIS file defines the prompting and fields for one GIS feature. For example, MH.GIS could define GIS prompts for manholes including fields like size, depth, condition, location, etc. These GIS files can be created with the Define Note File Prompts command. GIS prompting files are explained fully in section 5C.

One Note file per job is used to store all GIS information. The Note file always has the same filename as the coordinate CRD file, but with a NOT file extension. For example, job5.not would be the file name for the companion note file to job5.crd. Note files for GIS data storage are always ASCII files and are explained fully in section 7, Note File Data Structure and File Creation.

5. Store Data in Note File - ASCII GIS Prompting and Data Storage

The GIS Options button in the Configure Field command brings up the GIS Options pop-up dialog box. It controls GIS prompting and how GIS information is stored in Carlson Field. There are two formats and methods for GIS prompting and storage, ASCII or MDB. Store Data in Note File is the ASCII method. If the ASCII method is selected (checked) you can choose between two GIS prompting methods. The first method is to have one GIS prompting file for all collected points. This method will then have prompting for one type of GIS feature for the points. The second method uses different prompting for every type of point. It looks for a corresponding GIS prompting file to match the description of each stored point. The method to use is set by the Select GIS File Automatically by Point Description toggle.

GIS Data Collection Page

5A. One ASCII GIS Prompting File for All Collected Points.

Step 1) Pick the check box for Store Data in Note File (ASCII method).

Step 2) Hit Select File. This brings up a pop-up dialog box titled GIS File Name.

Step 3) Choose one GIS filename for prompting. Browse to the drive and subdirectory where the GIS prompting files reside and highlight one. Pick Open to load the selected GIS filename and close the pop-up box. The GIS filename selected should be displayed in the GIS Options dialog pop-up box after GIS File:

This ASCII method will prompt for the same GIS information for every point stored, regardless of description. For example, a FH.GIS (Fire Hydrant) file selection would have the prompting for fire hydrant GIS fields for every point stored.

5B. Select ASCII GIS Prompting File Automatically by Point Description.

Step 1) Pick the check box for Store Data in Note File.

Step 2) Pick the check box for Select GIS File Automatically by Point Description. The GIS file name displayed after GIS File will change to AUTOMATIC. GIS prompting will only appear if the stored point's description corresponds exactly to an existing GIS prompting filename (excluding the GIS extension). For example, if the point description...
is SMH, then Carlson Field looks for SMH.GIS for the GIS fields. If a point's description has no corresponding GIS file name, Carlson Field briefly displays "No GIS File Found" and continues automatically.

5C. ASCII GIS Prompting File Structure

The .GIS file defines the GIS fields and prompting for one GIS feature. This file is an ASCII file where each line contains a field definition. The definition line has the field name, prompt and default value separated by commas. If the field is a choice of options, the definition line also has each choice separated by commas. If the field's value is to be calculated automatically by an equation, the equation takes the place of the default value. The field's value is calculated automatically once the point is stored or edited. An example ASCII GIS file for Sewer Cleanout GIS prompting (SCO.GIS), is displayed below for a detailed explanation on ASCII GIS prompting file structure.

SCO,SCO (#),
SIZE,Size (4/6/8/10/12),4,4,6,8,10,12
TYPE,Type (L/M),L,L,M
COMMENTS,Comments,

SCO.GIS is an ASCII file. It is displayed here as it would appear in any text editor. Each line in the GIS file is a GIS prompt in SurvStar and Carlson Field. Each line consists of four items separated by commas. The first is Field Name (SIZE). The second is the prompt, including allowed input in parentheses and separated by slashes (Size (4/6/8/10/12)). The next is the default value (4). This is followed by the allowed values, separated by commas (4,6,8,10,12).

Descriptions for each of the four items and naming conventions for GIS prompting files are described in detail below:

Item 1 - Field Name: Field 1 is never displayed to the operator in Carlson Field. The Field Name is inserted at the beginning of each line in the Note file before the input GIS data. This Field Name corresponds to a column name in a Microsoft Access database table. If you convert GIS ASCII Note data files to MDB tables, the Field Name will become the column name. Converting collected Note files to MDB tables is only an option, not a requirement. The Field Name must be unique for the GIS file and is not allowed to have spaces or special characters.

Item 2 - Prompt: This is the prompt that actually appears when storing ASCII GIS information. It is usually the same name as Field 1 but can include spaces or special characters. Also displayed in the Prompt within parentheses are all allowed input options. Notice the line shown with a prompt SCO (#). The pound sign in parentheses signifies that a number is expected. In the next line the prompt is Size (4/6/8/10/12). When entering GIS information at this prompt only 4, 6, 8,10 and 12 are expected. IMPORTANT: Commas are not allowed within the prompt. All entries in the Prompt should be separated by a / (forward slash) instead.

Item 3 - Default: The default value is displayed directly after the prompt. If the field operator presses return without entering anything, the default will be stored as this line's GIS information. In the example for SIZE,Size (4/6/8/10/12),4,4,6,8,10,12 the next value after the parentheses is 4. Four will be the default value. If the default space is left blank as in the last line COMMENTS, Comments, , then there is no default value and no value will be saved if the operator doesn't enter anything.

Item 4 - Options: These are the only allowed input options at this GIS prompt. When inputting data, only one of these values will be accepted. So only one of the values 4, 6, 8, 10 or 12 will be accepted as input at the Size prompt. These values are the ones that actually control the input; the options appearing in Item 2 are only there so the operator can see his choices.

GIS Data Collection Page

6. Creating Prompting Files

Chapter 14. Field User Guide 559
The .GIS prompting files can be created by the Define Note File Prompts command. A brief description is included here for all the command options found in the Define Note File Prompts dialog box.

Load brings up a dialog pop-up box titled Specify .GIS File. This dialog box allows you to load an existing GIS prompting file.

To edit any individual GIS prompting line, highlight that line and pick Edit. The following pop-up dialog box titled GIS Field Record appears. You can input the four items of the prompting file line here. GIS prompting files need to be structured as described in section 5C. Add Option brings up a pop-up dialog box titled New GIS Option. To remove a value in Options for value, highlight the value and pick Remove Option.

To add a GIS prompting line, highlight the line above where you want the new line to go. Pick Add to bring up the pop-up dialog box titled GIS Field Record shown above. Enter in the Field Name, Prompt, Default Value and Options for Values and pick OK. Remember to follow the structure in Section 5C. The newly added GIS prompting line is inserted below the highlighted line.

The Move Up and Move Down buttons change the sequence of GIS prompting.

Remove deletes the highlighted GIS prompting line.

Save and Save As... store the currently loaded GIS file to the default name or to a new name.
7. NOT File GIS Data Storage and Structure

Note files (.NOT) store the GIS data for the points. Note files are created in Carlson Field automatically when Store Data in Note File is toggled on in Configure Field->GIS Options. Besides the GIS data, the note files can also store survey data such as GPS RMS and PDOP. The survey data to store in the note file is specified in the Configure Field->Point Settings command. One Note file contains all GIS data and Point Store information for all the field collected points of a job. These Note files always have the same name as the currently loaded coordinate file (with a NOT extension instead of CRD). Note files can contain GIS information, survey information or both. To view the note file data, you can open the note file with any text editor or run the List Points command and turn on the List Point Notes option.

JOB-001.NOT File with GIS Data Only

PT, ID:1 GIS_FILE:SMH.gis
SMH, SMH
SIZE, 30
TYPE, STND
MANUFACTURER, WOMAK
COMMENTS, SURVEYOR JSC

PT, ID: 2 GIS_FILE:SCO.gis
SCO, SCO
SIZE, 8
TYPE, M
COMMENTS, SURVEYOR JSC

JOB-002.NOT File with GIS & Survey Data

PT, ID:1 GIS_FILE:SMH.gis
TIME, 17:5:6
DATE, 2/15/2000
SMH, SMH
SIZE, 24
TYPE, STND
MANUFACTURER, WOMAK
COMMENTS, SURVEYOR JSC
HRMS, 0.04
VRMS, 0.07

PT, ID: 2 GIS_FILE:SCO.gis
TIME, 17:6:19
DATE, 2/15/2000
SCO, SCO
SIZE, 8
The two examples here show how Carlson Field’s Configure Field > Point Settings > Store Options can add survey information to the same Note file that GIS uses. The section of Note file corresponding to one point starts with a line showing the point number and GIS prompting file used. If no GIS prompting file exists, NONE is displayed. This line is the point identifier and all GIS and survey data stored below is referenced to this point number until the next point line identifier occurs.

**JOB-001.NOT File with GIS Data Only Corresponding GIS Prompting (SHM.GIS)**

PT_ID:1 GIS_FILE:SMH.gis Using SMH.GIS Prompting File for point 1

SMH.123 SMH,SMH (#), ,
SIZE,30 SIZE,Size (24/30),24,24,30
TYPE,STND TYPE,Type (STND/NSTND),STND,STND,
MANUFACTURER,WOMAK MANUFACTURER,Brand (Richard/Dewey/>
COMMENTS,SURVEYOR JSC COMMENTS,Comments, ,

**JOB-002.NOT File with GIS & Survey Data Corresponding GIS Prompting or Store Options Item**

PT_ID:1 GIS_FILE:SMH.gis Using SMH.GIS Prompting File for point 1

TIME,17:5:6 >Time/Date in Point Notes
DATE,2/15/2000 >Time/Date in Point Notes
NOTE1,MISC NOTES LINE 1 >Point Notes
NOTE2,MISC NOTES LINE 2 >Point Notes
SMH.78 SMH,SMH (#), ,
SIZE,24 SIZE,Size (24/30),24,24,30
TYPE,STND TYPE,Type (STND/NSTND),STND,STND,
MANUFACTURER,WOMAK MANUFACTURER,Brand (Richard/Dewey/>
COMMENTS,SURVEYOR JSC COMMENTS,Comments, ,
HRMS,0.04 >GPS RMS in Point Notes
VRMS,0.07 >GPS RMS in Point Notes
8. Point Store - ASCII GIS using GPS

The Point Store command in Field can store nearly unlimited GIS information with field collected points. The following procedure details the steps needed to field collect points with GIS information using the Point Store command and RTK equipment.

Before running this procedure, the following must be setup:
- Run GPS Setup to configure your GPS receiver.
- Run Align Local Coordinates to define the transformation from the GPS coordinate system to your job coordinate system
- Create .GIS prompting files to use with the Define Note File Prompts command.

Step 1 - Pick Point Store in the Field drop down menu.

Step 2 - If no coordinate file (.CRD) has been selected for the current drawing, then Tsunami will prompt you to load an existing or new CRD file. Pick New to create a new CRD file. For the CRD file name, type in GIS JOB001 and pick Save to create this new coordinate file.

Step 3 - To toggle on ASCII GIS prompting, pick the Options (F6) button. Then pick the GIS Options at the bottom of the Point Options dialog. In the GIS Options dialog, check on the Store Data in Note File and GIS File Automatically by Point Description toggles. Pick OK to close GIS Options and OK again to close Point Settings.

Step 4 - In the Desc field, type the point description that corresponds to an ASCII GIS prompting file (e.g. SCO for the GIS prompting file SCO.GIS)

Step 5 - Plumb the GPS antenna pole and pick Read (F1) to take a reading from the GPS receiver. The coordinates of the point appear at the top of the dialog box. Pick Store (F2) to store point number 1. (F5 both reads and stores.)

Step 6 - Point Number 1 plots on the screen. Immediately after point 1 plots, the first GIS prompting dialog pop-up box appears. The first GIS item is SCO(#). Enter the number for this sewer clean-out and pick Continue.
The four GIS prompts created in the SCO.GIS file appear as dialog boxes. Directly under the Enter GIS Data title in each dialog pop-up box you can see the GIS prompt including possible values. You can use the up or down arrow keys or pick the down arrow selection triangle to choose the value for each GIS prompt. If no values are shown, you can type any input for that value. Pick Previous or Continue to go backwards or forwards. Exit ends the GIS prompting.

The above procedure stores ASCII GIS information into one Note file with the same name as the current coordinate file. Review section 10 to plot, list and edit Note files in Carlson Field.

9. Point Store - ASCII GIS using Total Station

The Point Store command in Field can store both GIS information and survey information with field-collected points. The following procedure details the steps needed to collect points with GIS and survey information using the Point Store command and Total Station equipment.

Before running this procedure, create .GIS prompting files to use with the Define Note File Prompts command.

Step 1 - Pick Point Store in the Field drop down menu.
Step 2 - If no coordinate file (.CRD) has been selected for the current drawing, then Tsunmai will prompt you to load an existing or new CRD file. Pick New to create a new CRD file. For the CRD file name, type in GIS_JOB001 and pick Save to create this new coordinate file.

Step 3 - Pick Setup (F3) to bring up the pop-up dialog box titled Total Station Setup. The total station and computer running Carlson Field must be connected by serial cable.

Step 4 - Type in 1 for the Occupied Point. If there are no coordinates for point 1, then pick the Create Point button. In the Create Point dialog, enter point #1, Northing=5000, Easting=5000, Elev=100 and then click OK.

Step 5 - Set the Backsight Method to Azimuth and type 0 (zero) for the Bksight Azi. Input the Instrument Height and Rod Height.

Step 6 - Sight the total station toward an object assumed to be due north. The gun (total station) is zeroed in Total Station Setup dialog box by picking Zero Hz. A Message dialog pop-up box appears and says Done. Check the screen on the total station to see if it is reporting zero for the horizontal angle. If yes, pick OK to close this Message box and OK again to exit the Total Station Setup dialog box. If the horizontal angle has not changed, the total station configuration settings could be wrong. Check that the proper equipment is selected in Configure Field.

Step 7 - To toggle on ASCII GIS prompting, pick the Options (F6) button. Then pick the GIS Options at the bottom of the Point Options dialog. In the GIS Options dialog, check on the Store Data in Note File and GIS File Automatically by Point Description toggles. Pick OK to close
GIS Options and OK again to close Point Settings.

Step 8 - You are ready to collect points from this setup with the total station and prism pole. In the Desc field, type the point description that corresponds to an ASCII GIS prompting file (e.g. SMH for the GIS prompting file SMH.GIS)

Step 9 - Have the rodman setup over the point and sight the point with the total station. Press Read & Store (F5). The total station takes the shot. Point number 1 plots as a sewer manhole.

Step 10 - A group of pop-up dialog boxes appear that are all titled Enter GIS Data and prompt for the SMH.GIS GIS information SMH, Size, Type, Brand and Comments.

10. Plot, List and Edit GIS Notes in Carlson Survey/Field

Note file GIS and survey information can be plotted, reviewed and edited in Carlson Field.

Plotting Note Point Data - The command in Carlson Field that can plot Notes with points is Draw-Locate Points. In the Draw-Locate Points dialog, toggle on (check) Notes.

The Point Numbers toggle in the Draw-Locate Points dialog controls two output formats for plotting Note information. The one shown above is plotted with the point number, point elevation, point description and point symbol. The second format, shown to the right, plots the Note information with point number, elevation and description turned off. The point Note information is plotted with the point symbol only.

Every line of notes is a separate AutoCAD text entity.

Listing Point Note data for Review - To list the current coordinate CRD file, including Note data, pick List Points in the Points drop down menu. Enter the range of points to review or type all to review all points. Pick (check) List Point Notes to display Note data with coordinate points. Pick OK. The pop-up dialog box titled List Points Report appears as shown below. Scroll up or down to review the coordinate points and Note data.

To create a custom report of the coordinate and note data, pick the Use Report Formatter toggle in the List Points dialog. This method will display a list of all the coordinate and note field names and you can choose the order of
fields to report from this list. The Report Formatter can also output to Excel and Access.

**Edit Coordinate and Note Point Data** - The Input-Edit command in Coordinate File Utilites allows you to edit Note data. Coordinate File Utilites is found in the Points drop down menu. From the Coordinate File Utilities dialog, pick *Input-Edit Point*.

The Edit-Assign Point pop-up dialog box both reviews and edits coordinate and note data. This pop-

```
  1    0,00
    SMH
    SMH
    24
    STND
    WOMAK
```

```
  SMH
  24
  STND
  WOMAK
```

GIS Data Collection Page
up box displays only one point's coordinate and note values at a time. To go to a specific point number, type the desired point number and hit Enter. The coordinate and note values are displayed for this point number. To display the next or previous point, pick Next or Previous. To edit any value, pick that box and edit accordingly. To edit note values you must pick the note value and hit enter on the keyboard. This will display the value in the edit box. Edit the note value in this edit box and hit Enter to update this value. If more than three lines are displayed in the Notes area, an up/down scroll bar will appear to the right of this box. After editing the displayed values, selecting Next, Previous or OK automatically stores the edited values. Pick OK to save the edited values and exit.

11. GIS Data: MDB method

To use the Access Database method for storing GIS data, run Configure Field->GIS Options and turn on Store Data Direct to Database. This method uses one .MDB Microsoft Database file as a "Template File" to create the GIS prompting and a second "Output File" .MDB Microsoft Database file to store the GIS information directly into. Despite uses the MDB file format, this routine works entirely in Carlson Field and doesn't require Microsoft Access to be installed on the computer.

**Depth Sounder**

Carlson Field data collection can be used in conjunction with a depth sounder to survey the beds of rivers and lakes. Carlson Field takes input from both a GPS receiver and a depth sounder to determine and record the elevation of the terrain directly below the surveying boat or barge.

All of Carlson Field's routines work with the depth sounder to let you collect points on the underwater terrain. The elevation stored for each point is the elevation of the bed. Modeling of the bed surface works as easily as modeling any surface using Carlson Software. Carlson Field can be a powerful tool for marine surveying and construction.

**Settings**

To modify the Field depth sounder settings, go to the Field menu and select Configure Field. Choose the Depth Sounder Settings button.

The Depth Sounder Settings menu appears. At this point, Hydrotrac by Odom is the only equipment-specific depth sounder interface. Carlson Field works with other depth sounders that have NMEA standard interface. If you want...
to use Carlson Field without the depth sounder, make sure the Model is set to None.

For the Hydrotrac model, the depth sounder should be set so it outputs message DESO25 I/O. This is done using the Hydrotrac software. Odom should be contacted with any problems involving setting this message (www.odomhydrographic.com or 225-769-3051). The draft setting on the Hydrotac should also be set. This will account for the height difference between the water surface and the working sensor of the Hydrotac.

On the next line appears a box labeled Store Depth in Notes. Carlson Field saves point data in a coordinate file and in a text note file. By checking this box, the note file will record the water depth at each reading along with the other information about that point. (Settings to control the rest of the information saved in this file can be found in the menu Configure Field > Point Settings.)

The window labeled Debug should be set to zero for normal use.

The row of buttons labeled Serial COM Port refer to the COM port on your computer where the depth sounder is plugged in. Carlson Field requires two serial points on the computer when working with a depth sounder (one for the GPS and the other for the depth sounder). The depth sounder serial port must be separate from the GPS serial point.

**Starting Out**

Before working with the depth sounder, we suggest that you make sure the GPS system is working properly with Carlson Field. De-activate the depth sounder by setting the Model to None in the Depth Sounder Settings dialog box. Set up the GPS system that you are using and plug the rover receiver into the COM port for the GPS. Go to Monitor GPS Position under the Field menu. Check that the information being output is correct: Are the latitude and longitude readings what they should be? Are the north and east coordinates aligned to your job coordinate grid? Are the HRMS and VRMS low enough (less than one)? Is the status fixed? If it's autonomous or float, this rover could be having trouble receiving the radio corrections the base receiver should be broadcasting. If everything is working properly, exit the monitor screen and start the depth sounder setup.

Measure the vertical distance from the GPS antenna to the surface of the water. This distance will be called the rod height. Go to the Configure Field > General Settings window and enter this measurement in the Rod Height box.

Plug the depth sounder into the depth sounder COM port on your computer. Go to the Configure Field > Depth Sounder Settings window and set the depth sounder Model. Set the rest of these settings as you want them and click OK.

Go back to Monitor GPS Position. Everything should appear as before, except there should be a new entry called Depth and Elevation should have changed to Bottom Elv. The correct depth should be showing and the Bottom Elv should be showing the elevation of the bed.
The usual Carlson Field functions will all work with the depth sounder active. The windows for Monitor, Point Store and Auto Points at Interval will display the depth when the depth sounder is set as active.
Apache Lightbar

Carlson Field can use an external Light Bar for determining elevation differences and centerline offsets. Light Bars can indicate whether your current position is in cut, fill or on-grade when set vertically. When set horizontally, Light Bars can give centerline left/right offsets. Currently Carlson Field supports a light bar made by Apache, as well as by Mikrofyn, that has arrows for up/down, or left/right, and a row of lights for on-grade. The Light Bar must be connected to a separate serial port than the GPS.

CSI GBX Pro

Hardware Setup

1. Connect the receiver to the antenna by coaxial antenna cable if it is not already connected, and ensure that that the receiver has ample power.

2. Ensure that the antenna is tracking corrections from an MSK Radio Beacon. The easiest way to do this is to use the antenna's automatic frequency scanning when first powering on the receiver
   a) To do this, enter the [SETUP] menu, and select the option [AUTO BX SEARCH]
   
   Note: The beacon automatically selected by this scan will be saved to the receiver's memory and used automatically in the future, until either the scan is executed again, or until a new beacon is specified manually. Thus, it is not necessary to scan each time the beacon is used, provided it is still operating in the same general area.
   
   b) A scan can be performed again in the event that the beacon is lost to scan for the next nearest beacon.

3. Enter the [Setup] menu, then select [Options] then [NMEA ON/OFF]. This menu allows the enabling or disabling of various NMEA messages. The only ones which are necessary are the GGA, GSV and GSA messages. All others should be disabled.
4. In Carlson Field, no further setup is necessary to make use of the CSI GBX Pro. Simply use the other Carlson Field functions as normal. Note however, that the elevations reported by the CSI GBX Pro are MSL (Mean Sea Level).

**Depth Sounder**

Carlson Field data collection can be used in conjunction with a depth sounder to survey the beds of rivers and lakes. Carlson Field takes input from both a GPS receiver and a depth sounder to determine and record the elevation of the terrain directly below the surveying boat or barge.

All of Carlson Field's routines work with the depth sounder to let you collect points on the underwater terrain. The elevation stored for each point is the elevation of the bed. Modeling of the bed surface works as easily as modeling any surface using Carlson Software. Carlson Field can be a powerful tool for marine surveying and construction.

**Settings**

To modify the Field depth sounder settings, go to the Field menu and select *Configure Field*. Choose the *Depth Sounder Settings* button.

The *Depth Sounder Settings* menu appears. At this point, Hydrotrac by Odom is the only equipment-specific depth sounder interface. Carlson Field works with other depth sounders that have NMEA standard interface. If you want to use Carlson Field without the depth sounder, make sure the Model is set to None.

For the Hydrotrac model, the depth sounder should be set so it outputs message DESO25 I/O. This is done using the Hydrotrac software. Odom should be contacted with any problems involving setting this message (www.odomhydrographic.com or 225-769-3051). The draft setting on the Hydrotrac should also be set. This will account for the height difference between the water surface and the working sensor of the Hydrotrac.

On the next line appears a box labeled *Store Depth in Notes*. Carlson Field saves point data in a coordinate file and in a text note file. By checking this box, the note file will record the water depth at each reading along with the other information about that point. (Settings to control the rest of the information saved in this file can be found in the menu *Configure Field >Point Settings*.)

The window labeled *Debug* should be set to zero for normal use.

The row of buttons labeled *Serial COM Port* refer to the COM port on your computer where the depth sounder is plugged in. Carlson Field requires two serial points on the computer when working with a depth sounder (one for
Starting Out

Before working with the depth sounder, we suggest that you make sure the GPS system is working properly with Carlson Field. De-activate the depth sounder by setting the Model to None in the Depth Sounder Settings dialog box. Set up the GPS system that you are using and plug the rover receiver into the COM port for the GPS. Go to Monitor GPS Position under the Field menu. Check that the information being output is correct: Are the latitude and longitude readings what they should be? Are the north and east coordinates aligned to your job coordinate grid? Are the HRMS and VRMS low enough (less than one)? Is the status fixed? If it's autonomous or float, this rover could be having trouble receiving the radio corrections the base receiver should be broadcasting. If everything is working properly, exit the monitor screen and start the depth sounder setup.

Measure the vertical distance from the GPS antenna to the surface of the water. This distance will be called the rod height. Go to the Configure Field>General Settings window and enter this measurement in the Rod Height box.

Plug the depth sounder into the depth sounder COM port on your computer. Go to the Configure Field>Depth Sounder Settings window and set the depth sounder Model. Set the rest of these settings as you want them and click OK.

Go back to Monitor GPS Position. Everything should appear as before, except there should be a new entry called Depth and Elevation should have changed to Bottom Elv. The correct depth should be showing and the Bottom Elv should be showing the elevation of the bed.

The usual Carlson Field functions will all work with the depth sounder active. The windows for Monitor, Point Store and Auto Points at Interval will display the depth when the depth sounder is set as active.

Geodimeter/Trimble 5600

Geodimeter 600 For Remote Mode

**Note:** Firmware version 696-03.xx or higher is required on the instrument. To check the version, pick MNU-5-4-1.

**SET-UP**

1. Connect the instrument to the battery pack. There is no need to connect the keyboard to the battery if it is going to be turned off, or attached to the unit.
2. Connect the prism to the top port of GeoRadio.
3. Connect the bottom port of the GeoRadio to Carlson Field. Then turn on the radio.
4. Turn on the Geodimeter. The Geodimeter starts with the screen for leveling the instrument. When the instrument is leveled press [ENT] key to continue to the next step. Now the instrument starts compensator calibration. You can wait for calibration to finish or turn it off. To turn calibration off press on [F] 22, enter 0 for comp. This needs to be done when the instrument is turned on and before [ENT] is pressed.
5. Next Geodimeter will ask for different values for pressure, offset, etc. They can either be left like they are by pressing on [ENT] or they can be changed.
6. Press [F] 79, it is the End of Transfer character, which should be set to 4.
7. To set radio, and station channels, press [MNU], and enter 1 for "Set". After set press 5, which will give the user opportunity to change channel, station, and remote address.

**Note:** The channel, station and remote address on the Geodimeter should match the channel, station and remote address in Carlson Field.

8. To set the Geodimeter for remote mode, press on RPU, then 3 for remote and 1 for ok, you can answer [NO] to "Define Window?" If [ENT] is pressed, the instrument will ask "Aim to A Press Ent", for which the user have aim to upper/lower left boundary and press [ENT], for "Aim to B Press Ent", aim to the upper/lower right boundary and
press [ENT]. For "Measure ref obj?" press [ENT] if you want a reference object, otherwise press [NO]. Than the instrument is going to say remove keyboard however the keyboard can stay on.
9. After Geodimeter display screen turns itself off, it's ready for Carlson Field.

**CARLSON FIELD**

1. In Configure Field, under equipment type there should be Geodimeter. In Communication Settings Baud Rate should be set to 9600.
2. After Configure Field go to Equipment Setup and make sure GeoRadio is checked, and the channel, station and remote address is the same as it is in the total station.
   **Note:** We recommend using channel 3.
3. If calibration box is checked the instrument will calibrate, to turn of calibration the box should be unmarked.
4. In setup there is also an option to turn on/off-tracking lights.

**Geodimeter 600 For Direct Connection**

1. Connect the instrument to the battery pack, and the control unit to Carlson Field.
2. Under Field go to Configure Field and place Geodimeter in Equipment type.
3. Click on General Settings make sure that the baud rate is set to 9600.
4. Exit Configure Field.
5. Go to Equipment Setup and check Connect to Station and click OK.

Now you are ready.

**InnerSpace Tech Depth Sounder**

The communication settings for the InnerSpace Tech depth sounder are 9600-N-8-1.
Laser Atlanta

To setup Laser Atlanta select Menu on the instrument, then Serial, and set Baud rate to the same as Carlson Field's and Format to Laser Atlanta.

Leica Disto

The communication settings for the Leica Disto are 9600-E-7-1.

Leica GPS System 500

Setting Up a 500 Series Receiver

1. Connect the antenna cable to the ANT Port on the front of the receiver, and to the antenna.
2. If you are using the PacCrest radio module, screw it in place over Port 1 on the receiver and attach its antenna cable. Otherwise, connect any radio being used to Port 1, 2 or 3.
3. If an external power source is being used, be sure to plug it into the PWR Port on the front of the receiver.
4. If external power is not being used, ensure that there are batteries in one or both of the batter slots on the bottom of the receiver.
5. Plug the 9 pin serial connection cable into the serial port of the computer running Carlson Field and into the Terminal Port on the front of the receiver.

Configuring Carlson Field for Use With a 500 Series Receiver

1. Select "Configure Field" from the Field pull-down menu. This will open a new window with several buttons on it, as well as a pulldown list labeled "Equipment Type." Select "Leica 500 Series" in the Equipment Type menu, then select "Communication Settings."
2. Ensure that the COM port is set to the one that the serial cable is plugged into, and that the Baud Rate is 9600, the Char Length 8, the Stop Bits 1, and the Parity None. Close this menu and the Configure Field menu.
3. In the Field pull-down menu, select "Equipment Setup." This will open another menu with several selectable options and several buttons.
4. Use the radio buttons on the top right to select whether the receiver will be a rover or a base station. Also be sure to select the antenna types being used from the pulldown menu at left.
5. Enter the desired Satellite Elevation Cutoff in the text box above the column of buttons. All satellites with elevations less than this number will not be used in position calculation (receiver default is 15).

6. Select the "Radio Settings" button. This will open another window with several selectable settings. Select the Port number the radio is attached to on the front of the receiver, the baud rate of the radio, number of radio stop bits and radio parity. These last three settings should be listed in the documentation for the radio being used. Also, select the desired format to use for sending and receiving messages from the bottommost option. Exit this menu.

7. If the GPS receiver is being configured as a base station, select the "Configure Base Station" button from the Equipment Setup menu, and proceed with step 8. Otherwise, the receiver is ready for use.

8. There will now be a menu with a few buttons to select a method of determining the base station's present location. The options are:

   - **Read From GPS** - Read one or more position readings from the GPS and use this position or the average of several positions for the base station corrections.
   - **Enter Lat/Lon** - This option will bring up a menu to enter the exact Latitude, Longitude, and elevation of the receiver's position by hand.
   - **Enter State Plane Coord** - This option will bring up a menu to enter the coordinates of the position of the base station according to the state plane coordinate system.
   - **Read from File** - This option will read a coordinate set from a file already saved to the computer.

Select whichever method will be used, and enter any necessary data. The receiver is now configured and ready for use.

**Other Buttons In the Setup Menu:**

1. **Power Cycle Receiver** will shut the receiver down and then power it up again. Used to clear the receiver's memory.

2. **Power off Receiver** shuts the receiver down. Note that if this button is pressed, any settings changes made while in this menu will not be saved to the receiver.

3. **Send command to receiver** allows for sending messages to the receiver. The user must enter the message by hand. This feature is only intended for use in conjunction with the technical support provided with Carlson Field.

**Troubleshooting the Leica 500 Series in Carlson Field**

Several possible errors can occur in the course of using a 500 Series Leica receiver with Carlson Field. Carlson Field will use all its standard error messages to report usual types of error messages, such as an inability to communicate with the satellites that are being tracked. In addition, the Leica 500 Series of receivers will have their own set of error messages unique to themselves. This type of error message is reported if there is an error during the transmission of various configuration messages to the receiver to set up the base station settings. Such messages will say "Set Port Message Rejected", or "Set Base Antenna Message Rejected" or "Set Antenna Height Message Rejected" or "Set RTK Message Rejected." Each indicates which particular facet of the configuration failed. If one of these messages is rejected, it is likely a momentary transmission error. If, on the other hand, several (or all) are rejected, it is possible there is a problem in the communication line between the computer and the receiver, which should be checked.

**Leica TC Series**

**Leica TC Series Instrument Setup**

On the instrument, make sure that the communication settings have CR/LF for the terminator.

**Remote Mode**

1. Turn on Leica
2. Connect Leica to rover radio, and connect the radio to the larger battery.

3. Connect the base radio to Carlson Field, and the smaller battery.

4. In the Field menu go to Configure Field, and under equipment type put Leica TC

5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check if the baud rate is 19200. When Leica is turned on under Main Menu enter 5 for "Configuration", and 2 for "Communication Mode", then enter 1 for "Gsi parameters", and check if the baud rate is also set 19200.

6. Line Terminator in "Gsi parameters" should be set to CR/LF


8. When back in Communication Mode screen enter 5 for "RCS (Remote) ON/OFF" and make sure it's NOT set for remote mode.


10. In the Field menu go to Equipment Setup and for Connection Mode check remote.

11. When done click on OK.

To put Leica in Tracking: On Gun press "FNC" then ATR+ and LOCK+

**TCA 1800**

1. Turn on Leica

2. Connect Leica to Carlson Field

3. In Field go to Configure Field, and under equipment type put Leica TC

4. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. When Leica is turned on press [F3] for "conf", then enter 3. The baud rate can be changed by pressing [F6] for "list", when done enter [CONT]. In addition to baud rate parity, char length, and stop bits should also match.

Note: Default in Carlson Field is not the same as default in Leica.

**Leica 1100**

To set up the Leica 1100 total station select the following commands on the instrument: Main Menu>Configuration>communication mode> GSI parameters. In the GSI parameters command copy the following settings: (baud=to Carlson Field's, protocol=GSI, parity=to Carlson Field's, Terminator=CR/LF, Data Bits=to Carlson Field's, Stop Bit=1), Geocom Param (baud=Field's) RCS Param (baud=Field's). Also, make sure RCS mode is OFF.

**Leica 700**

To set communication settings for **Leica 705s**, go Shift key then Prog (Menu) key and then to All Settings and last to PC Comm.
Manual Total Station

This method allows you to run Carlson Field in total station mode without being connected to equipment. The program will prompt you to enter the horizontal angle, zenith angle and slope distance. This method can be used for demonstration purposes or to work with total stations that cannot connect to Carlson Field. For these total stations, instead of the automatic connection, you can take a shot, read the instrument and then manually enter the data into Carlson Field.

As with other total stations, the first step is to run Equipment Setup to establish the occupied point, backsight and instrument/rod heights before running Carlson Field functions. Then in Carlson Field functions, when you pick the Read button, the program will bring up a dialog for entering the angles and distance. The angles should be entered in dd.mmss format (degrees.minutes.seconds).
Mikrofyn Lightbar

Carlson Field can use an external Light Bar for determining elevation differences and centerline offsets. Light Bars can indicate whether your current position is in cut, fill or on-grade when set vertically. When set horizontally, Light Bars can give centerline left/right offsets. Currently Carlson Field supports a light bar made by Mikrofyn named RD-4 1137551, as well as by Apache, that has arrows for up/down, or left/right, and a row of lights for on-grade. The Light Bar must be connected to a separate serial port than the GPS.

Navcom Configuration Guide

This guide will walk you through the setup process for your Navcom units. It covers individual unit setup as well as base/rover setup under the simplest possible configuration. If you want to customize the configuration, consult the reference manual.

A) Preliminary setup steps

Perform the following preliminary steps to initialize your computer for communication with your Navcom units:
1) Startup the Carlson product you intend to use.
2) Select CONFIGURE FIELD, from the FIELD Menu.
3) Select NAVCOM from the EQUIPMENT TYPE dropdown.
4) Click the COMMUNICATION SETTINGS button. Verify that the SERIAL COM PORT is set to the port you intend to use to communicate with your Navcom unit. (usually COM1).
5) In the COM PORT SETTINGS box, click DEFAULT, and verify that baud rate=19200, parity=NONE, char length=8, and stop bits=1.
6) Click OK, and then click the GPS SETTINGS button.
7) Under GPS SETTINGS, set your HRMS and VRMS tolerance. For single-unit setup, these numbers should be at least 10. For base/rover configuration, they should be around 0.01.
8) Under PROJECTION TYPE, select the coordinate plane you wish to use. For state plane, make sure you choose the proper ZONE.
9) Click OK and then click EXIT.

B) Single-unit setup (no corrections)

Before attempting a multi-unit setup, it is recommended that you first try setting up your Navcom unit to output an uncorrected position. The steps to do so are explained here:

1) Mount your GPS Antenna on a tripod in a place where its view of the sky is not obstructed.
2) If your antenna is separate from your receiver, connect your antenna to your receiver's AN TENNA port. (This step can be skipped for the RT-3010S, and other all-in-one models)
3) Plug your receiver into a power supply, or insert fully charged batteries into the battery ports. (Not all units have battery ports).

4) Turn your receiver on by holding down the power button for a few seconds, or until the status lights flash on.

5) Use the serial port cable to connect your computer to port A of your Navcom unit. Make sure the port on your computer that you use corresponds to the one you chose during preliminary setup.

6) Under the FIELD menu, choose EQUIPMENT SETUP.

7) If a PORT SETUP window pops up, set CONTROL PORT to PORT A, and RTK DATA PORT to RADIO PORT.

8) Setup is now complete. Steps that follow are optional.

9) Click the NAVIGATION STATUS button. From here you can monitor the progress of your Navcom unit as it calculates its position. Click AUTOREFRESH to view continuously updated status reports.

10) It may take a few minutes for the unit to calculate its position, if the unit was reset, or recently turned on. When the calculation is complete, VALID NAVIGATION will read YES. When this occurs, the Navcom unit is ready for use. Click CLOSE, then click CANCEL WITHOUT SAVING.

11) To monitor your position, choose MONITOR GPS POSITION from the FIELD menu, and you will see your current position. All Carlson Field GPS functions should now work.

C) Multi-unit setup (using corrections from a base)

1) Base Setup
   a) Perform the preliminary and single-unit setup steps described above.
   b) Attach the radio antenna to the radio port of your base unit.
   c) Select EQUIPMENT SETUP from the FIELD menu.
   d) Select a CORRECTION TYPE. We recommend NCT RTK.
   e) CLICK the CONFIGURE BASE button.
   f) When prompted to enter a position, enter the exact position of the base unit. Note that the accuracy of your rover's calculation depends on this position being completely accurate.
   g) Enter a station ID of 0. The station ID is only used in RTCM mode.
   h) Verify that STATION TYPE now reads BASE.
   i) Base station setup is complete. Click SAVE SETTINGS AND EXIT.

2) Switch the device you're plugged in to:

   After configuring the base, unplug your serial cable from your base's port A, and plug it into your rover's port A. Note: Whenever you switch the device you're plugged into be sure to close the Equipment Setup window first.

3) Rover Setup
   a) Perform the preliminary and single-unit setup steps described above.
   b) Attach the radio antenna to the radio port of your rover unit.
   c) Select EQUIPMENT SETUP from the FIELD menu.
   d) Select a CORRECTION TYPE. We recommend NCT RTK. Note that this selection must match the selection made during base setup.
   e) CLICK the CONFIGURE ROVER button.
   f) Verify that STATION TYPE now reads ROVER.
   g) Rover setup is complete. Steps that follow are optional.
   h) You can verify that the rover is receiving correction by clicking the MONITOR INCOMING CONNECTION, and then clicking AUTOREFRESH. The open window shows the time since each correction type was last received (delta time). In NCT RTK mode, the delta time of 5b, should stay around 1 second, and the delta time of message 5c should not go above 30 seconds. If these numbers are high, or if they read NEVER, try repeating the setup process or calling Carlson Software technical support.
   i) Click SAVE SETTINGS AND EXIT, and then choose MONITOR GPS POSITION from the FIELD menu. The STATUS display should eventually go to LOCK.
Troubleshooting Base/Rover Configuration:

If you've configured a base to output corrections, and you're rover does not appear to be receiving the corrections, try each of the following in order:

1) Verify that your BASE and ROVER are both set to the same correction type.
2) Under Configure Radio, check that your ROVER is set to slave, and that your BASE is set to master.
3) Under Configure Ports, check that both your base and your rover's RTK Data Ports are set to the proper value (Usually Radio Port).
4) Under the Edit Base Position, check that your BASE is set to a valid position. Note that if the given position is too far away from the position the BASE is reading, the BASE will not send corrections.
5) If you're trying to use RTCM, make sure the BASE and ROVER have the same station ID's.
6) Try increase the RTK Max Age constraint.
7) Under Navigation Status, verify that the Navigation is valid on both units. If either unit does not have a valid position solution, correction wills not work.
8) Under Monitor Corrections, verify that the corrections you're using are arriving regularly. If they aren't you may need to reset both units.
9) Try configuring the BASE and ROVER again.
10) If all else fails, Soft Reset both units through the Reset Unit menu. After doing so, you will have to reconfigure the port settings of each device through the Configure Ports menu, and wait a few minutes for the devices to recalculate their position.
11) If none of these steps work, contact Carlson Software Technical Support.

Navcom GPS Setup

Carlson Field supports Navcom's NCT-2000D GPS message protocol, firmware versions 2.6 and later. If your Navcom unit has an earlier firmware version, contact Navcom for a free upgrade. Carlson Field has been tested extensively with Navcom models RT-3010S and RT-3020M.

From the Navcom GPS setup menu, or any of its submenus, the current device settings can be obtained by clicking the Retrieve Settings button. New settings can be saved by clicking the Save Settings or the Save Settings and Exit button. To cancel your changes, click Cancel without Saving.

By changing the SV Elevation Mask, you can prevent the Navcom Unit from using any satellite below a specified elevation angle (Range: 0-90).

By changing the PDOP Mask, you can prevent the Navcom Unit from using any GPS solution with a PDOP above a specified value (Range: 1-25).

By changing the RTK Max Age, you can prevent the Navcom Unit from using any RTK corrections older than a specified number of seconds. (Range: 0-1275, Multiple of 5).

By changing the Base Station ID on a base, you can provide your base with a unique identifying number so that rovers can specify which base they want to use for corrections. By changing this setting on a rover, you can specify which base unit you want to use. If 0 is specified, the rover will use any base station it can find. The base station ID only applies when using the RTCM correction format. (Range: 1-1023)

You can choose between 4 different Correction Types: NCT (Navcom Proprietary), CMR (Trimble's format), RTCM RTK (Messages 18-22), or RTCM DGPS (Message 1 and 9). When configured to BASE, changing the correction type changes the type being sent. When configured to ROVER, changing the correction type changes the type the unit is listening for. A ROVER will ignore all incoming correction messages except those of the type specified.

Configure Ports Submenu:
The **Control Port** should be configured to **Port A** or **Port B**, depending on which of the Navcom units' ports you are plugged into. Note that the **Control Port** refers to the number of the port on the Navcom unit, NOT the number of the COM port on your computer. If the **Control Port** is configured improperly, you will not be able to communicate with your Navcom unit.

The **RTK Data Port** refers to the device port out of which RTK corrections will be sent. This value should be set to **Radio Port**, unless you want to set up a non-wireless Base/Rover connection through Port A or Port B. The **RTK Data Port** cannot be the same as the **Control Port**.

**Configure Radio Submenu:**

The **Radio ID** is the value used to identify a unit on a wireless network of Navcom units. Make sure that no other Navcom unit in your vicinity shares the same **Radio ID**. By default, the **Radio ID** is the same as your Navcom unit's serial number. This value can be changed, although there isn't usually any need to do so.

The **Local Radio Type** can be set to either **Master** or **Slave**. Radio communication will only work between **Masters** and **Slaves**. Only one unit on your network should be set to **Master**. It makes sense to make the base unit a **Master**, and all rovers **Slaves**. These settings will be handled automatically by the **Configure Base** and **Configure Rover** routines. So there generally isn't any reason to set the **Local Radio Type** manually.

The **Local Antenna Power Level** allows you to configure your radio to use more or less power. The less power the radio has, the less it will be able to communicate over longer distances. It may be useful to change the power level if you're rover is not traveling far from your base, and you're trying to conserve battery power.

Within the **Navcom Radio Setup** menu, you will be able to access the following status information for all visible Navcom units on the network:

**External Power:** Indicates whether the unit is plugged into an external power source (On or Off).

**Battery A:** Indicates whether a well charged battery is plugged into Battery Port A (On/Good or Off/Low)

**Battery B:** Indicates whether a well charged battery is plugged into Battery Port B (On/Good or Off/Low)

**Status:** Indicates whether the unit is sending out corrections. (BASE or ROVER)

If more than two units are present, you can access this information for the additional units by selecting the desired unit's radio ID from the **Remote Radio ID** dropdown menu.

**Configure RTCM Submenu:**

Note: To access this menu, first configure the unit as a **BASE** and set the **Correction Type** to either **RTCM RTK** or **RTCM DGPS**.

Choose **message 18/19** to make your RTCM RTK base broadcast RTCM message types 18/19.

Choose **message 20/21** to make your RTCM RTK base broadcast RTCM message types 20/21.

Choose message 1 to make your RTCM DGPS base broadcast RTCM message type 1.

Choose message 9 to make your RTCM DGPS base broadcast RTCM message type 9

**Edit Base Position** Submenu:

Note: To access this menu, first configure the unit as a **BASE**.

If your **BASE** already has a GPS position set, it will be shown here. (If you don't see it, try pressing Retrieve.) To edit this value, change the displayed number and press the **Lock** button.

Click **Survey** to read a new GPS position from the Navcom unit.

Click **Empty**, to clear the GPS position from the unit.

**Reset Unit** Submenu:
Click *Soft Reset* to send a reset command to the Navcom unit. If the command is successful, all three status lights on the unit should go solid temporarily. After performing a soft reset, you will have to go to the *Configure Port Submenu* to reconfigure the control port.

Click *Factory Reset* to send an emergency reset command to the Navcom unit. However, in nearly all cases, it is only necessary to use the *Soft Reset* button. After performing a factory reset, you will have to go to the *Configure Port Submenu* to reconfigure the control port.

*View Firmware Submenu:*

This submenu displays the Navcom firmware version your unit is using, along with the hardware serial numbers and the hardware model name.

*Navigation Status Submenu:*

If *Valid Navigation* reads *Yes*, your unit has successfully solved its position. If it reads *No*, the unit's position has not yet been calculated, and an error message explaining why will be displayed in the *Error* field. A rover will not try to use RTK corrections unless its navigation is valid. Similarly, a base will not broadcast correction unless its navigation is valid.

*Navigation Status* will read *AUTONOMOUS* if it is not receiving the type of corrections it has been configured to use. It will read *FLOAT* if it is receiving the right kind of corrections, but hasn't finished using them to calculate its position. It will read *LOCK* when it is receiving corrections and has successfully used them to calculate its position.

*Navigation Mode* displays the specific type of correction that is currently being used.

*# of Satellites Used* shows the number of satellites the unit is able to use in its solution.

All *DOP* values are also shown here (GDOP, PDOP, HDOP, VDOP, and TDOP).

Click *Refresh* to load the latest values from the device.

*Monitor Incoming Corrections Submenu:*

Note: To access this menu, the local unit must be configured as a ROVER.

This menu displays the number of seconds since the arrival of each RTK correction type. At the top, the correction type currently being used is displayed.

In *NCT Correction Mode*, the relevant messages are 5B (correction), which should be arriving every second, and 5C (base position), which should be arriving every 16 seconds.

In *CMR Correction Mode*, the relevant messages are cmr0 (correction), which should be arriving every second, and cmr1(base position), which should be arriving every 30 seconds.

In *RTCM RTK Correction Mode*, the relevant messages are RTCM message 22, and either messages 18 and 19, or messages 20 and 21, depending on your base's RTCM setup. Messages 18-21 should be arriving every second. Message 22 should be arriving every 6 seconds.

In *RTCM DGPS Correction Mode*, the age of correction messages (1 and 9) cannot be monitored here.

Click *Refresh* to load the latest values from the device.

*Configure Base Submenu:*

Before clicking *Configure Base*, first choose the type of corrections you want to use. When you click *Configure Base*, all steps necessary to configuring a base will be performed. You will be prompted for a Base Position and a Radio ID. Upon completion, the unit status should read BASE. If it does not, or if an error occurs during base configuration, try again, or consult the Base/Rover configuration troubleshooting section below.

*Configure Rover Submenu:*
Before clicking *Configure Rover*, first choose the type of corrections you want to use. When you click *Configure Rover*, all steps necessary to configuring a base will be performed. Upon completion, the unit status should read ROVER. If it does not, or if an error occurs during rover configuration, try again, or consult the Base/Rover configuration troubleshooting section below.

*Switching the device you're plugged in to:*

Whenever you switch the device you're plugged into be sure to either close the Equipment Setup window, or click *Retrieve Settings* from the top level Equipment Setup menu.

*Troubleshooting Invalid Navigations:*

If the *Navigation Status* menu reports an invalid navigation, your unit has not yet been able to calculate it's position. The unit may need more time, if less than 4 satellites are visible, or an error is reported. If you can't get a valid solution for a few minutes, try raising the PDOP mask, or lowering the Satellite elevation mask.

*Troubleshooting Base/Rover Configuration:* If you've configured a base to output corrections, and your rover does not appear to be receiving the corrections, try each of the following in order:

1. Verify that your BASE and ROVER are both set to the same correction type.
2. Under *Configure Radio*, check that your ROVER is set to slave, and that your BASE is set to master.
3. Under *Configure Ports*, check that both your base and your rover's RTK Data Ports are set to the proper value (Usually Radio Port).
4. Under the *Edit Base Position*, check that your BASE is set to a valid position. Note that if the given position is too far away from the position the BASE is reading, the BASE will not send corrections.
5. If you're trying to use RTCM, make sure the BASE and ROVER have the same station IDs.
6. Try increase the RTK Max Age constraint.
7. Under *Navigation Status*, verify that the Navigation is valid on both units. If either unit does not have a valid position solution, correction will not work.
8. Under *Monitor Corrections*, verify that the corrections you're using are arriving regularly. If they aren't you may need to reset both units.
9. Try configuring the BASE and ROVER again.
10. If all else fails, Soft Reset both units through the *Reset Unit* menu. After doing so, you will have to reconfigure the port settings of each device through the *Configure Ports* menu, and wait a few minutes for the devices to recalculate their position.
11. If none of these steps work, contact Carlson Software Technical Support.

*Troubleshooting when you cannot establish communication with the unit:*

If all of your commands in the Equipment Setup menu are failing, try opening the *Configure Ports* submenu, selecting the proper Control Port, and saving the new settings. Make sure that you're plugged into the port you have chosen to be the control port.

If this does not work, issue a soft reset command. If this fails, try a factory reset command. If even this fails, call Carlson Software Technical Support.

**Nikon Total Stations**

**Nikon A-Series**
Nikon A-Series includes the A5LG/A5, A10LG/A10 and A20LG/A20. Also the C-100 and D-50 have the same communication as the A-Series and should be used in the SET mode.

**Nikon 500 Setup**

1. Turn on Nikon
2. Turn it Horizontally and Vertically to set it.
3. Connect Nikon to Carlson Field

Note: 9-pin serial cable from Nikon to Carlson Field should be NGT type and not SOKTOP.

4. In Field go to Configure Field, and under equipment type put Nikon 300,400,500 series.
5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. On Nikon press [MENU], then 3 for "sett", and 6 for "comm". The baud rate can be changed using the arrow keys.
6. Exit the Configure Field menu.
7. To check if units (Ft /M) matches for correct results, in Carlson Field under Settings go to Drawing Setup and select the appropriate button. On Nikon, press [MENU] and 3 for "sett" again, but now press 5 for "unit".

**Nikon 310**

Set the same baud rate in the Nikon 310 station as you did in Carlson Field and set the Nikon instrument to the record format by selecting on the instrument Fnc->>5(Set)->>6(other)->>3rd screen.

**OmniStar Otto**

In Field go to Configure Field and under equipment type select CSI GBX/OmniStar Otto and in Communication Settings set the baud rate to 9600.
Simulation (GPS)

Simulation GPS mode is for demonstration purposes to show or practice Carlson Field functions. This mode allows you to run Carlson Field without being hooked up to any equipment. The program will automatically generate a position. This position is the first point in the alignment. If there is no alignment, then the starting point is 5000,5000,1000. There are keyboard commands to control the simulation position during continuous read commands such as Stakeout and Track Position.

Here are the keyboard commands:
L - Turn Left
R - Turn Right
F - Go Faster
S - Slow Down
U - Up
D - Down
W - Switch Direction

Sokkia

Sokkia Radian IS

Hardware Setup

1. Make sure that the Radian IS has fully charged batteries installed, as described in the receiver documentation.
2. Connect the Radian IS serial cable to "COM1" on the Radian IS, plugging the other end into the controlling computer's serial port.
3. If the Radian IS is to be used as a base, connect a PDL base radio to the "COM2" port of the receiver. If the IS is to be used as a rover, connect a PDL rover radio to the "COM2" port if the receiver.
4. Power the Radian IS on with its external power switch.
5. Once the receiver finishes its self-initialization (when all the lights on the side panel go out and then the battery light lights in just one position), it is ready for use with Carlson Field. However, positions will not be able to be logged until the receiver has acquired a few satellites. The receiver has enough satellites when the center light is at the second or higher level (when it is orange instead of red).

Software Setup

6. To configure the IS for use, select "Equipment Setup" from the Field pulldown menu. This will open a menu with several options:
   a) Radio Baud Rate: This radio button sets the baud rate for COM2, the radio COM port. Make sure this number and the number the PDL's are set for is the same.
   b) Station Type: This sets whether the Radian IS is to be configured as a base station or a rover.
   c) Elevation Type: This allows selection of Geoid (MSL) or Ellipsoidal measures for height/altitude.
   d) RTK Dynamics: This sets the dynamics mode of the receiver. In general, this setting should be set to "Dynamic/Kinematic".
   e) Message Type: This sets what format of corrections this receiver will send/receive for RTK.
   f) Motion Dynamics: This is used to set the receiver's calculations appropriate to the motion of the receiver.
   g) Elevation Mask: This is the satellite elevation cutoff. No satellites with elevation less than this number will be
used in corrections. This allows filtering out of satellites close to the horizon, which provide less accurate calculations for positions.

h) Send Command to Receiver: This allows a specific user-entered command to be sent to the receiver. Mostly used for troubleshooting with Technical support.

i) Configure Base: This configures the parameters of a base station for the receiver (Ex: Current position, etc.)

j) Power Cycle Receiver: This powers the receiver down and then turns it back on, clearing the main memory.

k) Save and Exit: This saves all settings changes and exit this menu.

l) Cancel: This restores original settings and exit this menu.

To set the Radian IS up as a Rover:

7. Select "Rover" for Station Type, and set the Radio Baud to match the PDL's which are being used. Also, set "RTK Dynamics" to "Dynamic/Kinematic", and set Motion Dynamics to the appropriate option.

8. Select "Exit and Save". The receiver is now ready for use as a rover.

To set the Radian IS up as a Base:

9. Select "Base" for station type, and set the Radio Baud to match the PDL's which are being used.

For most jobs, set RTK Dynamics to "Dynamic/Kinematic" (unless you are sure that static is more appropriate—even small fluctuations from wind on the pole can cause problems in Static mode). Set motion dynamics to Foot/Walking, and then select "Configure Base Station"

10. In the menu dialog that opens, there are a few buttons:

a) Read from GPS: Read a position from the GPS and fix to that position

b) Enter Lat/Lon: Fix to a manually entered Lat/Lon position

c) Enter State Plane Coord: Fix to a manually entered State Plane Northing/Easting position

d) Read From File: Fix to a position read from a *.ref file.

e) Cancel: Cancel base setup

If Read From GPS is selected, the software will read once from the GPS receiver, and then fix to that position. If Enter Lat/Lon is selected, a dialog box will open and a Latitude and Longitude must be input manually. If Enter State Plane Coord is selected, a dialog box will open allowing the input of a set of Northing/Easting coordinates by hand.
Read from File will open a File>Open dialog and ask for the file name of the file to open.

Regardless of which option is selected, after the position is determined, this position will be displayed, and dialog boxes will open to enter a station id and the measured base antenna height. Once these values are entered, base setup is complete and the "Exit and Save" button can be selected to exit the Equipment Setup menu.

**Sokkia 500 Series**

1. Turn on Sokkia
2. Turn it Horizontally and Vertically to set it.
3. Connect Sokkia to Carlson Field
4. In Field go to Configure Field, and under equipment type put Sokkia
5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. On Sokkia press [ESC], then [CNFG]. Scroll down or enter 4 for "Comms setup." The baud rate can be changed using the arrow keys, when done press [ESC].
6. Exit the Configure Field menu.
7. To check if units (Ft /M) matches for correct results, in Carlson Field under Settings go to Drawing Setup and select the appropriate button. On Sokkia, in [CNFG] scroll to or enter 5 for "unit" and select appropriate unit using the arrow keys.

**Topcon Total Stations**

The Topcon instrument must have CR/LF (carriage return/linefeed) turned on for communication with Carlson Field.

**Topcon 200 Series**

To set CR/LF with 200 series:
1. Turn instrument off
2. Turn instrument on while holding F2 key
3. Choose F3 (Others set)
4. Press F4 (Page down)
5. Choose F3 (CR/LF) and set it on

To set this with 700 series:
1. Choose Parameter from the main screen
2. Scroll down until you find CR/LF and set it on

**Topcon ITS**
The command echo on the instrument must be turned off to work with Carlson Field.

**Topcon GTS-A4**
To setup the instrument hold down F-2 as you switch it on. This will bring up a parameters menu, press F-3 for Data Out. Hit Select to browse through the settings options, and make sure CR, LF: is ON and that Echo back: is OFF. Setup is complete.

**Topcon GTS-700**
To set the instrument to work with Carlson Field, press [F2] for "std" on the instrument.
**Topcon 800-A Remote Setup**

**Topcon Setup:**

Note: The instrument needs to be set to REC-A, not REC-B mode

1. Turn on the Topcon
2. Connect the Topcon to one of the radios, and the other radio connect to Carlson Field
3. Under Field menu go to Configure Field, and under equipment type select Topcon800A-Remote.
4. To set Topcon for external mode Press [F1] for "prog", then [F6] for "more". This will lead to more programs. Enter [F2] for "Ext.Link."
5. To select the radio channel, in External Link enter 2 for "settings" and 4 for "parameter (radio modem)" , then 3 for "set channel". Using the arrow keys change the channel. When done press for [F1] for set, then press [ESC] until get back to External Link Menu.

Note: Channel on the Topcon should match the channel set in Carlson Field.
6. After channel is set press 1 for "Execute"
7. Topcon is ready.

Note: If the batteries are low either in Topcon or the radios, communication problems will arise.

**Carlson Field Setup:**

1. In Configure Field, under equipment type there should be Topcon800A-remote. In Communication Settings Baud Rate should be set to 9600.
2. After Configure Field go to Equipment Setup and make sure the radio channel or radio frequency matches the channel and frequency in Carlson Field. Press Ok when done.

**Topcon 800A Quick Lock**

1. Dismount the handle from the Topcon, and mount RC-2H. Secure it with the fixing screw.
2. Attach RC-2R to the prism, and turn it on.

3. Using the Y cable attach the RC-2H to the radio and Carlson Field.

4. In Joystick click on Quick Lock and Topcon will do angle turn until it finds a prism in which it will lock to, and will start tracking.

5. If RC-2H is not attached to the radio with Y cable, when Quick Lock is pressed the big yellow button on RC-2H needs to be pressed in order for the Topcon to search for the prism.

Trimble

Trimble NT300D

1. In order to properly configure the NT300D to work with Carlson Field, it must first be powered up in Setup mode (by holding down the [Setup] button on the front panel of the receiver while powering it on) so that the advanced setup options are available. Once the NT300D is powered up in this mode, bring up the Setup menu via the [Setup] button. Page down using the More menu option until the I/O menu item is available, and select it.

a) In the I/O menu, select whichever port is to be used to interface the receiver with the computer running Carlson Field (Port 1 by default). Next, set both the input and the output to transmit/receive in NMEA, at 9600 baud rate. The final option, Remote Select, should be set to Primary.

b) Now the NMEA sentences must be configured. From the I/O menu, enter the NMEA Sentences submenu. Disable all sentences, save for the GGA sentences and the GSA sentences. Ensure the Talker ID is GP. From here, Return to the I/O menu.

c) The NMEA Control menu item, reachable from the I/O menu, has three options. The Output Rate here should be set to 1 second, the Position Output Rate set to Output Rate, and the NMEA Output Version to 2.1.

Next, the GPS settings must be configured, and can be found in the GPS menu under the main Setup menu. The GPS Mode should be set to 3D, and the DGPS mode set to Auto. The DGPS source should be toggled to Internal, and the Pos/Vel Filter should be Off. Mask Values should be left at Default, and the SNR at M.
Finally, the Beacon Receiver configuration (under *Beacon Receiver* on the Setup Menu) needs to have its Search Mode set to *Auto-Dist* Mode. All other values in all menus ought to either be left at their default settings, or configured as necessary to the local conditions (in the case of antenna height, etc.).

2. The RMS value reported in Carlson Field is the RMS value of the standard deviation of the range inputs to the navigation process including pseudoranges and DGPS corrections.

The NT300D is now properly configured, and if connected to a computer running Carlson Field, will transmit position fix data to the computer automatically. Before using it, however, it is best to power it down and then turn it back on normally, as running it in Setup Mode is not recommended.

**Trimble 4000 Series**

**Hardware Setup**

1. Setup the antenna and GPS receiver as normal. The radio should be on I/O Port 2.
2. Connect the Computer that Carlson Field is running on to I/O Port 1 by the appropriate cable.

**Front-Panel Configuration:**

**Base Station:**

1. After powering on the receiver, press the [Control] Button. From the selections available, select *MORE*. This will bring up a second page of options. Select *MORE* again. The front panel screen should now be on *RECEIVER CONTROL* "3 of 7".
2. Select *BAUD RATE/FORMAT*, and from the menu that this creates, select *SERIAL PORT 1 SETTINGS*.
3. Ensure that the port is set to 38400 baud, 8-Odd-1 Format, with no flow control.
4. Similarly, make sure that the settings for I/O Port 2 agree with those of the type of radio being used (typically 9600 8-None-1).
5. Return to the *RECEIVER CONTROL* menu, and go to page 4 o 7. Select *REFERENCE POSITION*.
6. Enter the Lat/Lon of the position the base is located at. Alternately, select *HERE* to have the GPS unit read the current position and use that as the base reference point.
7. On page 1 of the *RECEIVER CONTROL* menu, select *RTK OUTPUT CONTROL*.
8. Set the *RTK OUTPUTS* to Port 2, and the *ANTENNA HEIGHT* to the measured height of the antenna.
9. Ensure that all other forms of output (Cycled Output, 1PPS output, Event Markers, etc.) are disable. These options may all be accessed with the submenus accessible through the [Control] button.
10. Ensure that the Synch time of the Rover and Base are the same. This setting may be accessed by first pressing [Control] and then cycling through the menus until the *MASKS/SYNCH TIME* option is available.

**Rover Station:**

1. After powering on the receiver, press the [Control] Button. From the selections available, select *MORE*. This will bring up a second page of options. Select *MORE* again. The front panel screen should now be on *RECEIVER CONTROL* "3 of 7".
2. Select *BAUD RATE/FORMAT*, and from the menu that this creates, select *SERIAL PORT 1 SETTINGS*.
3. Ensure that the port is set to 38400 baud, 8-Odd-1 Format, with no flow control.
4. Similarly, make sure that the settings for I/O Port 2 agree with those of the type of radio being used (typically 9600 8-None-1).
5. Return to the *RECEIVER CONTROL* menus, and go to page 2.
6. Select *RTK ROVER CONTROL*.
7. Toggle the *ENABLE* setting to *L1/L2*.
8. Push the [Status] button, and select *POSITION*. There should now be an *RTK* option. Select it. This will bring up a screen displaying delta Northing/Easting, correction status, etc.
9. Ensure that the *STATIC* option appears at the right. This means you are in kinematic/rover mode. If instead the *ROVE* option is available, select it.
10. Ensure that all other forms of output (Cycled Output, 1PPS output, Event Markers, etc.) are disable. These options may all be accessed with the submenus accessible through the [Control] button.

11. Ensure that the Synch time of the Rover and Base are the same. This setting may be accessed by first pressing [Control] and then cycling through the menus until the **MASKS/SYNCH TIME** option is available.

**Trimble 4700/4800**

Hardware and Equipment:

1. Make sure that the computer's serial port is connected to the 4700/4800 in it's COM1 port (typically the port that a data collector is normally plugged into). Power should be supplied on COM2, and any radio used for RTK should be plugged into COM3.

2. All other equipment (antenna, wires, etc.) should be set up as normally directed by the manuals.

Software Configuration:

1. After selecting the Trimble 4700 equipment type from the "configure field" menu, open up "Equipment Setup." This should bring up a new window/dialog box with the following options:
   a. Receiver Type: Select whether you are using a 4700 or 4800 receiver.
   b. Station Type: Choose what type of RTK station you are setting this receiver up as a base or rover.
   c. RTK Correction type: Select the type of Corrections you would like a base station to transmit. Note that CMR messages should be used for most precision applications, as RTCM is only capable of producing less-accurate floating precision positions
   d. Radio Baud Rate: The baud rate of the radio port. This should be left at the default setting of 9600 in general
   e. Satellite Elevation Cutoff: All satellites with elevation from the horizon of less than this number will not be used in calculating a position. This allows less accurate low elevation satellite to be factored out of a position.
   f. Configure Base Station: Will configure the receiver to act as a base. See "Configuring Base Station" below.
   g. Cancel without saving: Will exit this menu without saving any changes that have been made.
   h. Save and Exit: Will save these settings to the receiver and to Carlson Field's setup and exit out of this menu.

Configuring Rover:

No real configuration is necessary, aside from setting up the equipment and setting the appropriate Receiver Type, Station Type, and Satellite Elevation Cutoff.

Configuring Base Station:

1. After selecting all the appropriate settings in "Configure GPS," click on the "Configure Base Station" button.

2. In the menu dialog that opens, there are a few buttons:
   a) Read from GPS: Read a position from the GPS and fix to that position
   b) Enter Lat/Lon: Fix to a manually entered Lat/Lon position
   c) Enter State Plane Coord: Fix to a manually entered State Plane Northing/Easting position
   d) Read From File: Fix to a position read from a *.ref file.
   e) Cancel: Cancel base setup

If Read From GPS is selected, the software will read once from the GPS receiver, and then fix to that position. If Enter Lat/Lon is selected, a dialog box will open and a Latitude and Longitude must be input manually. If Enter State Plane Coord is selected, a dialog box will open allowing the input of a set of Northing/Easting coordinates by hand. Read from File will open a File > Open dialog and ask for a file name of a reference file (*.REF) to open for use in corrections.

Regardless of which option is selected, after the position is determined, this position will be displayed, and dialog boxes will open to enter a station id (used by the base to identify itself to the rover(s)) and the measured base antenna height. Once these values are entered, base setup is complete and the "Exit and Save" button can be selected.
to exit the Equipment Setup menu. At this point, whenever looking at a menu that displays the connection status, "REFERENCE" will be displayed, instead of Float, Fixed, or Autonomous.

**Trimble 5800**

Carlson Field Configuration:

In Configure Field, set the Equipment Type to Trimble Generic.

In Equipment Setup, be sure to set the Data Type to match your receiver setup. This Data Type is the port on the receiver that communicates with Carlson Field. Typically, the Data Type should be set to 2 for the serial connection and to 4 for Bluetooth.

When configuring the Base receiver, use a base station id number in the range from 1 to 32.
Index

plus-0.5in
2 Tangents, Arc Length, 120
2 Tangents, Chord Length, 120
2 Tangents, Degree of Curve, 122
2 Tangents, External, 121
2 Tangents, Mid-Ordinate, 120
2 Tangents, Radius, 119
2 Tangents, Tangent Length, 121
2D Align, 83, 84
2D Polyline, 27, 115, 345, 348, 554
3 Point, 118, 126, 127, 263
3-Radius Curve Series, 125
3D Entity to 2D, 101
3D Polylines, 102
3D Viewer Window, 105, 108, 429, 436, 452, 453
4 Sided Building, 339

AASHTO, 511
Add Intersection Points, 88
Add Points At Elevation, 101
Add Polyline Vertex, 88
Align by Two Pairs of Points, 200
Align GPS To Local Coordinates, 396
Align Points, 205, 224
Alphanumeric, 54, 163, 195
Angle/Distance, 221
Angle Balance, 269, 293, 295
Angle Mode, 54, 144, 164
Annotation, 3, 24
Apache Lightbar, 572
Arc Length, 120, 122, 474
Arcview, 545, 558
Area Label Defaults, 251, 340
Arrowhead, 135, 234, 237
ASCII File, 41, 177, 191, 549, 550
ASE, 65, 581–585
Assign Contour Elevations, 422, 423
Attach Image to Entity, 546
Attribute Layers, 336
Attribute Layout ID, 184, 185, 231, 337
Audit Links, 543
Authorizing Carlson Software, 11
Auto Annotate, 88
AutoCAD Overview, 30
Automatic Point Numbers, 184
Auto Points at Interval, 411, 412, 552–554, 557, 570, 574
Auto Tablet On, 54, 164
Bearing-Bearing Intersect, 258, 259
Bearing-Distance Intersect, 257
Bearing & 3D Distance, 141
Benchmark, 415
Berm Grades, 502
Best Fit Curve, 126
Blips, 87, 147
Block Explode, 68
Boundary, 27, 136, 448
Boundary Polyline, 3, 136
Break, 69, 73, 74, 82, 91, 92, 95, 262, 486, 487, 517, 518
Break at Intersection, 74
Break by Crossing Polyline, 72
Breakline, 337, 437, 450
Breaklines, 436, 437, 450
Break Polyline at Specified Distances, 73
Building Face Surface, 417
Calculate Offsets, 127, 350
Carlson Field Icon Menu, 364
Carlson File Types, 24
Carlson Points, 78, 220, 248
Carlson Registration, 13
Centerline Conversion, 477
Centerline Conversions, 477
Centerline File, 477
Centerline Position, 455, 456
Change Attribute Style, 74
Change Block/Inserts Resize, 77
Change Block/Inserts Rotate, 76
Change Block/Inserts Substitute, 77
Change Elevations, 74, 195, 204
Change Layer, 95, 111
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Point Layer Color</td>
<td>240</td>
</tr>
<tr>
<td>Change Polyline Elevation</td>
<td>95</td>
</tr>
<tr>
<td>Change Polyline Width</td>
<td>94</td>
</tr>
<tr>
<td>Change Style</td>
<td>75</td>
</tr>
<tr>
<td>Change Text Font</td>
<td>79</td>
</tr>
<tr>
<td>Change Text Oblique Angle</td>
<td>81</td>
</tr>
<tr>
<td>Change Text Size</td>
<td>80</td>
</tr>
<tr>
<td>Change Text Width</td>
<td>80</td>
</tr>
<tr>
<td>Channel Sample</td>
<td>24</td>
</tr>
<tr>
<td>Check Elevation Range</td>
<td>96</td>
</tr>
<tr>
<td>Chord Bearing</td>
<td>142</td>
</tr>
<tr>
<td>Chord Length</td>
<td>119, 120, 123</td>
</tr>
<tr>
<td>CLAYER, 18</td>
<td></td>
</tr>
<tr>
<td>CL File, 85, 345, 477</td>
<td></td>
</tr>
<tr>
<td>Closed Polylines</td>
<td>545</td>
</tr>
<tr>
<td>Closure, 2, 287, 291, 310</td>
<td></td>
</tr>
<tr>
<td>Closure Error</td>
<td>341</td>
</tr>
<tr>
<td>Coal Sections</td>
<td>61, 171</td>
</tr>
<tr>
<td>Code Definitions</td>
<td>319, 329, 337</td>
</tr>
<tr>
<td>COGO Menu, 250</td>
<td></td>
</tr>
<tr>
<td>Color by Elevation</td>
<td>428</td>
</tr>
<tr>
<td>Command Entry</td>
<td>17</td>
</tr>
<tr>
<td>Common Format List</td>
<td>191</td>
</tr>
<tr>
<td>Compare Points</td>
<td>206, 207, 356</td>
</tr>
<tr>
<td>Compass, 309–311, 313</td>
<td></td>
</tr>
<tr>
<td>Composite Bed Qualities by Density, 61, 171</td>
<td></td>
</tr>
<tr>
<td>Compound Curve</td>
<td>513</td>
</tr>
<tr>
<td>Compound or Reverse</td>
<td>124</td>
</tr>
<tr>
<td>Configuration, 24, 26, 62, 152, 153, 172, 578, 582, 585, 593–595</td>
<td></td>
</tr>
<tr>
<td>Configure Field, 365, 378, 381, 385, 391, 396, 399–401, 403, 413, 455, 552, 555, 557, 558, 561, 562, 568, 569, 573–576, 578, 586, 589, 591</td>
<td></td>
</tr>
<tr>
<td>Contours, 94, 153, 427, 430, 432, 441, 443, 444, 447</td>
<td></td>
</tr>
<tr>
<td>Convert C&amp;G to Carlson Points, 245</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to Ashtech GIS, 428</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to C&amp;G, 245</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to Eagle Point, 249</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to Land Desktop, 244</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to Simplicity, 246</td>
<td></td>
</tr>
<tr>
<td>Convert Carlson Points to Softdesk, 248</td>
<td></td>
</tr>
<tr>
<td>Convert Civil 3D to Carlson Points, 244</td>
<td></td>
</tr>
<tr>
<td>Convert CRD to Land Desktop MDB, 242</td>
<td></td>
</tr>
<tr>
<td>Convert CRD to TDS CR5/Convert TDS CR5 to CRD, 242</td>
<td></td>
</tr>
<tr>
<td>Convert Eagle Point to Carlson Points, 249</td>
<td></td>
</tr>
<tr>
<td>Convert Geodimeter to Carlson Points, 247</td>
<td></td>
</tr>
<tr>
<td>Convert Land Desktop MDB to Carlson Points, 243</td>
<td></td>
</tr>
<tr>
<td>Convert Leica to Carlson Points, 247</td>
<td></td>
</tr>
<tr>
<td>Convert PacSoft CRD to Carlson CRD, 248</td>
<td></td>
</tr>
<tr>
<td>Convert Simplicity to Carlson Points, 247</td>
<td></td>
</tr>
<tr>
<td>Convert Softdesk to Carlson Points, 245</td>
<td></td>
</tr>
<tr>
<td>Convert Surveyor1 to CRD, 242</td>
<td></td>
</tr>
<tr>
<td>Coordinate File, 24, 40, 176, 190, 194, 197, 216, 222, 286, 287, 302, 319, 338, 349, 360, 371, 376</td>
<td></td>
</tr>
<tr>
<td>Coordinate File Utilities, 195</td>
<td></td>
</tr>
<tr>
<td>Coordinate File Utilities, 74, 144, 188, 196, 209, 222, 245, 247, 249, 253, 567</td>
<td></td>
</tr>
<tr>
<td>Coordinate Transformation, 25, 199</td>
<td></td>
</tr>
<tr>
<td>Copy Polyline Section</td>
<td>67</td>
</tr>
<tr>
<td>Copy To Layer, 67</td>
<td></td>
</tr>
<tr>
<td>Crandall, 2</td>
<td></td>
</tr>
<tr>
<td>Create Links, 542, 544, 549</td>
<td></td>
</tr>
<tr>
<td>Create Points from Entities, 264, 265</td>
<td></td>
</tr>
<tr>
<td>Create Polyline ID Labels</td>
<td>93</td>
</tr>
<tr>
<td>Crosshairs, 155</td>
<td></td>
</tr>
<tr>
<td>CSI GBX Pro, 572, 573</td>
<td></td>
</tr>
<tr>
<td>CSTYLE, 18</td>
<td></td>
</tr>
<tr>
<td>Current Query, 536</td>
<td></td>
</tr>
<tr>
<td>Curve - Arrow, 136</td>
<td></td>
</tr>
<tr>
<td>Curve Calc, 126, 127</td>
<td></td>
</tr>
<tr>
<td>Curve Edit Mode, 472</td>
<td></td>
</tr>
<tr>
<td>Curve Info, 52, 142, 162</td>
<td></td>
</tr>
<tr>
<td>Custom, 7, 8, 24, 225, 228, 335</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet, 356, 357, 359</td>
<td></td>
</tr>
<tr>
<td>Cutsheet, 371</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet Report, 353, 360</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet Spreadsheet Editor, 352</td>
<td></td>
</tr>
<tr>
<td>Database File Utilities, 548, 549</td>
<td></td>
</tr>
<tr>
<td>Data Collectors, 272</td>
<td></td>
</tr>
<tr>
<td>Deed Description, 25</td>
<td></td>
</tr>
<tr>
<td>Define Note File Prompts, 547–549, 560, 563, 564</td>
<td></td>
</tr>
<tr>
<td>Define Strata, 61, 171</td>
<td></td>
</tr>
<tr>
<td>Define Template Database, 529, 530, 532–535</td>
<td></td>
</tr>
<tr>
<td>Delete Points, 205</td>
<td></td>
</tr>
<tr>
<td>Delta Angle, 124</td>
<td></td>
</tr>
<tr>
<td>Denisty Polyline Vertices, 86</td>
<td></td>
</tr>
<tr>
<td>Depth Sounder, 568, 569, 573, 574</td>
<td></td>
</tr>
<tr>
<td>Description for Points, 205</td>
<td></td>
</tr>
<tr>
<td>Design Centerline, 469, 477</td>
<td></td>
</tr>
<tr>
<td>Design Pad Template, 3, 26, 496</td>
<td></td>
</tr>
<tr>
<td>Design Template, 496, 501, 510</td>
<td></td>
</tr>
<tr>
<td>Direct-Reverse Report, 303</td>
<td></td>
</tr>
</tbody>
</table>
Index

Direct-Reverse Settings, 301
Discussion Groups, 28
Display-Edit File, 149
Display-Edit Text/ASCII File, 49
Display Last Report, 149
Distance-Distance Intersect, 259
Ditch, 501, 502, 510
Ditch Grades, 501, 502
Divide Along Entity, 261
Divide Between Points, 260
Dozer, 26, 265
Dozer Push, 24
Dragline, 24, 26
Draw-Locate Points, 186, 205, 220, 251, 253–255, 316, 566
Draw 3D Grid File, 428, 431
Draw By Example, 133
Draw Centerline File, 476
Draw Grid, 480, 485
Drawing Explorer, 15, 40, 41, 43–45, 174–177
Drawing Inspector, 147, 148
Drawing Setup, 15, 53, 54, 135, 143, 145, 156, 158, 162, 164, 189, 216, 251, 336, 344, 515, 523, 524, 586, 589
Drawing Template, 330
Draw Menu, 114
Draw Polyline Blips, 87
Draw Profile, 26, 477, 479, 480, 490
Draw Section File, 515
Draw Triangulate Mesh, 452
Draw Typical Template, 506
DTM Menu, 419
Duplicate Points, 206
Dynamic Annotation, 53, 163
Eagle Point, 33, 249, 320–322
Eagle Point Coding, 320
Earth Curvature, 290, 307, 309, 372
Edit-Process Raw Data File, 267
Edit Menu, 64, 275
Edit Multiple Pt Attributes, 230
Edit Point, 190, 214
Edit Point Attributes, 228
Edit Points, 219, 338
Edit Polyline Section, 90
Edit Polyline Vertex, 89, 90
Edit Symbol Library, 159
Edit Table, 550
Elevation Difference, 373, 420, 421, 430
Elevation Zones, 428
End Areas, 24, 519
Enter-Assign Point, 255
Enter and Assign, 188
Entities to Polylines, 85
Entity Insertion Point Rotate, 78
Equipment Reference, 571
Erase by Closed Polyline, 65
Erase by Layer, 65
Erase Links, 543
Erase Outside, 66
Erase Point Attributes, 235
Erase Points, 220
Explode Carlson Points, 241
Export DXF File, 49
Export SHP File, 545
Export Text, 198
Export Text/ASCII File, 192, 198, 217
Extend, 3, 27, 69–72, 115–118
Extend Arc, 69
Extend by Distance, 69, 70
Extend to Intersection, 68, 69
Extract Project Archive, 46, 173
Extrapolate, 380, 426, 432–434
Extrapolate Grid, 429
Extrapolation, 426
Fence Diagram, 25
Ferm Codes, 25
Field Menu, 363
Field User Guide, 551
File Menu, 36, 270
File Types, 558
Fillet, 27, 98, 100
Fillet 3D Polyline, 98
Find Bad Angle, 303
Find Point, 148
Fix Point Attribute Overlaps, 236, 238
Flip Text, 82, 344, 482
Flood Note, 156
Freeze Layer, 112
General Commands, 32, 251, 253–255
Geodimeter, 247, 272, 314, 376, 574, 575
Geodimeter/Trimble 5600, 574
<table>
<thead>
<tr>
<th>Term</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geologic Column</td>
<td>25</td>
</tr>
<tr>
<td>GIS Database Settings</td>
<td>532</td>
</tr>
<tr>
<td>GIS Data Collection</td>
<td>557–559, 562, 564, 567</td>
</tr>
<tr>
<td>GIS File</td>
<td>185, 374, 530, 558–560, 563, 565</td>
</tr>
<tr>
<td>GIS Inspector</td>
<td>533</td>
</tr>
<tr>
<td>GIS Inspector Settings</td>
<td>532, 534</td>
</tr>
<tr>
<td>GIS Links</td>
<td>23, 542</td>
</tr>
<tr>
<td>GIS Menu</td>
<td>528</td>
</tr>
<tr>
<td>GIS Query/Report</td>
<td>535</td>
</tr>
<tr>
<td>GIS Settings</td>
<td>529</td>
</tr>
<tr>
<td>Grid File</td>
<td>53, 91, 95, 162, 187, 290, 427, 430, 432, 433</td>
</tr>
<tr>
<td>Grid File Utilities</td>
<td>25, 426</td>
</tr>
<tr>
<td>Grid Lines</td>
<td>481</td>
</tr>
<tr>
<td>Guardrail Expansion</td>
<td>502</td>
</tr>
<tr>
<td>HEC-2</td>
<td>25</td>
</tr>
<tr>
<td>Highlight Crossing Plines</td>
<td>97</td>
</tr>
<tr>
<td>Horizontal Axis Elevations</td>
<td>484</td>
</tr>
<tr>
<td>Hydrograph</td>
<td>25</td>
</tr>
<tr>
<td>Image Inspector</td>
<td>545</td>
</tr>
<tr>
<td>Import/Export LandXML Files</td>
<td>49, 526</td>
</tr>
<tr>
<td>Import DXF File</td>
<td>49</td>
</tr>
<tr>
<td>Import SHP File</td>
<td>544</td>
</tr>
<tr>
<td>Import Text/ASCII File</td>
<td>2, 17, 191, 198</td>
</tr>
<tr>
<td>INI Files</td>
<td>53, 162</td>
</tr>
<tr>
<td>InnerSpace Tech Depth Sounder</td>
<td>575</td>
</tr>
<tr>
<td>Input-Edit Centerline File</td>
<td>469</td>
</tr>
<tr>
<td>Input-Edit GIS Data</td>
<td>532, 537</td>
</tr>
<tr>
<td>Input-Edit Point</td>
<td>190, 207, 567</td>
</tr>
<tr>
<td>Input-Edit Profile File</td>
<td>477</td>
</tr>
<tr>
<td>Input-Edit Super Elevation</td>
<td>511</td>
</tr>
<tr>
<td>Inq-Set Menu</td>
<td>140</td>
</tr>
<tr>
<td>Insert Multi-Point Symbols</td>
<td>130</td>
</tr>
<tr>
<td>Insert Symbols</td>
<td>128, 130</td>
</tr>
<tr>
<td>Installing Carlson Software</td>
<td>5</td>
</tr>
<tr>
<td>Instruction Manual and Program Conventions</td>
<td>23</td>
</tr>
<tr>
<td>Interpolate Points</td>
<td>261, 263</td>
</tr>
<tr>
<td>Intersection Points</td>
<td>349</td>
</tr>
<tr>
<td>Intersections</td>
<td>257, 438</td>
</tr>
<tr>
<td>Interval Along Entity</td>
<td>261</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Inverse</td>
<td>251–255, 267, 341</td>
</tr>
<tr>
<td>Inverse with Area</td>
<td>340</td>
</tr>
<tr>
<td>Isolate Layer</td>
<td>112, 113, 186</td>
</tr>
<tr>
<td>Issuing Commands</td>
<td>31</td>
</tr>
<tr>
<td>Join</td>
<td>83, 100, 325</td>
</tr>
<tr>
<td>Join 3D Polyline</td>
<td>99</td>
</tr>
<tr>
<td>Join Nearest</td>
<td>3, 85, 100</td>
</tr>
<tr>
<td>Label Contours</td>
<td>444</td>
</tr>
<tr>
<td>Label Elevations</td>
<td>370</td>
</tr>
<tr>
<td>Label GIS Polyline: Closed Polyline Data</td>
<td>539</td>
</tr>
<tr>
<td>Label GIS Polyline: Closed Polyline Image</td>
<td>537</td>
</tr>
<tr>
<td>Label GIS Polyline: Open Polyline Data</td>
<td>540</td>
</tr>
<tr>
<td>Label Zeros</td>
<td>187, 318</td>
</tr>
<tr>
<td>LandXML</td>
<td>14, 27, 49–51, 272</td>
</tr>
<tr>
<td>Laser Atlanta</td>
<td>576</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>389</td>
</tr>
<tr>
<td>Layer and Style Defaults</td>
<td>18</td>
</tr>
<tr>
<td>Layer ID</td>
<td>141</td>
</tr>
<tr>
<td>Layer Inspector</td>
<td>146</td>
</tr>
<tr>
<td>Layer Report</td>
<td>146</td>
</tr>
<tr>
<td>LDD</td>
<td>242–244</td>
</tr>
<tr>
<td>Leica</td>
<td>247, 272, 376, 381–383, 418, 494–496, 576–578</td>
</tr>
<tr>
<td>Leica Disto</td>
<td>576</td>
</tr>
<tr>
<td>Leica GPS System</td>
<td>576</td>
</tr>
<tr>
<td>Leica TC Series</td>
<td>577</td>
</tr>
<tr>
<td>License Agreement</td>
<td>5, 12</td>
</tr>
<tr>
<td>Limit Polylines</td>
<td>61, 171</td>
</tr>
<tr>
<td>Line Type Scaler</td>
<td>144</td>
</tr>
<tr>
<td>Links Manager</td>
<td>203</td>
</tr>
<tr>
<td>LisCad</td>
<td>247</td>
</tr>
<tr>
<td>List Elevation</td>
<td>422</td>
</tr>
<tr>
<td>List Points</td>
<td>144, 189, 190, 205, 371, 561, 566</td>
</tr>
<tr>
<td>Load Saved Report</td>
<td>182</td>
</tr>
<tr>
<td>Locate on Real Z Axis</td>
<td>184, 187, 264, 370</td>
</tr>
<tr>
<td>Locate Point</td>
<td>17, 28, 184, 189, 236, 256, 318</td>
</tr>
<tr>
<td>Make 3D Grid File</td>
<td>424, 429, 430, 434</td>
</tr>
<tr>
<td>Manual Total Station</td>
<td>579</td>
</tr>
<tr>
<td>Map Points from</td>
<td>198</td>
</tr>
<tr>
<td>Maps</td>
<td>427</td>
</tr>
<tr>
<td>Maptech</td>
<td>273</td>
</tr>
<tr>
<td>Max Samples</td>
<td>58, 60, 168, 170</td>
</tr>
<tr>
<td>Median Design</td>
<td>497</td>
</tr>
<tr>
<td>Mikrofyn Lightbar</td>
<td>580</td>
</tr>
<tr>
<td>Mirror</td>
<td>28</td>
</tr>
<tr>
<td>Monitor GPS Position</td>
<td>415, 569, 574</td>
</tr>
<tr>
<td>Mortgage Block</td>
<td>156</td>
</tr>
<tr>
<td>Mouse Click Settings</td>
<td>160</td>
</tr>
<tr>
<td>Move Point Attributes</td>
<td>239</td>
</tr>
<tr>
<td>Move Point Attributes Single</td>
<td>233</td>
</tr>
<tr>
<td>Move Point Attributes with Leader</td>
<td>233, 239</td>
</tr>
<tr>
<td>Move Points</td>
<td>228</td>
</tr>
<tr>
<td>Multi-Point Symbols</td>
<td>131, 133</td>
</tr>
<tr>
<td>NADCON</td>
<td>199</td>
</tr>
<tr>
<td>National Geodetic Survey</td>
<td>368</td>
</tr>
</tbody>
</table>
Navcom Configuration Guide, 580
Navcom GPS Setup, 582
Nearest Found, 317
Nikon, 273, 314, 585, 586
Nikon Total Stations, 585
Nodes, 187
North Arrow, 483
Note File, 356, 371, 374, 526, 549, 557, 558, 561, 563, 565
Numeric, 54, 163
Object Data, 529
Object Linking, 53, 163
Obtaining Technical Support, 28
Occupied Point, 252, 305, 307
Offset 3D Polyline, 99
Offset Cutoff, 545
Offset Point Entry, 127
Offsets Point Entry, 348
Offset Stakeout, 457
OmniStar Otto, 586
Ownership, 25
Pattern Point Survey, 417
PC, PT, Radius Point, 118
PC, Radius, Arc Length, 119
PC, Radius, Chord, 118
PC Point, 119
PDSIZE, 53, 162
Pick Intersection Points, 256
Pipe Size, 26
PI Points, 343, 348, 472
Pivot Point Rotate by Bearing, 78
Point Check By Robotics, 418
Point Defaults, 184, 185, 231, 240, 253, 255, 258, 262, 316
Point Description, 148, 188, 204, 241, 242, 255, 261, 262, 316
Point Entity, 231
Point Group Manager, 210, 214
Point ID, 141, 203, 379
Point Layer, 53, 162, 337
Point Notes, 190, 290, 351, 369, 370, 562, 563, 566
Point Number Report, 206
Point Object Snap, 152
Point Protect, 51, 191, 209, 253, 289
Point Range, 26, 197
Points Menu, 183
Points on Centerline, 349
Point Store, 400, 401, 403, 404, 412, 413, 421, 456, 552–556, 561, 563, 564
Polygon Processor, 26
Polyline by Nearest Found, 138
Polyline Info, 143
Polyline to Centerline File, 476
Pre-calculated grids, 26
Prepare Story Stake, 466, 467
PRO, 17, 26, 37, 40, 51, 161, 176, 179, 457, 477, 478, 487, 493–496, 580
Process Only Strata with Beds, 61, 171
Product Overview, 2
Profile Conversion, 494–496
Project Explorer, 15, 43, 175
Properties and Layers, 34
Properties Toolbar, 35
Quick Keys, 18, 27
Radius Point, 122–124, 142, 345
Railroad, 127
Raw File On/Off, 256
Reame, 26
Reduce Direct-Reverse, 303
Reduce Polyline Vertices, 85, 86
Reduce Vertices, 3, 441, 443
Registration, 11, 14
Remove Duplicate Polylines, 91
Remove Polyline Arcs, 91, 95
Remove Polyline Segment, 92
Remove Polyline Vertex, 92
Renumber Points, 204, 207, 241, 304
repackaged, xi
Replace Text, 20, 83
Report Grade Elevation, 351, 352
Report Log, 52, 162
Rescale Drawing, 155
Resection, 416
Residuals, 26, 301
Resize, 281
Resize Point Attributes, 236
Restore Due North, 111
Restore Layer, 113
Reverse Curve, 513
Reverse Polyline, 85
Right of Way, 502
Rigid Body Transformation, 202
RoadCalc, 526, 527
Road Design, 26, 27, 357, 497, 499, 501, 505, 508, 515
Roadside Ditch, 26
Roads Menu, 454
Rotate Points, 109, 205, 222
Rotate Text, 79
Runoff, 26, 434
Run Off Tracking, 434
Satellite SkyPlot, 414
Save/Load Tablet Calibration, 152
SB-Slope, 26
Scale Point Attributes, 234, 236
Scale Points, 144, 205, 225
Screen Pick Point, 205
SDPS, 60, 170
Seam Stacking, 60, 170
Search Radius, 60, 170
Section Conversion, 526, 527
Section File, 356, 457, 461, 501, 515, 522
Section Name, 515
Section Report, 526
SEDCAD, 24, 59, 169
Select by Area, 103
Select by Elevation, 102
Select by Filter, 102
Selection of Items, 33
Sequential Numbers, 134
Set/Reset X-Hairs, 154
Set Coordinate File, 40, 176, 194, 267
Set Data Directory, 17
Set Layer, 111
Set Polyline Origin, 94
Set Project/Data Folder, 37
Set Project/Data Folders, 179
Setting Up a Project, 14
Sewer, 26, 492, 557, 559
Sewer Structure, 26
Shade, 108, 326
SHP File, 545
Shrink-Wrap Entities, 137
Side Shots, 254
Sight Distance, 296, 478, 491
Simulation (GPS), 587
Sliding Side Area, 3
Slope Distance, 306, 307
Slope Inspector, 465, 466
Slope Staking, 461, 462, 465
Smart Prompting, 532, 533
SMI, 24, 273, 314, 526
Smoothing, 443
Smooth Polyline, 86, 337, 402
Softdesk, 245, 248, 272, 494–496, 526
Sokkia, 587, 589
Sokkia/SDR, 314, 495
Sokkia G, 384, 385
Special Leader, 3
Spiral, 128, 470, 472–474
Spiral Curve, 127
Spiral In, 472
Split Bed by Parameters, 61, 171
Split Text into Two Lines, 82
SQL, 14
SRVPNO, 184, 240, 337, 445
Stakeout, 408–410, 459–461, 465, 466
Standard Report Viewer, 18, 49, 142, 149, 190, 291, 293
Start Point Number, 184, 185
Startup Wizard, 15–17, 52, 162
Station-Offset, 350, 358, 359, 420
Station/Polyline Centerline, 341
Station Polyline/Centerline, 343
Store Project Archive, 45, 46, 173, 174
Story Stake Along Polyline, 468
Story Stake By Points, 468
StrataCalc, 24
Strata Isopach Maps, 24
Strata Quantities, 27
Superelevation, 26, 357, 461, 512, 514
Surface 3D Viewer, 108
Surface Entities, 493, 515
Surface Inspector, 26
Surface Model, 85, 117, 434, 516
SurvCE, 25, 26, 270, 273, 299, 322, 356, 357, 530, 548, 549
SurvCE/SurvStar Data Transfer, 265
SurvCOGO, 273, 315
SurvStar, 265, 397, 529, 530, 547, 558, 559
Symbol Library, 26, 128
Symbol Plot Size, 144
Symbol Size, 53, 162, 335, 440
System Requirements, 4
System Variable Editor, 149
Tablet Calibrate, 153
Tablet Calibration, 153, 154
Tang, PC, Radius, Chord Length, 123
Tang, PC, Radius, Delta Angle, 124
Tangent, PC, Radius, Arc Length, 122
Tangent, PC, Radius, Tangent Length, 123
Tape Baseline, 263
TDS, 2, 267, 273, 274, 322
TDS CR, 242
Technical Support, 29, 582, 585
Template Database, 374, 530, 531
Template Point Profile, 357, 508
Template Points, 496
Template Transition, 508–511
Terramodel, 496, 526
Text Enlarge/Reduce, 79, 80
Text Explode To Polylines, 83
Text Plot Size, 144
Text Size, 79, 135, 281, 335, 344, 444, 520
Text Style, 344, 488
Thaw Layer, 112
Title Block, 3, 156
Toolbars, 51, 160
Topcon Total Stations, 589
Track Position, 413, 587
Transit, 294, 301, 501, 502, 508, 510, 511
Translate Points, 109, 205, 220
Triangulate & Contour, 435, 436, 452
Triangulation, 25, 27, 49, 58, 60, 168, 170, 356, 424, 425, 430, 435, 436, 446, 452, 453
Triangulation File Utilities, 447, 449
Trim, 28
Trimble, 191, 273, 378, 383–385, 582, 592–595
Trim by Point Symbol, 239, 240
Twist, 53, 78, 79, 162, 235, 365
Twist Point Attributes, 235
Twist Screen: Line Pline or Text, 110
Twist Screen: Standard, 109
Twist Screen: Surveyor, 110
Two Surface Volumes, 429–433
Typical Alignment Scenarios, 399
Typical Template, 496, 497, 507, 508
Universal Transverse Mercator, 199
Update Drawing from CRD File, 204
Using the Carlson Software Manual, 2
Variable Offset, 68

Ventilation, 26
Vertical Angle, 255, 278, 289, 301, 307
Vertical Angle Mode, 185
View Menu, 104
Volume, 3, 429, 430, 432, 433, 436, 447

Web Site, 29
Wild, 188, 191, 314, 495, 496
Wildsoft, 205, 272
Write Polyline File, 83

Zeiss, 191, 192, 273
Zoom Points, 105
Zoom Selection, 105

Index 602